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TASKE Call Center Management Tools 
Welcome to the TASKE Call Center Management Tools, a collection of Microsoft 
Windows based tools and utilities. These applications aid supervisors in analyzing the 
performance of the ACD call center and fine-tune its operation. 
 
After installing the software, access the applications of the TASKE ACD ToolBox 
through the TASKE ToolBox folder on the desktop of the PC, or through the Start button 
on the Windows task bar. Each application within the TASKE ToolBox folder provides 
the functionality for a particular aspect of call center management. 
 

 
 

Using this Guide 

This guide has a section for each application in the TASKE ACD ToolBox. For 
installation and configuration instruction, refer to the Installation and Configuration 
Guide for version 8.0 of the TASKE Call Center Management Tools. 
 
The contents of the TASKE ACD ToolBox vary depending on the type of installation 
performed on the PC (Server, Supervisor, Enterprise Supervisor, or Agent). The table 
below outlines the components installed with each type of installation. 
 

Installation Type Components Installed 
Server • Information Server 

• Administrator 
• Reports 
• ACD Monitor with Chat 
• Search 
• Traffic Analyzer 
• WallSign Server (if selected for installation) 
• Voice Server (if selected for installation) 
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Installation Type Components Installed 
Supervisor • Administrator 

• Reports 
• ACD Monitor with Chat 
• Search 
• Traffic Analyzer 
• WallSign Administrator (if selected for installation) 
• Voice Administrator (if selected for installation) 

 
Installation Type Components Installed 
Enterprise 
Supervisor 

• Administrator 
• Reports 
• ACD Monitor with Chat 
• Enterprise ACD Monitor 
• Search 
• Traffic Analyzer 
• WallSign Administrator (if selected for installation) 
• Voice Administrator (if selected for installation) 

 
Installation Type Components Installed 
Agent • Agent Desktop with Chat 
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TASKE Information Server 

The TASKE Information Server is an application for server installations only. Installed 
on the TASKE Server PC, this application ensures that the data supplied by the 
telephone system is collected, stored and properly dispersed to the real-time 
applications of the TASKE ACD ToolBox. 
 
Users of the TASKE Server PC use the Information Server interface for a number of 
applications. These include: 
 

 Viewing the client connections to the TASKE Information Server 
 Viewing site connections to the Information Server for Enterprise enabled sites 

(local and enterprise connections) 
 Monitoring the flow of the data stream 
 Viewing and changing the data port settings for the data stream 
 Viewing the individual connections to the Chat server 
 Viewing the TASKE Server IP information and status 
 Viewing the particulars of the TASKE Software license for the site and the 

number of clients currently using the TASKE suite of Tools 
 Integrating the Blue Pumpkin PrimeTime workforce management software with 

TASKE Call Center Management Tools 
 Setting the file location of the real-time adherence schedules 
 Showing the data alarms 
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Starting the Information Server 

Use the following steps to start the Information Server application on the TASKE server 
PC.  
 

1. Click the Start button on the Windows task bar. 
 

 
 

2. Select Programs from the Start menu. 
 

 
 

3. Select the TASKE 8.0 program group from the Programs menu. 
 

 
 

4. Select Information Server from the TASKE 8.0 program group to open the 
Information Server.  
 

 
 

 
 

When the Information Server is running, an icon is present in the Windows System 
Tray. If the application has encountered data alarms the icon appears with a red flag. 
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Right-click on this icon to open a menu that allows the user to perform the following 
activities: 
 

• open the Information Server window when it is closed, 
• open the TASKE Data Alarms dialog box, 
• display information about the TASKE Information Server application, including 

the Lock Number for the site, 
• and exit the Information Server application. 

 
Exiting the Information Server application completely shuts down the application and 
stops all data collection. Do not perform this action unless it is absolutely necessary.  
 

Viewing Client Connections 

The Clients tab of the Information Server allows a user to view the current number of 
client applications connected to the Information Server. Any client applications that 
require real-time information (such as the TASKE ACD Monitor) are displayed in the list 
at the top of the Clients tab. The list displays the client's IP address and the name of the 
application the client is using, and the site name. 
 

 
 
Selecting a client in the list by clicking on the client entry, displays the client information 
in the Status, Details, and Messages sections of the dialog box. 
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Status 

The Status section of the Clients tab displays the connection status of the 
selected client to the Information Server. The status is either Connected or 
Blocked.  

 
When a client is connected and receiving data, the Status section indicates a 
Connected state and displays a green light with the date and time of the 
connection.  
 
When the client connection to the Information Server is lost, the status section 
indicates a Blocked state and displays a yellow light to indicate there is a 
problem with the connection. The client application automatically attempts to 
reconnect at 15-second intervals as long as the client application is running.  
 

Disconnect 

To permanently disconnect a client from the Information Server, the user of the 
TASKE server must first lock the site to new connections from the Sites tab (see 
Locking Sites and Disconnecting Clients in the TASKE Enterprise section). This 
prevents the client application from reconnecting after 15 seconds. Once the site 
is locked, return to the clients tab, select the client to disconnect from the list of 
client connections, and click the Disconnect button.  
  

Details 

The Details section of the Clients tab displays the network name and the IP 
address of the client selected in the connection list. Select any client in the list to 
view the details for that PC. 
 

Messages 

The Messages section of the Clients tab displays information about the PBX 
messages sent to the Client from the Information Server. The Last sent section 
displays the date and time of the last message received by the Client from the 
Information Server. The Last queued section displays the date and time of the 
last message the Information Server attempted to send.  
 
If the client becomes Blocked, the Last sent and Last queued times may differ. 
The Last sent field will display the date and time of the last successful message. 
The Last queued field will display the date and time of the last message sent to 
the queue. Because the client connection is blocked, the messages will 
accumulate in the queue until the client connection is re-established, or 
disconnected. 
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Viewing the SMDR Connection 

The SMDR tab of the TASKE Information Server allows a user to view the SMDR 
connection to the TASKE Information Server. If the SMDR connection is active, and 
properly connected, SMDR records can be seen scrolling through the SMDR Events 
screen in the SMDR tab. The SMDR data cannot be manipulated from the Information 
Server - and should not be interpreted from the screen. The records are simply 
displayed to allow a user to confirm that the SMDR data is being collected. 
 

 
 
Up to 150 records are displayed in the SMDR tab at a time. 
 

SMDR Events 

The SMDR Events section of the SMDR tab displays the data being received 
from the SMDR connection and collected by the TASKE Collector for use with 
the ACD ToolBox applications. Scroll bars are present on the right-hand side and 
across the bottom of the SMDR Events window to allow a user to scroll through 
the SMDR records. 
 

Communications 

The Communications section of the SMDR tab displays information about the 
SMDR connection to the Information Server machine. The data port on the 
TASKE Information Server that transports the SMDR data is displayed, as well 
as the port settings. If the connection is receiving data, a green light is displayed 
with the title Working Normally. If the connection is not receiving data, a red light 
is displayed with the title Not working. See log file for details. 
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The port settings may be changed by clicking the Change... button. 
 

 
 

Communications Settings 

The Communications Settings dialog box appears when the Change... button is 
pressed in the Communications section of the SMDR tab. Any settings changed 
from here affect the port settings of the SMDR port. The settings will be used by 
the Information Server to attempt to receive data as soon as the OK button is 
clicked. 
 
The data port settings should only be changed if they are incorrect. If they are 
changed while the data is being received, the data connection may cease to 
function properly. 
 

Viewing Chat Connections 

The Chat tab of the TASKE Information Server allows a user to view the current number 
of agents and supervisors currently logged into the TASKE Chat Server through the 
ACD Monitor and the Agent Desktop applications. 
 

  
 

Chat Members 

The Chat Members section of the tab provides a table that indicates who is 
logged into TASKE Chat (using the network PC name), the machine the user is 
logged in from (also the network PC name), and the IP address of the PC.  
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Viewing License Information 

The TASKE License section of the License tab displays the TASKE software licensing 
information that is stored in the file "TaskeLck.lis" in the TASKE install directory. 
 

 
 
The TASKE License section of the License tab displays the following information: 
 

Customer: the customer name of the site. 
 
Lock Number: the Serial Number (or Lock Number) which is required for to receive 
TASKE Technical Support or for ordering upgrades of software from TASKE. 
 
Primary agent IDs: the maximum number of agents allowed to connect to the 
Information Server at any one time. 
 
Secondary IDs per agent: the maximum number of secondary agent IDs allowed 
on a per agent basis. 
 
Enterprise supervisors: the maximum number of Enterprise Supervisors allowed to 
connect at any time, and the number of Enterprise Supervisors currently active and 
connected to the Information Server. 
 
Supervisors: the maximum number of Supervisors allowed to connect at any time, 
and the number of Supervisors currently active and connected to the Information 
Server. 
 
Agent desktops: the number of Agent Desktops allowed to connect at any time, 
and the number of Agent Desktops currently active and connected to the Information 
Server. 
 
Wall signs: the number of Wall signs (Reader boards) that are in use, the number 
allowed to connect is unlimited. 
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Voice channels: the number of voice ports the site is enabled to use and the 
number actually being used. 

 
The licensing information can be updated by clicking the Update... button on the 
License tab. This is only necessary when a site upgrades and requires a change to its 
licensing configuration. The new license file must be provided by TASKE. The site can 
receive the file on diskette or via email. 
 
Clicking the Update... button opens the Browse for Folder dialog box. Select the location 
of the new license file and click OK to copy the new licensing information and update 
the License tab of the TASKE Information Server. 
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Viewing General Information 

The General tab of the TASKE Information Server allows a user to view TASKE Server 
IP information. The Server information cannot be manipulated from this tab; the 
information is available for reference only. 
 

 
 

TASKE Server Information 

The TASKE Server Information section of the General tab displays the following 
information. 

 
IP address: the IP address of the TASKE Server PC. 
 
Info server port: the port number the TASKE server uses to receive client 
connections. 
 
Chat server port: the port number the TASKE server uses to receive chat 
connections. 
 
Running since: the date and time the TASKE Information Server was 
launched.  
 

Integrating PrimeTime with TASKE 

The PrimeTime option on the Configure menu provides the PrimeTime Integration 
Wizard that allows users to integrate the Blue Pumpkin PrimeTime workforce 
management software with the TASKE Call Center Management Tools. 
 
 

 
 

If this is the first time using the PrimeTime Integration Wizard, the Welcome To 
PrimeTime Installation For TASKE ToolBox dialog box opens. If the integration process 
has already been completed at an earlier time and the user is simply updating the 
configuration, the Configure TASKE and PrimeTime dialog box opens. 



TASKE Call Center Management Tools            

 
- 12 - 

For instruction and information on integrating PrimeTime with TASKE, refer to the 
PrimeTime Integration and Configuration Guide for TASKE Call Center Management 
Tools. 
 

Setting the Real-time Adherence Schedule File Location 

TASKE ACD ToolBox applications, such as the ACD Monitor, use the information in the 
PrimeTime schedules to determine if agents are adhering to the schedules. If an agent 
is not adhering to the schedule, the ACD Monitor will raise an alarm if it is setup to do 
so. The practice of tracking agents in this manner is known as Real-time Adherence. 
This means that the ACD Monitor tracks agent activity in real-time and compares this 
activity with what is expected in the schedule. If the agent is conducting activities 
outside of the schedule, supervisors are immediately aware of this deviance from the 
schedule. 
 
For the Information Server to provide applications such as the ACD Monitor scheduling 
information, it must know where to locate the schedules. The Set RTAA Schedule File 
Location... option on the Configure menu opens the Set Schedule File Location dialog 
box. This dialog box sets the location of the root folder for the PrimeTime schedules.  
 
 

 
 
To locate the root folder for the PrimeTime Schedules, input the path to the folder in the 
Schedule File Location field. If this information is not readily available, click the Browse 
button to search the local PC or the network. When the appropriate path to the 
PrimeTime schedules is set, click OK to accept the path and close the Set Schedule 
File Location dialog box. 
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Showing Data Alarms 

Data alarms are raised when the Collector does not receive records from the PBX within 
a user-defined time period and when the disk storage capacity falls below a user-
defined threshold. Alarms are defined using the TASKE Administrator application on the 
server PC, but are displayed through the Information Server.  
 
The Information Server displays all data alarms that occur in the TASKE Data Alarms 
dialog box. By default, the Information Server automatically displays the TASKE Data 
Alarms dialog box and rings a bell every time an alarm is raised. To disable the dialog 
box from automatically opening and the alarm bell from ringing, disable the Display this 
window and Ring the alarm bell check boxes in the Each time an alarm is raised: 
section of the TASKE Data Alarms dialog box. To manually open the TASKE Data 
Alarms dialog box and view the data alarms, select Show data alarms... from the File 
menu.  
 

 
 

The alarms displayed in the TASKE Data Alarms dialog box provide the date and time 
that the alarm situation occurred along with a description of the event. To clear the 
alarms from the dialog box, click the Clear alarms button. This deletes all alarms from 
the window. 
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Closing Versus Exiting the Information Server 

Closing the Information Server window means that the application window is closed, but 
the application is still running in the background and collecting PBX data. Exiting the 
Information Server means that the application is completely shut down and all data 
collection stops. The Information Server should run continuously unless it is absolutely 
necessary to exit the application. 
 

Closing the Information Server 

To close the Information Server window, select Close from the File menu or click 
the X in the top, right corner of the TASKE Information Server title bar. 

 

 
 

The Information Server window closes, but the application continues to run and 
collect data in the background. When the Information Server is running, an icon 
is present in the Windows System Tray, as in the image below.  
 

 
 
The icon on the left represents the Information Server icon when no data alarms 
have occurred. The icon on the right represents the Information Server icon when 
the application has encountered data alarms. The red flag indicates the presence 
of data alarms. 

 
To re-open the Information Server window, double-click the Information Server 
icon in the Windows System Tray, or right-click on the icon and select Open from 
the menu. 
 

Exiting the Information Server 

To completely shut down the Information Server and stop data collection, right-
click on the Information Server icon in the Windows System Tray, and select Exit 
from the menu. This action produces the TASKE Information Server dialog box. 
The dialog box indicates that exiting from the Information Server closes all client 
connections and stops data collection. 
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Click Yes in the dialog box to stop data collection, close all client connections, 
and prevent any new client connections. Click No to close the Information Server 
window and prevent new clients from connecting, but continue data collection. 
 
Choosing to stop data collection from the PBX means that data created between 
the time the Information Server is shut down and restarted will not be collected 
and will not be available for any historical reporting, searches or analysis. 
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TASKE Enterprise 

TASKE Enterprise is a feature of the TASKE ACD ToolBox that allows the Information 
Server applications on TASKE Server PCs to share information across LAN (local area 
network) or WAN (wide area network) connections. The Enterprise feature is activated 
through licensing. If the site is licensed for one or more Enterprise Supervisors, the 
Enterprise feature is automatically activated during installation or with a license 
upgrade. 
 
The Information Server applications at Enterprise enabled sites communicate using 
TCP/IP. Site information is shared between the sites when Enterprise Supervisors 
initiate information requests from a remote site. Two TASKE applications provide 
statistical information over the Enterprise connection. These applications are the 
Enterprise ACD Monitor and Reports.  
 
Enterprise ACD Monitor functions the same as the ACD Monitor with the exception of 
ACD Replay. None of the ACD Replay functionality is available with the Enterprise ACD 
Monitor. Real-time and recent historical (last hour, last 12 hours) agent and queue 
statistics are available using the same methods as in the local ACD Monitor. Sites are 
identified using the site names or local for the local site.  
 
The Reports application generates reports for remote sites by retrieving data from a 
shared PBX directory on the TASKE Server PC at the remote site. When a request for a 
report on a remote site occurs, the Reports applications launches a Net Client that 
connects to the local Information Server. The local Information Server then forwards the 
request to the Information Server at the remote site. If the remote Information Server 
finds newer data than is available on the local Information Server, copies of the 
appropriate .pbx files are transferred to the local Information Server and the report is 
generated from these files. 
 
When an Enterprise Supervisor requests information from a remote site, the following 
sequence of events occurs. 
 

1. A client application (ACD Monitor) launches on a client PC. 
2. The client application opens a new client connection (Net Client). 

 

 
When a Net Client connection is open on a client PC, the icon for 
the Net Client is visible in the Windows System Tray. Only one 
Net Client connection starts for every client PC. Double-clicking 
the Net Client icon in the System Tray opens the Net Client 
Window. Here, a tab is present for every client application that is 
currently using the Net Client connection. 

 
3. The Net Client sends a request for data through the network to the local 

Information Server on behalf of the client application. 
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4. The local Information Server communicates the request for data to the 
Information Server at the remote site. 

5. The Information Server at the remote site routes a copy of the data received from 
its TASKE Collector to the local Information Server. The TASKE Collector 
receives call center data directly from the PBX. 

6. The local Information Server routes a copy of the data through the network to the 
Net Client, where it is transferred to the client application. 

 
The following diagram illustrates the path of a request for data between Enterprise 
enabled TASKE sites. 
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Checking for Enterprise Licensing 

There are two methods for determining if the Enterprise functionality is activated in a 
TASKE Server. Both methods require the Information Server to be started.  
 
The quickest and most obvious method for checking if Enterprise is activated is the 
presence of the Sites tab in the Information Server interface. If this tab is present, the 
site is licensed for Enterprise and the Enterprise functionality is active. 
 
The second place to check for Enterprise licensing is the License tab of the Information 
Server. If an entry for Enterprise Supervisors is displayed in the License tab, the TASKE 
Information Server is licensed for Enterprise and the Enterprise functionality is active. 
 
The Enterprise Supervisors entry in the License tab shows the maximum number of 
Enterprise Supervisors allowed to connect at one time and the number of Enterprise 
Supervisors currently connected. Use the following steps to view the License tab and 
check for Enterprise licensing. 
 

1. From the TASKE ToolBox, open the Information Server. 
2. Click the License tab to view the TASKE licensing information for the local 

TASKE site. 
  

 

  

 

 
 
 
 
 
 
 
 
 
 
 
 



TASKE Call Center Management Tools            

 
- 19 - 

Viewing Enterprise Site Connections 

The Sites tab is only present in the Information Server interface if the license file allows 
licensing for Enterprise Supervisors. This type of licensing allows the Information Server 
to collect, store, and disperse PBX data from TASKE Server PCs that are located at 
remote sites. The Sites tab provides an interface for the setup and maintenance of the 
remote site connections. The list at the top of the Sites tab displays all of the defined 
sites, regardless of the connection status. The local site is included in the list of Active 
sites. 
 

 
 

Status 

The Status section of the Sites tab displays the status of the connection from the 
site to the Information Server. If the site is connected and receiving data, a green 
light is present with the title "Local site activated" for the local TASKE site and 
"Connected to Remote Site" for other TASKE sites. The date and time the 
connection commenced are also displayed. If a site is Activated the Information 
Server can send and receive information requests to and from the site. 
 
Deactivated sites cannot send information to or receive information from the 
Information Server. Sites are deactivated manually through the Site Actions 
menu or automatically if there is an error with the site connection. The indicator 
light turns yellow to indicate the Information Server is attempting to activate the 
site connection and red when the connection has encountered a fatal error. A 
gray light indicates that the site is deactivated. 
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Details 

The Details section of the Sites tab displays the following information. 
 

PBX Type: displays the PBX type of the site selected in the sites list. 
 
Data Path: displays the local path for the data being stored from the local or 
remote site. 
 
Clients: displays the number of clients connected to the Information Server of 
the site selected in the sites list. This field also shows the lock status. If a site 
is locked, no new clients can connect to the site through the Information 
Server at the site. This feature is used for site maintenance. 
 

Last Message 

The Last Message section of the Sites tab displays information about the 
messages sent to the local Information Server from the site selected in the sites 
list. This section displays the following information. 
 

Time: displays the date and time of the last message received by the local 
Information Server from the site selected in the sites list.  
 
Type: displays the type of data record that was last received by the local 
Information Server from the site selected in the sites list.  
 

Adding, Modifying, and Removing Enterprise Site Connections 

Enterprise site connections to the local Information Server are setup, modified, and 
removed using the Sites tab of the Information Server. All of these actions are 
accomplished through the options available in the Site actions... drop-down menu. 
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Adding an Enterprise Site Connection 

Use the following steps to add an Enterprise site connection to the local 
Information Server. Once added, the site is added to the sites list on the Sites tab 
of the Information Server interface. 

 
1. Select the Sites tab in the Information Server interface. 
2. Click the Site actions... button on the Sites tab to open the drop-down 

menu. 
3. Select Add... from the menu to open the Add Site dialog box. 

 

 
 

4. Enter a unique name for the site in the Site name field. 
 
When an Enterprise site is added, a directory for storing the site data is 
created on the local TASKE Server PC. This directory is automatically 
assigned the same name as the site. When modifying the site connection 
information, the site name is not editable because of the inconsistency it 
would create in the directory structure. Local client applications connected 
to the Information Server also refer to the remote site by this name. To 
change a site name the site must be removed and re-added to the list with 
a new name. 
 

5. Enter the network name of the remote TASKE Server PC in the Server 
name field. 
 
Click the Browse... button to search the network (LAN or WAN) for the 
remote TASKE Server PC. When the remote PC is found by browsing the 
network, the IP address of the PC is automatically entered in the IP 
address field. 
 

6. Enter the IP address of the remote TASKE Server PC in the IP address 
field. 
 
If the Server name was found by browsing the network, the IP address of 
the remote TASKE Server PC will already be present in the IP address 
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field. If this is not the case, click the Auto button to have the IP address 
automatically detected based on the server name provided. 
 

7. Enter the IP port for incoming data from the remote TASKE Server PC in 
the IP Port field. 
 
By default, TASKE uses port number 5210 for incoming data from remote 
sites. Ensure that no other devices are using port number 5210. 
 

8. Select the type of the remote PBX from the drop-down list of PBX types. 
 
Once the Enterprise site is added, the PBX type cannot be changed. If the 
PBX type must be changed, the Enterprise site must be removed and re-
added. 
 

9. Enable the Activate automatically on startup check box to have the site 
automatically activated when the local Information Server is started. 
 
By default this check box is enabled. Disabling this check box means that 
the user will have to manually activate the site from the Sites tab of the 
Information Server. 
 

10. Click OK to accept the settings for the Enterprise site and add the new site 
to the sites list of the Sites tab. 

 
The new site is not activated automatically. The site must be manually activated 
to commence the collection of data and the processing of information requests. 

  

 

When new sites are added, a change is made to the 
data directory structure of the local TASKE Server PC. 
Under the "SiteData" directory, a directory and data 
subdirectories are created for each remote site. This 
change allows collected .pbx files from the local and 
"remote" sites to be saved locally and used by the 
Enterprise Supervisors. 
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Modifying an Enterprise Site Connection 

Use the following steps to modify the properties of an Enterprise site connection 
to the local Information Server.  
 

1. Select the Sites tab in the Information Server interface. 
2. Select the Enterprise site connection to modify from the sites list. 
3. Click the Site actions... button on the Sites tab to open the drop-down 

menu. 
4. Select Edit properties... from the menu to open the Edit Site Properties 

dialog box. 
 
This dialog box is identical to the Add Site dialog box. The only exception 
is that the Site name and PBX type fields are not editable. 
 

5. Make the required changes to the editable fields of the Edit Site Properties 
dialog box. Refer Adding An Enterprise Site Connection for descriptions of 
the fields in this dialog box.  

6. Click OK to accept the modifications to the properties of the Enterprise site 
connection and close the Edit Site Properties dialog box. 

 

Removing an Enterprise Site Connection 

Use the following steps to remove an Enterprise site connection from the local 
Information Server.  
 

1. Select the Sites tab in the Information Server interface. 
2. Select the Enterprise site connection to modify from the sites list. 
3. Click the Site actions... button on the Sites tab to open the drop-down 

menu. 
4. Select Remove from the menu to open the TASKE Information Server 

dialog box. 
 

 
 
This dialog box warns users that removing the site connection will result in 
the loss of any historical data for this site on the local TASKE Server PC. 
The dialog box also states that removing the site connection will not affect 
the data stored at the remote site. 
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5. Click Yes to remove the Enterprise site connection.  
 

Removing the Enterprise site connection removes the site from the sites list in 
the Sites tab of the Information Server.  
 

Activating and Deactivating Sites 

Enterprise site connections are manually activated and deactivated using the Sites tab 
in the Information Server. If a site is activated the Information Server can send and 
receive information requests to and from the site. Deactivated sites cannot send 
information to or receive information from the Information Server. 
 

Activating an Enterprise Site Connection 

Use the following steps to activate an Enterprise site connection. 
 

1. Select the Sites tab in the Information Server interface. 
2. Select the Enterprise site to activate from the sites list. 
3. Click the Site actions... button on the Sites tab to open the drop-down 

menu. 
4. Select Activate from the menu to activate the site. If the site is activated, 

the Activate menu option will not be available. The Deactivate option will 
be present in place of the Activate option. 

 
The Status section of the Sites tab displays the status of the connection. When 
the site is activated the light in the Status section is green with the title "Local site 
activated" for the local TASKE site and "Connected to Remote Site" for other 
TASKE sites. The date and time the connection commenced are also displayed. 
If a site is "Activated" the TASKE Information Server can send and receive 
information requests to and from the site. 
 

Deactivating an Enterprise Site Connection 

Use the following steps to deactivate an Enterprise site connection. 
 

1. Select the Sites tab in the Information Server interface. 
2. Select the Enterprise site to activate from the sites list. 
3. Click the Site actions... button on the Sites tab to open the drop-down 

menu. 
4. Select Deactivate from the menu to deactivate the site. If the site is 

deactivated, the Deactivate menu option will not be available. The Activate 
option will be present in place of the Deactivate option. 

 



TASKE Call Center Management Tools            

 
- 25 - 

The Status section of the Sites tab displays the status of the connection. When 
deactivated the light in the status section is gray with the title "Site is inactive". 
The date and time the connection commenced are also displayed.  
 

Locking Sites and Disconnecting Clients 

Sites can be locked and clients disconnected from the Sites tab of the Information 
Server. Maintenance at an Information Server is the main reason for locking a site and 
disconnecting the clients. Locking a site and manually disconnecting the clients 
provides a polite method for disconnecting service to the clients. Otherwise, clients 
would be disconnected without warning and continually attempt to reconnect. 
 
If maintenance is occurring at the local Information Server, all remote sites should be 
locked and all clients from all remote sites disconnected. If maintenance is occurring at 
a remote Information Server, the site connection at the local Information Server to that 
site should be locked and all clients disconnected from the site. Any client with access 
to the remote site through a different Information Server will still be able to connect. 
 
It is important to lock a site prior to disconnecting the clients. When clients are 
disconnected without locking a site, the client applications will automatically reconnect. 
Locking the site prior to disconnecting the clients prevents the client applications from 
reconnecting to the site. 
 

Locking an Enterprise Site 

Use the following steps to lock an Enterprise site. 
 

1. Select the Sites tab in the Information Server interface. 
2. Select the Enterprise site to lock from the sites list. 
3. Click the Site actions... button on the Sites tab to open the drop-down 

menu. 
4. Select Lock from the menu to lock the site. This action prevents new client 

connections, but does not affect existing client connections. 
 

When a site is locked, the Sites tab displays a lock icon in the Clients field of the 
Details section with the text "<site is locked to new clients>". 
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Disconnecting All Clients from an Enterprise Site 

Use the following steps to disconnect all clients from an Enterprise site. 
 

1. Select the Sites tab in the Information Server interface. 
2. Select the Enterprise site from the sites list that all clients will be 

disconnected from. 
3. Click the Site actions... button on the Sites tab to open the drop-down 

menu. 
4. Select Disconnect all clients from the menu to disconnect the clients from 

the site. Because the site is locked, the clients cannot reconnect.  
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TASKE Network Client 

The Network Client is a background application that acts as a liaison between client 
applications requiring real-time information and the Information Server. When a client 
application requiring real-time data launches, it sends a request to the Information 
Server through the Network Client application. The request asks the Information Server 
for permission to connect and receive data. When the Information Server accepts this 
request the client application has full access to the real-time data acquired from the 
PBX. 
 
The Network Client application is almost invisible to the user. When the application is 
running, an icon is present in the Windows System Tray. To open the Network Client 
window, double-click the icon in the System Tray, or right-click the icon and select Open 
from the menu. 

  

 
Network Client System Tray Icon 

 

 
 

Using the Network Client Interface 

The application window contains a tab for each TASKE client application on the PC that 
is currently interfacing with the Information Server. The Network Client automatically 
launches when the first of these client applications starts. The title of the application 
connected to the Information Server is displayed at the top of the tab. Within the tab, the 
status of the connection and information about the last event received by the client is 
displayed. When the last of the client applications on the PC is shut down, the Network 
Client application automatically shuts down as well. 
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Status 

The Status section of the Network Client displays the status of the connection 
between the client and the Information Server. If the client is connected and 
receiving data, a green light is present with the title: Connected to local site. The 
date and time indicate when the connection was established. The Server and 
Port information provides the IP address of the TASKE Server PC and the Port 
number the Server PC is using to receive client requests. If the client is 
disconnected, the light turns yellow to indicate a connection problem and the title 
changes to: Blocked. The Network Client automatically attempts to reconnect. 
 

Last Message 

The Last Message section of the Network Client displays information about the 
PBX messages being sent to the client from the Information Server. The Time 
section displays the date and time of the last message the client received from 
the Information Server. The Type section displays the type of data that was sent 
to the client, for instance, and SMDR record. If the client is Blocked the Last sent 
time may be earlier than the present time. During a blockage, messages pile up 
in the queue until the client re-establishes the connection, or disconnects. 
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TASKE Administrator 

The TASKE Administrator application is responsible for the development of the TASKE 
database, its configuration and maintenance, and the configuration and maintenance of 
its associated files. To perform these functions, the Administrator operates in two 
modes: Database and Configuration. 
 

The TASKE database is comprised of names, numbers, and other 
characteristics of a customer interaction center. These elements are defined 
in the Database Mode of the Administrator. The elements defined in the 
TASKE database mirror those elements defined in the PBX system. 

Registering these parameters and mirroring the PBX database elements enables the 
TASKE system to generate reports for the elements of a telephone system used 
throughout a company. Use the Administrator to define and maintain the TASKE 
database. This is the only TASKE application where database elements are defined, 
modified, and deleted.  
 

The Configuration Mode provides maintenance flags and configuration tools 
for the database. The interface for this mode is divided into three sections: 
Logs, Maintenance, and Alarms. For security purposes, the TASKE Servers 
are the only PCs with access to all three sections. On Supervisor PCs only 

the Logs section is provided in the Configuration Mode of the Administrator. 
 
Maintenance tools include a system log, alarm parameters set to user specifications 
that warn of maintenance needs, and the generation of statistics files. The configuration 
tools include an interface for configuring disk storage settings, error log tracking and 
ensuring the security of stored records by setting alarms to notify of any abnormalities. 
The application may be used routinely for activities such as reading maintenance logs, 
archiving, deleting and synchronizing shadow files, as well as performing disk statistics. 
 

Starting the Administrator 

The Administrator application is opened from the Windows desktop. Use one of the 
following methods to open the application. 
 

Opening the Administrator Using the Start Button 

Use the following steps to open the Administrator application using the Start 
button on the Windows desktop. 
 

1. Click Start on the toolbar of the Windows desktop. 
2. Select Programs from the menu. 
3. Select the TASKE 8.0 folder in the list of programs. 
4. Select Administrator from the list of TASKE applications to open the 

Administrator application. 
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Opening the Administrator from the TASKE Program Folder 

Use the following steps to open the Administrator application from the TASKE 8.0 
program folder. 
 

1. Double-click the TASKE 8.0 folder icon on the Windows desktop to open 
the TASKE 8.0 folder. 

2. Double-click the Administrator icon in the folder to open the Administrator 
application. 
 

 

 

 
 

Using the Menu Bar 

The menu bar contains three menus that provide keyboard or mouse access to the 
functions of the Administrator. The menus are File, View, and Help.  
 

File Menu 

The contents of the File menu vary depending on the Mode. The table below 
outlines the menu options for both the Database mode and the Configuration 
mode.   
 
Database Mode 

Option Shortcut Description 

Export N/A Select this option to open the Export Database 
dialog box. Use this dialog box to select the location 
and file type of the exported database, as well as the 
types of database elements to include in the export. 

Exit N/A Select this option to close the Administrator 
application. 
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Configuration Mode 

Option Shortcut Description 

Open N/A This option is only available in the Logs section of 
the Configuration mode. Select Open to open a 
saved TASKE log file. Only files with a .log 
extension can be opened. 

Save As... N/A Select this option to save the log file currently 
displayed in the Logs section of the Configuration 
mode. 

Save N/A This option is only available in the Alarms section of 
the Configuration mode. Select Save to save 
changes to the alarm parameters. 

Clear Log... N/A This option is only available in the Logs section of 
the Configuration mode. Select Clear Log... to clear 
the events from the log file. Prior to deleting the 
events, the user is prompted to save the log file. To 
retain the events, the log file must be saved prior to 
clearing the events.  

Refresh N/A This option is only available in the Logs section of 
the Configuration mode. Select Refresh to 
immediately update the log with the most recent 
events. 

Exit N/A Select this option to close the Administrator 
application. 
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View Menu 

The View menu provides keyboard or mouse access to various sections of the 
Administrator interface. The table below outlines the functionality of the View 
menu options. 
 
Option Shortcut Description 

Database CTRL+D Select this option to switch to the Database mode. 

Configuration CTRL+O Select this option to switch to the Configuration 
mode. 

Next Window F2 Move the window focus to the next section of the 
Administrator interface. Use the arrow keys to move 
throughout the elements of a window section and 
the spacebar to select.  

Previous 
Window 

Shift+F2 Move the window focus to the previous section of 
the Administrator interface. Use the arrow keys to 
move throughout the elements of a window section 
and the spacebar to select.  

  

Help Menu 

Use the Help menu to access the online help for the Administrator. Additionally, 
use this menu to view version and copyright information for the application.  
 
Option Shortcut Description 

Contents F1 Select Contents to access the Online Help for the 
Administrator application.  

About 
TASKE ACD 
Monitor... 

N/A Select About TASKE Administrator... to view version, 
copyright, and lock number information for the 
Administrator.  

 

Using the Main Control Panel 

The Main Control Panel is located on the left side of the Administrator window. This 
section of the window is responsible for: 
 

• Mode selection 
• Table selection in Database Mode 
• Tool selection in Configuration Mode 



TASKE Call Center Management Tools            

 
- 33 - 

Mode Selection 

The two buttons located at the top of the Main Control Panel are the mode 
selection buttons. These buttons toggle between the Database and Configuration 
modes. 
 

Table Selection in Database Mode 

In the Database Mode, the Main Control Panel displays a list of 
buttons. Each button provides access to a table for the database 
element described on the button. The tables are provided in the 
display area of the Administrator window. Use these tables to add, 
modify, and delete the database elements. 

 
The available tables of database elements are Trunks, Trunk 
Groups, Extensions, Extension Groups, Agents, Agent Groups, 
Queues, Queue Groups, Qualifier Codes, and DNIS codes. Use 
the Spectrum and Options tables to configure the database 
options.  

 
 
 
 
 

Tool Selection in Configuration Mode 

In the Configuration Mode, the contents of the Main Control Panel 
depends on the installation type of the TASKE software. For 
Server installations, the Main Control Panel in the Configuration 
Mode displays three buttons: Logs, Maintenance, and Alarms. For 
Supervisor installations, the Main Control Panel in the 
Configuration Mode displays only the Logs button. This difference 
in installation types is a security feature of the ACD ToolBox, 

allowing only those authorized to use the Server PC rights to maintaining, 
configuring, and setting alarm parameters for the TASKE database and PBX 
files.  
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Selecting a Mode 

The Administrator application operates in two modes: Database and Configuration. Use 
these modes to build the TASKE database and to maintain and configure its associated 
files.  
 
The two buttons located at the top of the Main Control Panel toggle between the 
Database and the Configuration modes. 
 

  
Database Mode Configuration Mode 

 
The Database Mode is used to construct the TASKE database. The TASKE database is 
comprised of names, numbers, and other characteristics of a customer interaction 
center. The elements defined in the TASKE database mirror those elements defined in 
the PBX system. Registering these parameters and mirroring the PBX database 
elements enables the TASKE system to generate reports for the elements of a 
telephone system used throughout a company. Use the Administrator to define and 
maintain the TASKE database. This is the only TASKE application where database 
elements are defined, modified, and deleted.  
 
The Configuration Mode provides maintenance flags and configuration tools for the 
database. The interface for this mode is divided into three sections: Logs, Maintenance, 
and Alarms. For security purposes, the TASKE Servers are the only PCs with access to 
all three sections. On Supervisor PCs only the Logs section is provided in the 
Configuration Mode of the Administrator. 
 
Maintenance tools include a system log, alarm parameters set to user specifications 
that warn of maintenance needs, and the generation of statistics files. The configuration 
tools include an interface for configuring disk storage settings, error log tracking and 
ensuring the security of stored records by setting alarms to notify of any abnormalities. 
The application may be used routinely for activities such as reading maintenance logs, 
archiving, deleting and synchronizing shadow files, as well as performing disk statistics. 
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Using the Database Mode 

The Database Mode allows the design, construction and editing of the TASKE 
database. This Includes configuring the number of Trunks, Extensions, Agents, Queues 
and Qualifiers in use on a telephone system and establishing groups of these elements 
for reporting purposes. 
 

Using the Database Mode Interface 

To use the Database Mode, click the Database button on the Main 
Control Panel. In Database Mode the Main Control Panel provides 
buttons to access the editable tables for the database elements. To 
select a table for viewing, click the button for the desired table. The 
available tables of database elements are Trunks, Trunk Groups, 
Extensions, Extension Groups, Agents, Agent Groups, Queues, 
Queue Groups, Qualifier Codes, and DNIS codes. Use the 
Spectrum and Options tables to configure the database options.  

 
The selected table appears in the display area that is located to the 
right of the Main Control Panel. This area is comprised of two 
sections for all tables with the exception of the Spectrum table and 
the Options table. These sections are the List Panel and the 
Details panel. Both the Spectrum table and the Options table are 
comprised of a single section. 

 

List panel 

The List panel is the top section of the display area. The panel contains a list of 
all defined database elements for the selected table. Each entry in the list 
provides the ID Number, Name and Nick Name of the element. To select a 
database element from the List panel, click on the entry for the element. When 
selected, the List panel entry is highlighted in blue. 
 

Details panel 

The Details panel is the bottom section of the display area. This panel provides 
detailed information for the record selected in the List panel. As the information 
required for each type of database element is unique, the contents of the Details 
panel varies for each table. Use the Details panel to create, edit, or delete 
database elements. The toolbar at the top of the Details panel provides the tools 
for performing these tasks. 
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Exporting the TASKE Database 

Use the following steps to export the TASKE database. Each database element 
selected for export is saved in a separate file in the file type and location 
selected. 
 

1. From the Database mode, select Export from the File menu to open the 
Export Database dialog box. 
 

 
 

2. Input the path to the exported database files in the Export Path field. The 
default location for the files is the root of the TASKE directory.  
 
If desired, click the  button to access the network and select another file 
location.  
 

3. Select a file type for the exported files from the Export As list. The file 
formats available for export include: 
 

 Ascii 
 Clarion 
 Comma Separated 

Variable 
 dBase II 
 dBase III 
 dBase IV 
 HTML Table 
 Lotus 123 1A 
 Lotus 123 2.0 
 Lotus 123 3.0 
 Lotus 123 4.0 

 Microsoft Excel 2.1 
 Microsoft Excel 3.0 
 Microsoft Excel 4.0 or greater 
 Print Image 
 Quattro 
 Quattro Pro 
 Quattro Pro 5.0 for Windows 
 Symphony 1.0 
 Symphony 1.1 
 Tab Separated Variable 
 Word Processing Text 
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4. Enable the check boxes of the database elements to export in the Export 
section of the dialog box. 

5. Disable the check boxes of the database elements not required for export 
in the Export section of the dialog box.  

6. Click Export to export the selected database elements and close the 
dialog box.  

 
Locate the new files in the location specified in the Export Path field. Open the 
files using the appropriate application for the file format.  
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Defining Trunks 

Click the Trunks button on the Main Control Panel in Database Mode to display 
the Trunks table. 
 

 
 

The List panel displays a list of all Trunks defined in the database. If the list is too 
long to display all defined Trunks, scroll bars are provided for navigation 
throughout the list. The list contains an ID Number, Name and Nick Name for 
each Trunk. 
 

ID Number Column - displays unique ID Numbers for each Trunk defined in 
the TASKE Database. The ID Number is the key parameter by which the 
TASKE Database indexes and tracks Trunk elements. 
 
Name Column - displays the names for each Trunk defined in the TASKE 
Database. The Name is a character string which represents the Trunk's full 
name for reference purposes and may appear in Trunk reports. 
 
Nick Name Column - displays nicknames for each Trunk defined in the 
TASKE Database. The Nick Name is simply an alternate way of naming 
Trunk records and may be used in reports. 
 

In the Details panel Trunks may be added, deleted or modified by using the New, 
Update and Delete buttons. 
 
The Is a Member Of section of the Details panel lists all Trunk Groups containing 
the selected Trunk. To examine one of these Trunks Groups, select the desired 
Trunk Group from the Is a Member Of section and click the Go To button. This 
action displays the Trunk Groups table with the details of the selected Trunk 
Group. 
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Adding Trunk Entries 

Use the following steps to add a trunk entry to the database. 
 

1. In the Trunk Record Details panel, click the New button. 
2. In the Trunk Record Detail panel, enter the ID, Name, and Nick Name of 

the new Trunk Record. 
3. Click the Update button. 

 
The Trunk ID in the TASKE database must be identical to the Trunk ID in the 
PBX system. 
 

Duplicating a Trunk Entry 

Use the following steps to duplicate a Trunk entry. This is useful when creating a 
new Trunk entry that is similar to another Trunk.  

 
1. Choose the Trunk entry to be duplicated from the List panel. 
2. In the Trunk Record Detail panel, change the ID (this is the only 

information that must be changed). Ensure that the new ID does not 
conflict with any existing trunks. 

3. In the Trunk Record Details panel, click the Update button. 
 

Modifying Trunk Entries 

Use the following steps to modify a Trunk entry.  
 

1. Choose the Trunk entry to be modified from the List panel. 
2. In the Trunk Record Detail panel, modify the Trunk Record. 
3. In the Trunk Record Details panel, click the Update button. 
 

Deleting Trunk Entries 

Use the following steps to delete a Trunk entry. 
 

1. Choose the Trunk entry to be deleted from the List panel. 
2. In the Trunk Record Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Defining Trunk Groups 

Click the Trunk Groups button on the Main Control Panel in Database Mode to 
display the Trunk Groups table. 
 

 
 

The List panel displays a list of all Trunk Groups defined in the database. If the 
list is too long to display all defined Trunk Groups, scroll bars are provided for 
navigation throughout the list. The list contains an ID Number, Name and Nick 
Name for each Trunk Group. 
 

ID Number Column - displays unique ID Numbers for each Trunk Group 
defined in the TASKE Database. The ID Number is the key parameter by 
which the TASKE Database indexes and tracks Trunk Group elements. 
 
To implement Call Costing in the customer interaction center, it is absolutely 
necessary to define the lowest Trunk Group Numbers, such as 1000, 1001, 
1002, and 1003 in the TASKE Database as Call Costing Trunk Groups, and 
reserve the higher Trunk Group numbers, such as 1010, for reporting 
purposes. This is because Call Costing searches for costing information on 
Trunk Groups with the lowest Trunk Group numbers. 
 
Name Column - displays the names for each Trunk Group defined in the 
TASKE Database. The Name is a character string that represents the Trunk 
Group's full name and is for reference purposes and may appear in Trunk 
Group reports. 
 
Nick Name Column - displays nicknames for each Trunk Group defined in 
the TASKE Database. The Nick Name is simply an alternate way of naming 
Trunk Group records and may be used in reports. 
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Use the Details panel to add, delete or modify Trunk Groups by using the New, 
Update and Delete buttons. 
 
The Trunk Members section of the Details panel lists all Trunks that are 
members of the selected Trunk Group. To examine one of these Trunks, select 
the desired Trunk from the Trunk Members section and click the Go To button. 
This action displays the Trunks table with the details of the selected Trunk. 
 

Adding Trunk Group Entries 

Use the following steps to add a Trunk Group entry to the database. 
 

1. In the Trunk Group Record Details panel, click the New button. 
2. In the Trunk Group Record Detail panel, enter the ID, Name, and Nick 

Name of the new Trunk Group Record. 
3. Select the Trunks that belong to the new Trunk Group from the Trunk 

Members list. 
4. Click the Update button. 
 

Duplicating a Trunk Group Entry 

Use the following steps to duplicate a Trunk Group entry. This is useful when 
creating a new Trunk Group entry that is similar to another Trunk Group.  
 

1. Choose the Trunk Group entry to be duplicated from the List panel. 
2. In the Trunk Group Record Detail panel, change the ID (this is the only 

information that must be changed). Ensure that the new ID does not 
conflict with any existing trunk groups. 

3. In the Trunk Group Record Details panel, click the Update button. 
 

Modifying Trunk Group Entries 

Use the following steps to modify a Trunk Group entry. 
 

1. Choose the Trunk Group entry to be modified from the List panel. 
2. In the Trunk Group Record Detail panel, modify the Trunk Group Record. 
3. In the Trunk Group Record Details panel, click the Update button. 
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Deleting Trunk Group Entries 

Use the following steps to delete a Trunk Group entry. 
 

1. Choose the Trunk Group entry to be deleted from the List panel. 
2. In the Trunk Group Record Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Defining Extensions 

Click the Extensions button on the Main Control Panel in Database Mode to 
display the Extensions table. 
 

 
 
The List panel displays a list of all Extensions defined in the database. If the list 
is too long to display all defined Extensions, scroll bars are provided for 
navigation throughout the list. The list contains an ID Number, Name and Nick 
Name for each Extension. 
 

ID Number Column - displays unique ID Numbers for each Extension 
defined in the TASKE Database. The ID Number is the key parameter by 
which the TASKE Database indexes and tracks Extension elements. 
 
Name Column - displays the names for each Extension defined in the 
TASKE Database. The Name is a character string which represents the 
Extension's full name and is for reference purposes and may appear in 
Extension reports. 
 
Nick Name Column - displays nicknames for each Extension defined in the 
TASKE Database. The Nick Name is simply an alternate way of naming 
Extension records and may be used in reports. 
Use the Details panel to add, delete, or modify Extensions by using the New, 
Update and Delete buttons. 

 
The Is a Member Of section of the Details panel lists all Extension Groups 
containing the selected Extension. To examine one of these Extension Groups, 
select the desired Extension Group from the Is a Member Of section and click the 
Go To button. This action displays the Extension Groups table with the details of 
the selected Extension Group. 
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Adding Extension Entries 

Use the following steps to add an Extension entry to the database. 
 

1. In the Extension Record Details panel, click the New button. 
2. In the Extension Record Detail panel, enter the ID, Name, Nick Name, and 

Port number of the new Extension Record. 
3. Click the Update button. 

 
For data collection to occur, the Extension ID in the TASKE database must be 
identical to the Extension ID in the PBX system.  
 

Duplicating an Extension Entry 

Use the following steps to duplicate an Extension entry. This is useful when 
creating a new Extension entry that is similar to another Extension.  
 

1. Choose the Extension entry to be duplicated from the List panel. 
2. In the Extension Record Detail panel, change the ID (this is the only 

information that must be changed). Ensure that the new ID does not 
conflict with any existing extensions. 

3. In the Extension Record Details panel, click the Update button. 
 

Modifying Extension Entries 

Use the following steps to modify an Extension entry. 
 

1. Choose the Extension entry to be modified from the List panel. 
2. In the Extension Record Detail panel, modify the Extension Record. 
3. In the Extension Record Details panel, click the Update button. 

 

Deleting Extension Entries 

Use the following steps to delete an Extension entry. 
 

1. Choose the Extension entry to be deleted from the List panel. 
2. In the Extension Record Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Defining Extension Groups 

Click the Extension Groups button on the Main Control Panel in Database Mode 
to display the Extension Groups table. 

 

 
 

The List panel displays a list of all Extension Groups defined in the database. If 
the list is too long to display all defined Extension Groups, scroll bars are 
provided for navigation throughout the list. The list contains an ID Number, Name 
and Nick Name for each Extension Group. 
 

ID Number Column - displays unique ID Numbers for each Extension Group 
defined in the TASKE Database. The ID Number is the key parameter by 
which the TASKE Database indexes and tracks Extension Group elements. 
 
Name Column - displays the names for each Extension Group defined in the 
TASKE Database. The Name is a character string that represents the 
Extension Group's full name and is for reference purposes and may appear in 
Extension Group reports. 
 
Nick Name Column - displays nicknames for each Extension Group defined 
in the TASKE Database. The Nick Name is simply an alternate way of naming 
Extension Group records and may be used in reports. 
 

Use the Details panel to add, delete or modify Extension Groups by using the 
New, Update and Delete buttons. 
 
The Extension Members section of the Details panel lists all Extensions that are 
members of the selected Extension Group. To examine one of these Extensions, 
select the desired Extension from the Extension Members section and click the 
Go To button. This action displays the Extensions table with the details of the 
selected Extension. 
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Adding Extension Group Entries 

Use the following steps to add an Extension Group entry. 
 

1. In the Extension Group Record Details panel, click the New button. 
2. In the Extension Group Record Detail panel, enter the ID, Name, and Nick 

Name of the new Extension Group Record. 
3. Select the Extensions that belong to the new Extension Group from the 

Extension Members list. 
4. Click the Update button. 
 

Duplicating an Extension Group Entry 

Use the following steps to duplicate an Extension Group entry. This is useful 
when creating a new Extension Group entry that is similar to another Extension 
Group. 
 

1. Choose the Extension Group entry to be duplicated from the List panel. 
2. In the Extension Group Record Detail panel, change the ID (this is the 

only information that must be changed). Ensure that the new ID does not 
conflict with any existing extension groups. 

3. In the Extension Group Record Details panel, click the Update button. 
 

Modifying Extension Group Entries 

Use the following steps to modify an Extension Group entry.  
 

1. Choose the Extension Group entry to be modified from the List panel. 
2. In the Extension Group Record Detail panel, modify the Extension Group 

Record. 
3. In the Extension Group Record Details panel, click the Update button. 
 

Deleting Extension Group Entries 

Use the following steps to delete an Extension Group entry. 
 

1. Choose the Extension Group entry to be deleted from the List panel. 
2. In the Extension Group Record Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Defining Agents 

Click the Agents button on the Main Control Panel in Database Mode to display 
the Agents table. 
 

 
 

The List panel displays a list of all agents defined in the database. If the list is too 
long to display all defined agents, scroll bars are provided for navigation 
throughout the list. The list contains an ID Number, Name and Nick Name for 
each agent. 
 

ID Number Column - displays unique ID Numbers for each agent defined in 
the TASKE Database. The ID Number is the key parameter by which the 
TASKE Database indexes and tracks agent elements. 
 
Name Column - displays the names for each agent defined in the TASKE 
Database. The Name is a character string which represents the agent's full 
name and is for reference purposes and may appear in agent reports. 
 
Nick Name Column - displays nicknames for each agent defined in the 
TASKE Database. The Nick Name is simply an alternate way of naming agent 
records and may be used in reports. 

 
Use the Details panel to add, delete, or modify agents by using the New, Update 
and Delete buttons. 
 
The Is a Member Of section of the Details panel lists all Agent Groups containing 
the selected agent. To examine one of these Agent Groups, select the desired 
Agent Group from the Is a Member Of section and click the Go To button. This 
action displays the Agent Groups table with the details of the selected Agent 
Group. 
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Adding Agent Entries 

Use the following steps to add an agent entry to the database. 
 

1. In the Agent Record Details panel, click the New button. 
2. In the Agent Record Detail panel, enter the ID, Name, and Nick Name of 

the new agent record. 
3. Click the Update button. 

 
For data collection to occur, the agent ID in the TASKE database must be 
identical to the agent ID in the PBX system. An agent Number must be seven 
digits or less to be compatible with PBX data record entries. 
 

Creating Secondary Agent IDs 

Secondary Agent IDs are a useful tool for providing agents with additional IDs for 
reporting purposes. For instance, a call center may have a queue for English 
callers, a queue for French callers, and a queue for Spanish callers. A single 
agent who is fluent in all of these languages may have to log into any of these 
queues to answer calls. 
 
Using secondary agent IDs, the agent can have an ID for each of the three 
queues. In this case, the primary ID may be a member of the English queue, 
while the two secondary IDs are used for the French and Spanish queues. Each 
ID shares the same name and nick name. 
 
Having established these three IDs for a single agent, the supervisor can view 
the reports and know the call statistics for this agent in all three languages. 
Two secondary agent IDs are provided for each agent in the basic TASKE 
license. Contact TASKE to inquire about increasing the number of secondary 
agent IDs per agent. 
 
Use the following steps to create a secondary agent ID. 
 

1. Choose the agent requiring the secondary agent ID from the List Panel. 
2. Input the new ID number under the heading 'Secondary IDs' in the Record 

Details Panel. Ensure that the ID number is not used for any other agents. 
3. Click Add in the Record Details Panel. The new ID number is added to the 

list of secondary agent IDs. 
4. Click Update to save the changes to the agent record. 

 
Once the maximum number of secondary agent IDs allowed by the TASKE 
license file is reached, the user is prevented from adding additional secondary 
IDs. 
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Duplicating an Agent Entry 

Use the following steps to duplicate an agent entry. This is useful when creating 
a new agent entry that is similar to another agent.  
 

1. Choose the agent entry to be duplicated from the List panel. 
2. In the Agent Record Detail panel, change the ID (this is the only 

information that must be changed). Ensure that the new ID does not 
conflict with any existing agents. 

3. In the Agent Record Details panel, click the Update button. 
 

Modifying Agent Entries 

Use the following steps to modify an agent entry. 
 

1. Choose the agent entry to be modified from the List panel. 
2. In the Agent Record Detail panel, modify the agent record. 
3. In the Agent Record Details panel, click the Update button. 

 

Deleting Agent Entries 

Use the following steps to delete an agent entry 
 

1. Choose the agent entry to be deleted from the List panel. 
2. In the Agent Record Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Defining Agent Groups 

Click the Agent Groups button on the Main Control Panel in Database Mode to 
display the Agent Groups table. 

 

 
 

The List panel displays a list of all Agent Groups defined in the database. If the 
list is too long to display all defined Agents, scroll bars are provided for 
navigation throughout the list. The list contains an ID Number, Name and Nick 
Name for each Agent. 
 

ID Number Column - displays unique ID Numbers for each Agent Group 
defined in the TASKE Database. The ID Number is the key parameter by 
which the TASKE Database indexes and tracks Agent Group elements. 
 
Name Column - displays the names for each Agent Group defined in the 
TASKE Database. The Name is a character string which represents the Agent 
Group's full name and is for reference purposes and may appear in Agent 
Group reports. 
 
Nick Name Column - displays nicknames for each Agent Group defined in 
the TASKE Database. The Nick Name is simply an alternate way of naming 
Agent Group records and may be used in reports. 
 

Use the Details panel to add, delete or modify Agent Groups by using the New, 
Update and Delete buttons. 
 
The Agent Members section of the Details panel lists all agents that are 
members of the selected Agent Group. To examine one of these agents, select 
the desired agent from the Agent Members section and click the Go To button. 
This action displays the Agents table with the details of the selected Agent. 
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Adding Agent Group Entries 

Use the following steps to add an Agent Group entry to the database. 
 

1. In the Agent Group Record Details panel, click the New button. 
2. In the Agent Group Record Detail panel, enter the ID, Name, and Nick 

Name of the new Agent Group Record. 
3. Select the Agents that belong to the new Agent Group from the Agent 

Members list. 
4. Click the Update button. 

 
The Agent Group is a reporting concept for the TASKE Database that identifies a 
collection of Agents to be reported on as a single entity. The PBX system does 
not employ this concept, and therefore the Agent Group IDs do not have to mirror 
any PBX system elements. 
 

Duplicating an Agent Group Entry 

Use the following steps to duplicate an Agent Group entry. This is useful when 
creating a new Agent Group entry that is similar to another Agent Group. 
 

1. Choose the Agent Group entry to be duplicated from the List panel. 
2. In the Agent Group Record Detail panel, change the ID (this is the only 

information that must be changed). Ensure that the new ID does not 
conflict with any existing agent groups. 

3. In the Agent Group Record Details panel, click the Update button. 
 

Modifying Agent Group Entries 

Use the following steps to modify an Agent Group entry. 
 

1. Choose the Agent Group entry to be modified from the List panel. 
2. In the Agent Group Record Detail panel, modify the Agent Group Record. 
3. In the Agent Group Record Details panel, click the Update button. 

 

Deleting Agent Group Entries 

Use the following steps to delete an Agent Group entry. 
 

1. Choose the Agent Group entry to be deleted from the List panel. 
2. In the Agent Group Record Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Defining Queues 

Click the Queues button on the Main Control Panel in Database Mode to display 
the Queues table. 
 

 
 
The List panel displays a list of all Queues defined in the database. If the list is 
too long to display all defined Queues, scroll bars are provided for navigation 
throughout the list. The list contains an ID Number, Name and Nick Name for 
each Queue. 
 

ID Number Column - displays unique ID Numbers for each Queue defined in 
the TASKE Database. The ID Number is the key parameter by which the 
TASKE Database indexes and tracks Queue elements. 
 
Name Column - displays the names for each Queue defined in the TASKE 
Database. The Name is a character string which represents the Queue's full 
name and is for reference purposes and may appear in Queue reports. 
 
Nick Name Column - displays nicknames for each Queue defined in the 
TASKE Database. The Nick Name is simply an alternate way of naming 
Queue records and may be used in reports. 
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Use the Details panel to add, delete, or modify Queues by using the New, 
Update and Delete buttons. 
 
The Is a Member Of section of the Details panel lists all Queue Groups 
containing the selected Queue. To examine one of these Queue Groups, select 
the desired Queue Group from the Is a Member Of section and click the Go To 
button. This action displays the Queue Groups table with the details of the 
selected Queue Group. 
 

Adding Queue Entries 

Use the following steps to add a Queue entry to the database. 
 

1. In the Queue Record Details panel, click the New button. 
2. In the Queue Record Detail panel, enter the ID, Name, Nick Name, and 

TSF Time of the new Queue Record. 
3. In the Type section, enable the Path or Queue radio button.  

 
Path - select Path to define the routing of calls to an agent group. Select 
the agent group from the drop-down list for the Agent Group ID field. 
 
Queue - select Queue to assign one dialable number to all extensions 
within an extension group. Select the desired extension group number 
from the Extn. Group ID drop-down list.  
 

4. Input the name of the Schedule Group in the Schedule Group field. This is 
the name of the group associated with this Queue in PrimeTime. The 
name must be spelled exactly as it is in PrimeTime, including spaces and 
punctuation, but it is not case sensitive.  

5. Click the Update button. 
 
For data collection to occur, the Queue ID in the TASKE database must be 
identical to the Queue ID in the PBX system.  
 
If the Schedule Group name is not input or is incorrect, the real-time adherence 
alarms will not function. 
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Duplicating a Queue Entry 

Use the following steps to duplicate a Queue entry. This is useful when creating 
a new Queue entry that is similar to another Queue. 
 

1. Choose the Queue entry to be duplicated from the List panel. 
2. In the Queue Record Detail panel, change the ID (this is the only 

information that must be changed). Ensure that the new ID does not 
conflict with any existing Queues. 

3. In the Queue Record Details panel, click the Update button. 
 

Modifying Queue Entries 

Use the following steps to modify a Queue entry. 
 

1. Choose the Queue entry to be modified from the List panel. 
2. In the Queue Record Detail panel, modify the Queue Record. 
3. In the Queue Record Details panel, click the Update button. 

 

Deleting Queue Entries 

Use the following steps to delete a Queue entry. 
 

1. Choose the Queue entry to be deleted from the List panel. 
2. In the Queue Record Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Queue Groups 

Click the Queue Groups button on the Main Control Panel in Database Mode to 
display the Queue Groups table. 
 

 
 
The List panel displays a list of all Queue Groups defined in the database. If the 
list is too long to display all defined Queue Group, scroll bars are provided for 
navigation throughout the list. The list contains an ID Number, Name and Nick 
Name for each Queue Group. 
 

ID Number Column - displays unique ID Numbers for each Queue Group 
defined in the TASKE Database. The ID Number is the key parameter by 
which the TASKE Database indexes and tracks Queue Group Code 
elements. 
 
Name Column - displays the names for each Queue Group defined in the 
TASKE Database. The Name is a character string which represents the 
Queue Group's full name and is for reference purposes and may appear in 
Queue Group reports. 
 
Nick Name Column - displays nicknames for each Queue Group defined in 
the TASKE Database. The Nick Name is simply an alternate way of naming 
Queue Group records and may be used in reports. 
 

Use the Details panel to add, delete or modify Queue Groups by using the New, 
Update and Delete buttons. 
 
The Queue Members section of the Details panel lists all Queues that are 
members of the selected Queue Group. To examine one of these Queues, select 
the desired Queue from the Queue Members section and click the Go To button. 
This action displays the Queues table with the details of the selected Queue. 
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Adding Queue Group Entries 

Use the following steps to add a Queue Group entry to the database. 
 

1. In the Queue Group Record Details panel, click the New button. 
2. In the Queue Group Record Detail panel, enter the ID, Name, and Nick 

Name of the new Queue Group Record. 
3. Select the Queues that belong to the new Queue Group from the Queue 

Members list. 
4. Click the Update button. 

 

Duplicating a Queue Group Entry 

Use the following steps to duplicate a Queue Group entry. This is useful when 
creating a new Queue Group entry that is similar to another Queue Group. 
 

1. Choose the Queue Group entry to be duplicated from the List panel. 
2. In the Queue Group Record Detail panel, change the ID (this is the only 

information that must be changed). Ensure that the new ID does not 
conflict with any existing Queue groups. 

3. In the Queue Groups Record Details panel, click the Update button. 
 

Modifying Queue Group Entries 

Use the following steps to modify a Queue Group entry. 
 

1. Choose the Queue Group entry to be modified from the List panel. 
2. In the Queue Group Record Detail panel, modify the Queue Group 

Record. 
3. In the Queue Group Record Details panel, click the Update button. 

 

Deleting Queue Group Entries 

Use the following steps to delete a Queue Group entry. 
 

1. Choose the Queue Group entry to be deleted from the list. 
2. In the Queue Group Record Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Defining Qualifier Codes 

Qualifier Codes are numbers an Agent enters into the telephone system while 
engaged on a Pilot call. The codes flag the call by type so that call statistics can 
be collected by the TASKE system for analysis and planning. There are two 
types of Qualifier Codes: Verified and Non-Verified. 
 
Verified Qualifier Codes are constructed as multiple pairs of 2 decimal digits. The 
first pair of digits forms a primary pair and is typically displayed as a row header 
in the Call Account Reports. Secondary pairs of digits typically form a column list; 
in effect a matrix is formed. Combining the primary pair with multiple secondary 
pairs results in codes of six digits or more. 
 
Non-Verified Qualifier Codes are used in an ad-hoc manner and are free form. 
They are used as a convenient mechanism to collate statistics on various types 
of calls. The TASKE system performs no verification on them and requires only 
that they be constructed in pairs of digits. Because the TASKE system places 
virtually no restrictions on the format of Non-Verified Qualifier Codes, the 
Qualifier Codes administrator does not apply to them.  
 

 
 
The List panel displays a list of all Qualifier Codes defined in the database. If the 
list is too long to display all defined Qualifier Codes, scroll bars are provided for 
navigation throughout the list. The list contains an ID Number, Name and Nick 
Name for each Qualifier Code. 
 

ID Number Column - displays unique ID Numbers for each Qualifier Code 
defined in the TASKE Database. The ID Number is the key parameter by 
which the TASKE Database indexes and tracks Qualifier Code elements. 
 
Name Column - displays the names for each Qualifier Code defined in the 
TASKE Database. The Name is a character string which represents the 
Qualifier Code's full name and is for reference purposes and may appear in 
Qualifier Code reports. 
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Nick Name Column - displays nicknames for each Qualifier Code defined in 
the TASKE Database. The Nick Name is simply an alternate way of naming 
Qualifier Code records and may be used in reports. 
 

Use the Details panel to add, delete, or modify Qualifier Codes by using the New, 
Update and Delete buttons. 
 

Adding Qualifier Code Entries 

Use the following steps to add an Qualifier Code entry to the database. 
 

1. In the Qualifier Code Record Details panel, click the New button. 
2. In the Qualifier Code Record Detail panel, enter the ID, Name, and Nick 

Name of the new Qualifier Code Record. 
3. Click the Update button. 

 

Duplicating an Extension Entry 

Use the following steps to duplicate an Extension entry. This is useful when 
creating a new Extension entry that is similar to another Extension.  
 

1. Choose the Extension entry to be duplicated from the List panel. 
2. In the Extension Record Detail panel, change the ID (this is the only 

information that must be changed). Ensure that the new ID does not 
conflict with any existing Qualifier Codes. 

3. In the Qualifier Code Record Details panel, click the Update button. 
 

Modifying Qualifier Code Entries 

Use the following steps to modify an Qualifier Code entry. 
 

1. Choose the Qualifier Code entry to be modified from the List panel. 
2. In the Qualifier Code Record Detail panel, modify the Qualifier Code 

Record. 
3. In the Qualifier Code Record Details panel, click the Update button. 
 

Deleting Qualifier Code Entries 

Use the following steps to delete an Qualifier Code entry. 
 

1. Choose the Qualifier Code entry to be deleted from the List panel. 
2. In the Qualifier Code Record Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Defining Spectrums 

The TASKE ToolBox generates various reports that provide a spectrum or profile 
of the timing of calls to the customer interaction center. There are three types of 
Spectrum settings: Answer Spectrums, Abandon Spectrums, and Interflow 
Spectrums. 
 
Click the Spectrums button on the Main Control Panel in Database Mode to 
display the Spectrums table in the display area. 
 

 
 
For example, the Reports include a Time To Answer spectrum that indicates the 
numbers of calls answered between 10 and 20 seconds, between 20 and 30 
seconds, and so on. This enables users to compare the spectrum of call 
answering with the time delay, and determine the delays faced by most callers. 
 

Answer Spectrum 

The Answer Spectrum section allows users to set 10 threshold times for the Time 
To Answer spectrum. Each of the 10 threshold times is set to an independent 
threshold time (in seconds), with each time getting progressively longer. This 
produces the profile of Time To Answer from 0 to "x" seconds. The Spectrum 
reports produced indicate the number of calls Answered within each of the 
threshold times. 
 

Abandon Spectrum 

The Abandon Spectrum section allows users to set 10 threshold times for the 
Time To Abandon spectrum. The Spectrum reports produced indicate the 
number of calls Abandoned within each of the threshold times. Each of the 10 
threshold times is set to an independent threshold time (in seconds), with each 
time getting progressively longer. This produces the profile of Time To Abandon 
from 0 to "x" seconds.   
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Interflow Spectrum 

The Interflow Spectrum section allows users to set 10 threshold times for the 
Time To Interflow spectrum. The Spectrum reports produced indicate the number 
of calls Interflowed within each of the threshold times. Each of the 10 threshold 
times is set to an independent threshold time (in seconds), with each time getting 
progressively longer. This produces the profile of Time To Interflow from 0 to "x" 
seconds.   
 

Updating Spectrum Settings 

Use the following steps to update Spectrum settings. 
 

1. Enter the number of seconds for each threshold time for the Answer, 
Abandon, and Interflow Spectrums. 

2. Click the Update button. 
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Defining Options 

The ACD ToolBox provides a wide range of reports that provide statistics on 
almost all aspects of the operation of a customer interaction center. The Options 
table provides an interface for setting reporting parameters. Click the Options 
button on the Main Control Panel in Database Mode to display the Options table 
in the display area. 
 

 
 
The available reporting options are listed below. 
 

Site Name 

Input a name for the site. All reports include the site name in the header of the 
report.  
 

Trunk Time to Answer 

Trunk Reports list the percentage of calls that are actually answered within "x" 
seconds. This value is compared with the target service level. The threshold time 
is entered in the Trunk time to answer selection box in seconds, and is reported 
under the % Ans'd Before xx Secs column heading in the Reports. 
 

Ignore Abandon Time 

Set a threshold time to identify genuine Abandons. These are calls that Abandon 
after the threshold time set in the Ignore abandon time selection box. Genuine 
Abandons are used in the Service Percentages for the Queue. 
 

Short Talk Time 

The ACD ToolBox allows users to identify calls that terminate after a very short 
talk time from other calls. The assumption is that a high proportion of very short 
Answered calls indicates a potential fault on one or more Trunks. For example, a 
faulty Trunk may allow a call to be Answered, but may not provide a satisfactory 
audio connection for conversation to take place. 
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These calls are reported under the Short Dur'n Calls column heading in the 
TASKE Trunk and Trunk Group Reports. The threshold is set in the Short talk 
time selection box. 
 

Add Application Port Time to Answer 

If the customer interaction center has implemented an automatic answering 
function, then a call may be answered within seconds. However, this is not the 
time that the caller perceives as the Time to Answer, since the caller may have to 
wait an additional period of time after the automatic answer before reaching an 
Agent. 
 
To obtain a true measure of the time that it takes to reach the Agent, the TASKE 
system takes into account both time periods. Enabling the Add Application Port 
Time to Answer check box instructs the ACD ToolBox to add the Time to Answer 
for the automatic answering device to the Trunk Time to Answer. 
 

Week Starts 

The TASKE ToolBox enables users to produce Daily Reports by Day of Week. 
The setting of the Week Starts selection box determines which day is the start of 
the work week. 
 

Start Time / End Time 

Use the Start Time and End Time fields to define the hours that encompass the 
reporting period for a day. Input the times using the 12-hour clock in HH:MM:SS 
AM/PM time format. 
 

Updating Options Settings 

Use the following steps to update Options settings. 
 

1. Change the desired Options settings. 
2. Click the Update button. 

 
 
 
 
 
 
 
 
 



TASKE Call Center Management Tools            

 
- 63 - 

Defining DNIS Numbers 

DNIS is an acronym for Dialed Number Identification Service. DNIS is a service 
in which the telephone company transmits an identification number to a PBX 
receiving a call. The identification number is typically the last four digits which the 
Caller dialed, but may be the whole number or may be a translated number. This 
filter allows users to extract call records based on the number dialed by the 
Caller. Reports can be generated for Queues and Queue Groups using DNIS 
information. In a DNIS Report, nick names appear for each DNIS. These nick 
names must be set up in the TASKE Administrator. 
 
Click the DNIS button on the Main Control Panel in Database Mode to display the 
DNIS table. 
 

 
 
 
The List panel displays a list of all DNIS numbers defined in the database. If the 
list is too long to display all defined DNIS numbers, scroll bars are provided for 
navigation throughout the list. The list contains an ID Number, Name and Nick 
Name for each DNIS number. 
 

ID Column - displays the ID for each DNIS entry defined in the TASKE 
Database. The ID is the key parameter by which the TASKE Database 
indexes and tracks DNIS elements. 
 
Name Column - displays names for each DNIS entry defined in the TASKE 
Database. The Name is a character string which represents the DNIS entry's 
full name and is for reference purposes and may appear in DNIS reports. 
 
Nick Name Column - displays nickname for each DNIS entry defined in the 
TASKE Database. The Nick Name is simply an alternate way of naming DNIS 
elements and is used in Queue and Queue Group reports. 

 
Use the Details panel to add, delete, or modify DNIS numbers by using the New, 
Update and Delete buttons. 
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Adding DNIS Entries 

Use the following steps to add a DNIS entry to the database. 
 

1. In the DNIS Details panel, click the New button. 
2. In the DNIS Details panel, enter the ID, Name, and Nick Name of the new 

DNIS record. 
3. Click the Update button. 

 

Duplicating a DNIS Entry 

Use the following steps to duplicate an DNIS entry. This is useful when creating a 
new DNIS entry that is similar to another DNIS entry. 
 

1. Choose the DNIS entry to be duplicated from the List panel. 
2. In the DNIS Details panel, change the ID (this is the only information that 

must be changed). Ensure that the new ID does not conflict with any 
existing agents. 

3. In the DNIS Details panel, click the Update button. 
 

Modifying DNIS Entries 

Use the following steps to modify a DNIS entry. 
 

1. Choose the DNIS entry to be modified from the List panel. 
2. In the DNIS Detail panel, modify the DNIS Record. 
3. In the DNIS Details panel, click the Update button. 

 

Deleting DNIS Entries 

Use the following steps to delete a DNIS entry. 
 

1. Choose the DNIS entry to be deleted from the list. 
2. In the DNIS Details panel, click the Delete button. 
3. Click Yes in the confirmation box that displays to continue with the Delete. 
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Using the Configuration Mode 

Configuration Mode allows users to perform file maintenance, set alarms and view logs 
for the TASKE Administrator Database. To use the TASKE Administrator in 
Configuration Mode, click on the Configuration icon on the Main Control Panel.  
 

Using the Configuration Mode Interface 

The Configuration Mode provides maintenance flags and 
configuration tools for the database. The interface for this mode is 
divided into three sections: Logs, Maintenance, and Alarms. For 
security purposes, the TASKE Servers are the only PCs with 
access to all three sections. On Supervisor PCs only the Logs 
section is provided in the Configuration Mode of the Administrator. 

 
Maintenance tools include a system log, alarm parameters set to user 
specifications that warn of maintenance needs, and the generation of statistics 
files. The configuration tools include an interface for configuring disk storage 
settings, error log tracking and ensuring the security of stored records by setting 
alarms to notify of any abnormalities. The application may be used routinely for 
activities such as reading maintenance logs, archiving, deleting and 
synchronizing shadow files, as well as performing disk statistics. 
 

Logs 

The Logs section displays a log of system events that include Collector events 
and any errors and alarms that occur. This log allows for the tracking and 
reporting of any errors or significant events that are encountered by the TASKE 
system.  
 

Maintenance 

The Maintenance tool contains two panels in the display area. The top panel 
displays current statistics on file space and disk space for the TASKE Server PC. 
Display various statistics by choosing the statistical criteria from the Display 
Usage drop down list. 
 
The lower panel displays tabs that contain controls for archiving, deleting and 
synchronizing shadow files. Using the tabs, these tasks can be scheduled to run 
automatically or they can be performed immediately by setting the required 
parameters and clicking the button to perform the task manually. For instance, 
click the Archive Now... button on the Archive Files tab, click the Delete Now... 
button on the Manually Delete Files tab, or click the Synchronize Now button on 
the Synchronize Shadow Files tab to manually perform these tasks.  
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Alarms 

The Alarms section provides the interface for setting alarm parameters. The 
alarms notify users when the Collector is not receiving data records, or if the 
available disk space falls below an acceptable level. Both of these alarms are 
based on user-defined thresholds. To disable the alarms, set the threshold 
values to zero. 
 

Using the Event Log 

The Logs section of the Configuration Mode displays a log of system events that 
include Collector events and any errors and alarms that occur. This log allows for 
the tracking and reporting of any errors or significant events that are encountered 
by the TASKE system.  
 
When errors or significant events occur in the TASKE applications, users are 
directed to the Log file for details. This Logs section of the Configuration Mode is 
the area to which these applications are referring. Each log entry contains the 
application where the event occurred, the date of the event, the time of the event, 
and a description of what occurred. 
 

 
 
Occasionally it will be necessary to save the log file and clear the events. The log 
file records all system events and can become very large. Although the actual file 
size may not be large, the number of records in the file may make it difficult to 
find recent events. By saving the log file and clearing the events, the user is able 
to retain the events in the saved .log file and start a new log file by clearing the 
log.  
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Saving the Log File 

Use the following steps to save the log file. 
 

1. Click the Logs button on the Main Control Panel to display the log.  
2. Select Save As... from the File menu to open the Save As dialog box. 
3. Select the desired location for the log file on the PC or network from the 

Save in: drop-down list. This list provides the available PC and network 
locations for saving the file. The default location for the log files is the root 
of the TASKE directory. 

4. Input a name for the log file in the File name: field. 
5. Ensure the file type in the Save as type field is: Log Files (*.log). 
6. Click OK to save the log file. 

 

Clearing the Log 

Use the following steps to clear the events in the log file. Before performing this 
task, the log file must be saved or the events will be lost. 
 

1. Click the Logs button on the Main Control Panel to display the log.  
2. Select Clear Log... from the File menu to open the TASKE Administrator 

dialog box. 
3. Click Yes to open the Save As dialog box and save the log file. The log file 

is cleared after the file is saved.  Or Click No to immediately clear the log 
file without saving.     
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Using the Maintenance Tool 

The Maintenance section of the Configuration Mode provides the interface for 
maintaining the TASKE files on the PC. Use this tool to view file statistics and 
manage files using the archiving, deleting, and shadow file synchronization 
utilities. 
 
The Maintenance tool contains two panels in the display area. The top panel 
displays current statistics on file space and disk space for the TASKE Server PC. 
Display various statistics by choosing the statistical criteria from the Display 
Usage drop down list. 
 

 
 
The lower panel displays tabs that contain controls for archiving, deleting and 
synchronizing shadow files. Using the tabs, these tasks can be scheduled to run 
automatically or they can be performed immediately by setting the required 
parameters and clicking the button to perform the task manually. For instance, 
click the Archive Now... button on the Archive Files tab, click the Delete Now... 
button on the Manually Delete Files tab, or click the Synchronize Now button on 
the Synchronize Shadow Files tab to manually perform these tasks. 
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Examining Disk and File Statistics 

The top panel of the Maintenance Tool in Configuration Mode provides general 
disk statistics for the drive where the TASKE files reside and very specific 
statistics for the various types of TASKE files and the amount of disk space they 
are using. These statistics are only available from the TASKE Server PC. 
 

 
 
General disk statistics for the drive where the TASKE files reside are provided in 
the Disk Statistics For... section of the panel. Three statistics are provided. These 
statistics are: Total Disk Space, Estimated Days Remaining, and Free Disk 
Space.  
 

 
 

Total Disk Space - displays the total (used and unused) disk space, in 
kilobytes, that is available on the drive where the TASKE files reside. 
 
Estimated Days Remaining - based on the current rate of disk usage for the 
TASKE files, this feature displays the estimated number of days remaining 
that TASKE will have enough disk space to continue producing logs and files 
until more free disk space is required. 
 
Free Disk Space - displays the amount of free (available for use) disk space, 
in kilobytes, that is currently available on the drive where the TASKE files 
reside. 
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Display statistics for the data files on the TASKE Server PC by choosing various 
types of statistics from the Display Usage drop-down list in the top panel of the 
Maintenance Tool. The pie chart in the panel provides a graphical breakdown of 
the statistic type selected in the Display Usage drop-down list. See below for 
descriptions of the available options in the Display Usage drop-down list. 
 

 
 

Entire Disk - displays the free disk space available on the drive where the 
TASKE files reside (red section of pie chart), the amount of disk space the 
TASKE files are currently using (green section of pie chart), and the amount 
of disk space occupied by non-TASKE files (blue section of pie chart). 
 

 
 
TASKE Files -  displays the space occupied by Compressed files (red section 
of pie chart), Daily Summary files (green section of pie chart), Weekly 
Summary files (blue section of pie chart), Monthly Summary files (yellow 
section of pie chart), and Yearly Summary files (cyan section of pie chart). 
 
PBX Data Files - displays the space occupied by PBX Data Files that are 
newer (red section of the pie chart) and older (green section of the pie chart) 
than the threshold value of days set for Data Files Older Than field of the 
Thresholds (In Days) section of the panel. The default value of this threshold 
is seven days. 
 
Daily Files - displays the space occupied by Daily Summary files that are 
newer (red section of the pie chart) and older (green section of the pie chart) 
than the threshold value of days set for Daily Files Older Than field of the 
Thresholds (In Days) section of the panel. The default value of this threshold 
is 365 days. 
 
Weekly Files - displays the space occupied by Weekly Summary files that 
are newer (red section of the pie chart) and older (green section of the pie 
chart) than the threshold value of days set for Weekly Files Older Than field 
of the Thresholds (In Days) section of the panel. The default value of this 
threshold is 365 days. 
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Monthly Files - displays the space occupied by Monthly Summary files that 
are newer (red section of the pie chart) and older (green section of the pie 
chart) than the threshold value of days set for Monthly Files Older Than field 
of the Thresholds (In Days) section of the panel. The default value of this 
threshold is 365 days. 
 

 
 
Year to Date Files - displays the space occupied by Year-to-Date Summary 
files that are newer (red section of the pie chart) and older (green section of 
the pie chart) than the threshold value of days set for Year to Date Files Older 
Than field of the Thresholds (In Days) section of the panel. The default value 
of this threshold is 365 days. 

 

Setting Thresholds for TASKE Files 

The Thresholds (In Days) section of the Maintenance tool allows users to set 
thresholds for the PBX data files, various types of summary files, and shadow 
files. The thresholds indicate when it is time to archive and delete these files. The 
Thresholds (In Days) section is located in the top panel of the Maintenance tool. 
Using this tool helps to keep the files on the TASKE Server current and aids in 
the efficient use of disk space.  
 

 
 
Set thresholds for the following file types: 
 

 PBX Data Files 
 Daily Summary Files 
 Weekly Summary Files 

 Monthly Summary Files 
 Year-to-Date Summary Files 
 Shadow Files 

 
The thresholds can be any number of days within the range of 0 to 365. These 
threshold values determine when files are archived and deleted. Those files 
exceeding the threshold are automatically archived and deleted if set up to do so, 
and these are also the files that are archived and deleted if the procedure is 
completed manually. 
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Use the following steps to set thresholds for the TASKE files. 
 

1. Locate the Thresholds (In Days) section of the Maintenance Tool. This is 
located in the top panel of the Maintenance Tool. 

2. For each file type, input the number of days for each threshold. The 
threshold range for each file type is 0 to 365 days. 

3. Click the Apply button to save the changes. 
 

Archiving PBX Data Files 

Archiving PBX data files that exceed the threshold set in the top panel of the 
Maintenance tool allows the files to be retained while creating more space for the 
new data files and logs. Once files have been archived, the TASKE Administrator 
recalculates the current disk usage and displays the information in the Disk 
Statistics panel of the TASKE Administrator window. 
 
Archiving PBX data files only increases disk space if the original files are deleted 
after archiving. 
 

 
 
Archived files are placed in the same directory as the source file. Archiving 
compresses the source files and renames the files with a new extension (.zip). 
This type of compression is a standard compression that applications such as 
WinZip® will decompress. Archive files manually or schedule the archive to be 
performed automatically. Once archived, the Reports application is still able to 
produce reports on the data in the compressed files. The Reports application is 
capable of reading data from archived files.  
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Archiving Files Automatically 

Use the following steps to archive PBX data files automatically. 
 

 
 

1. Select the Archive Files tab in the lower panel of the Maintenance tool. 
2. Ensure that the threshold value (in days) is correct in the Archive Files 

Older Than field. This is not an editable field. If the value is incorrect, the 
threshold must be changed in the Thresholds (In Days) section of the top 
panel.  

3. Locate the Automatic Archive section of the tab 
4. Enable the Automatically Archive Data Files checkbox. This opens the 

Schedule Auto Archive / Delete / Sync dialog box. 
 
If the schedule has already been defined in the Automatically Delete Files tab 
or the Synchronize Shadow Files tab, the schedule does not have to be 
altered. All of these tasks must be performed at the same time and share the 
same schedule. If this is the case, click Cancel in the Schedule Auto Archive / 
Delete / Sync dialog box and continue to step 14. 
 
5. Select a time from the Run File Maintenance at drop-down list. This sets 

the time for all scheduled activities for the files (archiving, deleting, 
synchronizing shadow files). 

6. Enable the check boxes for the days of the week to perform the automatic 
archiving, deleting, and synchronization of the shadow files. 

7. Click the Set Password... button to open the Set Password dialog box. 
This is where the log-in information is defined for the PC to log itself into 
the network at the time to perform the scheduled activities. 
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8. Verify the network ID for the PC in the Account field. 
9. Input the network password for the PC in the password field. 
10. Re-enter the network password for the PC in the Confirm Password field. 
11. Click OK to confirm the network log-in information and close the Set 

Password dialog box. 
12. Click OK in the Schedule Auto Archive / Delete / Sync dialog box to 

confirm all changes and close the dialog box. 
13. If desired, enable the Delete Originals after Archiving check box. Enabling 

this check box means that the original files are deleted as they are 
archived. This reclaims the space on the hard disk that was previously 
occupied by the original files. 

14. Click either the Logs or Alarms button on the Main Control Panel to open 
the TASKE Administrator dialog box. This dialog box prompts users to 
save the new archive settings.  

15. Click OK to save the schedule for archiving files. 
 

Archiving Files Manually 

Use the following steps to archive PBX data files manually. 
 

1. Select the Archive Files tab in the lower panel of the Maintenance tool. 
2. Ensure that the threshold value (in days) is correct in the Archive Files 

Older Than field. This is not an editable field. If the value is incorrect, the 
threshold must be changed in the Thresholds (In Days) section of the top 
panel.  

3. Locate the Manual Archive section of the tab. 
4. If desired, enable the Delete Originals after Archiving check box. Enabling 

this check box means that the original files are deleted as they are 
archived. This reclaims the space on the hard disk that was previously 
occupied by the original files. 

5. Click the Archive Now... button to open the TASKE Administrator dialog 
box. 

6. Click Yes to archive the files. 
 

Manually Deleting Data and Summary Files 

Deleting files purges the disk of old data files, creating space for new data files 
and log entries. Once files have been deleted, the Administrator recalculates the 
current disk usage and displays the information in the Disk Statistics panel of the 
Maintenance tool. 
 
The Manually Delete Files tab in the bottom panel of the Maintenance tool 
provides the interface for the immediate deletion of PBX data files and summary 
files. On this tab, users choose to delete all files exceeding their threshold value, 
or select the types of files to delete. Each file type is associated with a threshold 
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value that is measured in days. The thresholds are defined in the Thresholds (In 
Days) section of the Maintenance tool. Those files within the selected file types 
that exceed the number of days defined by the threshold are deleted. For 
instance, assume the threshold value for the Weekly Summary files is set to 10 
days. Selecting the Weekly Summary files for deletion and clicking the Delete 
Now... button will delete any Weekly Summary files that are older than 10 days. 
 

 
 

Caution is required when deleting files. This is a permanent and irreversible act 
that removes the files and the information they contain from the system. To retain 
the files in a compressed format and delete the original files, archive the files 
prior to deletion.  

 

Deleting All Files Exceeding a Threshold 

Use the following steps to delete all files exceeding a threshold. 
 

1. Select the Manually Delete Files tab in the lower panel of the Maintenance 
tool. 

2. Ensure that the threshold value (in days) is correct for each file type. If 
thresholds are incorrect, the threshold values must be changed in the 
Thresholds (In Days) section of the top panel.  

3. Enable the Delete All Files Exceeding Their Threshold radio button. 
4. Click Delete Now... to open the TASKE Administrator dialog box. 
5. Click Yes to confirm the deletion. 

 

Deleting Specific File Types Exceeding a Threshold 

Use the following steps to delete selected files exceeding a threshold. 
 

1. Select the Manually Delete Files tab in the lower panel of the Maintenance 
tool. 

2. Ensure that the threshold value (in days) is correct for each file type. If 
thresholds are incorrect, the threshold values must be changed in the 
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Thresholds (In Days) section of the top panel.  
3. Enable the Delete Selected Files Exceeding Their Threshold radio button. 
4. In the list of file types, enable the check box of each file type to delete. 

 
The file types available for deletion are: 
 

a. PBX Data Files 
b. Daily Summary Files 
c. Weekly Summary Files 
d. Monthly Summary Files 
e. Year-to-date Summary Files 
f. Shadow Files 

 
5. Click Delete Now... to open the TASKE Administrator dialog box. 
6. Click Yes to confirm the deletion. 

 

Automatically Deleting Data and Summary Files 

Deleting files purges the disk of old data files, creating space for new data files 
and log entries. Once files have been deleted, the Administrator recalculates the 
current disk usage and displays the information in the Disk Statistics panel of the 
Maintenance tool.  
 
The Automatically Delete Files tab in the bottom panel of the Maintenance tool 
provides the interface for scheduling the deletion of PBX data files and summary 
files. On this tab, users select the types of files to delete. Each file type is 
associated with a threshold value that is measured in days. The thresholds are 
defined in the Thresholds (In Days) section of the Maintenance tool. Those files 
within the selected file types that exceed the number of days defined by the 
threshold are automatically deleted when the scheduled task runs. For instance, 
assume the threshold value for the Weekly Summary files is set to 10 days. 
Selecting the Weekly Summary files for deletion means that any Weekly 
Summary files that are older than 10 days will be deleted when the system runs 
the scheduled task to delete the files. 
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Caution is required when deleting files. This is a permanent and irreversible act 
that removes the files and the information they contain from the system. To retain 
the files in a compressed format and delete the original files, archive the files 
prior to deletion.  
 

Scheduling Files for Deletion 

Use the following steps to schedule the deletion of selected files exceeding a 
threshold. 
 

1. Select the Automatically Delete Files tab in the lower panel of the 
Maintenance tool. 

2. Ensure that the threshold value (in days) is correct for each file type. If 
thresholds are incorrect, the threshold values must be changed in the 
Thresholds (In Days) section of the top panel.  

3. Enable the Auto Delete TASKE Files check box. 
4. In the list of file types, enable the check box of each file type to schedule 

for deletion. 
 
The file types available for deletion are: 
 

a. PBX Data Files 
b. Daily Summary Files 
c. Weekly Summary Files 
d. Monthly Summary Files 
e. Year-to-date Summary Files 
f. Shadow Files 
 

If the schedule has already been defined in the Archive Files tab or the 
Synchronize Shadow Files tab, the schedule does not have to be altered. All of 
these tasks must be performed at the same time and share the same schedule. If 
this is the case, click Cancel in the Schedule Auto Archive / Delete / Sync dialog 
box and continue to step 13. 
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5. Click Edit Schedule... to open the Schedule Auto Archive / Delete / Sync 
dialog box.  
 

 
 

6. Select a time from the Run File Maintenance at drop-down list. This sets 
the time for all scheduled activities for the files (archiving, deleting, 
synchronizing shadow files). 

7. Enable the check boxes for the days of the week to perform the automatic 
archiving, deleting, and synchronization of the shadow files. 

8. Click the Set Password... button to open the Set Password dialog box. 
This is where the log-in information is defined for the PC to log itself into 
the network at the time to perform the scheduled activities 
 

.  
 

9. Verify the network ID for the PC in the Account field. 
10. Input the network password for the PC in the password field. 
11. Re-enter the network password for the PC in the Confirm Password field. 
12. Click OK to confirm the network log-in information and close the Set 

Password dialog box. 
13. Click OK in the Schedule Auto Archive / Delete / Sync dialog box to 

confirm all changes and close the dialog box. 
14. Click either the Logs or Alarms button on the Main Control Panel to open 

the TASKE Administrator dialog box. This dialog box prompts users to 
save the new settings for automatic deletion.  

15. Click OK to save the schedule for deleting files. 
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Synchronizing Shadow Files 

A Shadow drive is a redundant file saving mechanism for TASKE systems using 
a remote LAN file server. When a TASKE system is setup to save to a Shadow 
drive, the PBX data files are stored to the Shadow drive and the remote file 
server simultaneously. Generally, the Shadow drive is a local hard drive on the 
TASKE Server PC, while the main drive that stores all TASKE files is a hard drive 
on the remote file server.  
 
The Maintenance tool in the Administrator application provides the tools to check 
the integrity of the files on the remote file server with those saved to the Shadow 
drive through a file synchronization process. This process compares the file on 
the Shadow drive with the file stored on the network. If a file does not exist on the 
network, it is copied from the Shadow drive to the network. If a file differs in size, 
the Shadow drive file is copied to the network. This process protects the system 
from file errors induced by network problems. 
 

 
 

Enabling a Shadow Drive 

Use the following steps to define a shadow drive location on the TASKE Sever 
PC.  
 

1. Select the Synchronize Shadow Files tab in the lower panel of the 
Maintenance tool. 

2. Enable the Enable Shadowing check box. 
3. Define the path for the Shadow drive in the Shadow Directory field. By 

default this directory is \taske\shadow. Click the Browse button to look for 
another directory or enter the new path in the field. 

4. When leaving the Maintenance tool, the TASKE Administrator dialog box 
will open, indicating that the changes should be saved. Click Yes to save 
the Shadow drive setup. 
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Manually Synchronizing Shadow Files 

Use the following steps to manually synchronize Shadow files with those files on 
the remote file server. These steps assume the Shadow drive is already enabled. 
 

1. Select the Synchronize Shadow Files tab in the lower panel of the 
Maintenance tool. 

2. Select the files to synchronize from the Shadow Files list in the Manual 
File Synchronization section of the tab and click the appropriate button to 
move the files to the Sync to Server list. See the options below. 
 

 
 

a. To select all files for synchronization, click the Add All >> button to 
move all files from the Shadow Files list to the Sync To Server list.  

b. To select multiple files grouped together, SHIFT + click the first and 
last files in the group. Click the Add > button to move the selected 
files to the Sync to Server list. 

c. To select multiple files that are not grouped together, CTRL + click 
each of the desired files. Click the Add > button to move the 
selected files to the Sync to Server list.  

 
To remove all the files from the Sync To Server list, click the << Remove 
All button. 
 
To select specific files to remove from the Sync To Server list, use the 
same selection methods as above and click the < Remove button. 

 
3. Click the Synchronize Now button to start the synchronization. The 

TASKE Administrator dialog box opens when the synchronization is 
complete. Click OK to acknowledge that the synchronization is complete 
and close the dialog box. 
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Automatically Synchronizing Shadow Files 

Use the following steps to automatically synchronize Shadow files with those files 
on the remote file server. These steps assume the Shadow drive is already 
enabled. 
 

1. Select the Synchronize Shadow Files tab in the lower panel of the 
Maintenance tool. 

2. Enable the Enable check box in the Automatic File Synchronization 
section of the tab. 
 

 
 

3. Click the Edit Schedule... button to open the Schedule Auto Archive / 
Delete / Sync dialog box. 

 
If the schedule has already been defined in the Archive Files tab or the 
Automatically Delete Files tab, the schedule does not have to be altered. All of 
these tasks must be performed at the same time and share the same schedule. If 
this is the case, do not click the Edit Schedule... button and continue to step 13. 
 

4. Select a time from the Run File Maintenance at drop-down list. This sets 
the time for all scheduled activities for the files (archiving, deleting, 
synchronizing shadow files). 

5. Enable the check boxes for the days of the week to perform the automatic 
archiving, deleting, and synchronization of the shadow files. 

6. Click the Set Password... button to open the Set Password dialog box. 
This is where the log-in information is defined for the PC to log itself into 
the network at the time to perform the scheduled activities. 
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7. Verify the network ID for the PC in the Account field. 
8. Input the network password for the PC in the password field. 
9. Re-enter the network password for the PC in the Confirm Password field. 
10. Click OK to confirm the network log-in information and close the Set 

Password dialog box. 
11. Click OK in the Schedule Auto Archive / Delete / Sync dialog box to 

confirm all changes and close the dialog box. 
12. Click either the Logs or Alarms button on the Main Control Panel to open 

the TASKE Administrator dialog box. This dialog box prompts users to 
save the new archive settings.  

13. Click OK to save the schedule for synchronizing Shadow files. 
 

Setting Alarms 

The Alarms section of the Configuration Mode provides the interface for setting 
alarm parameters for data collection and available disk space.  
 
The alarms notify users when the Collector is not receiving data records, or if the 
available disk space falls below an acceptable level. Both of these alarms are 
based on user-defined thresholds. To disable the alarms, set the threshold 
values to zero. 
 

 
 

Setting Collector Alarms 

The Alarms section of the Configuration mode provides the interface for defining 
parameters for Collector alarms. The Collector is a background utility of the ACD 
ToolBox that collects the data records from the PBX system.  
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The Collector monitors the connection to the PBX system and observes its data 
stream. Through its monitoring and observations, the Collector is able to verify 
the integrity of the data stream by timing the rate of arrival of event records. If 
data is not received from the PBX system within a user specified time threshold 
the Collector raises an alarm. 
 
All potential data loss alarms are recorded, however, to avoid raising an alarm 
when there is no one available to respond to the situation, enter a time range for 
raising alarms. For instance, if the business hours for the customer interaction 
center are from 8 AM to 6 PM, set these as the hours for raising data alarms. For 
alarms that are raised outside of these hours, users must refer to the Log file.  
 

Setting Parameters for Collector Alarms 

Use the following steps to set the parameters for the Collector alarms. 
 

1. In the Configuration mode, click the Alarms button to display the Collector 
and disk alarm parameters in the display area. 

2. Locate the Collector - Raise an Alarm If... section of the Alarms tool. This 
area contains the alarm settings for the Collector alarms. 

3. The first field requires the number of seconds the system should wait for 
new SMDR data records from the PBX. If no data records are received 
from the PBX within the specified number of seconds, the system raises a 
Collector alarm. Setting this value to 0 disables the alarm. 

4. The next two fields require the start time and the end time that define the 
time range for raising data alarms. Enter the start time in the first field and 
the end time in the second field. Both times must be in HH:MM format, 
using the 24-hour clock. 

5. Click the Save Changes button to save the new Collector alarm settings. 
 

Setting Disk Space Alarms 

The Alarms section of the Configuration mode provides the interface for defining 
disk space alarms. Using the disk space alarm parameters the Administrator 
monitors the available disk space to ensure it has sufficient space to handle the 
expected data records from the PBX system. 
 

 
 
The TASKE system stores all records received from the PBX system. Even for 
small customer interaction centers, this can be a large number of records every 
day. Despite the data compression techniques available, TASKE does require a 
large disk for storage.  
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To prevent potential data loss due to insufficient storage space, TASKE provides 
a disk audit function that notifies users when the available disk space is running 
low. The disk audit function monitors the percentage of available disk space. 
When this percentage falls below a user specified amount, the system raises an 
alarm. 
 
When determining the percentage to set for the disk space alarm, consider the 
following: 
 

a. the amount of disk space the data records generally use on a daily basis, 
and 

b. the amount of time it will take to off-load some of the information on the 
disk and make room for new data.  

 
The top panel of the Maintenance tool in the Configuration mode provides disk 
statistics. Review these statistics to determine the amount of disk space the data 
records consume in an average day.  
 
When an alarm is activated, clear it by removing unnecessary information from 
the disk. This may include unnecessary programs (do not remove TASKE 
applications) or old data files that have been archived or are no longer needed. 
To remove data files from the disk, use the Manually Delete Files tab in the 
Maintenance tool. 
 
Prior to deleting programs or files from the disk, contact the system administrator 
to ensure that these programs and files are not needed. 
 

Setting Disk Space Alarm Parameters 

Use the following steps to set the disk space alarm parameter.  
 

1. In the Configuration mode, click the Alarms button to display the Collector 
and disk alarm parameters in the display area. 

2. Locate the Disk - Raise an Alarm If... section of the Alarms tool. This area 
contains the alarm setting for the disk space alarm. 

3. In the editable field, input a percentage for the disk space. When the disk 
space falls below the percentage entered in this field, the system will raise 
an alarm. This must be a value in the range of 0 to 100. 
 

a. Setting this value to 0 disables the alarm. 
b. Setting this value to 100 means that the system will raise an alarm 

the moment the disk space falls below 100%. 
 

4. Click the Save Changes button to save the new disk space alarm setting. 
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Administrator Glossary 

Term Definition 

Account Code Account Codes are numbers an Agent enters in the system while 
engaged on a Queue call. The purpose is to flag a call by type so 
that call statistics can be collected by the TASKE system for 
analysis and planning. 
 
The fields that are applicable to Verified Call Activity Account Codes 
are: the Call Account Code Number, Name and Nick Name. A Call 
Account Code Number must be four (4) digits or less. 
 
Verified Account Codes are constructed as multiple pairs of 2 
decimal digits. The first pair of digits forms a primary pair and is 
typically displayed as a row header in the Call Account Reports. 
Secondary pairs of digits typically form a column list; in effect a 
matrix is formed. Combining the primary pair with multiple 
secondary pairs results in codes of six digits or more. 
 
Non-Verified Account Codes are used in an ad-hoc manner and are 
free form. They are used as a convenient mechanism to collate 
statistics on various types of calls. The TASKE system performs no 
verification on them and requires only that they be constructed in 
pairs of digits. Because the TASKE system places virtually no 
restrictions on the format of Non-Verified Account Codes, the 
Account Codes administrator does not apply to them.  

Agent Group A group of Agents used as the resource to handle incoming 
telephone calls depending on the Queue the caller is on. Agent 
Groups are also used for reporting purposes.  

DNIS DNIS is an acronym for Dialed Number Identification Service. DNIS 
is a service in which the telephone company transmits an 
identification number to a PBX receiving a call. The identification 
number is typically the last four digits the Caller dialed, but may be 
the whole number or may be a translated number.  

Extension The telephone connected to the telephone system is described as 
an Extension or Station. In principle, the telephone operates in the 
same way as the telephone in your home, and may in fact be the 
same type of telephone instrument. The telephones that are used in 
the business environment, particularly the telephones that are used 
in customer interaction centers, may also be more sophisticated 
than typical residential telephones. 
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Term Definition 

Extension 
Group 

Extensions may be placed in groups to form Extension Groups. The 
use of a group enables calls to be addressed to all Extensions of a 
group, rather than trying one Extension after another to find one 
free. 

Queue From a telephone perspective, a Queue is an access code. From a 
TASKE perspective, a Queue is what shows up in the data records. 
The TASKE system employs a Queue concept, where a Queue is 
primarily a means of providing an address mechanism for Extension 
Groups. The Queue enables one dialable number to represent all 
Extension members of a Group. The Queues that are used in the 
telephone system are dialable address numbers that correspond to 
telephone Hunt Groups. 

Queue Group Queues are placed in Queue Groups, in the same manner that 
Trunks and Extensions are grouped. This effectively enables 
"super-addresses" to be formed, where one Queue Group 
represents multiple answering points for reporting purposes. This 
provides powerful and flexible reporting mechanisms to be 
developed and used within the TASKE system. 

Shadow File The TASKE ToolBox network may run with a shadow disk function, 
where each record received from the Telephone System is written 
both to a network file server (used to share TASKE data files) and 
to the shadow directory (not necessarily "local", it may be located 
on another hard drive). This double storage of records provides you 
with a duplicate copy of the data records that are received from the 
Telephone System. 
 
Typically, the shadow drive would be a local hard drive resident on 
the TASKE Network Server, and the primary drive (storing all 
TASKE data files) would be a hard drive resident on a separate 
network file server. 
 
The shadow drive is used as a backup mechanism and stores data 
for a relatively short period of time, such as 30 days. This usually 
provides a long enough period for you to determine if the data on 
the primary network file server is accurate.  
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Term Definition 

Trunk A Trunk is a telephone circuit from the local Central Office to your 
telephone system, and is similar to the telephone line from the 
Central Office to your house or the telephone line from the 
telephone system to your desk. That is, a Trunk is a connection 
between two telephone switching systems, while a line is a 
connection between a telephone switching system and a telephone 
instrument. Outgoing calls from your telephone system to the Public 
Network are made over outgoing Trunks, whereas calls to the 
telephone system from the Public Network are made over incoming 
Trunks. In some Call Centers, Trunks handle both incoming and 
outgoing calls.  

Trunk Group The Trunks on a telephone system are usually programmed in one 
or more groups of Trunks called Trunk Groups. Using a Trunk 
Group enables several Trunks to be addressed as single entity, so 
that the Central Office does not have to direct a call to a particular 
Trunk and be concerned with whether the Trunks are individually 
busy or free. It merely sends a call to the telephone system's Trunk 
Group(s). If any Trunk in the group is free, then the call gets through 
to the system. This avoids the Caller having to try a Trunk and find it 
busy, and then try another, and so on until a free Trunk is found. 

TSF The Telephone Service Factor (TSF) is the ratio of calls which are 
either Answered or Abandoned before a threshold time, to the total 
number of calls which are offered. You specify the threshold, or TSF 
Time, in the TSF Time field for individual Queues. 
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TASKE ACD Monitor 

The TASKE ACD Monitor and Enterprise ACD Monitor are customer interaction center 
monitoring applications that report both real-time and historical customer interaction 
center activity for Queues and Queue Groups at local or remote sites. Use the ACD 
Monitor application to monitor only local Queues and Queue groups and the Enterprise 
ACD Monitor to monitor Queues and Queue groups at local and remote locations. 
 
The ACD Monitor application operates in two modes: Real-time and Replay. The 
Enterprise ACD Monitor application operates in Real-time mode only. With the 
exception of the Replay mode, both applications share the same user interface and 
functionality. 
 

Real-time Mode 

The Real-time mode displays customer interaction center activity in real-time, for the 
past hour, for the past 12 hours, and for the current day. The real-time statistics and 
reports are updated constantly to provide a dynamic view of the current customer 
interaction center activity. The last hour, last 12 hours, last 24 hours, and current day 
statistics and reports provide a shift overview using the customer interaction center 
statistics compiled over the selected time frame. 
 

Replay Mode 

The Replay mode is an animated review of a 24-hour period that shares the reports of 
the Real-time mode. Using the same real-time, last hour, last 12 hours, last 24 hours, 
and current day reports, users select a date with logged customer interaction center 
data. The information for the day is replayed in a real-time simulation. 
 

ACD Monitor Interface 

Together, the Menu Bar, the Main Control Panel, and the Queue Information Display 
Area  (QIDA) comprise the ACD Monitor interface. The interactive interface reports 
Queue and Queue Group information numerically, graphically, and tabularly. 
 
The TASKE ACD Monitor aids the management of a customer interaction center 
through the display of real-time and historical data. This data is easily accessible using 
the buttons on the Queue Panels. A Queue Panel is displayed in the QIDA for each 
Queue or Queue Group selected in the Queue Monitor List. Each Queue Panel is 
comprised of two panels, the Real-time Panel and the Review Panel. 
 
The Real-time Panel presents a number of buttons that display the current customer 
interaction center statistics. Clicking any button produces a report in graph or table 
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format. Click the button a second time to close the report. Each button displays the 
numerical value for the statistic it represents. Those buttons that do not provide a 
numeric value provide reports only. The icons on the buttons provide a graphical 
representation of the statistic for easy recognition. 
 

Clicking the Review button on the Real-time Panel opens the Review Panel. To 
close the Review Panel, click the Review button on the Real-time Panel a 
second time. The Review Panel is located directly below the Real-time Panel. 
Like the Real-time Panel, this panel is also populated with buttons that display 

customer interaction center statistics. Clicking any button produces a report in graph or 
table format. Click the button a second time to close the report.  
 
A button on the left side of the Review Panel selects the time period for viewing. The 
title of this button may be Last Hour, Last 12 Hours, last 24 hours, or Current Day. 
These titles reflect the time periods that are available for review. The current title of the 
button identifies the time period for the statistics currently displayed on the Review 
Panel. Clicking this button produces a menu of the available review periods. 
 
The Queues and Queue groups displayed in the QIDA are selected from the Queue 
Monitor List on the Main Control Panel. To aid in the global assessment of customer 
interaction center operations, multiple Queues can be selected from the Queue Monitor 
List and viewed simultaneously. The QIDA self-scales to accommodate multiple 
Queues. When there is more information than the QIDA can display, a scroll bar is 
provided for scrolling through the Queue information. 
 
The Real-time Panel statistics and reports are not available for PBX types that do not 
provide real-time information. 
 
Many of the application controls and graphs are annotated by ToolTips. If you require 
further information about a specific control or graph line, hold the cursor over it for a 
moment to produce a short message describing the purpose of the control or other 
screen element. 
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Starting the TASKE ACD / Enterprise ACD Monitor 

To start the ACD Monitor application, double-click the ACD Monitor or the 
Enterprise ACD Monitor icon in the TASKE ToolBox folder. This action opens 
the ACD Monitor window in Real-time mode and opens the TASKE Network 
Client for the ACD Monitor. 

 
If this is the first time opening the ACD Monitor application, the Queue Manager will 
open before the application window opens. Select the desired Queues and Queue 
Groups for monitoring from the Queue Selector and enable the "Monitor activity on 
selected Queue(s)" check box. Define the alarm settings for the Queues and Queue 
Groups if desired and click the OK button. The ACD Monitor application window opens, 
displaying the Queue Panels of the selected Queues and Queue Groups. 
 

 
 

Network Client 

The Network Client is the communication link between the ACD Monitor 
application and the real-time information provided by the Information Server. 
When the Network Client for the ACD Monitor is running, its icon  appears in 
the Windows System Tray. Exiting the ACD Monitor application automatically 
closes the ACD Monitor Network Client and terminates the connection with the 
Information Server. 
 

Using the Menu Bar 

The menu bar varies depending on the mode. In the Real-time mode, there are five 
menus that provide keyboard or mouse access to the functions of the ACD Monitor in 
the Real-time mode. The menus are File, View, Properties, Chat, and Help. In the 
Replay mode, a sixth menu, titled Replay, is added that provides the replay controls. 
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File Menu 

Use the File menu to exit the ACD Monitor application. The table below outlines 
the functionality of the File menu option.  
 
Option Shortcut Description 

Exit N/A Closes the ACD Monitor application and the Network 
Client for the ACD Monitor. When the Network Client 
is closed the connection to the Information Server is 
terminated. 

View Menu 

The View menu provides keyboard or mouse access to various sections of the 
ACD Monitor interface. The table below outlines the functionality of the View 
menu options. 
 
Option Shortcut Description 

Real Time CTRL+T Select this option to switch to the Real-time mode. 

Replay CTRL+R Select this option to switch to the Replay mode. 

Next 
Window 

F2 Move the window focus to the next section of the 
ACD Monitor interface. Use the arrow keys to move 
throughout the elements of a window section and 
the Enter key to select.  

Previous 
Window 

Shift+F2 Move the window focus to the previous section of 
the ACD Monitor interface. Use the arrow keys to 
move throughout the elements of a window section 
and the Enter key to select.  

Queue 
Manager 

CTRL+L Select this option to open the Queue Selection 
dialog box. 

Goto N/A Select this option to produce a sub-menu of the 
Queues and Queue Groups selected for monitoring. 
Select a Queue or Queue Group from the list to view 
that Queue or Queue Group in the QIDA. 
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Properties Menu 

The Properties menu provides keyboard or mouse access to various features of 
the ACD Monitor interface. The table below outlines the functionality of the 
Properties menu options. 
 
Option Shortcut Description 

Alarms N/A Select the Alarms option to produce a sub-menu that 
contains three options. These options are Real-time 
Adherence, Thresholds, and Info. Enable these options 
to display the alarm situations. Disable these options to 
avoid seeing these alarm situations. When enabled, 
the alarm option is displayed with a check-mark. When 
disabled, the check-marks are not present. 

Alarm 
Sound 
Frequency 

N/A Select this option to produce a sub-menu that contains 
four sound options for the alarms. These options are 
No Sound, Once, Every 30 seconds, and Every minute. 
The selected option is displayed with a check mark. 

Show 
Queue Nick 
Names 

CTRL+N Select this option to label the Queues and Queue 
Groups by the nick names instead of the ID numbers. 

Show 
Agent 
List... 

CTRL+A Select this option to open the Agent List dialog box for 
the selection of agents in Agent Maps. 

Show State 
Color 
Legend 

CTRL+E Select this option to open the State Colors dialog box. 
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Replay Menu - Replay Mode Only 

Use the Replay menu to access the replay controls of the Main Control Panel. 
 
Option Shortcut Description 

Step Back Ctrl+B As a replay progresses, the information is saved at 
the beginning of each hour. When a save occurs, a 
temporary marker, or placeholder, is created. Use 
the Step Back option to move backward to the last 
placeholder. 

Stop Ctrl+S Select Stop to stop the replay and reset the time to 
12:00 for the selected date. 

Play Ctrl+P Select Play to start the playback of call center data. 
The speed of the data replay is determined by the 
selection in the Speed field. 

Pause Ctrl+U Select Pause to pause the replay at the current 
event. When the replay is paused, the time field 
flashes the time the replay was paused. Click Pause 
again or click Play to restart the replay. 

Fast 
Forward 

Ctrl+F Select Fast Forward to immediately advance the 
replay to the next event.  

Step 
Forward 

Ctrl+O As a replay progresses, the information is saved at 
the beginning of each hour. When a save occurs, a 
temporary marker, or placeholder, is created. Use 
the Step Forward option to move forward to the next 
placeholder.  
A Step Forward cannot be completed before the 
time interval has been played. A Step Back must be 
completed before attempting to Step Forward.  

Triggers N/A Select Triggers to produce a sub-menu that contains 
a General option and a list of all Queues and Queue 
Groups selected for monitoring. Select General to 
open the Trigger dialog box and create a time of day 
trigger stop. Select a Queue or Queue Group to 
open the Queue Triggers dialog box and create 
trigger stops based on customer interaction center 
conditions. 
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Chat Menu 

Use the Chat menu to log into Chat and to open the Chat window. A user must 
log into the Chat application before the Chat window can be opened. 
 
Option Shortcut Description 

Chat N/A Opens the Chat application window.  

Logon N/A Log into the Chat application. The log-on process is 
automatic, no passwords or user names are 
required. The application uses the network name of 
the PC logging in as a user name. This option is not 
available for selection if the user is already logged 
into the Chat application. 

Logoff N/A Log out of the Chat application. The log-off process 
is automatic, no passwords or user names are 
required. This option is not available for selection if 
the user is already logged out of the Chat 
application. 

 

Help Menu 

Use the Help menu to access the online help for ACD Monitor and Chat. 
Additionally, use this menu to view version and copyright information for the 
application. 
 
Option Shortcut Description 

Contents F1 Select Contents to access the Online Help for the 
ACD Monitor application.  

Chat 
Contents 

N/A Select Chat Contents to access the Online Help for 
the Chat application.  

About 
TASKE 
ACD 
Monitor... 

N/A Select About TASKE ACD Monitor... to view version, 
copyright, and lock number information for the ACD 
Monitor.  
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Using the Main Control Panel 

The Main Control Panel is located on the left side of the ACD Monitor window. This 
section of the window is responsible for: 
 

 Mode selection 
 Display of system date and time in the Real-time mode 
 Access to the Queue Manager 
 Queue Monitor List display for Queue/Queue Group selection 
 Date selection in replay mode 
 Replay control 

 

Mode Selection 

The two buttons located at the top of the Main Control Panel are the mode 
selection buttons. These buttons toggle between the Real-time and Replay 
modes. 
 

 

Click the Real-time button to switch to the Real-time mode. 

 

Click the Replay button to switch to the Replay mode. 

 

Date and Time 

In the Real-time mode both the date and time are displayed for read-only 
purposes. In the Replay mode, the date is provided in a box that allows for the 
selection of the replay date and the time displays the time of day that is being 
replayed. 
 

Queue Manager 

Clicking the Queues... button accesses the Queue Manager where Queues and 
Queue Groups are selected for monitoring and the Alarm conditions are set for 
each. When a Queue or Queue Group is selected for monitoring it is added to the 
Queue Monitor List. 
 
 
 
 
 



TASKE Call Center Management Tools            

 
- 96 - 

Queue Monitor List 

The Queue Monitor List displays the Queues and Queue Groups selected for 
monitoring. The Queue Monitor List provides a button for each of the Queues 
selected in the Queue Manager. Select one or more Queues from the Queue 
Monitor List to display the Queue information in the QIDA. 
 
To change the order of the Queue and Queue Group buttons displayed on the 
Queue Monitor List, click a button and drag it to its new position in the list before 
releasing the mouse button.  
 

Replay Date Selection 

Use the date box on the Main Control Panel in the Replay mode to select a date 
for the data replay. 
 

 
Use the date box to select the replay date. Double-click in the 
date box to open the calendar in the Date Selection dialog box. 

 

Replay Control 

In the replay mode, set the replay speed and control the replay of data on the 
Main Control Panel. Similar to VCR controls, the replay controls maneuver 
throughout the day's data. In addition, use the trigger button to pause the replay 
at a specific time. 
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Using the Queue Manager 

Click the Queues... button on the Main Control Panel to open the Queue Manager. The 
Queue Manager provides the interface for selecting the Queues and Queue Groups to 
monitor and to set the individual alarm conditions for each.  
 
The Queue Manager is a dialog box that is comprised of two main sections. These 
sections are Queue Selector and Properties for Selected Queue(s). The Queue Selector 
is responsible for selecting Queues and Queue Groups. Once one or more Queues or 
Queue Groups are selected in the Queue Selector, the properties for the selections are 
set in the Properties for Selected Queue(s) section. Use the Properties for Selected 
Queue(s) section to enable or disable the monitoring of the selected Queues and 
Queue Groups and to set alarm parameters for the Queues and Queue Groups. 
 

 
 

Queue Selector 

The Queue selector selects or de-selects Queues and Queue Groups for 
monitoring. The Queue Selector is a table containing six columns. The columns 
are as follows. 
 

 
 

Status - displays the monitoring status of the Queue or Queue Group. If the 
Status column for a Queue or Queue Group displays "Monitoring", the Queue 
or Queue Group is selected for monitoring and displayed in the Queue 
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Monitor List. If the Status column for a Queue or Queue Group is blank, the 
Queue or Queue Group is not selected for monitoring.  
 
Name - displays the name of the Queue or Queue Group as it is defined in 
the Administrator application. 
 
Nick Name - displays the nick name of the Queue or Queue Group as it is 
defined in the Administrator application. The ACD Monitor can identify 
Queues and Queue Groups by the numerical ID or by the nick name. 
 
Site - indicates the location of the Queue or Queue Group. If the Queue or 
Queue Group originates from the local site, the column displays "local". If the 
Queue or Queue Group originates from an Enterprise site, the column 
displays the name of the remote site. 
 
ID - displays the numerical ID of the Queue or Queue Group as it is defined in 
the Administrator application. The ACD Monitor can identify Queues and 
Queue Groups by the ID or by the nick name. 
 
Type - displays whether the selection is a Queue or a Queue Group. If it is an 
individual Queue, the column displays "Single". If it is a group of Queues, the 
column displays "Group". 
 

Properties for Selected Queue(s) 

The Properties for Selected Queue(s) section of the Queue Manager is 
comprised of two main areas. These areas are Monitoring and Alarm Settings. 
The Monitoring area enables and disables the monitoring of the Queues and 
Queue Groups selected in the Queue Selector. The Alarm Settings area sets the 
alarm properties for the selected Queues and Queue Groups. 
 
The Monitoring area of the Properties for Selected Queue(s) section of the 
Queue Manager enables or disables the monitoring of the Queues and Queue 
Groups selected in the Queue Selector. When the Monitor activity on selected 
Queue(s) check box is enabled, the selected Queue or Queue Group is being 
monitored and a button for the Queue or Queue Group is present in the Queue 
Monitor List. When this check box is disabled, the Queue or Queue Group is not 
being monitored.  
 

 
 
The Alarm Settings area of the Properties for Selected Queue(s) section of the 
Queue Manager defines the alarm settings for the Queues and Queue Groups. 
There are two alarm types: Warning alarms and Critical alarms. The alarms are 
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applied to real-time call and agent statistics, and to the adherence of the agents 
to the schedule. One, both, or neither of the alarm types can be applied to each 
statistic. Each alarm is associated with a threshold. Set the threshold to 
determine the value the statistic must achieve prior to initiating an alarm. 
 

 
 

Closing the Queue Manager 

When all required Queues and Queue Groups are selected for monitoring and 
the required alarm settings are complete, click the OK button to enable the 
changes and close the Queue Manager. Those Queues and Queue Groups 
newly selected for monitoring will now appear on the Queue Monitor List and 
those Queues and Queue Groups where monitoring has been disabled will no 
longer appear on the Queue Monitor List. 
 

Enabling and Disabling the Monitoring of Queues and Queue Groups 

The Queue Manager is responsible for enabling and disabling the monitoring of 
Queues and Queue Groups. When enabled for monitoring, the Queue Monitor 
List in the Main Control Panel displays a button for the Queue or Queue Group. 
Selecting this button in the Queue Monitor List displays the Queue Panel for the 
Queue or Queue Group in the Queue Information Display Area  (QIDA). When 
monitoring for a Queue or Queue Group is disabled, the Queue Monitor List does 
not provide a button and monitoring must be enabled before statistics can be 
viewed. 
 

Enabling Monitoring for Queues and Queue Groups 

Use the following steps to enable monitoring for one or more Queues and Queue 
Groups in the Queue Manager.  
 

1. If the Queue Manager is not already open, click the Queues... button on 
the Main Control Panel of the Real-time mode to open the Queue 
Manager dialog box. 
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2. In the Queue Selector, select one or more Queues or Queue Groups. The 
Status column for all of these Queues and Queue Groups should be 
blank, indicating that none are currently being monitored. 
 

a. To select a single Queue or Queue Group from the Queue 
Selector, simply click the desired Queue or Queue Group. 

b. To select a group of Queues and Queue Groups that are in order, 
select the first Queue or Queue Group and SHIFT+click the last 
Queue or Queue Group in the list of those desired for selection.  

c. To select a group of Queues and Queue Groups that are not in 
order, select the first Queue or Queue Group and CTRL+click each 
of the remaining Queues and Queue Groups desired for selection. 
 

3. Enable the Monitor activity on selected Queue(s) check box in the 
Properties for Selected Queue(s) section of the Queue Manager. The 
Status column of the Queue Selector displays the word "Monitoring" for 
the selected Queues and Queue Groups. 

 

Disabling Monitoring for Queues and Queue Groups 

 Use the following steps to disable monitoring for one or more Queues and 
Queue Groups in the Queue Manager.  
 

1. If the Queue Manager is not already open, click the Queues... button on 
the Main Control Panel of the Real-time mode to open the Queue 
Manager dialog box. 

2. In the Queue Selector, select one or more Queues or Queue Groups. The 
Status column for all of these Queues and Queue Groups should display 
the word "Monitoring", indicating that all are currently being monitored. 
 

a. To select a single Queue or Queue Group from the Queue 
Selector, simply click the desired Queue or Queue Group. 

b. To select a group of Queues and Queue Groups that are in order, 
select the first Queue or Queue Group and SHIFT+click the last 
Queue or Queue Group in the list of those desired for selection.  

c. To select a group of Queues and Queue Groups that are not in 
order, select the first Queue or Queue Group and CTRL+click each 
of the remaining Queues and Queue Groups desired for selection. 
 

3. Disable the Monitor activity on selected Queue(s) check box in the 
Properties for Selected Queue(s) section of the Queue Manager. The 
Status column of the Queue Selector displays nothing for the selected 
Queues and Queue Groups. 
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Setting Alarm Parameters for Queues and Queue Groups 

Use the following steps to define both the Warning Alarm and the Critical Alarm 
for one or more Queues and Queue Groups in the Queue Manager. 
 

1. If the Queue Manager is not already open, click the Queues... button on 
the Main Control Panel of the Real-time mode to open the Queue 
Manager dialog box. 

2. Select the Queues and Queue Groups that require the same alarm 
settings in the Queue Selector.  

3. Select an alarm name in the Alarm Settings area of the Queue Manager. 
The alarm names available for selection are: 
 

a. Calls Waiting 
b. Longest Call Waiting 
c. Calls Abandoned (Last Hour) 
d. TSF (Last Hour) 
e. ASF (Last Hour) 
f. Agents Available 
g. Real-time Adherence (only available when licensed for PrimeTime) 
h. Bad Logins / Re-queues (alarm for the Queue Information Report) 
i. Expected Wait Time (15 Min) 

 
4. Enable the Warning alarm check box.  
5. Set the threshold value for the Warning alarm. 
6. Enable the Critical alarm check box. 
7. Set the threshold value for the Critical alarm. 
8. Repeat steps 3 to 6, as required, for the remaining alarm names. 

 
Threshold values are not applicable to the Bad Logins / Requeues alarm. To enable 
the alarm, select the desired queues and queue groups to display the alarm, select 
Bad Logins / Requeues from the Alarm Settings list, and enable the Critical check 
box. This alarm notifies users of bad login and requeue occurrences. To view the 
alarm details, view the Queue Information Report by clicking the Info button on the 
Real-time Panel. 
 
By default the Warning Alarm is displayed in blue and the Critical Alarm is displayed 
in red. These colors are changeable in the State Colors dialog box. Access this 
dialog box by selecting Show State Color Legend... from the Properties menu. When 
the dialog box is open, click the down arrows beside the alarms to open the Color 
dialog box and select a new color. 
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Selecting a Mode: Real-time or Replay 

The ACD Monitor application operates in two modes: Real-time and Replay. The 
Enterprise ACD Monitor application operates in Real-time mode only. With the 
exception of the Replay mode, both applications share the same user interface and 
functionality. The two buttons located at the top of the Main Control Panel toggle 
between the Real-time mode and the Replay modes. 
 
The Real-time mode displays customer interaction center activity in real-time, for the 
past hour, the past 12 hours, the past 24 hours, and the current day. The real-time 
statistics and reports are updated constantly to provide a dynamic view of the current 
customer interaction center activity. The last hour, last 12 hours, last 24 hours, and 
current day statistics and reports provide a shift overview using the customer interaction 
center statistics compiled over the selected time frame. 
 
The Replay mode is an animated review of a 24-hour period that shares the reports of 
the Real-time mode. Using the same real-time, last hour, last 12 hours, last 24 hours, 
and current day reports, users select a date  with logged customer interaction center 
data. The information for the day is replayed in a real-time simulation. 
 

The Queue Information Display Area 

Occupying the window area to the right of the Main Control Panel, the Queue 
Information Display Area (QIDA) presents statistical and performance information for 
Queues and Queue Groups based on queue and agent activity. The information 
displayed in the QIDA is dependent on the Queues and Queue Groups selected from 
the Queue Monitor List. Information is presented using numbers, graphs, and tables in 
both the Real-time mode and the Replay mode. 
 
Selection of a Queue or Queue Group from the Queue Monitor List displays the Queue 
Panel for the selection in the QIDA. If none of the Queues or Queue Groups are 
selected from the Queue Monitor List, none of the Queue Panels for the monitored 
Queues and Queue Groups are displayed in the QIDA. 
 
A Queue Panel is displayed in the QIDA for each Queue or Queue Group selected in 
the Queue Monitor List. Each Queue Panel is comprised of two panels, the Real-time 
Panel and the Review Panel.  
 
The Real-time Panel presents a number of buttons that display the current customer 
interaction center statistics. Clicking any button produces a report in graph or table 
format. Click the button a second time to close the report. Each button displays the 
numerical value for the statistic it represents. Those buttons that do not provide a 
numeric value provide reports only. The icons on the buttons provide a graphical 
representation of the statistic for easy recognition. 
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Clicking the Review button on the Real-time Panel opens the Review Panel. To 
close the Review Panel, click the Review button on the Real-time Panel a 
second time. The Review Panel is located directly below the Real-time Panel. 
Like the Real-time Panel, this panel is also populated with buttons that display 

customer interaction center statistics. Clicking any button produces a report in graph or 
table format. Click the button a second time to close the report.  
 
A button on the left side of the Review Panel selects the time period for viewing. The 
title of this button may be Last Hour, Last 12 Hours, Last 24 Hours, or Current Day. 
These titles reflect the time periods that are available for review. The current title of the 
button identifies the time period for the statistics currently displayed on the Review 
Panel. Clicking this button produces a menu of the available review periods. 
 
The Real-time Panel statistics and reports are not available for PBX types that do not 
provide real-time information. 
 
Many of the application controls and graphs are annotated by ToolTips. If you require 
further information about a specific control or graph line, hold the cursor over it for a 
moment to produce a short message describing the purpose of the control or other 
screen element. 

 

Displaying Queue and Queue Group Information 

The Queue Monitor List on the Main Control Panel provides an easy way to 
select one or more Queues or Queue Groups to display. Depending on how 
the list is used, the entire QIDA can display the details of a single Queue or 
Queue Group, or display several Queues and Queue Groups at once. 
 

To change the order of the Queue and Queue Group buttons displayed on the Queue 
Monitor List, click a button and drag it to its new position in the list before releasing the 
mouse button. 
 
To select one or more Queue(s) or Queue Group(s) 
 

1. Click the Queue(s)  and Queue Group(s)  of interest on the Queue Monitor 
List. A Queue or Queue Group is selected when its button in the Queue Monitor 
List is depressed. Click the button a second time to de-select the Queue or 
Queue Group.  

2. The Queue panels for the selected Queue(s) and Queue Group(s) open in the 
QIDA. 

3. De-select a Queue or Queue Group by clicking it a second time. 
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Alarm Situations 

When a Queue or Queue Group encounters an alarm situation, it 
is indicated on the button for the Queue or Queue Group in the 

Queue Monitor List. The indicator is a colored box that appears around the icon 
for the Queue or Queue Group. By default the color for a critical alarm is red and 
the color for a warning alarm is blue. These colors are user definable through the 
State Color dialog box.  
 

Overview of the Queue Panels 

The TASKE ACD Monitor aids the management of a customer interaction center 
through the display of real-time and historical data. This data is easily accessible using 
the buttons on the Queue Panels. A Queue Panel is displayed in the QIDA for each 
Queue or Queue Group selected in the Queue Monitor List. Each Queue Panel is 
comprised of two panels, the Real-time Panel and the Review Panel.  
 

 
 

Real-time Panel 

The Real-time Panel presents a number of buttons that display the current 
customer interaction center statistics. Clicking any button produces a report in 
graph or table format. Click the button a second time to close the report. Each 
button displays the numeric value for the statistic it represents. Those buttons 
that do not provide a numeric value provide reports only. The icons on the 
buttons provide a graphical representation of the statistic for easy recognition. 

 
The Replay mode adds the Trigger button to the Real-time Panel. This button 
allows users to select specific call center conditions that will stop the replay when 
the selected conditions are encountered in the call center records. 
 

Review Panel 

Clicking the Review button on the Real-time Panel opens the Review 
Panel. To close the Review Panel, click the Review button on the Real-
time Panel a second time. The Review Panel is located directly below the 
Real-time Panel. Like the Real-time Panel, this panel is also populated 

with buttons that display customer interaction center statistics. Clicking any 
button produces a report in graph or table format. Click the button a second time 
to close the report.  
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A button on the left side of the Review Panel selects the time period for viewing. 
The title of this button may be Last Hour, Last 12 Hours, Last 24 Hours, or 
Current Day. These titles reflect the time periods that are available for review. 
The current title of the button identifies the time period for the statistics currently 
displayed on the Review Panel. Clicking this button produces a menu of the 
available review periods.    
 
The Real-time Panel statistics and reports are not available for PBX types that do 
not provide real-time information. 

Recognizing Alarm Situations 

There are two types of alarm situations, warning and critical. The thresholds for the 
alarms are defined by the user in the Queue Manager. When a Queue or Queue Group 
encounters an alarm situation, it is flagged using color indicators in several areas of the 
ACD Monitor interface. By default the color for the warning alarm is blue and the color 
for the critical alarm is red. Change the colors or turn the color display off through the 
State Colors dialog box.  The areas of the ACD Monitor interface where alarms are 
indicated are: 
 

Queue Monitor List - the button for the Queue or Queue Group experiencing the 
alarm turns to the color of the alarm type it is encountering. 
 
Queue Panel - the background for the numeric value on the button experiencing the 
alarm turns the color of the alarm type it is encountering. If it is a real-time agent 
adherence alarm, the States button indicates the color of the alarm type and the 
Map button may also indicate the color, if the active map contains the agents who 
are not adhering to the schedule. 
 
Agent States Table / Agent Maps - for real-time agent adherence alarm situations, 
the background of the cells containing the agents not adhering to the schedule turn 
to the color of the alarm they are experiencing. 
 

Understanding Real-time Agent Adherence Alarms 

Real-time adherence alarms use the information in the PrimeTime schedules to 
determine if agents are adhering to the schedules. This means that the ACD 
Monitor tracks agent activity in real-time and compares this activity with what is 
expected in the schedule. If the agent is conducting activities outside of the 
schedule, supervisors are immediately aware of this deviance from the schedule. 
 
The following table identifies the conditions for agent non-adherence to the 
schedule.  
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  Scheduled State 

Actual State Taking Calls Off-Phone Period 

Unknown Non-Adherence Adherence 

Logged Out Non-Adherence Adherence 

Idle Adherence Non-Adherence 

Idle Forward Adherence Non-Adherence 

ACD  Adherence Non-Adherence 

ACD Hold* Adherence Non-Adherence 

Non-ACD* Adherence Adherence 

Non-ACD Hold* Adherence Adherence 

Outbound* Adherence Adherence 

Outbound Trunk* Adherence Adherence 

Outbound Hold* Adherence Adherence 

Make Busy Non-Adherence Adherence 

DND Non-Adherence Adherence 

Make Busy/DND Non-Adherence Adherence 

Work Time Adherence Non-Adherence 

Ringing Adherence Non-Adherence 

Unavailable Non-Adherence Adherence 

* When in a non-ACD state, it is not possible to determine if the agent is 
actually adhering to the schedule. While in a non-ACD state an agent may be: 

 talking with a customer that directly dialed the agent's extension  

 talking with a customer the agent dialed directly (outbound)   

 taking a personal call 

The number of possible scenarios makes it difficult to gauge whether the agent 
is actually adhering to the schedule. Therefore, the non-ACD states always 
constitute adherence regardless of the schedule. 

 
Real-time agent adherence alarms in Replay mode use the schedule that is 
currently in place. If a schedule change has occurred between the time the data 
was actually recorded and the time it is being played in the ACD Replay, the real-
time agent adherence alarms may not be accurate.  
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Saved Settings 

The ACD Monitor application creates a profile for each user based on the network log-in 
information. These user profiles provide users with a stable interface that is based on 
personal preferences. The profiles are created on a per PC basis, meaning that a user 
profile may vary from PC to PC.  
 
When exiting the ACD Monitor application, the profile is saved on the local PC with the 
current screen configuration. This includes color selections for alarms and agent states, 
Queue and Queue Group selections for display, and mode selection. When a user 
restarts the ACD Monitor, it is opened displaying the same screen configuration that 
was displayed when the application was last closed by that user.  
 

Using the Real-time Mode 

The Real-time mode displays customer interaction center activity in real-time, 
for the past hour, for the past 12 hours, and for the current day. The real-time 
statistics and reports are updated constantly to provide a dynamic view of the 

current customer interaction center activity. The last hour, last 12 hours, and current day 
statistics and reports provide a shift overview using the statistics compiled over the 
selected time frame. When in the Real-time mode, the application title bar states 
TASKE ACD Monitor. When operating in the Replay Mode, the title bar states TASKE 
ACD Monitor - Replay. 
 
Using the features of the Real-time mode simplifies the management of a customer 
interaction center. Agent and queue status is reported in real-time using a number of 
reporting formats. These formats include the numerical display of real-time statistics on 
the Queue Panel, a graphical view of the real-time statistics, a tabular view of the agent 
queue, and the user-definable agent maps that allow users to group agents logically in a 
table and display their status. 
 
The last hour, last 12 hours, last 24 hours, and current day statistics provide material for 
shift evaluation. Review answer service factors, telephone service factors, queue traffic, 
and agent performance. Reporting formats for the statistics in these time periods 
include the numerical display of the statistics on the Queue Panel, a corresponding 
graphical view for each statistic, a graphical performance evaluation of the agents by 
group, and an agent utilization graph that displays the agent states for the last hour. 
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The review panel reports on four different time periods: Last Hour, Last 12 Hours, Last 
24 Hours, and Current Day. 
 

Last Hour - provides customer interaction center data and statistical averages for 
the past 60 minutes. 
 
Last 12 Hours - provides customer interaction center data and statistical averages 
for the past 12 hours. 
 
Last 24 Hours - provides customer interaction center data and statistical averages 
for the past 24 hours.  
 
Current Day - provides customer interaction center data and statistical averages 
from 00:00 of the current day to the current time. 
 

Accessing Real-time Information 

The Queue Panels are the access point for all real-time and recent historical 
information. When a Queue Panel is displayed, the Real-time Panel is displayed. 
The ID or nick name of the Queue or Queue Group is presented in the top, left 
corner. Click the Review button on the Real-time Panel to access the Review 
Panel where the statistics for the Last Hour, Last 12 Hours, Last 24 Hours, and 
the Current Day are provided. 
 
The buttons on the Real-time Panels that display numeric values provide the 
Current States report when clicked. This report provides the real-time statistical 
values in the form of a dynamic bar graph. 
 
Click the States button to open the Agent States report. This report is a dynamic 
table that provides the current status of all agents in the Queue or Queue Group. 
This is a key report for tracking agent non-adherence to the schedule.  
 
Click the Map button to open the user-defined agent maps that provide agent 
state information. Use these maps to create a custom layout that groups agents 
according to the preferences of the user. For instance, create a map layout that 
groups agents according to their seating position in the call center. 
 
Click the Info button on a Queue Panel to display a text-based report that lists 
requeue, bad log-in, and invalid record incidences for the Queue or Queue Group 
in real-time. The report is a read-only display. Events are listed based on the time 
of the occurrence.  
 
The Real-time Panel statistics and reports are not available for PBX types that do 
not provide real-time information. 
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Viewing the Current States Report 

Real-time call center information is provided on the Real-time Panels of the 
Queue Panels. Many of the buttons on the Real-time Panel display the numeric 
values of the call center statistics they represent. When clicked, these buttons 
open the Current States report. For easy recognition of the statistics, icons are 
provided on each button. The button that was clicked to open the Current States 
report is depressed as long as the report is open and the report is titled with the 
statistical name of the button and the current value of the statistic. Clicking this 
button a second time closes the Current States report. 
 
The Current States report is a bar graph that includes the real-time statistics on 
the Real-time Panel. All bars on the graph are gray in color except for the bar 
that represents the statistic selected to open the graph. This bar is displayed in 
blue. The real-time statistics presented through the Queue Panels and the 
Current States report provide both queue and agent status information. These 
statistics are: 
 

 the time of the longest call waiting 
 the number of calls waiting 
 the number of agents on ACD calls 
 the number of agents on non-ACD calls 
 the number of agents logged on 
 the number of agents available 
 the number of agents idle 
 the number of agents unavailable 
 the number of agents logged out 

 
ToolTips are available for the real-time statistics. Descriptions for the buttons are 
available by holding the mouse over the button for a moment. To acquire an 
exact value for a statistic in the Current States report, hold the mouse over the 
graph bar until the value appears with a short description. 
 

Viewing the Agent States Report 

The Agent States table is accessed by clicking the States button on the 
Real-time Panel of a Queue Panel. This is a read-only tabular display 
that reports real-time agent activity for the Queue or Queue Group. The 
five agent states included in the table are Idle, ACD, Non-ACD, 

Unavailable, and Logged Out. All agents in the Queue or Queue Group are 
included and as their states change, it is reflected by their placement in the table. 
This is a key report for tracking agent non-adherence to the schedule. When an 
agent is not adhering to the schedule, the cell for the agent in the table changes 
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color. This color change overrides all other states in the table. To learn the 
details of an agent's non-adherence, simply hold the mouse pointer over the 
agent's cell to produce a ToolTip that contains the scheduling information. 
 

Viewing Agent Maps 

The Agent Maps are accessed by clicking the Map button on the Real-
time Panel of a Queue Panel. This is a real-time graphical report that 
dynamically illustrates the status of agents. Agents are grouped on the 
Agent Map logically and their status is reported using a combination of 

color, icons, and text. The ability to group agents by department or by seating 
placement within the call center translates into quick and easy personnel tracking 
and management. As with the Agent States report, the Agent Maps also provide 
information on non-adherence to the schedule. When an agent is not adhering to 
the schedule, the cell for the agent in the map changes color. This color change 
overrides all other state colors in the map. To learn the details of an agent's non-
adherence, simply hold the mouse pointer over the agent's cell to produce a 
ToolTip that contains the scheduling information. 
 

Viewing the Queue Information Report 

 Click the Info button on a Queue Panel to display a text-based report that 
lists requeue and bad log-in record incidences for the Queue or Queue 
Group in real-time. The report is a read-only display. Events are listed 
based on the time of the occurrence.  

 

 
 

Each entry in the report includes the time of the event, the event type, and a 
description of the event. The table below provides descriptions of the event 
types. 
 
Event Type Description 

Requeue A requeue occurs when the queue sends an available agent an 
ACD call, but the agent does not answer. The call is returned to 
the queue to be answered by the next available agent.  

Bad Log-in A bad log-in occurs when an agent attempts to log into an ACD 
queue using the wrong agent ID.  
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Legend of Queue Panel Icons 

The following table provides each of the Queue Panel icons with a description for 
both the Real-time Panel and the Review Panel.  
 

Real-time Panel 

Icon Description 

 

Review - opens the Review Panel for the display of historical statistics 
below the Real-time Panel. By default the Last Hour statistics are 
provided when the Review panel first displays. Other data available for 
display in this panel includes statistics for the last 12 hours, statistics 
for the past 24 hours, and statistics for the current day.  

 

Longest Call Waiting - the button displays the amount of time that the 
longest waiting caller has been waiting in MM:SS format. Clicking the 
button opens the Current States report. 

 

Calls Waiting - the button displays the number of calls waiting. 
Clicking the button opens the Current States report. 

 

Agents on ACD - the button displays the number of agents currently 
on ACD calls. Clicking the button opens the Current States report. 

 

Agents on Non-ACD - the button displays the number of agents 
currently on non-ACD calls. Clicking the button opens the Current 
States report. 
  
A non-ACD call is a call that does not originate from the ACD queue. 
When on a non-ACD call, an agent is considered available to accept 
ACD calls. 

 

Agents On - the button displays the number of agents currently logged 
into the ACD queue. Clicking the button opens the Current States 
report. 
  
The number of agents logged in includes all agents currently logged 
into the ACD queue, including those who are unavailable to accept 
ACD calls.  



TASKE Call Center Management Tools            

 
- 112 - 

Icon Description 

 

Agents Available - the button displays the number of agents currently 
available to accept an ACD call. Clicking the button opens the Current 
States report. 
  
The number of agents available includes idle agents and agents on 
non-ACD calls.  

 

Agents Idle - the button displays the number of agents who are 
currently idle and waiting to be offered an ACD call. Clicking the button 
opens the Current States report. 

 

Agents Unavailable - the button displays the number of agents 
currently unavailable to accept ACD calls. Clicking the button opens the 
Current States report.  
  
An agent is unavailable when logged out of the ACD queue or when 
the agent uses a PBX feature to place himself/herself into a state that 
indicates he/she is busy. An agent may do this while completing call 
related activities or when away from the agent station.  

 

Agents Logged Out - the button displays the number of agents 
currently logged out of the ACD queue. Clicking the button opens the 
Current States report. 

 

Agent States - opens the Agent States report. The Agent States report 
is a read-only tabular display that reports real-time queue activity for 
the Queue or Queue Group. The five agent states included in the table 
are Idle, ACD, Non-ACD, Unavailable, and Logged Out.  

 

Agent Map - opens the Agent Map reports. The Agent Map is a real-
time graphical report that dynamically illustrates the status of agents. 
Agents are grouped on the Agent Map logically and their status is 
reported using a combination of color, icons, and text.  

 

Info - opens a tabular, text-based report for re-queues and bad log-ins.   

 

Trigger - opens the Queue Triggers dialog box to set Trigger Stops for 
call center conditions. Available only in Replay mode. 
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Review Panel 

Historical Data Selection - locate this button on the Review 
Panel. The title of this button varies according to the type of data 
currently displayed in the Review Panel. The possibilities for the 
button title include Last Hour, Last 12 Hours, Last 24 Hours, and 
Current Day. Click the button to produce a menu and select 
another type of data for display in the Review Panel. 

  
Last Hour - provides customer interaction center data and statistical 
averages for the past 60 minutes. 
 
Last 12 Hours - provides customer interaction center data and statistical 
averages for the past 12 hours. 
 
Last 24 Hours - provides customer interaction center data and statistical 
averages for the past 24 hours.  

 
Current Day - provides customer interaction center data and statistical 
averages from 00:00 of the current day to the current time. 

 
Icon Description 

 

Longest Waiting Time - displays the time of the longest waiting caller 
for the last hour and opens the Longest Waiting Time report. This 
statistic is not available for the last 12 hours, the last 24 hours, or for 
the current day. 

 

Maximum Calls Waiting - displays the maximum number of calls 
waiting for the last hour and opens the Calls Waiting report. This 
statistic is not available for the last 12 hours, the last 24 hours, or for 
the current day. 

 

Calls Answered - displays the number of calls answered for the last 
hour, last 12 hours, the last 24 hours, or the current day. Clicking the 
button opens the Call Counts report. Hold the mouse pointer over the 
button to produce a ToolTip that provides the number of calls 
answered and the total number of calls offered for the selected review 
period. 

 

Calls Interflowed - displays the number of calls interflowed for the 
last hour, last 12 hours, the last 24 hours, or the current day. Clicking 
the button opens the Call Counts report. Hold the mouse pointer over 
the button to produce a ToolTip that provides the number of calls 
interflowed and the total number of calls offered for the selected 
review period. 
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Icon Description 

 

Calls Abandoned - displays the number of calls abandoned for the 
last hour, last 12 hours, the last 24 hours, or the current day. Clicking 
the button opens the Call Counts report. Hold the mouse pointer over 
the button to produce a ToolTip that provides the number of calls 
abandoned and the total number of calls offered for the selected 
review period. 

 

Answer Service Factor - displays the Answer Service Factor for the 
last hour, last 12 hours, the last 24 hours, or the current day. Clicking 
the button opens the Service Factors report. 

 

Telephone Service Factor - displays the Telephone Service Factor 
for the last hour, last 12 hours, the last 24 hours, or the current day. 
Clicking the button opens the Service Factors report. 

 

Average Time to Answer - displays the average time to answer for 
the last hour, last 12 hours, the last 24 hours, or the current day. 
Clicking the button opens the Time to Answer report. 

 

Maximum Time to Answer - displays the maximum time to answer 
for the last hour, last 12 hours, the last 24 hours, or the current day. 
Clicking the button opens the Time to Answer report. 

 

Average Time to Abandon - displays the average time to abandon 
for the last hour, last 12 hours, the last 24 hours, or the current day. 
Clicking this button opens the Average Time to Abandon report. 

 

Average Talk Time - displays the average talk time for the last hour, 
last 12 hours, the last 24 hours, or the current day. Clicking this button 
opens the Average Talk Time report. 

 

Average Interflow Time - displays the average time to interflow for 
the last hour, last 12 hours, the last 24 hours, or the current day. 
Clicking this button opens the Average Time to Interflow report. 

 

Agent by Group - click this button to open the Agent by Group report 
for the last hour, last 12 hours, the last 24 hours, or the current day. 

 

Agent Utilization - click this button to open the Agent Utilization 
report for the last hour. This report is not available for the last 12 
hours, the last 24 hours, or for the current day. 
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Monitoring with the Agent States Report 

The Agent States report is a read-only tabular display that reports real-time 
queue activity for the Queue or Queue Group. The five agent states included in 
the table are Idle, ACD, Non-ACD, Unavailable, and Logged Out. All agents in 
the Queue or Queue Group are included in the table and as their states change, 
it is reflected by their placement in the table. If there is more information in the 
table than the screen can accommodate, use the scroll bar to the right of the 
table to view the remaining information. 
 
The report is displayed in the QIDA after clicking the States button on the Queue 
Panel. The table is organized into five columns, each based on one or more 
agent states. The cells in the columns provide agent and agent state information. 
The amount of information displayed in the cells is dependant on the filters 
selected by the user. 
 
The Idle (I) and ACD (A) columns in the Agent Queue table are all very specific in 
regard to the state that is reported. The Non-ACD column reports both inbound 
(P) and outbound (O) non-ACD calls, the Logged Out column displays both the 
logged out (L) and inactive (?) states, while the Unavailable column reports the 
remaining agent states. 
 
In the title bar of each column a number is provided in brackets. This number 
indicates the number of agents currently in that state. 
 

Monitoring with Agent Maps 

The Agent Map is a real-time graphical report that dynamically illustrates the 
status of agents. Agents are grouped on the Agent Map logically and their status 
is reported using a combination of color, icons, and text. The ability to group 
agents by department or by seating placement within the call center translates 
into quick and easy personnel tracking and management. 
 

 
 
A default Agent Map is created for each monitored Queue that is titled: Map for 
Queue Name. This Agent Map is a shell only. Users must place agents on the 
map, edit the title if desired, and set the preferences. 
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Clicking the Map button on a Queue Panel displays the last viewed agent map 
for that Queue in the QIDA. The agent map consists of a toolbar and a grid area 
that displays the selected map layout. The toolbar contains one button, the Agent 
Maps... button that accesses the map setup. Other critical items required for the 
definition of an agent map are the Agent List and the State Color legend. Both of 
these items are accessible from the Agent Map toolbar and the Properties menu. 
 
The grid in the Agent Map is where the agents are grouped. The grid can be as 
small as one cell or as large as thirty rows by thirty columns, or nine-hundred 
cells. The cell size is scaled to accommodate the grid size, meaning that smaller 
grids have larger cells that can display more agent information. 
 
Agents can be grouped in any order, with blank cells surrounding each group for 
easy group recognition. The cells can display an agent state icon, the agent ID, 
the agent name, a character that represents the state, and the amount of time 
the agent has been in the state. This information can be filtered to display only 
the information that is pertinent to the user. 
 

Agent Map Setup 

The Agent Maps... button opens the Agent Maps dialog box where map layouts 
are created and modified. Several map layouts can be created for each Queue or 
Queue Group, allowing custom map layouts to be created that reflect the 
individual preferences of the users. To edit a map layout, enable the check box of 
the map layout to edit. 
 

Accessing the State Colors Legend 

Click the State Legend... button on the Agent Map toolbar or select Show State 
Color Legend from the Properties menu to open the State Colors dialog box. The 
State Colors dialog box lists each of the agent states with an associated color. 
Each state is provided on a button. By default all of these button are depressed, 
meaning that the state color for all of the states are enabled. To disable the 
display of color for a state, click the button so it is no longer depressed.  
 
Change any of the colors by clicking the down arrow beside a state. This action 
opens the Color dialog box where the user can select a new color for the state. 
When an agent enters a state, the cell is displayed in the color selected for that 
state in the State Colors dialog box. The only exceptions to this are when the 
display of color for the state is disabled or when the agent is not adhering to the 
schedule. This state is associated with another color that overrides all other 
states.  
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Disabling an agent state color through the State Color Legend turns off the color 
for the state only. The cell can still report the agent state through the agent state 
icon and the state character. 
 

Accessing the Agent List 

Click the Agent List... button on the Agent Map toolbar or select Show Agent 
List... from the Properties menu to open the Agent List - Queue Name @ Site 
Name dialog box. This dialog box contains a list of all agents in the Queue or 
Queue Group. Each agent listing includes the agent ID and the agent's name. 
Agents are added to the Agent Map by dragging the agent from the Agent List 
into an empty cell on the Agent Map. 
 
Only one agent map can be displayed for a Queue or Queue Group at any time. 
 

Create a New Map Layout 

Use the following steps to create a new map layout. 
 

1. Click Agent Maps... on the toolbar to open the Agent Maps dialog box. 
2. Click New to add a new map layout to the list. 
3. Type a name for the new map layout in the Map Name column. 
4. Click the Rows column and input the number of rows for the table. 
5. Click the Columns column and input the number of columns for the table. 
6. Click Update to save the new map layout. 

 

Edit a Map Layout 

Use the following steps to edit a map layout. 
 

1. Click Agent Maps... on the toolbar to open the Agent Maps dialog box. 
2. Change the map layout name in the Map Name column if required. 
3. Click the Rows column and change the number of rows for the table if 

required. 
4. Click the Columns column and change the number of columns for the 

table if required. 
5. Click Update to save the changes to the map layout. 

 
Removing occupied cells from the grid by reducing the grid size automatically 
removes the agents occupying the cells from the grid and returns the agent 
names to the Agent List. 
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Deleting a Map Layout 

Use the following steps to delete a map layout. 
 

1. Click Agent Maps... on the toolbar to open the Agent Maps dialog box. 
2. Enable the check box of the map layout to delete. 
3. Click Delete to open the TASKE ACD Monitor dialog box. 
4. Click Yes to delete the map layout. 

 

Map Layout - Adding and Removing Agents 

The ability to group agents by department or by seating placement within the call 
center translates into quick and easy personnel tracking and management. 
Agents can be grouped in any order, with blank cells surrounding each group for 
easy group recognition. A drag-and-drop feature is used to add agents to and 
remove agents from a map layout. 
 
Placing an Agent in a Map Layout - use the following steps to place an agent in 
a map layout. 
 

1. Click the Agent List... button on the Agent Map toolbar or select Show 
Agent List... from the Properties menu to open the Agent List dialog box. 

2. Drag an agent from the Agent List to an empty cell in the Agent Map. 
 
Move an Agent to Another Cell - use the following steps to move an agent to 
another cell within the map layout. 
 

1. Click the cell occupied by the agent to be moved. Do not release the 
mouse button. 

2. Drag the agent to the desired cell. 
3. Release the mouse button to place the agent in the new cell. 

 
Remove an Agent from a Map Layout - use the following steps to remove an 
agent from a map layout. 
 

1. Click the Agent List... button on the Agent Map toolbar or select Show 
Agent List... from the Properties menu to open the Agent List dialog box. 

2. Click the cell occupied by the agent to be moved. Do not release the 
mouse button. 

3. Drag the agent to the Agent List and release the mouse button to remove 
the agent from the agent map and place the agent back in the Agent List. 

 
Adding or moving an agent to an occupied cell removes the agent occupying the 
cell from the grid and returns the agent name to the Agent List. 
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Switching Between Map Layouts 

The map layouts for individual Queues or Queue Groups are accessed via the 
Map button on the Queue Panels. Several map layouts can exist for a single 
Queue or Queue Group. This allows custom maps to be created for each call 
center shift that reflect the individual preferences of the users. 
 
Use the following steps to switch between map layouts. 
 

1. Click the Agent Maps... button on the toolbar of the Agent Map to open the 
Agent Maps dialog box. 

2. Enable the check box for the desired map layout. 
3. Click Close to close the Agent Maps dialog box. 

 
Every Queue and Queue Group has a default map layout titled "Map for Queue 
Name". 
 

Filtering the Agent States Report and Agent Maps 

The Agent States report and Agent Maps are customizable to display varying 
amounts of information. This filtering process allows users to display only the 
information that is required in the cells and avoid overcrowding. Cell information 
is filtered in two ways, through the definition of the cell properties and the State 
Color Legend. 
 

Filtering Cell Information Using the Cell Properties 

Each cell in the Agent States report and the Agents Maps can display up to 
seven items. These items are: an agent state icon, the agent ID, the agent name, 
the agent nick name, the ACD Queue ID, a state character, and the amount of 
time the agent has spent in the current state. Users can choose to display all or 
none of these items in the cells of the report. By default, the agent state icon, 
agent ID, agent name, and the amount of time the agent has spent in the current 
state are displayed. 
 
Use the following steps to select or de-select the agent properties for display. 
 

1. Right-click in any cell of the Agent States report or an Agent Map to 
access the cell properties drop-down menu. 

2. Click an item to select it or de-select it from the list of properties to display. 
If a check mark is present beside the item, it is selected. If a check mark is 
not present beside the item, it is not selected. 

3. Repeat steps 1 and 2 for the selection or de-selection of additional items. 
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Properties cannot be changed for individual agents. Changing the display 
properties in the report affects the information display for all agents. 
 

The last option on the cell properties drop-
down menu is ToolTip. This option provides a 
sub-menu that contains all of the options in 
the cell properties menu except for View 
Icon. The selections in the ToolTip menu 
allow users to decide what information to 
include in the ToolTip that appears when the 
mouse pointer is held over the cell of an 
agent in the table. The options with a check 
mark beside them are selected and will be 
included in the ToolTip. To disable an item, 
simply select it to remove the check mark. 

 

Using Color to Display Agent States 

The use of color in the Agent States report and Agent Maps is very effective for a 
quick analysis of agent states. To further enhance the use of color, users can 
select any number of colors to represent the states, or even turn off the display of 
color for a state. The State Colors dialog box lists each of the agent states with 
an associated color. Each state is provided on a button. By default all of these 
button are depressed, meaning that the state color for all of the states are 
enabled. To disable the display of color for a state, click the button so it is no 
longer depressed.  
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Use the following steps to change the default colors for the agent states. 
 

1. Select Show State Color Legend... from the Properties menu or press 
CTRL+E to open the State Colors dialog box. 

2. Click the down arrow button beside one of the states in the Normal States 
section to open the Color dialog box.  

3. Select a new color for the state from the color dialog box and click OK. 
The state is immediately displayed in the new color. 

4. Repeat steps 2 and 3 as desired for the remaining states.  
 

Accessing Recent Historical Information 

The Queue Panels are the access point for all real-time and recent historical 
information. A Queue Panel is displayed in the QIDA for each Queue or Queue 
Group selected in the Queue Monitor List. Each Queue Panel is comprised of 
two panels, the Real-time Panel and the Review Panel. 
 

Clicking the Review button on the Real-time Panel opens the Review 
Panel where the recent historical information is located for the last hour, 
last 12 hours, the last 24 hours, and the current day. To close the Review 
Panel, click the Review button on the Real-time Panel a second time. 

The Review Panel is populated with buttons that display customer interaction 
center statistics. Clicking any button produces a report in graph or table format. 
Click the button a second time to close the report. 
 

A button on the left side of the Review Panel selects the time period 
for viewing. The title of this button may be Last Hour, Last 12 Hours, 

Last 24 Hours, or Current Day. These titles reflect the time periods that are 
available for review. The current title of the button identifies the time period for 
the statistics currently displayed on the Review Panel. Clicking this button 
produces a menu of the available review periods. 
 
Last Hour - provides customer interaction center data and statistical averages 
for the past 60 minutes. 
  
Last 12 Hours - provides customer interaction center data and statistical 
averages for the past 12 hours. 
  
Last 24 Hours - provides customer interaction center data and statistical 
averages for the past 24 hours.  
  
Current Day - provides customer interaction center data and statistical averages 
from 00:00 of the current day to the current time. 
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The graphs that present the Last Hour, Last 12 Hours, Last 24 Hours, and 
Current Day statistics are: 
 

 Longest Call Waiting (Last Hour only) 
  Calls Waiting (Last Hour only) 
 Call Counts 
 Service Factors 
 Average Time to Answer 
 Average Time to Abandon 
 Average Talk Time 
 Average Time to Interflow 
 Answered By Group 
 Agent Utilization 

 
Many of the application controls and graphs are annotated by ToolTips. If you 
require further information about a specific control or graph line, hold the cursor 
over it for a moment to produce a short message describing the purpose of the 
control or other screen element. 
 

Using the Longest Waiting Time Report 

The Longest Waiting Time report is a bar graph that indicates the amount 
of time the longest waiting caller has been waiting in the Queue or Queue 
Group for each minute of the last hour.  
 

Use the following steps to view the report. 
 

1. Select the Queue or Queue Group of interest from the Queue Monitor List. 
The Queue Panel for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the Last Hour time period. If the button on the left side of the 

Review Panel is titled Last Hour, the correct time period is selected. If the 
button is titled Last 12 Hours, Last 24 Hours, or Current Day, click the 
button and select Last Hour from the drop-down menu. 

4. Click the Longest Waiting Time button on the Review Panel to open the 
graph. 
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Using the Calls Waiting Report 

The Calls Waiting report is a bar graph that details the number of calls 
waiting in the queue for the Queue or Queue Group over the past hour.  
 
 

Use the following steps to view the report. 
 

1. Select the Queue or Queue Group of interest from the Queue Monitor List 
. The Queue Panel for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the Last Hour time period. If the button on the left side of the 

Review Panel is titled Last Hour, the correct time period is selected. If the 
button is titled Last 12 Hours, Last 24 Hours, or Current Day, click the 
button and select Last Hour from the drop-down menu. 

4. Click the Calls Waiting button on the Review Panel to open the graph. 
 

Using the Call Counts Report 

The Call Counts report is a bar graph that provides the 
number of calls answered, the number of calls 
abandoned, and the number of calls interflowed. The 
graph is available for all time segments. 

 
Use the following steps to view the report for any time period. 
 

1. Select the Queue  or Queue Group  of interest from the Queue Monitor 
List . The Queue Panel  for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the desired time period. Click the button on the left side of the 

Review Panel to produce a drop-down menu with the available time 
periods. Select the desired time period from this menu. When a time 
period is selected, the button adopts the time period title as its title. The 
button may be titled Last Hour, Last 12 Hours, Last 24 Hours, or Current 
Day. 

4. Click either the Calls Answered, Calls Interflowed, or Calls Abandoned 
button on the Review Panel to open the graph. 
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Using the Service Factors Report 

The Service Factors report is a bar graph that provides the 
Answer Service Factor and Telephone Service Factor. These 
statistics indicate how the calls that reach the call center are 
being handled. The graph is available for all time segments. 

 
Use the following steps to view the report for any time period. 
 

1. Select the Queue or Queue Group of interest from the Queue Monitor List. 
The Queue Panel for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the desired time period. Click the button on the left side of the 

Review Panel to produce a drop-down menu with the available time 
periods. Select the desired time period from this menu. When a time 
period is selected, the button adopts the time period title as its title. The 
button may be titled Last Hour, Last 12 Hours, Last 24 Hours, or Current 
Day. 

4. Click either the Answer Service Factor or the Telephone Service Factor 
button on the Review Panel to open the graph. 

 

Using the Time to Answer Report 

The Time to Answer report is a stacked bar graph that provides 
the average time to answer and the maximum time to answer. 
The graph is available for all time segments.  
 

Use the following steps to view the report for any time period. 
 

1. Select the Queue or Queue Group of interest from the Queue Monitor List. 
The Queue Panel for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the desired time period. Click the button on the left side of the 

Review Panel to produce a drop-down menu with the available time 
periods. Select the desired time period from this menu. When a time 
period is selected, the button adopts the time period title as its title. The 
button may be titled Last Hour, Last 12 Hours, Last 24 Hours, or Current 
Day. 

4. Click either the Average Time to Answer or the Maximum Time to Answer 
button on the Review Panel to open the graph. 
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Using the Average Time to Abandon Report 

The Average Time to Abandon report is a bar graph that provides the 
average amount of time a caller will wait in the queue before 
disconnecting and terminating the call. The graph is available for all time 
segments. The graph is available for all time segments.  

 
Use the following steps to view the report for any time period. 
 

1. Select the Queue or Queue Group of interest from the Queue Monitor List. 
The Queue Panel for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the desired time period. Click the button on the left side of the 

Review Panel to produce a drop-down menu with the available time 
periods. Select the desired time period from this menu. When a time 
period is selected, the button adopts the time period title as its title. The 
button may be titled Last Hour, Last 12 Hours, Last 24 Hours, or Current 
Day. 

4. Click the Average Time to Abandon button on the Review Panel to open 
the graph 

 

Using the Average Talk Time Report 

The Average Talk Time report is a bar graph that provides the average 
length of answered calls for the Queue or Queue Group. The graph is 
available for all time segments. 
 

Use the following steps to view the report for any time period. 
 

1. Select the Queue or Queue Group of interest from the Queue Monitor List. 
The Queue Panel for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the desired time period. Click the button on the left side of the 

Review Panel to produce a drop-down menu with the available time 
periods. Select the desired time period from this menu. When a time 
period is selected, the button adopts the time period title as its title. The 
button may be titled Last Hour, Last 12 Hours, Last 24 Hours, or Current 
Day. 

4. Click the Average Talk Time button on the Review Panel to open the 
graph. 
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Using the Average Time to Interflow Report 

The Average Time to Interflow report is a bar graph that provides the 
average length of time a call will remain in the Queue or Queue Group 
queue before being routed to another queue. The graph is available for 
all time segments.  

 
Use the following steps to view the report for any time period. 
 

1. Select the Queue or Queue Group of interest from the Queue Monitor List. 
The Queue Panel for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the desired time period. Click the button on the left side of the 

Review Panel to produce a drop-down menu with the available time 
periods. Select the desired time period from this menu. When a time 
period is selected, the button adopts the time period title as its title. The 
button may be titled Last Hour, Last 12 Hours, Last 24 Hours, or Current 
Day. 

4. Click the Average Time to Interflow button on the Review Panel to open 
the graph. 

 

Using the Answered by Group Report 

The Answered by Group report is a bar graph that indicates the 
percentage of calls handled by each Agent Group within the Queue or 
Queue Group. The graph is available for all time segments. 
 

Use the following steps to view the report for any time period. 
 

1. Select the Queue or Queue Group of interest from the Queue Monitor List. 
The Queue Panel for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the desired time period. Click the button on the left side of the 

Review Panel to produce a drop-down menu with the available time 
periods. Select the desired time period from this menu. When a time 
period is selected, the button adopts the time period title as its title. The 
button may be titled Last Hour, Last 12 Hours, Last 24 Hours, or Current 
Day. 

4. Click the Answered by Group button on the Review Panel to open the 
graph. 
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Using the Agent Utilization Report 

The Agent Utilization report is a bar graph that indicates the agent states 
and the number of agents in each state for the last hour. The graph 
includes the number of agents idle, the number of agents on ACD calls, 
the number of agents on non-ACD calls, and the number of agents 

unavailable. 
 
Use the following steps to view the report. 
 

1. Select the Queue or Queue Group of interest from the Queue Monitor List. 
The Queue Panel for the selected Queue or Queue group opens. 

2. Click the Review button on the Queue Panel.  
3. Select the Last Hour time period. If the button on the left side of the 

Review Panel is titled Last Hour, the correct time period is selected. If the 
button is titled Last 12 Hours, Last 24 Hours, or Current Day, click the 
button and select Last Hour from the drop-down menu. 

4. Click the Agent Utilization button on the Review Panel to open the graph. 
 

Using the Replay Mode 

The Replay mode is an animated review of a 24-hour period that shares the 
reports of the Real-time mode. Using the same real-time, last hour, last 12 
hours, last 24 hours, and current day reports, users select a date with logged 

customer interaction center data. The information for the day is replayed in a real-time 
simulation. When in the Replay mode, the application title bar states TASKE ACD 
Monitor - Replay. When operating in the Real-time mode the title bar simply states 
TASKE ACD Monitor. 
 
Click the Replay button on the Main Control Panel to switch to the Replay Mode. 
Located on the Main Control Panel, the controls for the replay are similar to that of a 
VCR. Use the replay controls to maneuver throughout the day's data. To further control 
the replay of data, users select thresholds, or trigger stops, based on customer 
interaction center conditions or a specific time of day. These thresholds pause the 
replay when the selected conditions are encountered.  
 
The thresholds for customer interaction center conditions are selected for individual 
Queues or Queue Groups from the Queue Panels. Thresholds can be set for three 
customer interaction center conditions. These are the number of calls waiting, the 
number of abandoned calls during a 15-minute interval, and the amount of time the 
longest waiting caller has been waiting. 
 
The time of day trigger stop is accessed from the Main Control Panel. It is a general 
threshold that applies to all monitored Queues and Queue Groups. 
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The Speed slider control on the Main Control Panel determines the speed of the replay. 
At its slowest, the data is replayed in real-time, where one second equals one second. 
At its fastest, the data is replayed at 1000 times the real-time increments, meaning that 
one millisecond equals one second. Between these two extremes, the replay speeds 
range from 2 times to 999 times the real-time increments. The speed is changeable 
while the replay is in progress, allowing users to quickly move through the information 
and slow it down when an in-depth analysis is required. 
 
As the replay progresses, the time indicates the time of day the replay is displaying. The 
time is presented in 24-hour format and its speed of progression depends on the replay 
speed. 
 

Selecting the Replay Date 

The Replay mode is an animated review of any 24-hour period with 
logged call center data. To replay call center data, the user must 
select a date from the date box on the Main Control Panel where 
the replay controls and date selection options are located. The date 
box in the top of the replay controls section allows users to select a 
date using one of two methods. Type the date into the date box or 
to double-click the date box and open the Replay Date Selection 

calendar. 
 
Use the following steps to select the replay date using the Replay Date Selection 
calendar. 
 

1. Double-click the date box to open the Replay 
Date Selection calendar. 

1. Use  and  to select the desired year. 
2. Use  and  to select the desired month. 
3. Click on each of the desired date(s). When a 

date is selected it is highlighted in blue. 
4. Click OK to close the Replay Date Selection 

calendar. 
5. Click  to begin the replay. 
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Using the Replay Controls 

The Replay mode uses stored PBX data to provide an as-it-happened repetition 
of a selected 24-hour period. The replay of call center data is controlled in a 
manner similar to that of a VCR. Use the replay controls to maneuver throughout 
the data for the selected day. Prior to playing the data, select the date for the 
replay and set the replay speed to an adequate level. 
 

The controls for the Replay mode are located on the Main Control 
Panel. Use the controls to select the replay date and speed, and to 
control the progression of the information. The controls for the 
replay are similar to that of a VCR. Use the replay controls to 
maneuver throughout the day's data. 
 
In addition, a time of day trigger stop can be set using the Trigger 

Stops button on the Main Control Panel. To set Queue or Queue Group specific 
thresholds for customer interaction center conditions, use the Trigger buttons on 
the Queue Panels. 
 

Starting the Replay 

Clicking the  button starts the playback of call center data. The speed of the 
data replay is determined by the selection in the Speed field. 
 

Pausing the Replay 

Clicking the  button pauses the replay at the current event. When the replay is 
paused, the time field flashes the time the replay was paused. Click Pause again 
or Play to restart the replay. 
 

Stopping the Replay 

Clicking the  button stops the replay and resets the time to 12:00 for the 
selected date. 
 

Fast Forwarding the Replay 

Clicking the  button immediately advances the replay to the next event. Clicking 
and holding the button continues to advance through the events until the button 
is released. 
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Using the Hourly Placeholder Buttons 

As a replay progresses, the information is saved at the beginning of each hour. 
When a save occurs, a temporary marker, or placeholder, is created. The  and 

 buttons are used to move from placeholder to placeholder when the replay is 
paused. 
 
When the  button is clicked, the replay time returns to 12:00 and all markers 
are removed. 
 

Setting Trigger Stops 

Use the Trigger buttons on the Main Control Panel and on the Queue Panels to 
define time of day and queue events that pause the replay when encountered. 
 

Setting the Replay Speed 

The Speed slider control on the Main Control Panel determines the speed of the 
replay. At its slowest, the data is replayed in real-time, where one second equals 
one second. At its fastest, the data is replayed at 1000 times the real-time 
increments, meaning that one millisecond equals one second. Between these 
two extremes, the replay speeds range from 2 times to 999 times the real-time 
increments. The speed is changeable while the replay is in progress, allowing 
users to quickly move through the information and slow it down when an in-depth 
analysis is required. 
 

Setting the Replay Speed 

The Replay mode is an animated review of a 24-hour period that shares the 
reports of the Real-time mode. Using the same real-time, last hour, last 12 hours, 
last 24 hours, and current day reports, users select a date with logged customer 
interaction center data. The information for the day is replayed in a real-time 
simulation. The speed of the simulation is set using the Speed slider control. 
 
Use the following steps to set the replay speed. 
 

1. Move the slider to the desired position within the replay speed range. 
2. Adjust the slider at any time during the replay. 

 
At its right-most position, or slowest replay speed, the data is replayed in real-
time, where one second equals one second. At its left-most position, or fastest 
replay speed, the data is replayed at 1000 times the real-time increments, 
meaning that one millisecond equals one second. Between these two extremes, 
the replay speeds increase in increments of 50. The speed is changeable while 



TASKE Call Center Management Tools            

 
- 131 - 

the replay is in progress, allowing users to quickly move through the information 
and slow it down when an in-depth analysis is required. 
 

Setting Trigger Stops in Replay 

The replay mode is an animated review of call center data over a 24-hour period. 
Control of the replay is similar to that of a VCR. Use the replay controls to 
maneuver throughout the data for the selected day. To further control the replay 
of data, users select thresholds based on customer interaction center conditions 
or a specific time of day that pause the replay when the selected conditions are 
encountered. 
 
Known as Trigger Stops, the thresholds for customer interaction center 
conditions are selected for individual Queues or Queue Groups using the Trigger 
button on the Queue Panel. Thresholds can be set for three conditions. These 
are Calls Waiting, Abandoned Calls, and the Longest Waiting Call. The time of 
day Trigger Stop is a general threshold that applies to all monitored Queues and 
Queue Groups. Only one time of day trigger stop can be set at a time. 
 

Defining Trigger Stops for Customer Interaction Center Conditions 

Use the following steps to define a trigger stop for customer interaction center 
conditions. 
 

1. Click the Trigger button on the Queue Panel for the desired Queue or 
Queue Group to open the Queue Triggers dialog box. 

2. Enable the check boxes for the desired Trigger Stops and set the value or 
time thresholds for each. 

3. Click OK. 
 

Defining a Time of Day Trigger Stop 

Use the following steps to define a trigger stop based on the time of day. 
 

1. Select the Trigger button on the Main Control Panel to open the Trigger 
dialog box. 

2. Enable the Stop at Record Time (HH:MM:SS) check box and set the time 
for the Trigger Stop. 

3. Click OK. 
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Using the Enterprise ACD Monitor 

To monitor the Queues/Queue Groups on a remote TASKE site, the Enterprise Monitor 
looks at the information from a remote Information Server.  
 
Launching the Enterprise ACD Monitor application and selecting the desired local or 
remote Queues and Queue Groups to monitor prompts the following sequence of 
events: 
 

1. The Enterprise Monitor opens a State Machine session for each site selected - 
local or remote. 

2. The State Machine uses the Net Client, visible in the Windows system tray , to 
receive the request to monitor a specific Queue/Group and sends that request to 
the local Information Server. 

3. The Information Server, seeing that the request is for data from a remote TASKE 
site, looks in the site list for the location of the remote site and sends the request 
to the Information Server at the remote site. 

4. The remote Information Server receives the request and sends the information 
back to the "local" Information Server. 

5. The Information Server receives the information and passes it back through the 
local network to the Net Client for the Enterprise ACD Monitor. 

6. The Net Client passes the information to the state machine, which then passes it 
to the Enterprise ACD Monitor application. 

7. The Enterprise ACD Monitor displays the information as requested. 
 
The following diagram illustrates the path the information request follows from the 
Enterprise ACD Monitor being started, to the display of the information. 
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Monitoring Remote Sites 

To monitor the Queues and Queue Groups on a remote TASKE site, the TASKE 
Enterprise Monitor looks at .pbx files that are saved on the local Information 
Server of the remote site. The Enterprise Supervisor then only needs to have 
access to a shared PBX directory on the local Information Server. 
 
Use the following steps to monitor remote and local TASKE sites with Enterprise 
Monitor. 
 

1. From the TASKE ToolBox, open the Enterprise Monitor. 
2. Click the Queues... button on the Main Control Panel to open the Queue 

Manager. 
3. Select the Queues and Queue Groups to be monitored in the Queue 

Selector. All Queues and Queue Groups from all available TASKE 
Enterprise Queues and Queue Groups are displayed in the Queue 
Selector with the monitoring status, name, nick name, location, ID, and 
type. 
 

 
 

4. Assuming the monitoring status for all Queues and Queue Groups in this 
case is disabled, enable the "Monitor activity on selected Queue(s)" check 
box to enable the monitoring status for the selected Queues and Queue 
Groups.  

5. Set the alarm settings for the desired Queues and Queue Groups. 
6. Click OK to enable the changes and close the Queue Manager. The 

Queues and Queue Groups selected for monitoring now appear in the 
Queue Monitoring List. 

 
From this point forward, the only functionality the Enterprise ACD Monitor does 
not provide that the ACD Monitor does is the Replay mode. The Enterprise 
Monitor does not include any of the Replay features that are available in ACD 
Monitor and the Replay mode selection button is disabled. 
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ACD Monitor Glossary 

Term Definition 

Agent Map Clicking the Map button on the Real-time Panel of the Queue 
Panels opens the Agent Map reports. 

An Agent Map is a real-time graphical report that dynamically 
illustrates the status of agents. Agents are grouped logically and 
their status is reported using a combination of color, icons, and text. 
To access the map layouts for a Queue or Queue Group, click the 
Map button on the Queue Panel of the desired Queue or Queue 
Group. 

Agent State 
Characters 

? No activity recorded for the agent since log in 
A Agent is on an ACD call 
D Agent is in Do Not Disturb 
F Idle Forward 
H Agent is on Hold 
I Agent is Idle (waiting to be offered a call) 
L Agent is Logged Out 
M Agent is in Make Busy 
N Agent is Unavailable / Not Ready 
O Agent is on an Outbound call 
P Agent is on an inbound non-ACD call 
R Ringing 
T Outbound Trunk 
U Make Busy – DND 
V Not Ready - DND 
W Agent is in Work Time 
X Unavailable 

Agent States 
Report 

Clicking the States button on the Real-time Panel of the 
Queue Panels opens the Agent States report. 

The Agent States report is a read-only, real-time display that 
reports queue activity for the Queue or Queue Group. The five 
agent states included in the table are Idle, ACD, Non-ACD, 
Unavailable, and Logged Out. To access the Agent States report 
for a Queue or Queue Group, click the States button on the Queue 
Panel of the desired Queue or Queue Group. 
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Term Definition 

Current States 
Report  

 
The Current States report is a bar graph that represents the real-
time statistics. The title of the statistic selected on the Real-time 
Panel is displayed in the graph margin with the numeric value of the 
statistic. All statistics are represented by a bar in the graph with the 
graph of the selected statistic displayed in a highlight color. 

Main Control 
Panel 

Located on the left side of the ACD Monitor window, the Main 
Control Panel is responsible for mode selection, the display of the 
system date and time in the real-time mode, the display and setup 
of the Queue Monitor List, the date selection in the Replay mode, 
and replay control. 

Menu Bar The menu bar spans the top of the ACD Monitor window. The menu 
bar contains four menus that provide keyboard or mouse access to 
the functions of the ACD Monitor. The menus are File, View, Chat, 
and Help. 

Mode Selection Click the Real-time button to switch to the Real-time mode. 
 
 
Click the Replay button to switch to the Replay mode. 

Queue A Queue is a dialable number that accesses a group of answering 
positions (agent or extension groups). 

Queue Group A Queue Group is used strictly for reporting and monitoring 
purposes in TASKE applications. This is a group of Queues given a 
single identifying number that is traceable in reports and the ACD 
Monitor. For instance, in a call center with three Technical Support 
Queues create a Queue Group that includes all three Queues. 
Using the Queue Group monitor all agents in all three Queues 
simultaneously and include all three Queues in a single report. 

Queue 
Information 
Display Area 
(QIDA) 

The Queue Information Display Area (QIDA) displays Queue and 
Queue Group information for the Queues or Queue Groups 
selected from the Queue Monitor List. Information is presented 
numerically, graphically, and tabularly in both the Real-time mode 
and the Replay mode. 
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Term Definition 

Queue Monitor 
List 

The Queue Monitor List, located on the Main Control Panel, 
provides a button for each of the Queues or Queue Groups 
selected for monitoring. Select one or more Queues or Queue 
Groups from the Queue Monitor List to display the information in 
the QIDA. Use the list to view the details of a single Queue or 
Queue Group, or monitor several Queue panels and their reports at 
once in the QIDA. 

Queue Panels Queue Panels display the graph control buttons that provide call 
center statistics and performance information. For those graph 
control buttons that represent a call center statistic, the numeric 
value of the statistic is visible on the button. Clicking any of the 
graph control buttons provides a graphical or tabular view of the call 
center information. 

Review Panel 
Time Periods 

The review panel reports on four different time periods: Last Hour, 
Last 12 Hours, Last 24 Hours, and Current Day. 
 

Last Hour - provides customer interaction center data and 
statistical averages for the past 60 minutes. 
 
Last 12 Hours - provides customer interaction center data and 
statistical averages for the past 12 hours. 
 
Last 24 Hours - provides customer interaction center data and 
statistical averages for the past 24 hours.  
 
Current Day - provides customer interaction center data and 
statistical averages from 00:00 of the current day to the current 
time. 
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Term Definition 

Replay Controls 
 Use the date box to select the replay date. Double-

click in the date box to open the calendar in the 
Date Selection dialog box. 

 Clicking the play button starts the playback of call 
center data. The speed of the data replay is 
determined by the selection in the Speed field. 

 Clicking the pause button pauses the replay at the 
current event. When the replay is paused, the time 
field flashes the time the replay was paused. Click 
Pause again or Play to restart the replay. 

 Clicking the stop button stops the replay and 
resets the time to 12:00 for the selected date. 

 Clicking the fast forward button immediately 
advances the replay to the next event. Clicking 
and holding the button continues to advance 
through the events until the button is released. 

  Clicking the hourly placeholder buttons 
immediately advances the replay to the next event. 
Clicking and holding the button continues to 
advance through the events until the button is 
released. 

 The Trigger button on the Main Control Panel 
opens the Triggers dialog box where time of day 
thresholds are set. To set the time, individually 
click the hour, minute, and second fields and type, 
or use the up and down arrows, to set the two-digit 
value for each field. 

 

The Trigger button on the Queue Panels open the 
Queue Triggers dialog box where thresholds are 
set for individual Queues and Queue Groups. 

 The Speed slider control on the Main Control 
Panel determines the speed of the replay. At its 
slowest, the data is replayed in real-time, where 
one second equals one second. At its fastest, the 
data is replayed at 1000 times the real-time 
increments, meaning that one millisecond equals 
one second Between these two extremes, the 
replay speeds increase in increments of 50.  
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TASKE Reports 

The TASKE Reports application generates custom reports based on data collected from 
the PBX system. These reports aid in managing a balance between the call load 
presented to the customer interaction center, and the capacity of the customer 
interaction center to process these calls. 
 
The Reports application also features the ability to forecast the future call demand. The 
future call demand is forecast with reasonable reliability by studying calling patterns 
derived from historical data. Supervisors use this information to estimate the call load 
and to schedule the resource requirements. 
 
The Reports application generates several types of custom reports that are presented in 
text format. These reports are viewed in the Publication Viewer, a main section of the 
Reports interface.  
 
The content of the reports can be categorized in three ways: 
 

 by customer interaction center resource (Trunks, Extensions, Extension Groups, 
Agents, Agent Groups, Queues, and Queue Groups) 

 by reporting period (day, week, and month) 
 by interval (half-hour, hour, day, week, or month) 

 
Select a reporting period and generate a report for a specific resource or resource 
group. The data is collated across several time intervals and describes the performance 
of the selected resource or resource group. The statistics in a report are totaled or 
averaged by time interval, over the reporting period. 
 

Starting TASKE Reports 

The Reports application is opened from the Windows desktop. Use one of the following 
methods to open the application. 
 

Opening Reports Using the Start Button 

Use the following steps to open the Reports application using the Start button on 
the Windows desktop. 
 

1. Click Start on the toolbar of the Windows desktop. 
2. Select Programs from the menu. 
3. Select the TASKE folder in the list of programs. 
4. Select Reports from the list of TASKE applications to open the Reports 

application. 
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Opening Reports from the TASKE Program Folder 

Use the following steps to open the Reports application from the TASKE ToolBox 
program folder. 
 

1. Double-click the TASKE ToolBox folder icon on the Windows desktop to 
open the TASKE ToolBox folder. 

2. Double-click the Reports icon in the folder to open the Reports application. 
 

 

 

 
 

Using the Menu Bar 

The menu bar contains two menus that provide keyboard or mouse access to the 
functions of the Reports application. The menus are File and Help. 
 

File Menu 

Use the File menu to access various areas and functions of the Reports 
application. The table below outlines the functionality of the File menu.   
 
Option Shortcut Description 

New N/A Opens the properties window to create a new report 
for the reporting period selected in the Main Control 
Panel.  

Delete N/A Deletes the report template selected in the Report 
Templates panel. 

Export N/A Generates a summary for the report selected in the 
Report Templates panel and exports the report in 
the format selected for the report in the Export tab 
of the properties window. When Export is selected 
from the File menu, the user is required to select a 
date for the report from the Date Selection 
calendar. 
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Option Shortcut Description 

Properties N/A Opens the properties window for the report 
template selected in the Report Templates panel. 

Print Setup N/A Opens the Print Setup dialog box. Select a printer 
and define the properties for printing the report in 
this dialog box. 

Print... N/A Opens the Print dialog box. Select a printer,define 
the properties for printing the report, and print the 
report from this dialog box.  

Print 
Preview 

N/A Provides a preview of the printed report. Print the 
report from the preview window. 

Notification 
Reports 

N/A Enables or disables the Notification Reports. When 
a check mark is present beside this menu option 
Notification Reports are enabled. If a check mark is 
not present, Notification Reports are disabled. 

Schedule 
Report 
Generator 

N/A Opens the Schedule Report Generator for 
scheduling the automatic printing and exporting of 
reports. 

Exit N/A Select this option to close the Reports application. 
  

Help Menu 

Use the Help menu to access the online help for the Reports application. 
Additionally, use this menu to view version and copyright information for the 
application. 
 
Option Shortcut Description 

Contents F1 Select Contents to access the Online Help for the 
Reports application.  

About 
TASKE 
Reports... 

N/A Select About TASKE Reports... to view version, 
copyright, and lock number information for the 
Reports.  
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Using the Main Control Panel 

The Main Control Panel spans the left side of the Reports interface and contains a set 
of six buttons. These buttons serve as the starting point for creating report templates. 
The first five buttons represent reporting periods. The reporting periods are: Daily, 
Weekly, Monthly, Year by Week and Year by Month.  
 
The sixth button, the Forecast button, also represents a reporting period, however, this 
reporting period is in the future. The report templates created for the Forecast period 
are based on the projected call load.  
 
The reports that can be generated for all of the reporting periods are listed in the Report 
Types by Period tables below. 
 
Trunk Reports 

Reporting Period Resource Report Options 

Daily Trunk Quarter hour, half hour, hour 

Weekly Trunk Quarter hour, half hour, hour, day of week 

Monthly Trunk Quarter hour, half hour, hour, day of month 

Year by Week Trunk Half hour, hour, day of week, week 

Year by Month Trunk Half hour, hour, day of month, month 

 
Extension Reports 

Reporting Period Resource Report Options 

Daily Extension Quarter hour, half hour, hour 

Weekly Extension Quarter hour, half hour, hour, day of week 

Monthly Extension Quarter hour, half hour, hour, day of month 

Year by Week Extension Half hour, hour, day of week, week 

Year by Month Extension Half hour, hour, day of month, month 

 
Extension Group Reports 

Reporting Period Resource Report Options 

Daily Extension Group By Extension 

Weekly Extension Group By Extension 

Monthly Extension Group By Extension 

Year by Week Extension Group By Extension 

Year by Month Extension Group By Extension 
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Agent Reports 

Reporting Period Resource Report Options 

Daily Agent Quarter hour, half hour, hour, agent group, Queue 

Weekly Agent Quarter hour, half hour, hour, day of week, agent 
group, Queue 

Monthly Agent Quarter hour, half hour, hour, day of month, agent 
group, Queue 

Year by Week Agent Half hour, hour, day of week, week, agent group, 
Queue 

Year by Month Agent Half hour, hour, day of month, month, agent group, 
Queue 

 
Agent Group Reports 

Reporting Period Resource Report Options 

Daily Agent Group Quarter hour, half hour, hour, agent, Queue 

Weekly Agent Group Quarter hour, half hour, hour, day of week, agent, 
Queue 

Monthly Agent Group Quarter hour, half hour, hour, day of month, agent, 
Queue 

Year by Week Agent Group Half hour, hour, day of week, week, agent, Queue 

Year by Month Agent Group Half hour, hour, day of month, month, agent, Queue 

 
Queue Reports 

Reporting Period Resource Report Options 

Daily Queue Quarter hour, half hour, hour, DNIS, area code, area 
code & city, state 

Weekly Queue Quarter hour, half hour, hour, day of week, DNIS, area 
code, area code & city, state 

Monthly Queue Quarter hour, half hour, hour, day of month, DNIS, area 
code, area code & city, state 

Year by Week Queue Half hour, hour, day of week, week, DNIS, area code, 
area code & city, state 

Year by Month Queue Half hour, hour, day of month, month, DNIS, area code, 
area code & city, state 

Daily Queue Answer 
Spectrum 

Quarter hour, half hour, hour 

Weekly Queue Answer 
Spectrum 

Quarter hour, half hour, hour, day of week 
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Queue Reports 

Reporting Period Resource Report Options 

Monthly Queue Answer 
Spectrum 

Quarter hour, half hour, hour, day of month 

Year by Week Queue Answer 
Spectrum 

Half hour, hour, day of week, week 

Year by Month Queue Answer 
Spectrum 

Half hour, hour, day of month, month 

Daily Queue Abandon 
Spectrum 

Quarter hour, half hour, hour 

Weekly Queue Abandon 
Spectrum 

Quarter hour, half hour, hour, day of week 

Monthly Queue Abandon 
Spectrum 

Quarter hour, half hour, hour, day of month 

Year by Week Queue Abandon 
Spectrum 

Half hour, hour, day of week, week 

Year by Month Queue Abandon 
Spectrum 

Half hour, hour, day of month, month 

Daily Queue Interflow 
Spectrum 

Quarter hour, half hour, hour 

Weekly Queue Interflow 
Spectrum 

Quarter hour, half hour, hour, day of week 

Monthly Queue Interflow 
Spectrum 

Quarter hour, half hour, hour, day of month 

Year by Week Queue Interflow 
Spectrum 

Half hour, hour, day of week, week 

Year by Month Queue Interflow 
Spectrum 

Half hour, hour, day of month, month 

Daily Queue Activity Quarter hour, half hour, hour, pairs of acct codes 

Weekly Queue Activity Quarter hour, half hour, hour, day of week, pairs of acct 
codes 

Monthly Queue Activity Quarter hour, half hour, hour, day of month, pairs of 
acct codes 

Year by Week Queue Activity Half hour, hour, day of week, week, pairs of acct codes 

Year by Month Queue Activity Half hour, hour, day of month, month, pairs of acct 
codes 

Monthly Queue Peaks Peak offered, peak answered, peak abandoned, peak 
interflowed 
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Queue Group Reports 

Reporting Period Resource Report Options 

Daily Queue Group Quarter hour, half hour, hour, Queue, DNIS, area code, 
area code & city, state 

Weekly Queue Group Quarter hour, half hour, hour, day of week, Queue, 
DNIS, area code, area code & city, state 

Monthly Queue Group Quarter hour, half hour, hour, day of month, Queue, 
DNIS, area code, area code & city, state 

Year by Week Queue Group Half hour, hour, day of week, week, Queue, DNIS, area 
code, area code & city, state 

Year by Month Queue Group Half hour, hour, day of month, month, Queue, DNIS, 
area code, area code & city, state 

Daily Queue Group Answer 
Spectrum 

Quarter hour, half hour, hour, Queue 

Weekly Queue Group Answer 
Spectrum 

Quarter hour, half hour, hour, day of week, Queue 

Monthly Queue Group Answer 
Spectrum 

Quarter hour, half hour, hour, day of month, Queue 

Year by Week Queue Group Answer 
Spectrum 

Half hour, hour, day of week, week, Queue 

Year by Month Queue Group Answer 
Spectrum 

Half hour, hour, day of month, month, Queue 

Daily Queue Group Abandon 
Spectrum 

Quarter hour, half hour, hour, Queue 

Weekly Queue Group Abandon 
Spectrum 

Quarter hour, half hour, hour, day of week, Queue 

Monthly Queue Group Abandon 
Spectrum 

Quarter hour, half hour, hour, day of month, Queue 

Year by Week Queue Group Abandon 
Spectrum 

Half hour, hour, day of week, week, Queue 

Year by Month Queue Group Abandon 
Spectrum 

Half hour, hour, day of month, month, Queue 

Daily Queue Group Interflow 
Spectrum 

Quarter hour, half hour, hour, Queue 

Weekly Queue Group Interflow 
Spectrum 

Quarter hour, half hour, hour, day of week, Queue 

Monthly Queue Group Interflow 
Spectrum 

Quarter hour, half hour, hour, day of month, Queue 

Year by Week Queue Group Interflow 
Spectrum 

Half hour, hour, day of week, week, Queue 
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Queue Group Reports 

Reporting Period Resource Report Options 

Year by Month Queue Group Interflow 
Spectrum 

Half hour, hour, day of month, month, Queue 

Daily Queue Group Activity Quarter hour, half hour, hour, Queue, pairs of acct 
codes 

Weekly Queue Group Activity Quarter hour, half hour, hour, day of week, Queue, 
pairs of acct codes 

Monthly Queue Group Activity Quarter hour, half hour, hour, day of month, Queue, 
pairs of acct codes 

Year by Week Queue Group Activity Half hour, hour, day of week, Queue, pairs of acct 
codes 

Year by Month Queue Group Activity Half hour, hour, day of month, month, Queue, pairs of 
acct codes 

Monthly Queue Group Peaks Peak offered, peak answered, peak abandoned, peak 
interflowed 

  

Daily Reports 

Daily reports have three (3) report interval options: 15 minutes, half 
hour and hour. Daily reports are used to monitor the operations of a 

customer interaction center on a daily basis. The load activity data from the Daily 
reports of previous months or years can be used to forecast the call demand 
expected on a specific day of the year, such as Boxing day. For example, the 
level of Load Activity shown in last year's Daily report for September 9th might be 
a good indication of the level of Load Activity expected on September 9th of the 
current year. 
 
The statistics for each day typically cover an entire 24 hour time span. However, 
this time span may be truncated if the report options are set to limit the reporting 
hours of the day to a personalized definition of a business bay. The start and end 
times for the business day are set in the Administrator application. Go to the 
Options table of the Database mode to set these parameters. 
 

Weekly Reports 

Weekly reports have four (4) report interval options: 15 minutes, 
half hour, hour, and day of the week. Weekly reports are used to 

monitor the operations of a customer interaction center on a weekly basis. If the 
load activity for a customer interaction center is not expected to vary much 
between the days of the week but is expected to vary from week to week, then 
the Weekly reports might be used for forecasting purposes. This would be less 
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time consuming than viewing Daily reports since the data is reviewed a week at a 
time rather than a day at a time. 
 
Weekly reports represent a reporting period of seven (7) consecutive days. The 
statistics for each day of the week typically cover an entire 24 hour time span 
unless daily reports have been truncated to fewer hours. The week start day is 
set in the Administrator application. Go to the Options table of the Database 
mode to set this parameter. 
 

Monthly Reports 

Monthly reports have four (4) report interval options: 15 minutes, 
half hour, hour, and day of the month. Monthly reports may be used 

to compare this month's performance and call handling productivity with a 
previous month's performance. Monthly reports may also be used for budget 
planning purposes. For example, to examine the seasonal load activity levels that 
pertain to term hiring, Monthly reports would provide the load activity data in a 
manageable number of reports, rather than 31 Daily reports or 4 Weekly reports. 
 
Monthly reports represent a report period of up to 31 consecutive days, 
representing an entire calendar month. The statistics for each day of the month 
typically cover an entire 24 hour time span unless daily reports have been 
truncated to fewer hours. 
 

Year By Week Reports 

Year By Week reports have four (4) report interval options: half 
hour, hour, day of the week, and week. Year By Week reports may 

be used to compare this year's performance and call handling productivity by 
week with a previous year. The Year By Week reports enable performance and 
load activity for a relatively long period of time to be reviewed in one report. 
 
Year By Week reports can be generated for a minimum period of 1 week to a 
maximum period of 52 consecutive weeks, representing an entire calendar year, 
divided by week. The statistics for each day of the year that forms the Weekly 
report that is used by the Year By Week report typically covers an entire 24 hour 
time span unless daily reports have been truncated to fewer hours. 
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Year By Month Reports 

Year By Month reports have four (4) report interval options: half 
hour, hour, day of the month, and month. Year By Month reports 

may be used to compare this year's performance and call handling productivity 
by month with a previous year. The Year By Month reports enable performance 
and load activity for a relatively long period of time to be reviewed in one report. 
 
Year By Month reports can be generated for a minimum period of 1 month to a 
maximum period of 24 consecutive months, representing 2 entire calendar years, 
divided by month. The statistics for each day of the year that forms the Monthly 
report that is used by the Year By Month report typically covers an entire 24 hour 
time span unless daily reports have been truncated to fewer hours. 
 

Forecast Reports 

Within a customer interaction center, if there are more Agents than 
calls, then the Agents are idle for part of the time and costs are 

increased. In most cases, the Queue is designed so that the number of Agents 
available at any given time is less than the number of incoming calls. This places 
an upper limit on the number of Agents required for a customer interaction 
center. 
 
If there are more calls than available Agents, then callers must be kept waiting 
for an available Agent. The length of time a Caller waits depends on how many 
calls there are compared to the number of available Agents. However, there is an 
upper limit on the amount of time a caller will wait before abandoning the call. 
Therefore, there must be enough agents available to maintain the desired level of 
service.  
 
In between these upper and lower limits there is a balance where a given number 
of Agents provide satisfactory service at minimal cost. The objective of customer 
interaction center management is to achieve a good balance. 
 
The balance between economy and service is the crux of the operation of the 
customer interaction center, and produces very significant problems. The first of 
these is to predict how many calls can be expected over a given period of time 
(of an hour, a work shift or a day, for example). As telephone traffic (or the total 
number of calls made and the total duration of these) is highly variable in nature, 
it is very difficult to predict. The only practical means of obtaining a reasonable 
estimate is to perform an historical analysis of past experience and use this to 
predict future traffic volumes and patterns. 
 
The process of estimating projected traffic levels, or call loads on the Queue is 
termed Forecasting. Forecasting data is used to estimate the number of Agents 
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and other resources (such as Queues) needed to meet the forecast call load, and 
identify which Agents will work which shifts (i.e. scheduling). 
 

Using the Report Templates Panel 

The Report Templates panel occupies the upper, right quadrant of the Reports 
interface. This panel displays a table of the report templates created for the reporting 
period currently selected in the Main Control Panel.  
 

 
 

The table provides the following columns: 
 

Name - displays the names of the report templates defined for the reporting period. 
 
Sites - displays the name of the site where the content of the report template is 
based.  
 
Description - displays a short description of the report templates. 
 
Auto Print - displays a Yes or No indicator to flag whether the report template is set-
up for automatic printing. 
 
Auto Export - displays a Yes or No indicator to flag whether the report template is 
set-up for automatic export. 

 
The color of the Report Templates panel title bar corresponds to the color of the button 
selected for the reporting period in the Main Control Panel. The title bar of the Report 
Templates panel contains four buttons. These buttons provide the tools for creating new 
report templates, editing existing report templates, viewing the report for a report 
template, and immediately exporting a report for a report template. 
 

New - creates a new template for the reporting period selected in the Main Control 
Panel. 
 
Properties - displays the Properties window for the selected report template. 
 
View - generates a report based on the selected report template and displays the 
report in the Publication Viewer. 
 
Export - generates a report based on the selected report template in the format 
selected in the Export tab of the Properties window. 
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Using the Properties Window 

The Properties window defines the properties for the report templates. The 
window contains three tabs: General, Content and Export. The Properties 
window is launched when creating a new report template or when an existing 
report template is selected in the Report Templates panel and the Properties 
button is clicked. 
 
To open the Properties window for an existing report template, double-click the 
entry of the desired report template in the table of the Report Templates panel. 
 

General Tab 

The General tab of the Properties window displays the general properties 
available for the report templates. To create a report template a name and 
description must be assigned. 
 

 
 
This tab provides the interface for users to define the name and description of the 
report template as well as set-up the automatic printing and exporting of the 
report. 
 

Site - a non-editable field that displays the name of the site for the report 
template. 
 
Report Template - an editable field where the user inputs a name for the 
report template. The name is mandatory, and is displayed in the Name 
column of the table in the Report Templates panel. 
 
Report Description - an editable field where the user inputs a description for 
the report template. The description is displayed in the Description column of 
the table in the Report Templates panel.  
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Auto Print - enable this check box to flag the report for automatic printing. 
 
Auto Export - enable this check box to flag the report for automatic export. 
The report is exported in the format selected on the Export tab of the 
Properties window. 
 
Schedule Report Generator... - click this button to open the Schedule 
Report Generator dialog box. Use this dialog box to set the days of the week 
and time of day to automatically print and export reports. 
 
Time Period - the Time Period section of the General tab is only visible for 
Year by Week and Year by Month report templates. This section of the tab 
allows users to set a variable time period for the report. 
 

Content Tab 

The Content tab of the Properties window displays the resources and report 
options available for the report templates. 
 

 
 
This tab provides the interface for users to select the resource and report options 
for the report template. 
 

Resource - the Resource drop-down list provides a selection of resource 
types. Each resource type represents an element of the TASKE database. 
Selection of a resource type determines the resource content of the report.  
 
Report Options - the report options provide various intervals and criteria for 
reporting on the selected resource. The report options vary depending on the 
resource selected. Select the resource options globally using the Report 
Options buttons at the top of the Content tab, or individually for the members 
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of the resource group. To apply report options to individual members of a 
resource group, select a resource member in the table of the display area and 
enable the check boxes of the desired report options. 
 
Display Area - the display area of the Contents tab contains a table that lists 
all members of the selected resource type. The table has a column for the ID 
of the resource member, the name of the resource member, as well as a 
column for each of the report options. Report options that have been selected 
for any of the resource members in the current template appear with a red 
check mark.  
 

Export Tab 

The Export tab of the Properties window displays the available options for 
exporting a report. 
 

 
 
This tab provides the interface for users to select an export file format, time 
format, and location of the new file after the export. Use the check boxes to 
further define the format and location of the exported reports.  
 

Export Format - select the file format for the exported file. A report may be 
exported to one of several file formats. A file format must be chosen before 
the report can be exported. 
 
Time Format - select a time format  to determine how the data is displayed in 
the report. 
 
Export Path - set the Export Path to define the location of the exported report 
in the selected file format. Click the Browse button to search for a directory on 
the local PC or network, or enter the path of the export directory location 
directly in the Export Path field. 
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Use Account Code in Column Title -  use this check box to determine the 
format of the column titles in the Queue Activity report. When enabled, the 
Account Code ID is included in the column titles of the Queue Activity report.  
 
Export to separate date folder -  use this check box to determine how the 
files are exported to the desired location. If this check box is disabled, the files 
will be exported to the specified folder and will overwrite any existing files in 
that folder with the same names. Enabling this check box prompts the 
creation of a new folder within the folder specified in the Export Path field. 
The new folder is named in the format YYYYMMDD. If a folder with this name 
already exists, any data in the folder will be overwritten with the newly 
exported files.   

 

Defining Export Properties for Reports 

The Export tab of the Properties window displays the available options for 
exporting a report. 
 

 
 
This tab provides the interface for users to select an export file format, time 
format, and location of the new file after the export. Use the check boxes to 
further define the format and location of the exported reports.  
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Export Filenames - exported reports are named with very specific filenames 
to aid in the identification of the exported files. The files are named using the 
following conventions: 

 
Component Component Options Appearance in Filename 

Period Daily Pd 

  Weekly Pw 

  Monthly  Pm 

  Yearly Py 

Type Agent Ta 

  Extension Te 

  Group Tg 

  Queue Tq 

  Trunk Tt 

  Activity (Queue) Tact 

  Answer Spectrum Tansp 

  Abandon Spectrum Tabsp 

  Interflowed Spectrum Tfsp 

Interval 15 Minute I15 

  30 Minute I30 

  60 Minute I60 

  Day  Id 

  Week Iw 

  Month Im 

  Area Code Iar 

  DNIS Idn 

  Area Code and City Iac 

  State or Province Isp 

  Abandon Caller Iabn 

  Agent Ia 

  Account Code Iact 



TASKE Call Center Management Tools            

 
- 154 - 

Component Component Options Appearance in Filename 

 Interval Peak Offered Ipo 

  Peak Answered Ipan 

  Peak Abandoned Ipab 

  Peak Interflowed Ipf 

Element # The element number is the ID of the reporting element 
that is the focus of the report. A reporting element may 
be a trunk, trunk group, extension, extension group, 
agent, agent group, Queue, or Queue group.    

 
Using these naming conventions, a filename for an Agent Daily by Period 
report for agent 7500 with a 30-minute interval that is exported to Microsoft 
Excel would be: PdTaI307500.xls 

 
Export Format - select the file format for the exported file. A report may be 
exported to one of several file formats. A file format must be chosen before 
the report can be exported. 

 
The file formats available for export include: 

 
• Ascii 
• Clarion 
• Comma Separated Variable 
• dBase II 
• dBase III 
• dBase IV 
• HTML Table 
• Lotus 123 1A 
• Lotus 123 2.0 
• Lotus 123 3.0 
• Lotus 123 4.0 

• Microsoft Excel 2.1 
• Microsoft Excel 3.0 
• Microsoft Excel 4.0 
• Print Image 
• Quattro 
• Quattro Pro 
• Quattro Pro 5.0 for Windows 
• Symphony 1.0 
• Symphony 1.1 
• Tab Separated Variable 
• Word Processing Text 

 
Time Format - select a time format  to determine how the data is displayed in 
the report. 
 
Export Path - set the Export Path to define the location of the exported report 
in the selected file format. Click the Browse button to search for a directory on 
the local PC or network, or enter the path of the export directory location 
directly in the Export Path field. 
 



TASKE Call Center Management Tools            

 
- 155 - 

Use Account Code in Column Title -  use this check box to determine the 
format of the column titles in the Queue Activity report. When enabled, the 
Account Code ID is included in the column titles of the Queue Activity report.  
 
Export to separate date folder -  use this check box to determine how the 
files are exported to the desired location.  
 
If this check box is disabled, files are exported to the specified folder and 
overwrite any existing files in that folder with the same names.  
 
Enabling this check box prompts the creation of a new folder within the folder 
specified in the Export Path field. The new folder is named in the format 
YYYYMMDD. If a folder with this name already exists, any files in the folder 
with the same filenames are overwritten with the newly exported files.  
 
When exporting weekly or monthly files, the exported files are placed in the 
date folder for the first day of the month. All daily files for that day are also 
placed in that folder. When exporting YearbyWeek or YearbyMonth reports, 
the files are placed in the folder for the first day of the report.  

 

Using the Forecast Properties Window 

The Forecast Properties window defines the properties for the Forecast report 
templates. The window contains four tabs: General, Queues/Queue Groups, 
Forecast Parameters, and Selected Dates. The Forecast Properties window is 
launched when creating a new report template or when an existing report 
template is selected in the Report Templates panel and the Properties button is 
clicked. 
 
To open the Forecast Properties window for an existing report template, double-
click the entry of the desired report template in the table of the Report Templates 
panel. 
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General Tab 

The General tab of the Properties window displays the general properties 
available for the Forecast report templates. To create a Forecast report template 
assign a name and description to the report template.   
 

 
 
This tab provides the interface for users to define the name and description of the 
Forecast report template. 
 

Site - a non-editable field that displays the name of the site for the report 
template. 
 
Report Template - an editable field where the user inputs a name for the 
report template. The name is mandatory, and is displayed in the Name 
column of the table in the Report Templates panel. 
 
Report Description - an editable field where the user inputs a description for 
the report template. The description is displayed in the Description column of 
the table in the Report Templates panel.  
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Queues/Queue Groups Tab 

The Queues/Queue Groups tab of the Forecast Properties window displays the 
resources and report options available for the Forecast report templates. 
 

 
 
This tab provides the interface for users to define the content and reporting 
options of the report.  
 

Queue - click the Queue button to base the Forecast report template on 
Queues. Enable the reporting options for the desired Queues in the display 
area. When a reporting option is selected, a red check mark populates its cell 
for the Queue entry in the display area.  
 
Queue Group - click the Queue Group button to base the Forecast report 
template on Queue Groups. Enable the reporting options for the desired 
Queue Groups in the display area. When a reporting option is selected, a red 
check mark populates its cell for the Queue Group entry in the display area.  
 
Selection - a reporting option that marks the Queue or Queue Group for 
inclusion in the Forecast report. If the Selection option is not checked, the 
Queue/Queue Group will not be included in the report. 
 
Interflows - a reporting option that classifies interflowed calls as one call, 
rather than multiple calls for multiple Queues/Queue Groups. With this option 
unchecked, an interflowed call is counted as a new call each time it is 
transferred to another Queue/Queue Group. 
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Forecasting Parameters Tab 

The Forecasting Parameters tab of the Forecast Properties window displays the 
user-defined parameters for creating the Forecast.  
 

 
 
The Forecast Parameters tab provides the interface for users to accept the 
default Forecast parameters or to edit the parameters if these parameters do not 
fit the customer interaction center. 
 

Resolution - this is the interval used by the Forecast report when calculating 
and reporting the results for the numbers of calls, the number of Agents, and 
the average Talk Time. The Resolution options include quarter hour, half hour 
or one hour. The default resolution is Half Hour. 
 
Size - this selection determines whether the Forecast report will be run for 
one (or more) days or one (or more) weeks.  The Size options include one 
day and one week. The default size is One Day.  
 
From Time/To Time - set the beginning time for the daily reporting period in 
the From Time field and the end time for the daily reporting period in the To 
Time field. Both times must be input in HH:MM format using the 24-hour 
clock. The default for the From Time is 9:00. The default for the To Time is 
17:00. The Forecast report is divided into quarter hour, half hour or one hour 
intervals for each day. To avoid cluttering the reports with entries that fall 
outside of the regular business hours, use the From Time and To Time fields 
to set the daily time range to include in the Forecast report. 
 
TSF % - the Telephone Service Factor (TSF) percentage is used for Forecast 
report calculations. This value is the ratio of calls that are either Answered or 
Abandoned before a threshold time, divided by the total number of calls that 
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are offered. The default TSF percentage is 80%, but is adjustable in 1% 
increments from 1% to 100%. 

 
TSF Time (secs) - the TSF time defines the threshold time for the TSF 
percentage. The default TSF time is 20 seconds, but any value between 0 
and 100 is acceptable. 
 
Wrapup Time (secs) - the wrap-up time, also known as work time, is a factor 
that is added to call times for agents to complete paperwork after the callers 
disconnect. The default wrap-up time is 0 seconds, but any value between 0 
and 100 is acceptable. 
 

Selected Dates Tab 

The Selected Dates tab of the Forecast Properties window displays a calendar 
for selecting the days or weeks to use as the historical basis of the Forecast 
report. 
 

 
 

The interface of the Select Dates tab provides a calendar in the bottom portion of 
the tab and a display area in the top portion of the tab. As dates are selected in 
the calendar, they are displayed in the display area above. Users select days or 
weeks in the calendar. The selection from the Size drop-down list (days or 
weeks) in the Forecast Parameters tab determines whether days or weeks are 
selected in the calendar. 
 
Use the following steps to select dates from the calendar in the Select Dates tab. 
 

1. Use  and  to select the desired year. 
2. Use  and  to select the desired month. 
3. Click the desired date(s). This may be a span of days or weeks. 
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The selected calendar period is highlighted in blue. The dates selected in this tab 
act as the historical basis for the Forecast report template. The logged data that 
exists for these days should be similar to the period the user is attempting to 
forecast in order to achieve an accurate projection. 
 

Using the Publication Viewer 

The Publication Viewer occupies the lower, right quadrant of the Reports interface. This 
panel displays the reports generated for the report templates of Report Templates 
panel. The Publication Viewer displays the last report generated. This may not always 
correspond with the report template currently selected in the Report Templates Panel. 
The View button must be clicked on the Report Templates title bar for a report to be 
generated and displayed in the Publication Viewer. 
 

 
 

The color of the Publication Viewer title bar corresponds to the color of the button 
selected for the reporting period in the Main Control Panel. The title bar of the Report 
Templates panel contains three buttons and a page selection tool for maneuvering 
throughout the pages of the report. The buttons provide the tools for previewing the 
printed report, printing the report, and changing the font of the report. The page 
selection tool provides left and right arrow buttons for moving forward or backward 
throughout the pages of the report. In addition it tells the user the page number of the 
report that is currently displayed in the Publication Viewer and the total number of pages 
in the report. 
 

Print Preview - provides a preview of the printed report, if desired, print the report 
from this window. 
 
Print - opens the Print dialog box where users can select a printer, define the 
properties for printing the report, and print the report.  
 
Change Font - opens the Font dialog box where users can change the font type, 
style, and size. 
 
All fonts used by the Reports application are provided by the default printer for the 
computer. If a message appears that states no fonts are installed, this indicates that 
there is no default printer installed and one must be designated. 
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Page Counter - allows users to scroll through the pages of the generated report. 
 

Changing the Report Font 

The font of a report is changeable to accommodate user preferences. Use any of 
the installed default printer fonts and set the style and size as desired. When 
changing the font, it is important that this is a global change. All future reports will 
use the new font. 
 
Use the following steps to change the font of a report. 

 
1. Click Change Font... on the title bar of the Publication Viewer to open the 

Font dialog box. 
2. Select a font from the Font list. 
3. Select a font style from the Font style list. 
4. Select a font size from the Size list or input a value for the font size in the 

Size box. 
5. Click OK. 

 
The Sample section of the Font dialog box provides an illustration of the selected 
font variables.  

 

Manually Exporting a Report 

Use the following steps to export a report using an existing report template. 
 

1. Select the desired reporting period (Daily, Weekly, Monthly, Year by Week, Year 
by Month, or Forecast) from the Main Control Panel. 

2. Select a report template from the list of available templates. 
3. Click Properties on the title bar of the Main Control Panel to open the Properties 

window. 
4. Select the Export tab. 
5. Check the export settings (export file format, time format, and export path) and 

make any required changes to these settings.  
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The file formats available for export include: 
 

• Ascii 
• Clarion 
• Comma Separated Variable
• dBase II 
• dBase III 
• dBase IV 
• HTML Table 
• Lotus 123 1A 
• Lotus 123 2.0 
• Lotus 123 3.0 
• Lotus 123 4.0 

• Microsoft Excel 2.1 
• Microsoft Excel 3.0 
• Microsoft Excel 4.0 
• Print Image 
• Quattro 
• Quattro Pro 
• Quattro Pro 5.0 for Windows 
• Symphony 1.0 
• Symphony 1.1 
• Tab Separated Variable 
• Word Processing Text 

 
6. Click OK to accept the export settings and close the Properties window. 
7. Ensure the appropriate report template is selected in the Report 

Templates panel. 
8. Click Export on the Report Template panel title bar to open the Date 

Selection calendar.  
9. Use  and  to select the desired year. 
10. Use  and  to select the desired month. 
11. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected calendar 
period is highlighted in blue. 

12. Click OK to close the Date Selection calendar and export the report for the 
selected date. 

13. Locate the exported file in the directory specified in Export Path field of the 
Properties window and open the file using the appropriate software 
application.  

 
The export properties do not have to be reset every time the report is exported. 
These settings are saved with the Export Properties and only require changes as 
needed. 

 
 
 
 
 
 
 
 
 
 
 



TASKE Call Center Management Tools            

 
- 163 - 

Manually Printing a Report 

Preview and print reports manually using the Print Preview... and Print... buttons 
on the title bar of the Publication Viewer.  Each printed page of a report includes 
the date of the report, the report title, the page number, the site name, and the 
content of the report.  
 
Use the following steps to preview a report before printing. 

 
1. Click Print Preview... from the title bar of the Publication Viewer to open 

the preview window. 
2. Use the Next Page, Prev Page, One/Two Page, Zoom In, and Zoom Out 

buttons to view the report in the preview window. 
3. If desired, click Print to open the Print dialog box and print the search 

results. 
4. Click Close to exit the preview window. 

 
Use the following steps to print a report. 

 
1. Click Print... from the title bar of the Publication Viewer to open the Print 

dialog box. 
2. Select the printer, print range, and the number of copies. 
3. Click OK. 

 
Use the following steps to define the print setup. 

 
1. Select Print Setup from the File menu to open the Print Setup dialog box. 
2. Make the required changes to the printer, paper, and paper orientation. 
3. Click OK.  

 

Generating Reports 

A report template is a shell for a report. The template defines the resources, reporting 
options, and characteristics of the report but does not contain the report content. The 
report content is generated based on the data for the selected date(s) in the TASKE 
database. 
 
To view, export, or print a report, a report template must first be created for the report. 
Report templates are created for each of the reporting periods. To view a report 
template or to create a new report template for a reporting period, click the button for 
the desired reporting period on the Main Control Panel. This action displays the existing 
report templates in the Report Templates panel and provides the tools for creating a 
new report template in the title bar of the panel. 
 
Once a template is created, the report is viewable, exportable, and printable for any 
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date with pertinent data in the TASKE database. Create report templates for the Daily, 
Weekly, Monthly, Year by Week, Year by Month, and Forecast reporting periods.  
 
To change the name of a report template, right-click on the template listing in the Report 
Templates panel, and select Rename from the menu. 
 

Generating Reports from Existing Templates 

Use the following steps to generate a report using an existing report template. 
 

1. Select the desired reporting period (Daily, Weekly, Monthly, Year by 
Week, Year by Month, or Forecast) from the Main Control Panel. 

2. Select a report template from the list of available templates. 
3. Click View on the Report Templates panel title bar to open the Date 

Selection calendar.  
4. Use  and  to select the desired year. 
5. Use  and  to select the desired month. 
6. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected calendar 
period is highlighted in blue. 

7. Click OK to close the Date Selection calendar and generate the report for 
the selected date. 

8. The report opens in the Publication Viewer. If no data is available for the 
selected date, the TASKE Reports dialog box opens indicating that there 
is nothing to report on for the specified options.  

9. Scroll through the pages of the report using the page selector tools on the 
title bar of the Publication Viewer. 
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Creating Trunk Report Templates 

Generate Trunk reports for specific dates using a report template. The template 
draws data from the TASKE database that pertains to the selected Trunk(s) and 
organizes it into a tabular report. The template is based on a reporting period 
(Daily, Weekly, Monthly, Year by Week, or Year by Month) and reports on the 
Trunk(s) using the selected reporting options. 
 
Use the following steps to create a report template for a Trunk. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Trunk from the Resource drop-down list.  
c. Enable the Individual Trunks check box to report on individual 

trunks only. 
d. Select the Trunks to include in the report from the list of Trunks in 

the display area. To select a group of Trunks that are in order, 
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select the first Trunk and SHIFT+click the last Trunk in the list of 
those desired for selection. To select a group of Trunks that are not 
in order, select the first Trunk and CTRL+click each of the 
remaining Trunks desired for selection. 

e. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Trunks. The report options for Trunks vary 
according to the reporting period selected. The table below outlines 
the report options available for each reporting period. 
 
Trunk Reports 

Reporting Period Resource Report Options 

Daily Trunk Quarter hour, half hour, hour 

Weekly Trunk Quarter hour, half hour, hour, day of week 

Monthly Trunk Quarter hour, half hour, hour, day of month 

Year by Week Trunk Half hour, hour, day of week, week 

Year by Month Trunk Half hour, hour, day of month, month 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Trunk report template 

and close the Properties window. 
 

7. View the report. 
a. Select the new Trunk report template in the Report Templates 

panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 
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f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Extension Report Templates 

Generate Extension reports for specific dates using a report template. The 
template draws data from the TASKE database that pertains to the selected 
Extension(s) and organizes it into a tabular report. The template is based on a 
reporting period (Daily, Weekly, Monthly, Year by Week, or Year by Month) and 
reports on the Extension(s) using the selected reporting options. 
 
Use the following steps to create a report template for an Extension. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  
 
 



TASKE Call Center Management Tools            

 
- 168 - 

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Extension from the Resource drop-down list.  
c. Enable the Individual Extensions check box to report on individual 

Extensions only. 
d. Select the Extensions to include in the report from the list of 

Extensions in the display area. To select a group of Extensions that 
are in order, select the first Extension and SHIFT+click the last 
Extension in the list of those desired for selection. To select a group 
of Extensions that are not in order, select the first Extension and 
CTRL+click each of the remaining Extensions desired for selection. 

e. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Extensions. The report options for Extensions 
vary according to the reporting period selected. The table below 
outlines the report options available for each reporting period. 
 
Extension Reports 

Reporting Period Resource Report Options 

Daily Extension Quarter hour, half hour, hour 

Weekly Extension Quarter hour, half hour, hour, day of week 

Monthly Extension Quarter hour, half hour, hour, day of month 

Year by Week Extension Half hour, hour, day of week, week 

Year by Month Extension Half hour, hour, day of month, month 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Extension report 

template and close the Properties window. 
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7. View the report. 
a. Select the new Extension report template in the Report Templates 

panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Extension Group Report Templates 

Generate Extension Group reports for specific dates using a report template. The 
template draws data from the TASKE database that pertains to the selected 
Extension Group(s) and organizes it into a tabular report. The template is based 
on a reporting period (Daily, Weekly, Monthly, Year by Week, or Year by Month) 
and reports on the Extension Group(s) using the selected reporting options. 
 
Use the following steps to create a report template for an Extension Group. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
Create a new template. 

b. Click New in the Report Templates panel to open the Properties 
window. 
 

2. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  
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d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

3. Define the Content properties. 
a. Select the Content tab. 
b. Select Extension Group from the Resource drop-down list.  
c. Select the Extension Groups to include in the report from the list of 

Extension Groups in the display area. To select a group of 
Extension Groups that are in order, select the first Extension Group 
and SHIFT+click the last Extension Group in the list of those 
desired for selection. To select a group of Extension Groups that 
are not in order, select the first Extension Group and CTRL+click 
each of the remaining Extension Groups desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Extension Groups. The report options for 
Extension Groups vary according to the reporting period selected. 
The table below outlines the report options available for each 
reporting period. 
 
Extension Group Reports 

Reporting Period Resource Report Options 

Daily Extension Group By Extension 

Weekly Extension Group By Extension 

Monthly Extension Group By Extension 

Year by Week Extension Group By Extension 

Year by Month Extension Group By Extension 

 
4. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
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c. Select a time format for the exported report from the Time Format 
list of radio buttons. 

d. Define the location of the exported file in the Export Path field. Click 
the Browse button to browse the local PC or the network for a file 
location. 
 

5. Accept the properties. 
a. Click OK to save the properties of the new Extension Group report 

template and close the Properties window. 
 

6. View the report. 
a. Select the new Extension Group report template in the Report 

Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 
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Creating Agent Report Templates 

Generate Agent reports for specific dates using a report template. The template 
draws data from the TASKE database that pertains to the selected Agent(s) and 
organizes it into a tabular report. The template is based on a reporting period 
(Daily, Weekly, Monthly, Year by Week, or Year by Month) and reports on the 
Agent(s) using the selected reporting options. 
 
Use the following steps to create a report template for an Agent. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
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4. Define the Content properties. 
a. Select the Content tab. 
b. Select Agent from the Resource drop-down list.  
c. Select the Agents to include in the report from the list of Agents in 

the display area. To select a group of Agents that are in order, 
select the first Agent and SHIFT+click the last Agent in the list of 
those desired for selection. To select a group of Agents that are not 
in order, select the first Agent and CTRL+click each of the 
remaining Agents desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Agents. The report options for Agents vary 
according to the reporting period selected. The table below outlines 
the report options available for each reporting period. 
 
Agent Reports 

Reporting Period Resource Report Options 

Daily Agent Quarter hour, half hour, hour, agent group, 
Queue 

Weekly Agent Quarter hour, half hour, hour, day of week, 
agent group, Queue 

Monthly Agent Quarter hour, half hour, hour, day of month, 
agent group, Queue 

Year by Week Agent Half hour, hour, day of week, week, agent 
group, Queue 

Year by Month Agent Half hour, hour, day of month, month, 
agent group, Queue 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Agent report template 

and close the Properties window. 
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7. View the report. 
a. Select the new Agent report template in the Report Templates 

panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Agent Group Report Templates 

Generate Agent Group reports for specific dates using a report template. The 
template draws data from the TASKE database that pertains to the selected 
Agent Group(s) and organizes it into a tabular report. The template is based on a 
reporting period (Daily, Weekly, Monthly, Year by Week, or Year by Month) and 
reports on the Agent Group(s) using the selected reporting options. 
 
Use the following steps to create a report template for an Agent Group. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  
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d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Agent Group from the Resource drop-down list.  
c. Select the Agent Groups to include in the report from the list of 

Agent Groups in the display area. To select a group of Agent 
Groups that are in order, select the first Agent Group and 
SHIFT+click the last Agent Group in the list of those desired for 
selection. To select a group of Agent Groups that are not in order, 
select the first Agent Group and CTRL+click each of the remaining 
Agent Groups desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Agent Groups. The report options for Agent 
Groups vary according to the reporting period selected. The table 
below outlines the report options available for each reporting 
period. 
 
Agent Group Reports 

Reporting Period Resource Report Options 

Daily Agent Group Quarter hour, half hour, hour, agent, 
Queue 

Weekly Agent Group Quarter hour, half hour, hour, day of 
week, agent, Queue 

Monthly Agent Group Quarter hour, half hour, hour, day of 
month, agent, Queue 

Year by Week Agent Group Half hour, hour, day of week, week, 
agent, Queue 

Year by Month Agent Group Half hour, hour, day of month, month, 
agent, Queue 
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5. Define the Export Properties. 
a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Agent Group report 

template and close the Properties window. 
 

7. View the report. 
a. Select the new Agent Group report template in the Report 

Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 
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Creating Queue Report Templates 

Generate Queue reports for specific dates using a report template. The template 
draws data from the TASKE database that pertains to the selected Queue(s) and 
organizes it into a tabular report. The template is based on a reporting period 
(Daily, Weekly, Monthly, Year by Week, or Year by Month) and reports on the 
Queue(s) using the selected reporting options. 
 
Use the following steps to create a report template for a Queue. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
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4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue from the Resource drop-down list.  
c. Select the Queues to include in the report from the list of Queues in 

the display area. To select a group of Queues that are in order, 
select the first Queue and SHIFT+click the last Queue in the list of 
those desired for selection. To select a group of Queues that are 
not in order, select the first Queue and CTRL+click each of the 
remaining Queues desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queues. The report options for Queues vary 
according to the reporting period selected. The table below outlines 
the report options available for each reporting period. 
 
Queue Reports 

Reporting Period Resource Report Options 

Daily Queue Quarter hour, half hour, hour, DNIS, area 
code, area code & city, state 

Weekly Queue Quarter hour, half hour, hour, day of week, 
DNIS, area code, area code & city, state 

Monthly Queue Quarter hour, half hour, hour, day of month, 
DNIS, area code, area code & city, state 

Year by Week Queue Half hour, hour, day of week, week, DNIS, 
area code, area code & city, state 

Year by Month Queue Half hour, hour, day of month, month, DNIS, 
area code, area code & city, state 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue report template 

and close the Properties window. 
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7. View the report. 
a. Select the new Queue report template in the Report Templates 

panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Queue Answer Spectrum Report Templates 

Generate Queue Answer Spectrum reports for specific dates using a report 
template. A Queue Answer Spectrum report indicates how many calls were 
answered in a specified time period by a specific Queue. The template draws 
data from the TASKE database that pertains to the selected Queue(s) and 
organizes it into a tabular report. The template is based on a reporting period 
(Daily, Weekly, Monthly, Year by Week, or Year by Month) and reports on the 
Queue(s) using the selected reporting options. 
 
Use the following steps to create a report template for a Queue Answer 
Spectrum. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
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3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Answer Spectrum from the Resource drop-down list.  
c. Select the Queues to include in the report from the list of Queues in 

the display area. To select a group of Queues that are in order, 
select the first Queue and SHIFT+click the last Queue in the list of 
those desired for selection. To select a group of Queues that are 
not in order, select the first Queue and CTRL+click each of the 
remaining Queues desired for selection. 
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d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queues. The report options for Queue 
Answer Spectrums vary according to the reporting period selected. 
The table below outlines the report options available for each 
reporting period. 
 
Queue Answer Spectrum Reports 

Reporting Period Resource Report Options 

Daily Queue Answer 
Spectrum 

Quarter hour, half hour, hour 

Weekly Queue Answer 
Spectrum 

Quarter hour, half hour, hour, day of 
week 

Monthly Queue Answer 
Spectrum 

Quarter hour, half hour, hour, day of 
month 

Year by Week Queue Answer 
Spectrum 

Half hour, hour, day of week, week 

Year by Month Queue Answer 
Spectrum 

Half hour, hour, day of month, month 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Answer 

Spectrum report template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Answer Spectrum report template in the 

Report Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
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e. Click the desired date (may be a span of one day, one week, or one 
month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Queue Abandon Spectrum Report Templates 

Generate Queue Abandon Spectrum reports for specific dates using a report 
template. A Queue Abandon Spectrum report indicates how many calls were 
abandoned in a specified time period by a specific Queue. The template draws 
data from the TASKE database that pertains to the selected Queue(s) and 
organizes it into a tabular report. The template is based on a reporting period 
(Daily, Weekly, Monthly, Year by Week, or Year by Month) and reports on the 
Queue(s) using the selected reporting options. 
 
Use the following steps to create a report template for a Queue Abandon 
Spectrum. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field. A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  
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e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Abandon Spectrum from the Resource drop-down 

list.  
c. Select the Queues to include in the report from the list of Queues in 

the display area. To select a group of Queues that are in order, 
select the first Queue and SHIFT+click the last Queue in the list of 
those desired for selection. To select a group of Queues that are 
not in order, select the first Queue and CTRL+click each of the 
remaining Queues desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queues. The report options for Queue 
Abandon Spectrums vary according to the reporting period 
selected. The table below outlines the report options available for 
each reporting period. 
 
Queue Abandon Spectrum Reports 

Reporting Period Resource Report Options 

Daily Queue Abandon 
Spectrum 

Quarter hour, half hour, hour 

Weekly Queue Abandon 
Spectrum 

Quarter hour, half hour, hour, day of 
week 

Monthly Queue Abandon 
Spectrum 

Quarter hour, half hour, hour, day of 
month 

Year by Week Queue Abandon 
Spectrum 

Half hour, hour, day of week, week 

Year by Month Queue Abandon 
Spectrum 

Half hour, hour, day of month, month 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
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c. Select a time format for the exported report from the Time Format 
list of radio buttons. 

d. Define the location of the exported file in the Export Path field. Click 
the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Abandon 

Spectrum report template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Abandon Spectrum report template in the 

Report Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Queue Interflow Spectrum Report Templates 

Generate Queue Interflow Spectrum reports for specific dates using a report 
template. A Queue Interflow Spectrum report indicates how many calls were 
interflowed in a specified time period by a specific Queue. The template draws 
data from the TASKE database that pertains to the selected Queue(s) and 
organizes it into a tabular report. The template is based on a reporting period 
(Daily, Weekly, Monthly, Year by Week, or Year by Month) and reports on the 
Queue(s) using the selected reporting options. 
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Use the following steps to create a report template for a Queue Interflow 
Spectrum. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field. A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Interflow Spectrum from the Resource drop-down list.  
c. Select the Queues to include in the report from the list of Queues in 

the display area. To select a group of Queues that are in order, 
select the first Queue and SHIFT+click the last Queue in the list of 
those desired for selection. To select a group of Queues that are 
not in order, select the first Queue and CTRL+click each of the 
remaining Queues desired for selection. 
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d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queues. The report options for Queue 
Interflow Spectrums vary according to the reporting period selected. 
The table below outlines the report options available for each 
reporting period. 
 
Queue Interflow Spectrum Reports 

Reporting Period Resource Report Options 

Daily Queue Interflow 
Spectrum 

Quarter hour, half hour, hour 

Weekly Queue Interflow 
Spectrum 

Quarter hour, half hour, hour, day of 
week 

Monthly Queue Interflow 
Spectrum 

Quarter hour, half hour, hour, day of 
month 

Year by Week Queue Interflow 
Spectrum 

Half hour, hour, day of week, week 

Year by Month Queue Interflow 
Spectrum 

Half hour, hour, day of month, month 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Interflow 

Spectrum report template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Interflow Spectrum report template in the 

Report Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 
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f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Queue Activity Report Templates 

Generate Queue Activity reports for specific dates using a report template. A 
Queue Activity report provides a detailed analysis of the types of calls received 
and handled by referencing Account Codes entered in the TASKE database. 
Queue Activity reports indicate the number of received call records for each 
Account Code, by Queue.  The template draws data from the TASKE database 
that pertains to the selected Queue(s) and organizes it into a tabular report. The 
template is based on a reporting period (Daily, Weekly, Monthly, Year by Week, 
or Year by Month) and reports on the Queue(s) using the selected reporting 
options. 
 
Use the following steps to create a report template for Queue Activity. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field. A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  
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e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Activity from the Resource drop-down list.  
c. Select the Queues to include in the report from the list of Queues in 

the display area. To select a group of Queues that are in order, 
select the first Queue and SHIFT+click the last Queue in the list of 
those desired for selection. To select a group of Queues that are 
not in order, select the first Queue and CTRL+click each of the 
remaining Queues desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queues. The report options for Queue Activity 
vary according to the reporting period selected. The table below 
outlines the report options available for each reporting period. 
 
Queue Activity Reports 

Reporting Period Resource Report Options 

Daily Queue Activity Quarter hour, half hour, hour, pairs of 
account codes 

Weekly Queue Activity Quarter hour, half hour, hour, day of 
week, pairs of account codes 

Monthly Queue Activity Quarter hour, half hour, hour, day of 
month, pairs of account codes 

Year by Week Queue Activity Half hour, hour, day of week, week, 
pairs of account codes 

Year by Month Queue Activity Half hour, hour, day of month, month, 
pairs of account codes 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
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d. Define the location of the exported file in the Export Path field. Click 
the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Activity report 

template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Activity report template in the Report 

Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 
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Creating Queue Peaks Report Templates 

Generate Queue Peaks reports for specific dates using a report template. These 
reports provide a detailed analysis of call traffic by identifying the peak intervals 
for calls that were received in a specified time period by a specific Queue. The 
template draws data from the TASKE database that pertains to the selected 
Queue(s) and organizes it into a tabular report. The template is based on the 
Monthly reporting period only and reports on the Queue(s) using the selected 
reporting options. 
 
Use the following steps to create a report template for Queue Peaks. 
 

1. Select the reporting period. 
a. Click the Monthly button on the Main Control Panel. 

 
2. Create a new template. 

a. Click New in the Report Templates panel to open the Properties 
window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field. A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Peaks from the Resource drop-down list.  
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c. Select the Queues to include in the report from the list of Queues in 
the display area. To select a group of Queues that are in order, 
select the first Queue and SHIFT+click the last Queue in the list of 
those desired for selection. To select a group of Queues that are 
not in order, select the first Queue and CTRL+click each of the 
remaining Queues desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queues. The report options for Queue Peaks 
vary according to the reporting period selected. The table below 
outlines the report options available for each reporting period. 
 
Queue Peaks Reports 

Reporting Period Resource Report Options 

Monthly Queue 
Peaks 

Peak Offered - analyzes data for the report, 
identifying the interval of the month 
producing the highest number of calls (i.e. 
the Busy Hour). 
Peak Answered - analyzes data for the 
report, identifying the interval of the month 
producing the highest number of answered 
calls. This information is used to identify 
intervals when the highest level of Agent 
staffing is required. 
Peak Abandoned - analyzes data for the 
report, identifying the interval of the month 
producing the highest number of abandoned 
calls and the number of calls for the interval. 
This information is used to identify intervals 
during the business day or work shift that 
are under-staffed. 
Peak Interflowed - analyzes data for the 
report, identifying the interval of the month 
producing the highest number of interflowed 
calls. 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
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6. Accept the properties. 
a. Click OK to save the properties of the new Queue Peaks report 

template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Peaks report template in the Report 

Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Queue Group Report Templates 

Generate Queue Group reports for specific dates using a report template. The 
report provides a detailed analysis of the calls received and entered in the 
TASKE database by indicating how many calls were handled in a specified time 
period by a specific Queue Group. The template draws data from the TASKE 
database that pertains to the selected Queue Group(s) and organizes it into a 
tabular report. The template is based on a reporting period (Daily, Weekly, 
Monthly, Year by Week, or Year by Month) and reports on the Queue Group(s) 
using the selected reporting options. 
 
Use the following steps to create a report template for a Queue Group. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
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3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Group from the Resource drop-down list.  
c. Select the Queue Groups to include in the report from the list of 

Queue Groups in the display area. To select a group of Queue 
Groups that are in order, select the first Queue Group and 
SHIFT+click the last Queue Group in the list of those desired for 
selection. To select a group of Queue Groups that are not in order, 
select the first Queue Group and CTRL+click each of the remaining 
Queue Groups desired for selection. 
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d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queue Groups. The report options for Queue 
Groups vary according to the reporting period selected. The table 
below outlines the report options available for each reporting 
period. 
 
Queue Group Reports 

Reporting Period Resource Report Options 

Daily Queue 
Group 

Quarter hour, half hour, hour, Queue, DNIS, 
area code, area code & city, state 

Weekly Queue 
Group 

Quarter hour, half hour, hour, day of week, 
Queue, DNIS, area code, area code & city, 
state 

Monthly Queue 
Group 

Quarter hour, half hour, hour, day of month, 
Queue, DNIS, area code, area code & city, 
state 

Year by Week Queue 
Group 

Half hour, hour, day of week, week, Queue, 
DNIS, area code, area code & city, state 

Year by Month Queue 
Group 

Half hour, hour, day of month, month, 
Queue, DNIS, area code, area code & city, 
state 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Group report 

template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Group report template in the Report 

Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
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d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Queue Group Answer Spectrum Report Templates 

Generate Queue Group Answer Spectrum reports for specific dates using a 
report template. A Queue Group Answer Spectrum report indicates how many 
calls were Answered in a specified time period by a specific Queue Group. The 
template draws data from the TASKE database that pertains to the selected 
Queue Group(s) and organizes it into a tabular report. The template is based on 
a reporting period (Daily, Weekly, Monthly, Year by Week, or Year by Month) and 
reports on the Queue Group(s) using the selected reporting options. 
 
Use the following steps to create a report template for a Queue Group Answer 
Spectrum. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field. A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  
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e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Group Answer Spectrum from the Resource drop-

down list.  
c. Select the Queue Groups to include in the report from the list of 

Queue Groups in the display area. To select a group of Queue 
Groups that are in order, select the first Queue Group and 
SHIFT+click the last Queue Group in the list of those desired for 
selection. To select a group of Queue Groups that are not in order, 
select the first Queue Group and CTRL+click each of the remaining 
Queue Groups desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queue Groups. The report options for Queue 
Group Answer Spectrums vary according to the reporting period 
selected. The table below outlines the report options available for 
each reporting period. 
 
Queue Group Answer Spectrum Reports 

Reporting Period Resource Report Options 

Daily Queue Group Answer 
Spectrum 

Quarter hour, half hour, hour, 
Queue 

Weekly Queue Group Answer 
Spectrum 

Quarter hour, half hour, hour, day 
of week, Queue 

Monthly Queue Group Answer 
Spectrum 

Quarter hour, half hour, hour, day 
of month, Queue 

Year by Week Queue Group Answer 
Spectrum 

Half hour, hour, day of week, 
week, Queue 

Year by Month Queue Group Answer 
Spectrum 

Half hour, hour, day of month, 
month, Queue 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
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c. Select a time format for the exported report from the Time Format 
list of radio buttons. 

d. Define the location of the exported file in the Export Path field. Click 
the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Group Answer 

Spectrum report template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Group Answer Spectrum report template in 

the Report Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Queue Group Abandon Spectrum Report Templates 

Generate Queue Group Abandon Spectrum reports for specific dates using a 
report template. A Queue Group Abandon Spectrum report indicates how many 
calls were abandoned in a specified time period by a specific Queue Group. The 
template draws data from the TASKE database that pertains to the selected 
Queue Group(s) and organizes it into a tabular report. The template is based on 
a reporting period (Daily, Weekly, Monthly, Year by Week, or Year by Month) and 
reports on the Queue Group(s) using the selected reporting options. 
 
Use the following steps to create a report template for a Queue Group Abandon 
Spectrum. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
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2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field. A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Group Abandon Spectrum from the Resource drop-

down list.  
c. Select the Queue Groups to include in the report from the list of 

Queue Groups in the display area. To select a group of Queue 
Groups that are in order, select the first Queue Group and 
SHIFT+click the last Queue Group in the list of those desired for 
selection. To select a group of Queue Groups that are not in order, 
select the first Queue Group and CTRL+click each of the remaining 
Queue Groups desired for selection. 
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d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queue Groups. The report options for Queue 
Group Abandon Spectrums vary according to the reporting period 
selected. The table below outlines the report options available for 
each reporting period. 
 
Queue Group Abandon Spectrum Reports 

Reporting Period Resource Report Options 

Daily Queue Group 
Abandon Spectrum 

Quarter hour, half hour, hour, 
Queue 

Weekly Queue Group 
Abandon Spectrum 

Quarter hour, half hour, hour, day 
of week, Queue 

Monthly Queue Group 
Abandon Spectrum 

Quarter hour, half hour, hour, day 
of month, Queue 

Year by Week Queue Group 
Abandon Spectrum 

Half hour, hour, day of week, week, 
Queue 

Year by Month Queue Group 
Abandon Spectrum 

Half hour, hour, day of month, 
month, Queue 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Group Abandon 

Spectrum report template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Group Abandon Spectrum report template in 

the Report Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
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e. Click the desired date (may be a span of one day, one week, or one 
month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 
 

Creating Queue Group Interflow Spectrum Report Templates 

Generate Queue Group Interflow Spectrum reports for specific dates using a 
report template. A Queue Group Interflow Spectrum report indicates how many 
calls were Interflowed in a specified time period by a specific Queue Group. The 
template draws data from the TASKE database that pertains to the selected 
Queue Group(s) and organizes it into a tabular report. The template is based on 
a reporting period (Daily, Weekly, Monthly, Year by Week, or Year by Month) and 
reports on the Queue Group(s) using the selected reporting options. 
 
Use the following steps to create a report template for a Queue Group Interflow 
Spectrum. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field. A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  
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e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Group Interflow Spectrum from the Resource drop-

down list.  
c. Select the Queue Groups to include in the report from the list of 

Queue Groups in the display area. To select a group of Queue 
Groups that are in order, select the first Queue Group and 
SHIFT+click the last Queue Group in the list of those desired for 
selection. To select a group of Queue Groups that are not in order, 
select the first Queue Group and CTRL+click each of the remaining 
Queue Groups desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queue Groups. The report options for Queue 
Group Interflow Spectrums vary according to the reporting period 
selected. The table below outlines the report options available for 
each reporting period. 
 
Queue Group Reports 

Reporting Period Resource Report Options 

Daily Queue Group 
Interflow Spectrum 

Quarter hour, half hour, hour, 
Queue 

Weekly Queue Group 
Interflow Spectrum 

Quarter hour, half hour, hour, day of 
week, Queue 

Monthly Queue Group 
Interflow Spectrum 

Quarter hour, half hour, hour, day of 
month, Queue 

Year by Week Queue Group 
Interflow Spectrum 

Half hour, hour, day of week, week, 
Queue 

Year by Month Queue Group 
Interflow Spectrum 

Half hour, hour, day of month, 
month, Queue 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
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c. Select a time format for the exported report from the Time Format 
list of radio buttons. 

d. Define the location of the exported file in the Export Path field. Click 
the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Group Interflow 

Spectrum report template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Group Interflow Spectrum report template in 

the Report Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 
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Creating Queue Group Activity Report Templates 

Generate Queue Group Activity reports for specific dates using a report template. 
A Queue Group Activity report provides a detailed analysis of the types of calls 
received and handled by referencing Account Codes entered in the TASKE 
database. Queue Group Activity reports indicate the number of received call 
records for each Account Code, by Queue Group.  The template draws data from 
the TASKE database that pertains to the selected Queue(s) and organizes it into 
a tabular report. The template is based on a reporting period (Daily, Weekly, 
Monthly, Year by Week, or Year by Month) and reports on the Queue(s) using 
the selected reporting options. 
 
Use the following steps to create a report template for Queue Group Activity. 
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Properties 

window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field. A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Group Activity from the Resource drop-down list.  
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c. Select the Queues to include in the report from the list of Queues in 
the display area. To select a group of Queues that are in order, 
select the first Queue and SHIFT+click the last Queue in the list of 
those desired for selection. To select a group of Queues that are 
not in order, select the first Queue and CTRL+click each of the 
remaining Queues desired for selection. 

d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queues. The report options for Queue Group 
Activity vary according to the reporting period selected. The table 
below outlines the report options available for each reporting 
period. 
 
Queue Group Activity Reports 

Reporting Period Resource Report Options 

Daily Queue Group 
Activity 

Quarter hour, half hour, hour, Queue, 
pairs of account codes 

Weekly Queue Group 
Activity 

Quarter hour, half hour, hour, day of 
week, Queue, pairs of account codes 

Monthly Queue Group 
Activity 

Quarter hour, half hour, hour, day of 
month, Queue, pairs of account codes 

Year by Week Queue Group 
Activity 

Half hour, hour, day of week, Queue, 
pairs of account codes 

Year by Month Queue Group 
Activity 

Half hour, hour, day of month, month, 
Queue, pairs of account codes 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format list 

of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Group Activity report 

template and close the Properties window. 
 

7. View the report. 
a. Select the new Queue Group Activity report template in the Report 

Templates panel. 
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b. Click View on the Report Templates panel title bar to open the Date 
Selection Calendar. 

c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the report 
for the selected date. 

g. The report opens in the Publication Viewer. If no data is available for 
the selected date, the TASKE Reports dialog box opens indicating that 
there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools on 
the title bar of the Publication Viewer. 

 

Creating Queue Group Peaks Report Templates 

Generate Queue Group Peaks reports for specific dates using a report template. 
These reports provide a detailed analysis of call traffic by identifying the peak 
intervals for calls that were received in a specified time period by a specific 
Queue Group. The template draws data from the TASKE database that pertains 
to the selected Queue Group(s) and organizes it into a tabular report. The 
template is based on the Monthly reporting period only and reports on the Queue 
Group(s) using the selected reporting options. 
 
Use the following steps to create a report template for Queue Group Peaks. 
 

1. Select the reporting period. 
a. Click the Monthly button on the Main Control Panel. 

 
2. Create a new template. 

a. Click New in the Report Templates panel to open the Properties 
window. 
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3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Report Templates field. A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
characters and spaces.  

d. Enable the Auto Print check box to have the report print 
automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select Queue Group Peaks from the Resource drop-down list.  
c. Select the Queues to include in the report from the list of Queues in 

the display area. To select a group of Queues that are in order, 
select the first Queue and SHIFT+click the last Queue in the list of 
those desired for selection. To select a group of Queues that are 
not in order, select the first Queue and CTRL+click each of the 
remaining Queues desired for selection. 
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d. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected Queues. The report options for Queue Group 
Peaks vary according to the reporting period selected. The table 
below outlines the report options available for each reporting 
period. 
 
Queue Group Peaks Reports 

Reporting Period Resource Report Options 

Monthly Queue 
Group 
Peaks 

Peak Offered - analyzes data for the report, 
identifying the interval of the month 
producing the highest number of calls (i.e. 
the Busy Hour). 
Peak Answered - analyzes data for the 
report, identifying the interval of the month 
producing the highest number of answered 
calls. This information is used to identify 
intervals when the highest level of Agent 
staffing is required. 
Peak Abandoned - analyzes data for the 
report, identifying the interval of the month 
producing the highest number of abandoned 
calls and the number of calls for the interval. 
This information is used to identify intervals 
during the business day or work shift that 
are under-staffed. 
Peak Interflowed - analyzes data for the 
report, identifying the interval of the month 
producing the highest number of interflowed 
calls. 

 
5. Define the Export Properties. 

a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new Queue Group Peaks 

report template and close the Properties window. 
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7. View the report. 
a. Select the new Queue Group Peaks report template in the Report 

Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Creating Forecast Report Templates 

Generate Forecast reports for specific dates using a report template. The 
template draws data from the TASKE database and organizes it into a tabular 
report. The process of estimating projected traffic levels, or call loads on a Queue 
is termed Forecasting. Forecast data is used to estimate the number of Agents 
and other resources needed to meet the expected call load and to schedule 
shifts. 
 
The Forecast report template defines the reporting resource (Queues or Queue 
Groups), the forecasting parameters, (resolution, size, time range, TSF %, TSF 
time, and wrap-up time) and the specific date(s) to include in the report. 
 
Use the following steps to create a report template for a Forecast. 
 

1. Select the reporting period. 
a. Click the Forecast button on the Main Control Panel. 

 
2. Create a new template. 

a. Click New in the Report Templates panel to open the Properties 
window. 
 

3. Define the General properties. 
a. Select the General tab. 
b. Input a name for the template in the Forecast Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  
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c. If desired, input a description for the template in the Forecast 
Description field. The description can contain any combination of 
characters and spaces.  
 

4. Define the content of the Forecast report template. 
a. Select the Queue/Queue Groups tab. 
b. Click the Queue button to base the Forecast report template on 

Queues, or click the Queue Groups button to base the Forecast 
report template on Queue Groups. The depressed button indicates 
the selection.  

c. Select the Queues or Queue Groups to include in the Forecast from 
the list in the display area. To select a group of Queues or Queue 
Groups that are in order, select the first Queue/Queue Group and 
SHIFT+click the last Queue/Queue Group in the list of those 
desired for selection. To select a group of Queues/Queue Groups 
that are not in order, select the first Queue/Queue Group and 
CTRL+click each of the remaining Queues/Queue Groups desired 
for selection.  

d. Enable the desired report options for the selected Queues/Queue 
Groups in the appropriate columns of the display area. There are 
two report options: Selection and Interflows. When a report option 
is selected for a Queue or Queue Group, its column in the display 
area is populated with a red check mark. Selection - marks the 
Queue or Queue Group for inclusion in the Forecast report. If the 
Selection option is not checked, the Queue/Queue Group will not 
be included in the report. Interflows - classifies interflowed calls as 
one call, rather than multiple calls for multiple Queues/Queue 
Groups. With this option unchecked, an interflowed call is counted 
as a new call each time it is transferred to another Queue/Queue 
Group. 
 

5. Define the Forecasting Parameters. 
a. Select the Forecasting Parameters tab. 
b. Select the report resolution from the Resolution drop-down list. The 

Resolution options include quarter hour, half hour or one hour. This 
is the interval used by the Forecast report when calculating and 
reporting the results for the numbers of calls, the number of Agents, 
and the average Talk Time. The default resolution is Half Hour. 

c. Select the size of the reporting period from the Size drop-down list. 
The Size options include one day and one week.  This selection 
determines whether the Forecast report will be run for one (or 
more) days or one (or more) weeks. The default size is One Day. 

d. Set the beginning time for the daily reporting period in the From 
Time field and the end time for the daily reporting period in the To 
Time field. Both times must be input in HH:MM format using the 24-
hour clock. The default for the From Time is 9:00. The default for 
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the To Time is 17:00. The Forecast report is divided into quarter 
hour, half hour or one hour intervals for each day. To avoid 
cluttering the reports with entries that fall outside of the regular 
business hours, use the From Time and To Time fields to set the 
daily time range to include in the Forecast report. 

e. Set the Telephone Service Factor (TSF) percentage in the TSF % 
field. The TSF (%) is used for Forecast report calculations. This 
value is the ratio of calls that are either Answered or Abandoned 
before a threshold time, divided by the total number of calls that are 
offered. The default TSF percentage is 80%, but is adjustable in 1% 
increments from 1% to 100%.  

f. Set the number of seconds for the TSF time in the TSF Time (secs) 
field. The TSF time defines the threshold time for the TSF 
percentage. The default TSF time is 20 seconds, but any value 
between 0 and 100 is acceptable. 

g. Set the number of seconds to use for the wrap-up time in the 
Wrapup Time (secs) field. The wrap-up time, also known as work 
time, is a factor that is added to call times for agents to complete 
paperwork after the callers disconnect. The default wrap-up time is 
0 seconds, but any value between 0 and 100 is acceptable. 
 

6. Select the dates to use as a forecasting base. 
a. Select the Select Dates tab. The date(s) selected in this tab are 

used as the historical base of the Forecast report. 
b. Use  and  to select the desired year. 
c. Use  and  to select the desired month. 
d. Select the desired date(s). This may be a span of one day or more 

days or one or more weeks, depending on the Size value selected 
in the Forecasting Parameters tab. The selected calendar period is 
highlighted in blue. 

 
7. Accept the properties. 

a. Click OK to save the properties of the new Forecast report template 
and close the Properties window. 

8. View the report. 
a. Select the new Forecast report template in the Report Templates 

panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. The report opens in the Publication Viewer. If no data is available 

for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

d. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 
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Printing and Exporting Reports Automatically 

Schedule reports to automatically print and export during the slow or non-working hours 
of a customer interaction center. The advantages of scheduling the automatic printing 
and exporting of reports include the use of printer and network resources during non-
demanding hours and the availability of reports to supervisors and managers when the 
customer interaction center day begins. 
 
Schedule reports to automatically print and export for all reporting periods except 
Forecast. The schedule is defined in the Schedule Report Generator dialog box. This 
dialog box is accessible from the General tab of any report template, except for 
Forecast report templates, or by selecting Schedule Report Generator... from the File 
menu.  
 

 
 
Schedule the task to run daily or for any combination of the days of the week. Select 
any half-hour interval between 4:00 AM and 6:30 AM to begin the scheduled task of 
automatically printing and exporting the reports. When the time comes to run the 
scheduled task, the network user information defined in the Schedule Report Generator 
dialog box allows the PC to log itself into the network and perform the report printing 
and exporting. The schedule applies to all reports defined for automatic printing and 
exporting. Changing a schedule that has already been defined changes the schedule for 
all reports enabled for automatic printing and exporting.  
 

Scheduling Reports to Print and Export Automatically 

Use the Schedule Report Generator dialog box to schedule Daily, Weekly, 
Monthly, Year by Week, and Year by Month reports to automatically print and/or 
export at specified dates and times. For a report to automatically print according 
to the schedule, the Auto Print check box must be enabled on the General tab of 
the Properties window for the report template. For a report to automatically 
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export according to the schedule, the Auto Export check box must be enabled on 
the General tab of the Properties window. 
 
Microsoft Windows limits TASKE Reports to a single Schedule Report Generator. 
Because of this it may be wise to schedule only daily reports for automatic 
printing and exporting. In a call center it may be necessary to print and export 
daily reports Monday through Friday and a weekly report on a Saturday. By 
including the Saturday weekly report in the schedule for automatic printing and 
exporting, all daily reports will also be run on Saturday, producing exported 
and/or printed reports that are not required.  
 
Use the following steps to enable a report for automatic printing and/or export 
and set-up the schedule. The schedule applies to all reports defined for 
automatic printing and exporting. Changing a schedule that has already been 
defined changes the schedule for all reports enabled for automatic printing and 
exporting. 
  

1. Select the desired reporting period from the Main Control Panel. This can 
be any reporting period except Forecast.  

2. Select the desired report template from the Report Templates panel.  
3. Click the Properties button in the title bar of the Report Templates panel to 

open the Properties window. 
4.  Select the General tab. 
4. Enable the Auto Print button to flag the report for automatic printing. 
5. Enable the Auto Export button to flag the report for automatic export. 
6. Click the Schedule Report Generator... button to open the Schedule 

Report Generator dialog box. 
7. Enable the Automatically run Report Generator check box. 
8. Select the time of day to begin the automatic printing and exporting of the 

reports from the Generate summaries & reports at drop-down list of times. 
The times are listed in half-hour intervals from 4:00 AM to 6:30 AM. 

9. Enable the check boxes for the days of the week to run the scheduled 
tasks of automatically printing and exporting the reports. 

 
This schedule applies to all reports defined for automatic printing and 
exporting. Changing a schedule that has already been defined changes 
the schedule for all reports enabled for automatic printing and exporting. 
 

10. If using Windows NT or Windows 2000, click the Set password... button to 
open the Set Password dialog box. If Windows NT or Windows 2000 is not 
the operating system, this option is not available.  

11. Verify the network domain and PC name in the Account field. This is the 
name the PC uses to log into the network when it is time to run the 
scheduled task.  
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12. Input the network log-in password in the Password field. The password 
must be the network recognized password for the PC for the log-in to be 
successful.  

13. Re-type the password in the Confirm password field.  
14. Click OK to accept the network log-in information and to close the Set 

Password dialog box. 
15. Click OK in the Schedule Report Generator dialog box to accept the 

schedule and close the dialog box.  

Using Enterprise Reports 

To generate an Enterprise report, the Reports application looks at .pbx files that are 
saved on the Enterprise Supervisor's local Information Server. The Enterprise 
Supervisor needs to have access to a shared directory that contains these files, at the 
TASKE site to retrieve and use data. 
 
When a report is requested by an Enterprise Supervisor for information from a "remote" 
TASKE site, the following sequence of events occurs. 
 

1. An Enterprise Supervisor launches the TASKE Reports application. 
2. The Enterprise Supervisor selects a site and creates a new report template or 

selects an existing report template. 
3. The Enterprise Supervisor chooses "View" or "Export" to create the report, and 

then selects the date(s) for the report to cover. 
 

If the report is for the local site, steps 4 through 7 are omitted. 
 

4. TASKE Reports opens a Net Client. The icon for the Net Client is visible in the 
Windows System tray . The Net Client connects to the Information Server and 
asks it to check for an up to date .pbx file for the date(s). 

5. If necessary, the Enterprise enabled Information Server forwards the request to 
the Information Server who owns the remote site. 

6. If necessary, the Information Server for the remote site sends an up to date copy 
of the requested .pbx file back to the requesting Enterprise enabled Information 
Server. 

7. The Enterprise enabled Information Server receives the data file (if sent) and 
saves it in the appropriate directory for the remote site. 

8. The TASKE Reports application retrieves the information from the .pbx files in its 
Information Servers directory and builds the report to be displayed in the TASKE 
Reports application. 
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The diagram below illustrates the path that the request follows, from the report being 
requested, to the display of the report. 
 

 
 

Creating Enterprise Reports 

When an Enterprise Supervisor is installed, the Reports application for the 
Enterprise Supervisor works differently than for a non-enterprise Supervisor. The 
Reports application for an Enterprise Supervisor has the ability report on data 
from all sites connected to the Enterprise Supervisor's Information Server 
. 
Use the following steps to create a report for a remote site.  
 

1. Select the reporting period. 
a. Select the desired reporting period (Daily, Weekly, Monthly, Year 

by Week, or Year by Month) from the Main Control Panel. 
 

2. Create a new template. 
a. Click New in the Report Templates panel to open the Select Site 

dialog box. 
b. Select the site for the report. 
c. Click OK.  

 
3. Define the General properties. 

a. Select the General tab. 
b. Input a name for the template in the Report Templates field.  A 

name is mandatory and can contain any combination of characters 
and spaces.  

c. If desired, input a description for the template in the Report 
Description field. The description can contain any combination of 
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characters and spaces.  
d. Enable the Auto Print check box to have the report print 

automatically. The report must be scheduled to print automatically. 
To schedule the automatic printing, click the Schedule Report 
Generator... button to open the Schedule Report Generator dialog 
box.  

e. Enable the Auto Export check box to have the report export 
automatically. The report must be scheduled to export 
automatically. To schedule the automatic export, click the Schedule 
Report Generator... button to open the Schedule Report Generator 
dialog box.  

f. If it is a Year by Week report, select the number of weeks to use for 
the Time Period. If it is a Year by Month report, select the number 
of months to use for the Time Period. 
 

4. Define the Content properties. 
a. Select the Content tab. 
b. Select a resource from the Resource drop-down list.  
c. If it is a Trunk or Extension report, enable the Individual 

Trunks/Extensions check box to report on individual 
trunks/extensions only. 

d. Select the members of the resource group to include in the report 
from the list in the display area. To select a group of resource 
members that are in order, select the first member and SHIFT+click 
the last member in the list of those desired for selection. To select a 
group of members that are not in order, select the first member and 
CTRL+click each of the remaining members desired for selection. 

e. Click the buttons of the desired report options. When a report 
option is selected, its button is depressed and the column in the 
display area, for that report option, is populated with a red check 
mark for the selected resource members. The report options for 
vary according to the reporting period and resource selected.  
 

5. Define the Export Properties. 
a. Select the Export tab. 
b. Select a file type for the exported file from the Export Format list. 
c. Select a time format for the exported report from the Time Format 

list of radio buttons. 
d. Define the location of the exported file in the Export Path field. Click 

the Browse button to browse the local PC or the network for a file 
location. 
 

6. Accept the properties. 
a. Click OK to save the properties of the new report template and 

close the Properties window. 
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7. View the report. 
a. Select the new report template in the Report Templates panel. 
b. Click View on the Report Templates panel title bar to open the Date 

Selection Calendar. 
c. Use  and  to select the desired year. 
d. Use  and  to select the desired month. 
e. Click the desired date (may be a span of one day, one week, or one 

month depending on the reporting period selected). The selected 
calendar period is highlighted in blue. 

f. Click OK to close the Date Selection calendar and generate the 
report for the selected date. 

g. The report opens in the Publication Viewer. If no data is available 
for the selected date, the TASKE Reports dialog box opens 
indicating that there is nothing to report on for the specified options.  

h. Scroll through the pages of the report using the page selector tools 
on the title bar of the Publication Viewer. 

 

Using Notification Reports 

Notification reports inform users of data collection events that have occurred over the 
time period of the selected report. These reports detail three types of events: data 
collection started, data collection stopped, and call record errors. 
 
A Notification report is the first page of any report generated and displayed in the 
Publication Viewer, assuming there are valid events to include in a Notification report. If 
there are no valid events to include in a Notification report for the period, the Notification 
report is not generated. Each event type in a Notification report is represented by an 
identifying code. The reports include columns for the date, the time, the event code, and 
descriptions of the events. 
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Generating Notification Reports 

Notification reports are either enabled or disabled. When enabled, a Notification 
report is the first page of any report generated and displayed in the Publication 
Viewer, assuming there are valid events to include in a Notification report. If there 
are no valid events to include in a Notification report for the period, the 
Notification report is not generated. When the Notification reports are disabled, 
the reports are not produced for the reporting period, even if valid events exist. 
 

Enabling and Disabling Notification Reports 

Notification reports are enabled and disabled from the File menu. Use the 
following steps to enable or disable the Notification reports. 

 
1. Click File on the toolbar to open the File menu. 
2. Select Notification Reports from the File menu to enable or disable the 

Notification reports and close the File menu. 
 

 
  
By default the Notification reports are enabled. When a check mark is present 
beside the Notification Reports option in the File menu the reports are enabled. If 
a check mark is not present, the reports are disabled.   
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Notification Report Events 

Each event in a Notification report is provided with the date and time that the 
event occurred, a code, and a description. If the event represents a faulty call 
record, the record is included in the description. 
 
The following events are included in Notification reports. 
 
Code Description 

000001 Data collection started 

000002 Data collection stopped 

000003 Faulty record - the record is displayed in the description column of the 
report 
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Traffic Analyzer 

The TASKE Traffic Analyzer application aids in the identification of required resources 
for a customer interaction center. Use the calculation wizards to quickly and easily apply 
complex traffic equations to the data of the customer interaction center. Reports provide 
information in a combination of tables and graphs. 
 
Use the Cost Justification Guide to generate a cost benefit analysis of running a 
customer interaction center. Input values for the operating costs and learn how to 
decrease costs and increase revenue.  
 
Using the Traffic Analyzer, perform traffic calculations relevant to the customer 
interaction center.  The application applies three of the most commonly applied traffic 
equations: Erlang B, Erlang C, and Poisson.  Two of the equations: Erlang B and 
Poisson relate the Grade of Service (GOS) to the traffic and the number of Trunks.  The 
Erlang C equation relates the level of traffic allowed through by the Trunks, to the 
number of Extensions/Agents and the delay characteristics. 
 
Erlang B is the equation most commonly used for Trunk and Blocking calculations.  It 
assumes that there is no queuing and that Callers who get blocked simply give up and 
do not try the call again. Erlang C is the equation most commonly used for Agent and 
delay calculations where ACD queuing is employed.  It assumes that all Callers who 
reach the Queue wait until the call is answered, no matter how long it takes. Poisson is 
another equation sometimes used for Trunk and Blocking calculations.  It assumes that 
there is no queuing, and that all Callers who get a busy signal retry the call. Among the 
probabilities that can be calculated are the chance that an incoming call will be blocked, 
the probability that an Agent will be busy, and the number of Agents required to achieve 
a specified level of service. 
 

Overview of the Traffic Analyzer Interface 

To open the Traffic Analyzer program, double click on the Traffic Analyzer icon in the 
TASKE ToolBox.  The Traffic Analyzer window is presented below. Continue with this 
section for descriptions of the features available in the Traffic Analyzer program window. 
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Menu Bar 

In the Menu Bar (top of the window) of the Traffic Analyzer, a set of drop-down 
menus is displayed. 
 

 
 
The three menus include Calculations, View and Help and are for creating 
analyses of the traffic on the phone system, changing the display of toolbars and 
menus, and accessing the Traffic Analyzer online help. 
 

Tool Bar 

In the Tool Bar (top of window, below menu bar) of the Traffic Analyzer program, 
a set of tool buttons is displayed.  The buttons include 2D Horizontal Bar Graph, 
Recalculate Current Statistics, Calculate Required Staffing, and Activate Cost 
Justification Wizard. 
 

 
 
These tools are used to create and recalculate new and existing analyses of 
traffic, and perform cost justification for a call center. 
 

Main Window 

In the Traffic Analyzer Main Window, any analyses of traffic are displayed.  The 
main window appears blank upon entering the traffic analyzer, but different 
graphs and statistics are displayed once created. 
 

Status Bar 

The Status Bar (bottom of window) of the Traffic Analyzer displays statistics 
about the status of the analysis being displayed in the Main Window.  The Status 
bar also displays button names when the mouse pointer is held over a button in 
the button bar, as well as displaying a brief description of menu options as they 
are highlighted in the drop-down menus. 
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Understanding Traffic Concepts 

There can be wide variations in the number of calls received over different intervals of 
time.  However, in an ACD customer interaction center, call arrivals do tend to form 
hourly, daily, and seasonal patterns. These patterns can be used to analyze traffic and 
perform estimates on expected traffic loads.  Therefore, although telephone call 
behavior is essentially random over a short period of time, patterns can be detected 
over longer periods of time. 
 
A rough pattern is established for call duration over a very large number of calls.  The 
pattern is a ‘bell curve’ with very few calls of very short duration and very few calls of 
great duration when compared with the average call duration.  However, most calls 
approximate the average.  The pattern of call arrivals and call durations has a great 
affect on how many calls can be handled successfully. 
 
The average number of calls and the average call duration are estimated in order to 
determine the degree of Server utilization over a given period of time. In telephone 
traffic engineering terms, a Server is a device that accepts telephone traffic.  A Server 
may be a Trunk which accepts calls that originate from an Extension, as is the case for 
Outbound calls, or an Extension or Agent in the case of Incoming calls.  In both 
instances, the Server is the acceptor of the call. 
 
If a call is not accepted by a Server then it may be Blocked, and the Caller given a busy 
signal.  If the Server is not immediately available but the call is allowed to wait to be 
accepted, then it will be delayed.  The two key service parameters affecting the call and 
the Servers are Blocking and delay.  The traffic load on a group of Servers is 
determined by multiplying the average call duration by the average number of calls over 
a given period of time, and is expressed in either Erlangs (number of hours of server 
time) or CCS (100 call seconds, or centum call seconds of time). 
 

Busy Hour/Busy Season 

To determine how many Servers should be provided on a telephone or ACD 
system, the concept of a Busy Hour is used.   The Busy Hour is the period of the 
day when the traffic is the highest. 
 
There are also seasonal variations in traffic over periods such as the Christmas 
season, where an increase or decrease in the number of incoming calls can be 
predicted.  The term Busy Season is used to designate these periods.  The Busy 
Hour is usually measured in the busy season so that an average Busy Hour is 
found for the Busy Season—or Average Busy Season Busy Hour (ABSBH). 
 
Telephone Systems are typically engineered based on the ABSBH traffic model.  
This ensures good service at all times, with the exception of peak periods without 
being excessively expensive. 
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Blocking 

Blocking is the term used to indicate a call, which is unsuccessful, because it 
cannot be connected, as opposed to a call that connects but finds the called 
party busy.  The probability of Blocking lies between 0 and 100%, and typically 
falls in the range between 1% and 10%.  The probability of a call being Blocked 
(expressed as P.01 to P.10) is between 1 in 100, and 1 in 10.   
 
In formal traffic engineering terms this probability is termed the Grade of Service 
(GOS).  The higher the GOS, the lower the service provided, the lower the GOS, 
the higher the service provided. 
 

Queue Delay/Call Abandons 

In an ACD situation, successful Callers are placed in Queue and may face a 
delay.  This introduces another measurement of service performance—the 
probability of delay.  The less the chance of being delayed and the less the 
delay, the better the service and vice versa. 
 
In the following example, a threshold delay of 30 seconds is chosen.  Service 
might be considered acceptable if 90% of Callers experience this, or a lesser 
delay.  This is expressed as a service performance target of a ‘90% probability of 
delay of less than 30 seconds’.  If a Caller is not delayed longer than 30 seconds, 
then service is considered to be acceptable.  If a Caller is delayed longer than 30 
seconds, then service is considered to be unacceptable. 
 

Call Duration 

The duration of an ACD call typically consists of the following three components. 
 

 The average Queue Time is the time spent in the ACD Queue waiting for 
an Agent to become free and is often termed the Average Speed of 
Answer (ASA). 

 The average Talk Time is the time the Caller actually spends connected to 
an Agent, regardless of whether conversation is taking place or not. 

 The average Work Time is the time the Agent spends performing paper 
work in connection with a call, but after the Caller has disconnected. 

 
To a Trunk, the call duration consists only of the Queue Time and the Talk Time; 
the Trunk (and the Caller) are not involved while the Agent is performing 
paperwork on Work Time. 
 
To the Extension and Agent, the call duration consists only of the Talk Time and 
the Work Time; the Extension and Agent are not involved while the call is waiting 
in Queue on Queue Time. 
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Thus, the duration of a call usually differs from the perspective of the Trunk 
carrying the call into the CO or Telephone System PBX from the Extension or 
Agent who is handling the call. 
 

Service Criteria 

To provide good service requires that a call be responded to within or 
approximately within the Caller's expectations. What does a Caller expect?  
Good service might be defined by the three components illustrated below. 
 

 
 

 The Caller expects to have a reasonable chance of obtaining a free Trunk 
into the system. 

 The Caller expects a response within a reasonable amount of time. 
 The Caller expects to be treated with reasonable courtesy and to be given 

reasonably accurate and current information. 
 

Creating a Traffic Analysis 

The Grade Of Service (GOS) is primarily related to the number of Trunks compared to 
the level of traffic.  The delay characteristic is primarily related to the number of 
Extensions/Agents compared to the level of traffic allowed through by the Trunks.  
 
Traffic engineering revolves around several basic questions concerning the relationship 
between the following parameters. 
 

• What is the GOS for a given number of Trunks and level of traffic? 
• How many Trunks are required to handle a given level of traffic at a particular 

GOS? 
• What is the probability of delay and the amount of delay experienced for a given 

level of traffic and number of Extensions/Agents? 
• What are the delay characteristics? 
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• How many Extensions/Agents are required to handle a given level of traffic with 
particular delay characteristics? 

 
Mathematical models that approximate these relationships have been developed but 
they are complex.  The TASKE ToolBox enables the most common of these equations 
for you to perform the calculations required for traffic engineering.   
Two of the equations: Erlang B and Poisson relate the GOS to the traffic and the 
number of Trunks.  The Erlang C equation relates the level of traffic allowed through by 
the Trunks, to the number of Extensions/Agents and the delay characteristics. 
"Erlang B" is the equation most commonly used for Trunk and Blocking calculations.  It 
assumes that there is no queuing and that Callers who get blocked simply give up and 
do not try the call again. 
 
"Erlang C" is the equation most commonly used for Agent and delay calculations where 
ACD queuing is employed.  It assumes that all Callers who reach the Queue wait until 
the call is answered, no matter how long it takes. 
 
"Poisson" is another equation sometimes used for Trunk and Blocking calculations.  It 
assumes that there is no queuing, and that all Callers who get a busy signal retry the 
call. 
 
The following figure summarizes the different traffic equations and the assumptions 
behind them.  The three equations (Poisson, Erlang B and Erlang C) correspond to 
idealized situations at the corners of the triangle, where the assumptions behind the 
equations are fully applied.  Points "A", "B", "C", "D" represent practical situations. 
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Service Percentage - Level of Abandons 

The Service Percentage is a term used to represent service performance.  This is 
the percentage of calls which obtain a Trunk and are answered compared to the 
total number of calls which obtain a Trunk, and is the inverse of the rate of 
abandons.  For example, if 6% of Callers abandon while waiting in the Queue, 
then the Abandon Rate is 6%, and the Service Percentage is 94%. 
 

Telephone Service Factor - Speed of Answer 

As mentioned previously, the TSF is the ratio of calls that obtain a Trunk and are 
either answered or abandoned before a threshold time, to the total number of 
calls which obtain a Trunk.  The Telephone Service Factor is illustrated below. 
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Creating an Erlang C Traffic Analysis 

The Calculation Wizard prompts for all of the information needed to 
create a graph of the traffic analysis calculation. Clicking the Calculation 
Wizard button on the toolbar takes users step-by-step through the 

process of creating a traffic analysis, using the traffic equation of the user's 
choice. The steps below act as a guide for creating an Erlang C traffic analysis.  
 

Erlang C - Erlang C modeling assumes calls placed by a source that are 
blocked will never hang up, but will queue forever waiting for a server to 
become free. This model follows the characteristics of an incoming ACD 
caller to an ACD group or a caller into a Queue Group. 

 
1. Click the Calculation Wizard button on the toolbar to open the Statistic 

Selection dialog box. 
2. Enable the Erlang C radio button. 

 

.  
 

3. Click Next to open the Erlang C Statistics dialog box. 
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4. Enable the radio button for the desired statistic and click the Next button. 
The remaining dialog boxes that follow vary according to the type of 
statistic selected.  

5. With each dialog box that follows, enter the calculation parameters and 
click the Next button to continue to the next dialog box in the Calculation 
Wizard. 

6. In the final dialog box the Next button is replaced by the Finish button. 
Click Finish to create the traffic analysis based on the selections of the 
previous dialog boxes. 

 

Erlang C Traffic Calculations 

The Erlang C selection allows the following calculations to be performed. The 
explanation of each of the parameters, shown below, together with an example 
indicates how these calculations are used to manage customer interaction center 
traffic. 
 

Probability of Blockage (ERLC_GOS formula) 

This calculation relates the GOS to the number of Agents and the call load (or 
the number of calls per hour and the average duration of these).  The calculator 
accepts  the number of calls per hour, the average call duration, and the number 
of available Agents as parameters.  The GOS that results from the call load being 
presented to a given number of Agents, may be determined. 
 
For example, the Probability of Blockage calculation can be applied to estimate 
the expected call load and to know how many Agents are scheduled to work. 
Then, you can calculate the GOS that Callers are expected to receive.  Although 
the GOS is generally stated as the probability of Blockage, the GOS in an Erlang 
C model actually represents the probability that a Caller will experience a delay.  
Thus, a GOS of P.10, or 10%, means that a Caller has a 10% chance of being 
delayed. 
 

Probability of X or Less Agents Busy (ERLC_X_CHAN formula) 

This calculation determines the probability that X Agents are simultaneously busy 
when a given call load is presented to a limited number of available Agents.  The 
calculator accepts the number of calls per hour, the average call duration, and 
the number of available Agents as parameters. It then calculates the probability 
of a specified number of Agents being busy at any point in time. 
 
This calculation is used to determine the probability of having no Agents that are 
busy (i.e. All Agents idle).  Agent utilization, or the proportion of time that an 
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Agent is busy compared to the total work time of the Agent, depends on the call 
load and the number of Agents available.  
 
For a certain call load and a limited number of Agents, the calculation reveals 
that an Agent(s) would be idle for a significant proportion of the time. Then, you 
might consider reducing the number of Agents for the shift.  However, there is a 
close relationship between Agent utilization and the TSF experienced by Callers.  
Particularly for a small Agent group, you may find that a relatively low Agent 
utilization is the price that must be paid to ensure a high level of service to 
Callers. 
 
This calculation determines the probability that between X and Y Agents are 
simultaneously busy when a given call load is presented to a given number of 
available Agents. The calculator accepts as parameters, the number of calls per 
hour, the average call duration, and the number of available Agents, and 
calculates the probability that greater than X and fewer than Y Agents are busy at 
any point in time. 
 
This calculation determines the probability that between X and Y Agents are 
simultaneously busy when a given call load is presented to a given number of 
available Agents. The calculator accepts as parameters, the number of calls per 
hour, the average call duration, and the number of available Agents, and 
calculates the probability that greater than X and fewer than Y Agents are busy at 
any point in time. 
 
This calculation determines the probability that four or more Agents in a group of 
eight are busy at any known point in time.  If you supervise a Queue with eight 
Agents in the morning work shift and four Agents in the afternoon work shift, you 
can calculate the affect of reducing the number of Agents to four for the morning 
work shift. 
 

Probability of X and Y Agents Busy (ERLC_INTEG formula) 

This calculation determines the probability that between X and Y Agents will be 
simultaneously busy when a current call load is presented to a limited number of 
available Agents.  The calculator accepts the number of calls per hour, the 
average call duration, and the number of available Agents as parameters. Then, 
it calculates the probability that no fewer than X, and no more than Y Agents are 
busy at any point in time.   
 
You can use this calculation to determine the traffic on the least occupied Agents 
in an Agent Group.  For example, you can calculate the probability of Agents 8 to 
10 (for a group of 10 Agents) being busy when presented with 250 calls per hour, 
and having an average duration of 70 seconds. This calculator calculates the 
probability of Agents 8 to 10 being busy and determines whether the individual 
Agent traffic justifies the cost. 
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Traffic that can be Carried (ERLC_TRAF formula) 

This calculation determines the traffic or call load that can be handled by a 
limited number of Agents within a given GOS.  The calculator accepts the 
number of available Agents, the required GOS, and the average call duration as 
parameters. Then, it calculates the number of calls per hour that can be handled.   
 
For example, you can determine the call load, with an average call duration of 70 
seconds, that can be handled by four Agents, while maintaining the GOS within 
the company’s target of P.05.  This calculation can demonstrate that the number 
of calls per hour that can be handled is less than expected. To remedy this, you 
can either increase the number of Agents to maintain the GOS within target, or 
the GOS must be allowed to decline to enable the call load to be handled by the 
available Agents.   
 

Agents Required to Achieve a GOS (ERLC_TKS formula) 

This calculation determines the number of servers (or Agents in this case) 
required to handle a certain call load within an acceptable GOS.  The calculator 
accepts the number of calls per hour, the average call duration of those calls, 
and the required GOS as parameters. Then, it calculates the number of Agents 
required to handle the calls. 
  
For example, you can determine how many Agents are required to handle 300 
calls per hour at an average call duration of 80 seconds, while maintaining the 
GOS rating at P.20.  If this calculation shows that the number of Agents required 
is more than the number you expect to have available, then the GOS will be 
worse than the target GOS of P.20. 
 

Probability of Delay (ERLC_DELAYT formula) 

This calculation determines the probability of a Caller having to wait a minimum 
of XX seconds to be answered, when a limited number of Agents are presented 
with a certain call load.  The calculator accepts the number of seconds for the 
threshold time, the number of calls per hour, the average call duration of those 
calls, and the number of available Agents, as parameters. Then, it calculates the 
probability of Callers having to wait for at least the threshold time. 
 
For example, you can determine the probability of Callers that will have to wait 
more than 20 seconds for an Agent to respond, when 30 calls per hour with an 
average single call duration of 70 seconds, are presented to 3 Agents.  If the Call 
Center's level of service target is that 80% of calls be answered within 15 
seconds, then 20 seconds might be considered a very poor response.  The 
Supervisor can use this probability to know the number of Callers that receive 
this poor level of service. 
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Average Queue Depth (ERLC_AVQ formula) 

This calculation determines the average number of Callers waiting in the Queue 
at any point in time, when there are a limited number of Agents being presented 
with a certain call load.  The calculator accepts the number of calls per hour, the 
average call duration of those calls, and the number of available Agents as 
parameters. Then, it calculates the average number of Callers who are delayed 
and waiting in the ACD Queue at any point in time.   
 
Because this calculation produces a value for the average number of Callers, the 
result may not be a whole number.  For example, in the first second there may be 
one Caller waiting in Queue.  For the next three seconds there may be no Callers 
waiting; the average probability is then 1+3/4 = 1.25 Callers in Queue. 
 
This calculation determines the average number of Callers waiting in Queue, 
when 70 calls per hour with an average call duration of 70 seconds, are 
presented to 4 Agents.   
 
Use this calculation to determine the amount of Recorded Announcement 
Devices (RAD) that are required to provide Queue delay announcements to 
Callers. For example, if the calculation indicates that the average number of 
Callers in Queue is 0.03, then enough RAD equipment to deliver an 
announcement to one Caller at a time is required.  If the calculation for a larger 
Queue were to indicate that the average number of Callers in Queue is 3.8, then 
it would probably be wise to provide enough RAD equipment to deliver 
announcements to 5 Callers at a time; sometimes there are more Callers in 
Queue than the average.  
 

Average Delay (ERLC_AVGDLY formula) 

This calculation determines the average time that a Caller waits in the ACD 
Queue before being answered by an Agent, when a limited number of Agents is 
presented with a certain call load.  The calculator accepts the number of calls per 
hour, the average call duration of those calls, and the number of available Agents 
as parameters. Then, it calculates the average delay experienced by the Callers.   
 
For example, you can determine the average waiting time for Callers when 7 
Agents are presented with 70 calls per hour with an average call duration of 70 
seconds.  In this case, the average wait is insignificant. If different parameters 
are applied and the wait time is considered to be too long, then additional Agents 
should be made available, or the average call duration should be decreased. 
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Agents Required (ERLC_AGENTS formula) 

This calculation determines the number of Agents required to handle a given call 
load within a stated TSF.  The calculator accepts the number of calls per hour, 
the average call duration of the calls, and the required TSF percentage and time 
as parameters. Then, it calculates the number of Agents required to handle the 
call load within the TSF requirements. 
 
For example, you can determine the number of Agents required to handle 150 
calls per hour, with an average duration of 80 seconds, and within a TSF of 80% 
of calls answered or abandoned within 20 seconds.  This is a key calculation in 
the Forecasting and Scheduling process. 
 

Creating an Erlang B Traffic Analysis 

The Calculation Wizard prompts for all of the information needed to 
create a graph of the traffic analysis calculation. Clicking the Calculation 
Wizard button on the toolbar takes users step-by-step through the 

process of creating a traffic analysis, using the traffic equation of the user's 
choice. The steps below act as a guide for creating an Erlang B traffic analysis.  
 

Erlang B - Erlang B modeling assumes that calls placed by a source that are 
initially blocked will not reattempt the call and that the call will not queue up 
waiting for a server to come free. When the call is initially blocked, the caller 
hangs up and NEVER re-attempts to originate again. This distribution typically 
models outgoing trunk groups. 

 
1. Click the Calculation Wizard button on the toolbar. 
2. Enable the Erlang B radio button. 
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3. Click Next to open the Erlang B Statistics dialog box. 
 

 
 

4. Enable the radio button for the desired statistic and click the Next button. 
The remaining dialog boxes that follow vary according to the type of 
statistic selected.  

5. With each dialog box that follows, enter the calculation parameters and 
click the Next button to continue to the next dialog box in the Calculation 
Wizard. 

6. In the final dialog box the Next button is replaced by the Finish button. 
Click Finish to create the traffic analysis based on the selections of the 
previous dialog boxes. 

 

Erlang B Traffic Calculations 

The Erlang B selection allows the following calculations to be performed. The 
explanation of each of the parameters, shown below, together with an example 
indicates how these calculations are used to manage Call Center traffic. 
 

Probability of Blockage (ERLB_GOS formula) 

This calculation relates the Grade Of Service (GOS) to the number of  Trunks 
and to the call load (or the number of calls per hour and the average duration of 
these).  The calculator accepts the number of calls per hour, the average call 
duration, and the number of available Trunks as parameters Then, it calculates 
the GOS that results from the designated call load being presented to the 
designated number of Trunks.  
  
For example, you can determine the probability of a Caller receiving a busy 
signal when trying to access an outgoing Trunk under the following conditions: it 
is expected that the number of outgoing calls is 150 per hour; the average call 
duration is 70 seconds; and the number of Trunks is 3.  In an Erlang B model, the 
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GOS directly represents the level of Blocking.  This calculation results in a P.34 
chance of receiving a busy signal.  This means that a Caller trying to access an 
outgoing Trunk has a 34%, or approximately a 1 in 3 chance of receiving a busy 
signal.  This is a very poor level of service.  The GOS would typically be in the 
range of P.01 to P.10.   
 

Probability of X or Less Trunks Busy (ERLB_X_CHAN formula) 

This calculation determines the probability that exactly X number of Trunks will 
be simultaneously busy when a stated call load is presented to a given number of 
available Trunks. The calculator accepts the number of calls per hour, the 
average call duration, and the number of available Trunks as parameters. Then, 
it calculates the probability that exactly the specified number of Trunks are busy 
at any point in time. 
 
For example, you can determine the probability of getting an all Trunks busy 
condition in a group of 4 Trunks under the following conditions: there are 250 
calls per hour, with an average duration of 70 seconds. The calculation results in 
a probability of about 0.39, meaning that there is a 39% chance of all 4 Trunks in 
the group being busy at the same time.  This can also be expressed as precisely 
4 Trunks being busy for 39% of the time.   
 

Probability of X and Y Trunks Busy (ERLB_INTEG formula) 

This calculation determines the probability that between X and Y Trunks will be 
simultaneously busy when a current call load is presented to a limited number of 
available Trunks. The calculator accepts the number of calls per hour, the 
average call duration, and the number of available Trunks as parameters. Then, 
it calculates the probability that no fewer than X, and no more than Y Trunks are 
busy at any point in time.  
 
You can use this calculation to determine the traffic on the least occupied Trunks 
in a Trunk Group.  For example, you can calculate the probability of Trunks 8 to 
10 (for a group of 10 Trunks) being busy when presented with 250 calls per hour, 
and having an average duration of 70 seconds. This calculator calculates the 
probability of Trunks 8 to 10 being busy and determines if the individual Trunk 
traffic justifies the cost. 
 

Traffic that can be Carried (ERLB_TRAF formula) 

This calculation determines the traffic (call load) that can be handled by a limited 
number of Trunks within a certain GOS. The calculator accepts the number of 
Trunks, the GOS required to be met, and the average call duration as 
parameters. Then, it calculates the number of calls per hour that can be handled.  
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Alternatively, the number of calls can be used.  In this case, the calculator 
determines the average call duration needed in order to meet the GOS.   
 
For example, you can determine the call load, with an average call duration of 70 
seconds, that can be handled by three Trunks while maintaining the GOS within 
the company's target of P.03.  If this calculation shows that the number of calls 
per hour that can be handled is less than expected, then the number of Trunks 
must be increased to maintain the target GOS.  Otherwise, the level of Blocking 
must be allowed to worsen to enable the call load to be handled by the Trunks 
that are available.   
 
Alternatively, the same calculation might be performed with a known number of 
calls per hour.  The calculator then determines the average call duration that can 
be accepted while still remaining within the target GOS.   
 

Trunks Required to Achieve a GOS (ERLB_TKS formula) 

This calculation determines the number of Trunks required to handle a certain 
call load within a stated GOS.  The calculator accepts the number of calls per 
hour, the average call duration of those calls, and the required GOS as 
parameters. Then, it calculates the number of Trunks required to handle the call 
load within the required GOS. 
 
For example, you can determine the number of Trunks required to handle 150 
calls per hour, with an average duration of 70 seconds, within a GOS of P.02.  
This is a key calculation in the Forecasting and Scheduling process.  
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Creating a Poisson Traffic Analysis 

The Calculation Wizard prompts for all of the information needed to create a 
graph of the traffic analysis calculation. Clicking the Calculation Wizard button on 
the toolbar takes users step-by-step through the process of creating a traffic 
analysis, using the traffic equation of the user's choice. The steps below act as a 
guide for creating a Poisson traffic analysis.  
 

Poisson - Poisson modeling assumes that calls placed by a source that are 
initially blocked will hang up and reattempt the call at random intervals until 
the call successfully connects OR until it has waited the length of time the call 
would have lasted if not blocked. The model assumes that calls will never 
queue.  This distribution is not widely used in North America, but is provided 
for completeness. 
 
1. Click the Calculation Wizard button on the toolbar. 
2. Enable the Poisson radio button. 

 

 
 

3. Click Next to open the Poisson Statistics dialog box. 
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4. Enable the radio button for the desired statistic and click the Next button. 
The remaining dialog boxes that follow vary according to the type of 
statistic selected.  

5. With each dialog box that follows, enter the calculation parameters and 
click the Next button to continue to the next dialog box in the Calculation 
Wizard. 

6. In the final dialog box the Next button is replaced by the Finish button. 
Click Finish to create the traffic analysis based on the selections of the 
previous dialog boxes. 

 

Poisson Traffic Calculations 

This calculation relates the GOS to the number of Trunks and the call load (the 
number of calls per hour and the average duration of these).  The calculator 
accepts the number of calls per hour, the average call duration, and the number 
of available Trunks as parameters. Then, it calculates the GOS that results from 
the call load being presented to the designated number of Trunks.   
 
Although the GOS generally means the probability of Blockage, the GOS in the 
Poisson model represents the probability that a Caller will receive a busy signal 
on the first call attempt.  The Poisson model assumes that Callers who meet a 
busy condition will re-try the call.  The GOS in the Poisson model does not 
necessarily represent the probability of a call being unsuccessful, only that it is 
unsuccessful on the first attempt. 
 
For example, you can determine the probability of getting an all Trunks busy 
condition in a group of 4 Trunks, where there are 150 calls per hour with an 
average duration of 70 seconds.  The calculation results in a probability of 
approximately 0.33, meaning that there is a 33% chance of all 4 Trunks being 
busy at the same time.  Because the Poisson model assumes that Callers who 
meet a busy condition on the first call attempt re-try the call, this is not the same 
as saying that the Callers have a 33% probability of being unsuccessful in 
obtaining a Trunk. 
 

Probability of Blockage at Call Arrival Rate (POIS_GOS formula) 

This calculation relates the probability of call Blocking to the number of Trunks 
and to the call load (the number of calls per hour and the average duration of 
these).  The calculator accepts the number of calls per hour, the average call 
duration, and the number of available Trunks as parameters. Then, it calculates 
the probability of call Blocking that results from a certain call load being 
presented to a given number of Trunks.   
 
The term ‘probability of Blocking’ is used here to distinguish this calculation from 
that of the Poisson GOS.  The probability of Blocking is the chance that a Caller 
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will meet a busy signal on repeated call attempts, whereas, the Poisson GOS 
relates only to the chance of receiving a busy signal on the first attempt. 
 
For example, you can determine the probability of a Caller being unsuccessful in 
getting a free Trunk (even after re-trying the call), when four Trunks are 
presented, with 150 calls per hour, and an average call duration of 70 seconds.  
The calculation results in a probability of about 0.16, meaning that there is a 16% 
chance of a Caller meeting a busy condition on the first and subsequent call 
attempts.   
 
Notice that the result here is 16%, as opposed to the 33% result obtained when 
the Poisson GOS was calculated.  Together these results mean that the Caller 
has a 33% chance of meeting a busy condition on the first call attempt and a 
16% overall chance of meeting a busy condition on all call attempts. 
 

Probability That Selected Trunks Are Busy (POIS_INTEG formula) 

This calculation determines the probability that X Trunks or fewer are busy at any 
point in time when a certain call load is presented to a limited number of Trunks.  
The calculator accepts the number of calls per hour, the average call duration, 
and the number of Trunks as parameters. Then, it calculates the probability that 
X or fewer number of the Trunks will be busy at any point in time.   
 
This calculation might be applied where you suspect that you have too many 
Trunks in a Trunk Group and you wish to determine the peak number of Trunks 
required.  In this situation you may wish to know the probability that eight or 
fewer Trunks are busy in a group of 10, when presented with 150 calls per hour, 
with an average call duration of 70 seconds. 
 
This calculation might be applied where you suspect that you have too many 
Trunks in a Trunk Group and you wish to determine the peak number of Trunks 
required.  In this situation you may wish to know the probability that eight or 
fewer Trunks are busy in a group of 10, when presented with 150 calls per hour, 
with an average call duration of 70 seconds. 
 
This calculator allows you to calculate the probability that 8 or fewer Trunks are 
busy.  Then, you can calculate the probability that 9 or fewer Trunks are busy.  If 
the difference between the probability of 9 or fewer Trunks, and 8 or fewer 
Trunks being busy is small, then it may be that no more than 8 Trunks are 
required (statistical comparison).   
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Traffic capacity of Trunks for a GOS (POIS_TRAF formula) 

This calculation determines the traffic or call load that can be handled by a 
limited number of Trunks within a stated GOS.  The calculator accepts the 
number of Trunks with the required GOS, and the average call duration as 
parameters. Then, it calculates the number of calls per hour that can be handled. 
For example, you can determine the required call load, with an average call 
duration of 70 seconds, that can be handled by three Trunks, while maintaining a 
GOS within the value of P.03.  If this calculation shows that the number of calls 
per hour that can be handled is less than expected, then the following is true. 
The number of Trunks must be increased to maintain the GOS within target, or 
the level of Blocking must be allowed to worsen to enable the call load to be 
handled by the Trunks that are available.   
 
The Blocking formula used in this function is that described in the ‘Probability of 
Blockage at a call arrival rate’, not that described in the ‘Probability of Blockage 
for a GOS’.   
 

Trunks Required for a GOS (POIS_TKS formula) 

This calculation determines the number of Trunks required to handle a given call 
load within a given GOS. The calculator accepts the number of calls per hour, the 
average call duration of these calls and the required GOS as parameters. Then, 
it calculates the number of Trunks required to handle the call load within the GOS 
requirement.   
 
For example, you can determine the number of Trunks required to handle 150 
calls per hour, with an average duration of 70 seconds, within a GOS of P.02.  
This is a key calculation in the Forecasting and Scheduling process.   
 
The Blocking formula used in this function is that described in the  ‘Probability of 
Blockage at a call arrival rate’, not that described in the  ‘Probability of Blockage 
for a GOS’. 
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Understanding Traffic Reports 

When a traffic model is selected and one of its formulae is used to perform calculations, 
a report is presented that resembles the sample Traffic Analyzer report below. 
 

 
 
Each report provides an example of the calculation that corresponds to the calculator.  
All reports contain the following three sections. 
 

 The top left hand side of the report provides a brief explanation of the calculation 
performed, and any relevant criteria.  For example in the above analysis, the 
report displays that the calculation performed is “Traffic Capacity of Trunks for a 
GOS” and the calculation is based on the criteria of 250 calls per hour.  

 The top right hand side of the report contains the results of the calculation in the 
form of a table.  The example above displays the Grade Of Service required by 
the Number Of Trunks available.  The data in this table corresponds to the graph 
displayed below, in the bottom half of the report.  

 The lower section of the report contains a chart or graph produced using the 
parameters, data, and results from the table in the top-right section.   
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Recalculating a Traffic Analysis 

You can quickly change the parameters of an existing traffic analysis 
calculation by using the Recalculation Wizard. 
 

 
Use the following steps to recalculate the traffic analysis 
. 

1. Click the Recalculation Wizard button. 
2. Enter the new parameters in the dialogs as they are presented. 
3. At the final dialog, click Finish to create your analysis graph. 

 

Switching Between Line, Bar, and Pie Charts 

By default, all analysis data is displayed in a Simple Line Chart. If your analysis lends 
itself to presentation in another chart style, you can easily switch to another of the 
sixteen available styles. 
 
Use the following steps to present the data as a line chart. 
 

1.  Use the Calculation Wizard to produce a Simple Line Chart of your data. 
2.  Click Graph Styles, Line Charts 
3.  Choose one of the four styles of line charts from the flyout list. 

 
Use the following steps to present the data as a bar chart. 
 

1. Use the Calculation Wizard to produce a Simple Line Chart of your data. 
2. Click Graph Styles, Bar Charts 
3. Choose one of the ten styles of bar charts from the flyout list. 

 
Use the following steps to present the data as a pie chart. 
 

1. Use the Calculation Wizard to produce a Simple Line Chart of your data. 
2. Click Graph Styles, Pie Charts 
3. Choose one of the two styles of pie charts from the flyout list. 
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Calculating Staffing Requirements 

The staffing option performs calculations with custom input parameters, and 
produces reports.  The Staffing window is divided into three sections, the 
Traffic Model Information panel, the Data Table panel and the Graph panel. 

 

Traffic Model Information Panel 

The Traffic Model Information panel contains 5 boxes. The first four of these 
allow the entry of parameters. The fifth box, Agts Required, contains the number 
of agents required. This value is based on the values entered in the previous four 
boxes. The dialog box is initially filled with default values for all entries; enter data 
as single values or within a range. 
 

 
 

Data Table Panel  

The Average Calls/Hour, Average Talk Time, Service Goal, TSF Time, and 
Agents Required can be edited in the Traffic Model Information Block. Once the 
values are entered, the probability of queuing, probability of delay, average delay 
time, and average queue depth in the Data Table panel is updated in text format 
and the Graph panel is updated in graphical format. An example of these 
variables in the Data Table panel is shown below. 
 

 
 

Graph Panel 

An example of the variables displayed in graph format is shown below. 
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Using the Cost Justification Guide 

It is essential to understand the cost components and structure of a customer 
interaction center. The Traffic Analyzer aids in justifying cost requirements to senior 
management, and assists in the overall management and operation of the customer 
interaction center with the Cost Justification Guide.   
 
The guide describes how to calculate cost components using hypothetical cost figures. 
The cells in the tables of the guide can be edited costs entered that correspond to the 
customer interaction center.  The guide provides various suggestions for reducing 
customer interaction center operating costs and for increasing customer interaction 
center revenues. 
 

To open the Cost Justification Guide, click the Cost Justification button on the 
toolbar. The Cost Justification Guide provides a model for understanding the 
cost structure of a customer interaction center. To help illustrate the model, an 

example of a hypothetical customer interaction center’s cost structure is provided. This 
is important to understand because the basis for cost justification comes from projecting 
how features of the equipment will impact the cost structure of the customer interaction 
center. 
 
The Cost Justification Wizard includes the following sections: Call Center Cost 
Dynamics, Load Labor Costs, Equipment and Automation Costs, Transmission Costs, 
Reducing Call Center Costs, and Increasing Call Center Revenue. Continue for 
descriptions of each section of the Cost Justification Wizard. 
 

Call Center Cost Dynamics 

Your total customer interaction center costs include Loaded Labor Costs, 
Equipment and Automation Costs, and Transmission Costs. The relative 
proportion of each cost is illustrated in the customer interaction center Cost 
Dynamics chart. 
 

Load Labor Costs 

Customer interaction center load labor costs are calculated from the following 
cost components: 
 

 Agent cost per hour 
 Facility cost per agent per hour 
 Supply cost per agent per hour 
 Management and support staff cost per hour 
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Equipment and Automation Costs 

Customer interaction center Equipment and Automation costs may include the 
ACD system, the computer system, and the furniture used by employees. 
Equipment and Automation costs are measured in cost per workstation units. 
 

Transmission Costs 

Transmission Costs include the cost of both voice and data transmission. 
 

Reducing Call Center Costs 

Customer interaction center managers must justify the costs of equipment 
features by identifying the operational savings they provide. Cost justification 
examples are provided for the following customer interaction center features:  
 

 Delayed Answer  
 Agent Telephone 
 Wrap-Up Data Entry 
 Voice Response 

 

Increasing Call Center Revenue 

Total annual revenues may significantly increase with the use of an ACD system. 
Your potential increased revenue can be determined using the Increasing Call 
Center Revenue Worksheet. 
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TASKE Agent Desktop 

The TASKE Agent Desktop is a PC-based version of TASKE WallSign that is only 
available through an Agent installation of the TASKE ACD ToolBox. Using the Agent 
Desktop application, agents view current call center conditions in a sizable, on-screen 
window that displays user-specified, real-time call center data on the computer desktop. 
By continuously updating agents with real-time data on call activity, the TASKE Agent 
Desktop is an important tool in maintaining call center service levels.  
 
The TASKE Agent Desktop displays queue status information, call center performance 
parameters, system time and other measures for Queues or Queue Groups. Statistics 
are displayed in cells that change color when call traffic exceeds pre-defined thresholds, 
alerting agents to take action before potential problems arise.  
 
The Agent Desktop interface is a table that floats on the Windows desktop or docks to 
one of its edges. On the surface, the Agent Desktop application window appears to 
have no control mechanisms. To access the program features and functionality, 
right-click anywhere in the application window to launch the program menu. 
 

 
 
The application window is sizable by clicking and holding the left mouse button on the 
border of the window, and dragging until the desired window size is obtained. View the 
application window horizontally, vertically, or as a grid, with user-defined dimensions. 
When viewed as a grid, the Agent Desktop window is only viewable as a floating 
window. When viewed horizontally or vertically, users have the ability to dock the 
application window to any edge of the Windows Desktop. The docking feature resizes 
all other application windows, allowing agents to view call and queue statistics while 
working in other applications.  
 
To view the Agent Desktop window when the application is running, but the window is 
hidden from view, double-click the Agent Desktop icon in the Windows system tray.  
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Starting Agent Desktop 

The Agent Desktop application is opened from the Windows desktop. Use one of 
the following methods to open the application. 
 

Opening the Agent Desktop Using the Start Button 

Use the following steps to open the Agent Desktop application using the Start 
button on the Windows desktop. 

1. Click Start on the toolbar of the Windows desktop. 
2. Select Programs from the menu. 
3. Select the TASKE folder in the list of programs. 
4. Select Agent Desktop from the list of TASKE applications to open the 

Agent Desktop application. 
 

Opening the Agent Desktop from the TASKE Program Folder 

Use the following steps to open the Agent Desktop application from the TASKE 
ToolBox program folder. 

1. Double-click the TASKE ToolBox folder icon on the Windows desktop to 
open the TASKE ToolBox folder. 

2. Double-click the Agent Desktop icon in the folder to open the Agent 
Desktop application. 

 

Using the Agent Desktop Interface 

On the surface, the Agent Desktop application window appears to have no control 
mechanisms. To access the program features and functionality, right-click 
anywhere in the application window to launch the program menu. By default, when 
the Agent Desktop application starts, it automatically opens the settings file that was 
used last. However, in the event that a settings file was not open when the application 
closed, or it is the first time opening the application after installation, the application 
window is blank when the application starts.  
 

  
Agent Desktop - No Settings File Open Agent Desktop - Settings File Open 
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Because the Agent Desktop application must share the PC 
desktop with other applications, it is very important that it 
maximize the workspace available. To aid in the 
maximization of workspace, the application controls are 
situated in a pop-up menu that is accessed by right-clicking 
in the application window or by right-clicking the Agent 
Desktop icon in the Windows system tray. The menu 
provides access to all of the features and functionality of the 
application. 

 

Adjusting the Window Size and Position 

As long as the Agent Desktop is in a floating state, meaning 
that it is not docked to the PC desktop, it can be resized and 
moved to any location on the PC desktop. Adjust the Agent 
Desktop window to be as small as a few pixels or as large 
as the full desktop. As the window size is adjusted, the font 
size is automatically adjusted to accommodate the new 
window size. 

 
To adjust the window size, move the cursor to the border of the Agent Desktop 
window. When the mouse pointer becomes a double-headed arrow, click and 
hold the left mouse button. Drag the mouse until the Agent Desktop reaches the 
desired size and release the mouse button.   
 
To re-position the Agent Desktop window on the PC desktop, move the mouse 
pointer to any position within the Agent Desktop window. Click and hold the left 
mouse button. Drag the Agent Desktop window to the desired position and 
release the mouse button.  
 

Agent Desktop Display Window: Hide/Restore Versus Always on Top 

Use the Hide/Restore and Always on Top options to control the display of the 
Agent Desktop window.  
 

Hide/Restore 

Select Hide from the program menu to minimize the Agent Desktop application. If 
the application window is already hidden, the Hide menu option is not available 
for selection. When hidden the application is still running in the background, but 
is not visible.  
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There are two methods for viewing the Agent Desktop window when it is hidden: 
 

a. Double-click the Agent Desktop icon in the Windows system tray.  
b. Right-click the Agent Desktop icon in the Windows system tray and select 

Restore from the menu.  
 

Always on Top 

Select Always on Top from the program menu to force the Agent Desktop 
application window to the forefront of the PC desktop at all times. This means 
that the application window can never be covered by another application. When 
the Always on Top option is selected in the program menu, a check mark is 
present beside the menu item.   
 

Creating, Saving, and Opening Agent Desktop Settings 

A settings file is a file that contains the user-defined display parameters for a group of 
statistics selected by the user. Saving the display settings allows the user to open the 
settings file and view the statistics, rather than adding the variables to the window each 
time the application is started. Several settings files may be required to suit different 
users, shifts, and situations. Create any number of settings files to serve every user, 
every shift, and every situation. 

  

Creating a New Settings File 

Use the following steps to create a new settings file. 
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select New Settings from the menu. This action clears the window of any 
variables currently displayed or closes the settings file that is open. The 
user is prompted to save the current settings before any variables are 
cleared or a settings file is closed. 

3. Add the desired variables to the application window. 
4. Save the new settings file. 

 

Saving a New Settings File 

Use the following steps to save a new settings file. 
 

1. Define the desired variables for display in the Agent Desktop window. 
2. Right-click anywhere within the Agent Desktop window to open the 

program menu. 
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3. Select Save Settings As... from the menu to open the Save As dialog box. 
4. Select the desired location for the settings file on the PC or network from 

the Save in: drop-down list. This list provides the available PC and 
network locations for saving the file. The default location for Agent 
Desktop settings files is TASKE/Prefs/AgentDesktop. 

5. Input a name for the settings file in the File name: field. 
6. Ensure the file type in the Save as type: field is: Settings File (*.adt). 
7. Click OK to save the new settings file. 
 

Saving an Existing Settings File 

Use the following steps to save an existing settings file. 
 

1. Change the variable display as desired in the Agent Desktop window. 
2. Right-click anywhere within the Agent Desktop window to open the 

program menu. 
3. Select Save Settings... from the menu to save the file using the same 

name and the same location. If the file is new, the Save Settings... option 
opens the Save As dialog box, prompting the user to input the file name 
and location.  

 

Opening a Settings File 

Use the following steps to open a settings file. 
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select Open Settings... from the menu to open the Open dialog box. 
3. Select the location of the settings file on the PC or network from the Look 

in: drop-down list. This list provides the available PC and network 
locations for saving the file. The default location for Agent Desktop 
settings files is TASKE/Prefs/AgentDesktop. 

4. Select the desired setting file from the list of files. 
5. Click Open to open the settings file in the Agent Desktop window. 
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Adding, Editing, and Deleting ACD Variables 

The Agent Desktop receives real-time, statistical ACD information, or ACD variable 
information, from the Information Server. To display this information in the Agent 
Desktop application window, the user must define each ACD variable and its display 
parameters. The display parameters include setting threshold ranges and the 
corresponding colors for each. Using the thresholds and the colors, the cell for an ACD 
variable is able to change color according to the current threshold range for the ACD 
variable. This color change alerts agents to changes in the conditions of the customer 
interaction center.  
 

Adding ACD Variables to the Agent Desktop Window 

Use the following steps to define the display settings for an ACD variable and 
add it to the Agent Desktop window.  
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select Add Variable For from the menu. A sub-menu opens displaying a 
list of the available Queues and Queue groups. 

3. Select a Queue or Queue Group from the list to open the 
Background/Foreground Colors for ACD Statistic dialog box. 

4. Select a statistic (ACD variable) from the ACD Statistic drop-down list. 
5. Input a name for the ACD variable in the ACD Statistic Name field. A 

default name should already be present in this field. To accept the default 
name, do not enter anything in the field. 

6. Define the ACD variable threshold ranges and colors. Define color 
combinations for up to three threshold ranges. 

7. Click OK to accept the settings for the new ACD variable and display in 
the ACD variable in the Agent Desktop window. 

 

Editing ACD Variables 

Use the following steps to edit the name or display parameters of an ACD 
statistic. 
  

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select Edit Variable from the menu. A sub-menu opens displaying a list of 
the defined ACD variables by Queue/Group.  

3. Select an ACD variable from the list to open the Background/Foreground 
Colors for ACD Statistic dialog box. 

4. Change the ACD variable name as desired. 
5. Change the ACD variable threshold ranges and colors as desired.  
6. Click OK to accept the changes and close the dialog box.  
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Deleting ACD Variables 

Use the following steps to delete an ACD variable. This action removes the ACD 
variable from the Agent Desktop window. 
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select Delete Variable from the menu. A sub-menu opens displaying a list 
of the defined ACD variables by Queue/Group.  

3. Select the ACD variable to delete from the list. The variable is immediately 
removed from the Agent Desktop window. 

 

Defining Thresholds for ACD Variables 

The display parameters for ACD variables include setting threshold ranges and 
the corresponding colors for each. Using the thresholds and the colors, the cell 
for an ACD variable is able to change color according to the current threshold 
range for the ACD variable. This color change alerts agents to changes in the 
conditions of the customer interaction center.  
 
Use the following steps to define the three threshold ranges and the 
corresponding colors for an ACD variable. 
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Perform one of the following actions to open the Background/Foreground 
Colors for ACD Statistic dialog box. 

a. If the process involves adding a new ACD variable, select Add 
Variable For from the menu. A sub-menu opens displaying a list of 
the available Queues and Queue groups. Select a Queue or Queue 
Group from the list to open the Background/Foreground Colors for 
ACD Statistic dialog box. In this case, the user must select an ACD 
statistic and define the ACD variable name prior to defining the 
thresholds and color ranges.  

b. If the process involves editing an existing ACD variable , Select Edit 
Variable from the menu. A sub-menu opens displaying a list of the 
defined ACD variables by Queue/Group. Select an ACD variable 
from the list to open the Background/Foreground Colors for ACD 
Statistic dialog box. 
 

3. Locate the Colors and Thresholds for ACD Statistics area of the dialog 
box. Notice that only the two middle threshold values are editable. The top 
value defines the minimum value for the statistic and the bottom value 
defines the maximum value for the statistic. Depending on the type of 
ACD Statistic selected, the threshold values may be in a time format or a 
numeric format. 
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4. Input the threshold value in the field between Range 1 
and Range 2 to define the first threshold range. This 
threshold range includes all values between the minimum 
value and the value input by the user in the first editable 
field.   

5. Input the threshold value in the field between Range 2 
and Range 3. This defines both the second and third 
threshold ranges. 

a. The second threshold range includes all values 
between the first user-defined threshold value and the second user 
defined threshold value.  

b. The third threshold range includes all values between the second 
user-defined threshold value and the maximum value.  
 

6. If desired, click the Background color box in the Colors for Range 1 
section to open the Color dialog box and change the default background 
color for the ACD variable cell in the Agent Desktop window.  
 

 

 
 
7. Select the desired color for the background of the ACD variable cell in the 

Agent Desktop window.  
8. Click OK to accept the color choice and close the Color dialog box. 
9. If desired, click the Font color box in the Colors for Range 1 section to 

open the Color dialog box and change the default font color for the text in 
the ACD variable cell.  

10. Click OK to accept the color choice and close the Color dialog box. 
11. If desired, repeat steps 7 to 11 in the Colors for Range 2 and the Colors 

for Range 3 sections.  
12. Click OK to accept the thresholds and color ranges and close the 

Background/Foreground Colors for ACD Statistic dialog box. 
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Filtering Cell Information 

Each cell in the Agent Desktop window can display up to six items. These items are:  
 

  

 a state icon 
 the Queue/Group ID 
 the Queue/Group name 
 the Queue/Group nick name 
 the ACD variable name 
 the value of the ACD variable.  

 
Users can choose to display all or none of these items. By default, the state icon, 
Queue/Group ID, Queue/Group name, the ACD variable name, and the ACD variable 
value are displayed. The information selected for display is selected for all cells, these 
settings cannot be defined for individual cells in the Agent Desktop window. 
 

Selecting Cell Information for Display 

Use the following steps to select or de-select cell information for display. 
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select View from the menu. A sub-menu opens displaying the list of items 
available for display. A check mark beside an item in the list means that 
the information is already selected for display.  

3. Select an item from the list.  
a. Selecting an item with a check mark de-selects that item, meaning 

that the information is removed from the cells.  
b. Selecting an item without a check mark selects that item, meaning 

that the information is added to the cells of the Agent Desktop. 
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Docking the Agent Desktop Window to the PC Desktop 

Dock the Agent Desktop window to the PC desktop in a similar manner to any other 
Windows application. A docked application window affixes itself to a particular location 
on the PC desktop and cannot be moved unless it is undocked. The Agent Desktop 
window can dock to any edge of the PC desktop, meaning the top, bottom, right, or left 
of the screen. All other applications resize to fit in the remaining desktop space. The 
only exception to this applies to the grid display. When displayed as a grid, the Agent 
Desktop window cannot be docked to the Windows Desktop. 
 

Docking the Agent Desktop Window 

Use the following steps to dock the Agent Desktop window to the PC Desktop. 
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select Dock from the menu. A sub-menu opens displaying the list of 
window orientations available. These are Left, Right, Top, and Bottom. 

3. Select a window orientation from the menu. The Agent Desktop window 
docks to the selected side of the PC desktop, and resizes/moves all other 
desktop applications to fit. 

 

Undocking the Agent Desktop Window 

Use the following steps to undock the Agent Desktop window from the PC 
Desktop. 
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select Undock from the menu. The Agent Desktop undocks from the 
selected side of the PC desktop, and returns to its original state of floating. 
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Changing the Variable Display 

By default, any variables added to the Agent Desktop are displayed horizontally in the 
order they are created. Users can change the order of the ACD Variables in the Agent 
Desktop window as well as change the orientation of the application window on the PC 
desktop. There are three views for the Agent Desktop. These are Vertical, Horizontal, 
and Grid.  
 

Changing the Display Order of Variables 

Use the following steps to change the display order of the ACD variables in the 
Agent Desktop window. 

 
1. Right-click anywhere within the Agent Desktop window to open the 

program menu. 
2. Select Change Display Order... from the menu to open the Change 

Variable Order dialog box. 
3. Choose an ACD variable from the list of ACD variables.  
4. Change the order of the ACD variable in the list using one of the following 

methods. 
a. Click the ACD variable to move and drag it to the desired location in 

the list.  
b. Select the ACD variable to move and click the up/down arrows in the 

top, left corner of the dialog box to move the ACD variable through the 
list. 

5. Click OK to accept the order of the variables and close the dialog box. 
 

Displaying Variables Horizontally 

Use the following steps to display the variables in the Agent Desktop window 
horizontally. 
 

 
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select Display Variables from the menu. A sub-menu opens displaying a 
list of the orientation settings for the Agent Desktop window.. 

3. Select Across from the sub-menu. The variables automatically rearrange 
to a horizontal configuration within the Agent desktop. 
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Displaying Variables Vertically 

Use the following steps to display the variables in the Agent Desktop window 
vertically. 
 

 

1. Right-click anywhere within the Agent Desktop window 
to open the program menu. 

2. Select Display Variables from the menu. A sub-menu 
opens displaying a list of the orientation settings for the 
Agent Desktop window.. 

3. Select Downward from the sub-menu. The variables 
automatically rearrange to a vertical configuration 
within the Agent desktop. 

  
  

Displaying the Agent Desktop as a Grid 

Use the following steps to display the variables in the Agent Desktop window in a 
grid formation. It is important to note that the Agent Desktop cannot be docked 
when it is displayed as a grid. 
 

 
 

1. Right-click anywhere within the Agent Desktop window to open the 
program menu. 

2. Select Display Variables from the menu. A sub-menu opens displaying a 
list of the orientation settings for the Agent Desktop window.. 

3. Select Grid from the sub-menu open the Agent Desktop Grid Setting 
dialog box. 

4. Input the number of rows and columns for the grid. 
5. Click OK. The variables automatically rearrange to the defined grid 

configuration within the Agent desktop. 
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Changing the Font 

The Agent Desktop uses the same font for all variables displayed in the cells of the 
application window. The font is automatically sized to fit the window. Change the font to 
any installed font on the PC. The standard Windows Font dialog box allows you to 
change the font used to display the ACD variables in the Agent Desktop Window.  
Use the following steps to change the font in the cells of the Agent Desktop window.  
 

1. Right-click anywhere within the Agent Desktop window to open the program 
menu. 

2. Select Change Font... from the menu to open the Font dialog box. .  
3. Select a font from the Font list of installed fonts. The sample section of the dialog 

box provides a preview of the font selected in the list. 
4. Select a style from the Font Style list. The sample section of the dialog box 

provides a preview of the selected font with the selected style applied.  
5. Click OK to select the font settings and close the dialog box. 

 

Exiting from the Agent Desktop Application 

Use the following steps to exit from the Agent Desktop application. 
 

1. Right-click anywhere within the Agent Desktop window to open the program 
menu. 

2. Select Exit from the menu. If the current settings are not saved, the application 
prompts the user to save the settings. Otherwise, the application window closes 
and the program shuts down. 
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TASKE Search 

To effectively manage a call center, supervisors require accurate and current 
information about all activities. The primary activities include handling telephone 
calls and responding to telephone inquiries. A supervisor requires detailed 

information regarding the quantity, distribution, and type of telephone calls handled. 
 
The IWATSU ADIX system tracks call center activities and produces real-time event 
records providing information about all the calls made and received. Every inbound and 
outbound call results in the generation of a basic real-time event record and several 
situations cause the creation of multiple records for the same call. Additional records of 
interest are generated whenever an unsupervised transfer to a Pilot is performed or 
when a call is recalled out of an ACD queue. It is obvious that a single day in a typical 
call center that receives thousands of calls a day produces a vast amount of data. 
 
In some situations it is necessary to examine the raw event records from the PBX. The 
TASKE Search utility allows users to extract specific real-time event records and to 
save them as a .txt file readable by word processing and text editing software 
applications. Examining this smaller, and more manageable, number of records 
simplifies the task of extracting the required information. 
 
To extract the required records from the mass of records created in a day, the TASKE 
Search application provides a powerful and flexible search mechanism that allows users 
to specify call criteria. The search criteria is used to filter the records and produce an 
output of real-time event records for those calls that match the specified conditions. The 
action of the Search program is exclusive and not inclusive, meaning that records failing 
to match the required criteria are excluded. 
 
The Search program uses two filtering methods to find records: an Event Filter and Call 
Type Filter. The Event Filter is used to search for individual records, while the Call Type 
Filter is used to search for specific types of calls.  
 

Using the Search Interface 

The control and use of the TASKE Search utility is exercised through the user interface. 
The TASKE Search interface consists of the Main Window, the Information Window, the 
Information Tabs, and the Menu Bar. 
 

Main Window 

The Main Window acts as a shell for five sub-windows that present call event 
information. The sub-windows housed by the Main Window are the PBX file 
window, the Event Filtered search window, the Call Type search window, the 
Explanation window, and the Sorted window. The PBX file window is the basis 
for the remaining four windows. This window contains all call event records for 
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the selected day. The information in the Event Filtered window, the Call Type 
window, the Explanation window, and the Sorted window are the result of 
conducting searches on the PBX file, requesting an explanation for the call 
events, or sorting the event records contained in the PBX file. Creating a Filter By 
Events opens the Event Filtered search window that contains the search results 
and creating a Filter By Call Type opens the Call Type search window that 
contains the search results. The Explanation window changes the view of the 
PBX file window to include a record description with each call event record. The 
Sorted window sorts the event records in the PBX file by the call ID. Switch 
between the windows using the Information Tabs located at the base of the Main 
Window. 
 

Information Window 

The Information Window opens when a search is conducted or an explanation of 
call records is requested. The Information Window provides a description of the 
type of information in the Main Window. The content of the Information Window 
varies according to the sub-window selected in the Main Window. By default, the 
Information Window is docked vertically, on the right side of the Search program 
interface, but its position is variable. Dock the Information Window to the left side 
of the interface, horizontally, to the top or bottom of the interface, or view it as a 
floating window. To re-situate the Information Window in the Search interface, 
use the mouse to drag the window to the desired screen position and drop it in 
the new position. 
 

Information Tabs 

The Information Tabs are located at the base of the Main Window. Use these 
tabs to select a window for viewing within the Main Window. Selection of a 
window using the Information Tabs also affects the content of the Information 
Window. The availability of the Information Tabs depends on the windows that 
are open in the Main Window. These tabs are the PBX Data tab, the Explanation 
tab, the Sorted tab, the Event Filtered tab, and the Calls Filtered tab. 
 

Menu Bar and Toolbars 

The Menu Bar and Toolbar span the top of the TASKE Search interface. The 
Menu Bar provides keyboard or mouse access to the functions of the TASKE 
Search utility. The Toolbars provide one-click shortcuts to a number of the 
functions accessed via the Menu Bar. The Menu Bar contains six menus: File, 
Edit, View, Tools, Window, and Help. 
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Opening PBX files 

To begin using the TASKE Search utility, open a PBX file. The Search program opens 
standard PBX files (.pbx) and compressed files (.zip). 
 
Use the following steps to open a PBX file. 
 

1. Choose Open from the File menu. 
2. Select a PBX file to open from the \\taske\SiteData\Smdr\ directory. 
3. Click Open. 

 
The PBX Data window opens in the Main Window. The window contains the event 
records for the selected day. 
 
The PBX file naming convention includes the date. For example, IW991012.pbx was 
created on October 12, 1999. 
 

Printing Search Information 

Preview and print the search results for each window individually. The printed page 
includes a header with the window name, date and time and a footer that includes the 
page number. 
 

Print Preview from the Main Window 

Use the following steps to use the Print Preview option to preview and print the 
search results from the Main Window. 
 

1. Select the Information Tab of the window to preview and print. 
2. Select Print Preview from the File menu to open a print preview of the 

selected window. 
3. Use the Next Page, Prev Page, One/Two Page, Zoom In, and Zoom Out 

buttons to view the search results. 
4. Click Print to open the Print dialog box and print the search results or 

Close to exit the print preview window. 
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Printing the Main Window Contents 

Use the following steps to print the contents of the Main Window. 
 

1. Select the Information Tab of the window to print. 
2. Click  on the Toolbar or select Print from the File menu to open the Print 

dialog box. 
3. Select the printer, print range, and the number of copies. 
4. Click OK. 

 

Printing the Information Window Contents 

Use the following steps to print the contents of the Information Window. 
 

1. Select Print Info Window from the File menu or click  on the Search 
Toolbar to open the Print dialog box. 

2. Select the printer, print range, and the number of copies. 
3. Click OK. 

 

Copying Information to the Clipboard 

Copy the event records from any of the windows open in the Main Window to the 
Windows Clipboard. From the Windows Clipboard, the information is available for 
pasting into other applications. 
 
Use the following steps to select several successive records and copy the selection to 
the Clipboard. 
 

1. Select the Information Tab of the window containing the records to copy in the 
Main Window. 

2. Drag the mouse pointer from the beginning of the first record to the end of the 
last record to copy. 

3. Click  or select Copy from the Edit menu to copy the selected records to the 
Clipboard. 

 
Use the following steps to select several non-successive records and copy the selection 
to the Clipboard. 
 

1. Select the Information Tab of the window containing the records to copy in the 
Main Window. 

2. Drag the mouse pointer from the beginning of a record to the end of the record. 
3. Repeat step 2 until all required records are highlighted. 
4. Click  or select Copy from the Edit menu to copy the selected records to the 

Clipboard. 
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Saving Search Information 

Save the results of a search filter as a text file for use with text editing or word 
processing software applications. 
 
Use the following steps to save information from the Main Window as a .txt file. 
 

1. Select the Information Tab of the window to save. 
2. Click  or select Save As from the File menu to open the Main Window - Save 

As dialog box. 
3. Choose the destination directory and type a name for the file. 
4. Click Save. 

 
Use the following steps to save information from the Information Window as a .txt file. 
 

1. Click  or select Save Info Window from the File menu to open the Info Window 
- Save As dialog box. 

2. Choose the destination directory and type a name for the file. 
3. Click Save. 

 

Using the Search Commands 

The commands of the Search applications are available through the menus of the menu 
bar. For speed and convenience, many of these commands are also provided on the 
toolbar. 

Using the File Menu 

The File menu consists of the following commands: 
 

Menu Bar 
Command 

Toolbar 
Button 

Description 

Open  The Open command provides the Open dialog box 
where A PBX file is selected for viewing in the TASKE 
Search interface. PBX files are found in \\taske\smdr\ 
on the PC. 

Close N/A The Close command closes the selected window. To 
close a window, select the desired information tab to 
display the window and choose Close from the File 
menu. The File Info tab is the only information tab that 
does not accept the Close command. 

Save As  The Save As command is used to save the data in the 
currently selected Main Window tab as a text file (.txt). 
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Menu Bar 
Command 

Toolbar 
Button 

Description 

Print 
Preview 

N/A The Print Preview command displays how the 
currently selected Main Window tab will look when 
printed. View multiple pages, magnify or reduce the 
size of the page on the screen, or print the current 
page. 

Print  The Print command sends the currently selected Main 
Window tab to the printer. The Print dialog box 
specifies the print options before printing. 

Save Info 
Window  The Save Info Window command is used to save the 

data in the currently selected Information Window tab 
as a Text file (.txt). The Save Info Window command is 
only available when the Information Window is open. 

Print Info 
Window  The Print Info Window command sends the currently 

active information window to the printer. The Print 
dialog box specifies the print options before printing. 
The Print Info Window command is only available 
when the Information Window is open. 

Exit  
  

The Exit command closes the current search session 
without saving and shuts down the Search utility. The 
Exit button is located in the right corner of the Title 
Bar, directly above the Menu Bar. 

 

Using the Edit Menu 

The Edit menu consists of the following commands: 
 

Menu Bar 
Command 

Toolbar 
Button 

Description 

Copy  The Copy command sends the current selection to the 
Windows clipboard. From the clipboard the selection is 
available to other applications. The Copy command is 
only available when records are selected from any of 
the windows accessed through the Main Window. 
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Using the View Menu 

Use the features of the View menu to customize the Search interface or to 
refresh the display. 
 
Menu Bar 
Command 

 

 
Toolbar 
Button 

N/A 

Description The File Toolbar command enables or disables the toolbar 
view. A check mark indicates the view of the File Toolbar is on. 
The absence of a check mark indicates the view of the toolbar 
is off. The toolbar provides quick access to file related 
commands. 

  
Menu Bar 
Command 

 

 
Toolbar 
Button 

N/A 

Description The Search Toolbar command enables or disables the toolbar 
view. A check mark indicates the view of the Search Toolbar is 
on. The absence of a check mark indicates the view of the 
toolbar is off. The toolbar provides quick access to search and 
display related commands. 

  
Menu Bar 
Command 

 

Toolbar 
Button 

N/A 

Description The Status Bar displays program status information and 
information on the selected window. 
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Menu Bar 
Command 

 

Toolbar 
Button 

N/A 

Description Enabling the Workbook Mode displays the Information Tabs at 
the base of the Main Window. Disabling the Workbook Mode 
hides the Information Tabs and the Window menu on the 
Menu Bar must be used for window selection. 

  
Menu Bar 
Command 

 

Toolbar 
Button  

Description Enabling the Info Window menu item displays the Information 
Window. Disabling this option hides the Information Window 
and the Main Window uses real estate reserved for the 
Information Window. 

  
Menu Bar 
Command 

Refresh Display 

Toolbar 
Button  

Description The Refresh Display command redraws all windows after 
changes made to fonts or colors. 
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Using the Tools Menu 

The Tools menu consists of the following commands: 
 

Menu Bar 
Command 

Toolbar 
Button 

Description 

Sort By Call 
ID  The Sort By Call ID command automatically sorts 

the telephone system data by Call ID. The Sorted 
window opens in the Main Window, containing the 
filtered data. This function is only available when the 
PBX Data tab is selected in the Main Window. 

Explain 
Records  The Explain Records command opens the 

Explanation window in the Main Window. The 
Explanation window changes the view of the PBX 
file window to include a record description with each 
call event record. 

Filter By 
Events  The Filter By Events command opens the Event 

Filter dialog box. Define search parameters for the 
type of event data to search for, including ACD, ICM, 
and COL events. This function is only available 
when the PBX data tab is selected in the Main 
Window. 

Filter By Call 
Type  The Filter By Call Type command opens the Call 

Type Filter dialog box. Define search parameters for 
call types, including: Calls Answered, Abandoned, 
Interflowed, and Overflowed. This function is only 
available when the PBX data tab is selected in the 
Main Window. 

Preferences Use the Preferences command to customize fonts, 
display colors, and define keywords in the Keyword 
list. 
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Using the Window Menu 

The Window menu contains selections that switch between and arrange the sub-
windows of the Main Window. 
 

Menu Bar 
Command 

Toolbar 
Button 

Description 

Cascade N/A The Cascade command layers the open windows in 
the Main Window. 
 

 
Tile N/A The Tile command uses the Main Window area to 

display all of the open windows simultaneously. 
 

 
Arrange 

Icons 
N/A The Arrange Icons command automatically 

arranges the Title Bars of the minimized windows in 
the Main Window. 
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Menu Bar 
Command 

Toolbar 
Button 

Description 

Select 
Window 

N/A The Window Menu displays the windows that are 
open in the Main Window. Only those that are open 
appear on the menu. Use the list to switch between 
the windows. A check mark next to an item indicates 
the current window selection. 
 

 
 

Using the Help Menu 

The Help menu consists of the following commands: 
 

Menu Bar 
Command 

Toolbar 
Button 

Description 

Help 
Contents  The Help Contents command opens the online help 

file for the TASKE Search utility. 

About Search 
Tool 

N/A The About Search Tool command opens the About 
Search Tool dialog box where version and copyright 
information is available for the TASKE Search utility.
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Understanding Call Event Records 

The TASKE Search utility provides a means for call center supervisors to view call 
center activity directly from the records produced by the PBX. These records, though 
somewhat cryptic, provide comprehensive call center information that is searchable. By 
creating search filters, supervisors view only the records that conform to the defined 
search criteria. 
 
Deciphering the information included in a call event record is a difficult task when 
viewing records directly from the PBX. A call event record is a record that describes an 
event occurring within the PBX and its associated phone system. There are three event 
types, ACD events, COL events, and ICM events. The content of call records depends 
on the events the records are reporting. 
 
The first three fields in all event records are the same regardless of the event type. 
These fields are the event code, the time, and the call ID. The remaining information in 
an event record is event specific. 
 
Event Code - each event has a unique identifier known as an event code. The code is a 
four-digit hexadecimal number, meaning that it can include numerical characters from 0 
to 9 and alpha characters from A to F.  
 
Event Time - the event time is the second field in an event record. This field presents 
the time the event occurred using the format of the 24-hour clock. No separators are 
used to differentiate between hours, minutes, and seconds, making 10:45:20 PM 
appear as 224520.  
 
Call ID - the call ID is the third field in an event record. The call ID is a number assigned 
to a call when it enters the system. If an event occurs that is unrelated to a call, this field 
is blank. For those records related to calls, the call ID is any number from 1 to 9999. 
The call ID follows a call from its inception to its termination. When the call is 
terminated, the call ID is available for reuse by new calls entering the system.  
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Identifying ACD Events 

ACD events refer to calls handled through the ACD (Automatic Call Distribution) 
queue. Following are descriptions for all of the ACD event records. These 
descriptions include the event code, the event title, and a description of the 
information the event presents in the format it is presented. The Format section 
of the event descriptions provide a number in parentheses for each field in the 
record. These numbers indicate the maximum number of characters for the field. 
 
Event Code: 3307 

Event: ACD Hold Pickup 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Picking Up (4), Blank Field (4), ACD 
Group Number (4) 

Event Code: 3308 

Event: ACD Incoming Pickup 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Picking Up (4), Blank Field (4), ACD 
Group Number (4) 

Event Code: 330B 

Event: ACD Barge In 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Barging In (4), Blank Field (4), ACD Group 
Number (4) 

Event Code: 330C 

Event: ACD Line Hold 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Holding (4), Blank Field (4), ACD Group 
Number (4) 

Event Code: 330D 

Event: ACD Camp-on 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Originating Station Number (4), Receiving Station Number 
(4), ACD Group Number (4) 
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Event Code: 330E 

Event: ACD Transfer 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Originating Station Number (4), Receiving Station Number 
(4), ACD Group Number (4) 

Event Code: 3315 

Event: ACD Line Disconnect 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Blank Field (4), Blank Field (4), ACD Group Number (4) 

Event Code: 331A 

Event: ACD Incoming Call End 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Blank Field (4), Blank Field (4), ACD Group Number (4) 

Event Code: 333D 

Event: ACD Reply 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Blank Field (4), Blank Field (4), ACD Group Number (4) 

Event Code: 3347 

Event: ACD Holding Status Change 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Hold Type (4), Blank Field (4), ACD Group Number (4) 

Event Code: 3350 

Event: ACD Originating Call 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Blank Field (4), Blank Field (4), ACD Group Number (4) 

Event Code: 3370 

Event: ACD Queue 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Priority (4), Blank Field (4), ACD Group Number (4) 

Event Code: 3371 

Event: ACD Priority 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), New Priority (4), Blank Field (4), ACD Group Number (4) 
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Event Code: 3372 

Event: ACD Expansion 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Expanded ACD Group Number (4), Blank Field (4), ACD 
Group Number (4) 

Event Code: 3373 

Event: ACD Distribution 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Distributed (4), Agent ID Distributed (4), 
ACD Group Number (4) 

Event Code: 3374 

Event: ACD Intercept 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Blank Field (4), Blank Field (4), ACD Group Number (4) 

Event Code: 3375 

Event: ACD Help 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Calling Station Number (4), Called Station Number (4), 
ACD Group Number (4) 

Event Code: 3376 

Event: ACD Help Pickup 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Picking Up (4), Blank Field (4), ACD 
Group Number (4) 

Event Code: 337B 

Event: ACD Forward 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Forwarding Destination (4), Blank Field (4), ACD Group 
Number (4) 

Event Code: 3380 

Event: ACD Help Cancel 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Canceling (4), Blank Field (4), ACD Group 
Number (4) 
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Event Code: 33E2 

Event: ACD Partial Disconnect from Conference 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Dropped (4), Blank Field (4), ACD Group 
Number (4) 

Event Code: 33E3 

Event: ACD Recall 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Recalled (4), Blank Field (4), ACD Group 
Number (4) 

Event Code: 33E4 

Event: ACD Monitor 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Monitoring (4), Blank Field (4), ACD Group 
Number (4) 

Event Code: 0921 

Event: Account Code Registration Executed 

Format: Event Code (4), Time (6), Call ID (4), Station Number (4), 
Account Code (4), Account Code (4), Account Code (4) 

Event Code: 3385 

Event: ACD Emergency Record 

Format: Event Code (4), Time (6), Call ID (4), Trunk/Station Number 
(4), Station Number Operating (4), Blank Field (4), ACD Group 
Number (4) 

Event Code: 3426 

Event: ACD Agent Busy 

Format: Event Code (4), Time (6), Blank Field (4), Station Number (4), 
Blank Field (4), Agent ID (4) 

Event Code: 3427 

Event: ACD Agent Idle 

Format: Event Code (4), Time (6), Blank Field (4), Station Number (4), 
Blank Field (4), Agent ID (4) 
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Event Code: 347D 

Event: ACD Agent Not Available Start 

Format: Event Code (4), Time (6), Blank Field (4), Station Number (4) 

Event Code: 347E 

Event: ACD Agent Not Available End 

Format: Event Code (4), Time (6), Blank Field (4), Station Number (4) 

Event Code: 3530 

Event: ACD Call Wrap-up Start 

Format: Event Code (4), Time (6), Blank Field (4), Station Number (4) 

Event Code: 3532 

Event: ACD Call Wrap-up End 

Format: Event Code (4), Time (6), Blank Field (4), Station Number (4) 

Event Code: 3621 

Event: ACD Mode Change Registration Executed 

Format: Event Code (4), Time (6), Blank Field (4), ACD Mode (4), 
Blank Field (4), Blank Field (4), ACD Group Number (4) 

Event Code: 3721 

Event: Qualification Code Registration Executed 

Format: Event Code (4), Time (6), Blank Field (4), Station Number 
Executing (4), Qualification Code (4) 

Event Code: 3821 

Event: Agent Login 

Format: Event Code (4), Time (6), Blank Field (4), Station Number 
Executing (4), Agent Priority (4), Agent ID (4), ACD Group 
Number (4) 

Event Code: 3822 

Event: Agent Logout 

Format: Event Code (4), Time (6), Blank Field (4), Station Number 
Executing (4), Blank Field (4), Agent ID (4), ACD Group 
Number (4) 
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Event Code: 3921 

Event: Supervisor Login 

Format: Event Code (4), Time (6), Blank Field (4), Station Number 
Executing (4), Blank Field (4), Supervisor ID (4), ACD Group 
Number (4) 

Event Code: 3922 

Event: Agent Logout 

Format: Event Code (4), Time (6), Blank Field (4), Station Number 
Executing (4), Blank Field (4), Supervisor ID (4), ACD Group 
Number (4) 

Event Code: 4121 

Event: ACD Call Sequence Change 

Format: Event Code (4), Time (6), Blank Field (4), Station Number 
Operating (4), Sequence Mode (4), New Sequence Number 
(4), ACD Group Number (4) 

 

Identifying COL Events 

COL events refer to inbound and outbound calls involving a central office line. 
Following are descriptions for all of the COL event records. These descriptions 
include the event code, the event title, and a description of the information the 
event presents in the format it is presented. The Format section of the event 
descriptions provide a number in parentheses for each field in the record. These 
numbers indicate the maximum number of characters for the field. 
 
Event Code: 0101 

Event: Outgoing Seizure 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4) 

Event Code: 0107 

Event: Hold Pickup 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4) 
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Event Code: 0108 

Event: Incoming Pickup 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4) 

Event Code: 010B 

Event: Barge In 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4) 

Event Code: 010C 

Event: Line Hold 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4), Hold Type (4) 

Event Code: 010D 

Event: Camp-on 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), 
Originating Station Number (4), Receiving Station Number (4) 

Event Code: 010E 

Event: Transfer 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), 
Originating Station Number (4), Receiving Station Number (4) 

 Event Code: 010F 

Event: Line Add-on 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Adding 
Station Number (4), Station Number Added (4) 

Event Code: 0112 

Event: Outgoing Dialing 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Number 
Dialed (4), Number Dialed (4), Number Dialed (4) 

Event Code: 0115 

Event: Line Disconnect 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4) 
 
 



TASKE Call Center Management Tools            

 
- 276 - 

Event Code: 0119 

Event: Incoming Call Start 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4) 

Event Code: 011A 

Event: Incoming Call End 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4) 

Event Code: 0147 

Event: Holding Status Change 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Hold 
Type (4) 

Event Code: 014C 

Event: Incoming Call to Pilot 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number Old Ringing (4), Station Number Ringing (4) 

Event Code: 0152 

Event: Call Forward No Answer 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), 
Forward From Station Number (4), Forward To Station Number 
(4) 

 Event Code: 01E2 

Event: Partial Disconnect from Conference 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4) 

Event Code: 01E3 

Event: Recall 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4) 

Event Code: 01E4 

Event: Line Monitoring 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Station 
Number (4) 



TASKE Call Center Management Tools            

 
- 277 - 

Event Code: 01E5 

Event: Outgoing Dialing End 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4), Number 
Dialed (4), Number Dialed (4), Number Dialed (4) 

Event Code: 9126 

Event: Trunk Busy 

Format: Event Code (4), Time (6), Call ID (4), Station Number (4) 

Event Code: 9127 

Event: Trunk Idle 

Format: Event Code (4), Time (6), Call ID (4), Station Number (4) 

Event Code: 4086 

Event: Number Identification Start 

Format: Event Code (4), Time (6), Call ID (4), Station Number (4), 
Information (12) 

Event Code: 40E5 

Event: Number Identification Stop 

Format: Event Code (4), Time (6), Call ID (4), Station Number (4), 
Information (12) 

 Event Code: 4819 

Event: Abandoned Call Status 

Format: Event Code (4), Time (6), Call ID (4), Trunk Number (4) 
 

Identifying ICM Events 

ICM events refer to internal calls. Following are descriptions for all of the ICM 
event records. These descriptions include the event code, the event title, and a 
description of the information the event presents in the format it is presented. The 
Format section of the event descriptions provide a number in parentheses for 
each field in the record. These numbers indicate the maximum number of 
characters for the field. 
 
Event Code: 0207 

Event: Hold Pickup 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Station Number (4) 
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Event Code: 0208 

Event: Incoming Pickup 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Station Number (4) 

Event Code: 020B 

Event: Barge In 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Station Number (4) 

Event Code: 020C 

Event: Line Hold 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Station Number (4) 

Event Code: 020D 

Event: Camp-on 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Originating Station 
Number (4), Receiving Station Number (4)

Event Code: 020E 

Event: Transfer 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Originating Station 
Number (4), Receiving Station Number (4)

Event Code: 020F 

Event: Line Add-on 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Adding Station Number 
(4), Station Number Added (4) 

Event Code: 0215 

Event: Line Disconnect 

Format: Event Code (4), Time (6), Call ID (4) 

Event Code: 0219 

Event: Incoming Call Start 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Station Number (4) 
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Event Code: 021A 

Event: Incoming Call End 

Format: Event Code (4), Time (6), Call ID (4), 
Station Number (4) 

Event Code: 0247 

Event: Holding Status Change 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Hold Type (4) 

Event Code: 024C 

Event: Incoming Call to Pilot 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Station Number Old 
Ringing (4), Station Number Ringing (4) 

Event Code: 0250 

Event: Originating Call 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Calling Station Number 
(4), Called Station Number (4) 

Event Code: 0252 

Event: Call Forward No Answer 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Forward From Station 
Number (4), Forward To Station Number 
(4) 

Event Code: 02E2 

Event: Partial Disconnect from Conference 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Station Number (4) 

Event Code: 02E3 

Event: Recall 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Station Number (4) 
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Event Code: 02E4 

Event: Line Monitoring 

Format: Event Code (4), Time (6), Call ID (4), 
Blank Field (4), Station Number (4) 

Event Code: 9026 

Event: Station Busy 

Format: Event Code (4), Time (6), Call ID (4), 
Station Number (4) 

Event Code: 9027 

Event: Station Idle 

Format: Event Code (4), Time (6), Call ID (4), 
Station Number (4) 

Event Code: 0A33 

Event: Forward Activate 

Format: Event Code (4), Time (6), Blank Field (4), 
Station Number (4) 

Event Code: 0A34 

Event: Forward Deactivate 

Format: Event Code (4), Time (6), Blank Field (4), 
Station Number (4) 

Event Code: 0D33 

Event: DND Activate 

Format: Event Code (4), Time (6), Blank Field (4), 
Station Number (4) 

Event Code: 0D34 

Event: DND Deactivate 

Format: Event Code (4), Time (6), Blank Field (4), 
Station Number (4) 
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Sorting Records by Call ID 

The call ID is a number from 1 to 9999 that is assigned to a call when it enters 
the system. The number follows the call from its inception to its termination. 
When the call is terminated, the call ID is available for reuse by new calls 
entering the system. 
 
The call ID occupies the third field in call event records. The number assigned for 
the call ID is right justified in the call ID field and depending on the number 
assigned for the call ID, the field may display one to four digits. For instance, the 
call ID field displays three blank spaces and a 3 for a call ID of three. If an event 
record is not associated with a call the field is blank. 
 

 
 
Sorting call records by call ID displays the events that occur within a call 
chronologically, however, the calls themselves are not displayed chronologically. 
Because the call IDs are reused, the Sorted window displays all calls with a call 
ID of 1 before displaying the calls with a call ID of 2 and so on, up to 9999. To 
find the beginning and ending of a call, look for the event codes that identify 
these events. Every event between the events describing the inception and 
termination of a call describe the call activity. 
 
Sort call event records using the Sort By Call ID command. This command can 
only be used from the PBX file window that contains all of the event records in 
the open .pbx or .zip file. This means that when the records are sorted by call ID, 
the Sorted window contains all records in the file except those that are not 
associated with a call. 
 

Opening the Sorted Window 

The call ID is a number from 1 to 9999 that is assigned to a call when it enters 
the system. The number follows the call from its inception to its termination. 
When the call is terminated, the call ID is available for reuse by new calls 
entering the system. Sort call event records using the Sort By Call ID command. 
This command can only be used from the PBX file window that contains all of the 
event records in the open .pbx or .zip file. 
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Use the following steps to sort call event records by call ID. 
 

1. Click the PBX Data tab in the Main Window to view the PBX file window. 
2. Click  or select Sort By Call ID from the Tools menu to open the Sorted 

window and view the sorted records. 
 

Completing these steps when a Sort By Call ID has already been performed 
simply changes the view from the PBX file window to the Sorted window without 
performing the sort again. 
 

Explaining Call Records 

The Explanation window displays the call event records in the open .pbx or .zip 
file with event descriptions. In the Explanation window all event records 
encompass two lines. The first line includes the record contents as displayed in 
the PBX file window. The second line includes the record association in square 
brackets and the translation of this association in understandable terminology. 
 

 
 
Open the Explanation window using the Explain Records command. This 
command can only be used from the PBX file window that contains all of the 
event records in the open .pbx or .zip file. 
 

Opening the Explanation Window 

The Explanation window displays the call event records in the open .pbx or .zip 
file with event descriptions. Open the Explanation window using the Explain 
Records command. This command can only be used from the PBX file window 
that contains all of the event records in the open .pbx or .zip file. 
 
Use the following steps to sort call event records by call ID. 
 

1. Click the PBX Data tab in the Main Window to view the PBX file window. 
2. Click  or select Explain Records from the Tools menu to open the 

Explanation window and view the records with the event descriptions. 
 

Completing these steps when the Explain Records operation has already been 
performed simply changes the view from the PBX file window to the Explanation 
window without performing the operation again. 
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Filtering Call Records by Event 

An Event Filter provides event related search results based on user-defined search 
parameters. The search parameters are defined in the Event Filter dialog box. 
 
Use the following steps to open the event filter dialog box. 
 

1. Click the PBX data tab in the Main Window to display the PBX file window. 
2. Click  or select Filter By Events from the Tools menu. 

 

 
 
Using the Event Filter dialog box, select the events to include in the search filter. The 
events are categorized by type: ACD, ICM, and COL events. Include all of the events in 
the search filter or use any combination of the 72 events available in the list of events. 
To further refine the search results, use the Pattern Search option or the Additional 
Filters section of the dialog box. The Pattern Search option searches for the occurrence 
of specific alphanumeric patterns in the call records. Using the Additional Filters section 
define a range of time to include only the records occurring within that time period and, 
if desired, identify a specific agent group, agent number, trunk, extension, and call ID to 
search for records including those entities. 
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Selecting Events 

When performing an Event Filter search, identify the events to include in the 
search filter. Use the Events section of the Event Filter dialog box to select the 
events. Select individual events in the events list or select events by type. 
 

The events are categorized by type: ACD, ICM, and 
COL events. Include all of the events in the search filter 
or use any combination of the 72 events available in the 
list of events. 

 
Enabling a check box for an event type automatically 
enables all of the check boxes for that event type in the 
event list. Enable the All Events check box to enable 
the check boxes for all events in the event list. Disabling 
an event type disables the check boxes for those 
events in the event list. For instance, enabling the 

check boxes for ACD Events and ICM Events automatically enables the check 
boxes for those event types in the event list. At the same time, all of the check 
boxes for the COL Events are disabled and excluded from the search filter. 
 
Use the following steps to select events for an event filter. 
 

1. Enable the check boxes of the event types to include in the filter. 
2. Enable the check boxes of any additional events to include in the filter 

from the event list. 
3. Disable the check boxes of any events to exclude from the filter from the 

event list. 
4. Set any additional search parameters in the Pattern Search or Additional 

Filters sections of the dialog box. 
5. Click OK. 

 
The events in the event list are listed according to the event types. ACD events 
are first, COL events are second, and ICM events are third. 
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Searching for a Pattern 

Use the Pattern Search section of the Event Filter dialog box to search for a 
specific alphanumeric string of characters occurring in call records. For instance, 
input T067S065 to find records where these alphanumeric characters appear 
together. The search results of this search filter will include all of events selected 
from the event list that include trunk number 067 (T067) and extension number 
065 (S065) appearing together. 
 

Use the .. and ? wildcards when unsure of the specific 
character string. The ? wildcard is a place filler. For 
each ? used, there must be a value to fill the space. For 

example, entering 11??092 matches any record that has 11, followed by any two 
characters, and 092. The .. wildcard is similar to the ? wildcard, except there is 
no limit to the number of characters the .. represent. For example, entering 
11..092 matches any record that has a 11, followed by any number of characters, 
and 092. 
 
Use the following steps to search for a pattern in call records. 
 

1. Enable the Search for Pattern check box. 
2. Input the pattern. Note that the alpha characters are case sensitive. 
3. Select the events to include in the search filter. 
4. Click OK. 

 
Enabling the Pattern Search disables the Additional Filters section of the dialog 
box. These filters cannot be used simultaneously. 
 

Using Additional Filters 

Use the Additional Filters section of the Event Filter dialog box to refine an Event 
Filter based on the time events occurred and the entities involved in the events. 
 

Use the Start Time and End Time boxes to define the 
time range of the events to include in the filter. For 
instance, setting a start time of 8:00:00 AM and an end 
time of 5:00:00 PM will result in a search filter that 
includes all records for the selected events that 
occurred between 8 AM and 5 PM. 

 
To search for records that include specific entities, use 
the Agent Group, Agent #, Trunk, Call ID, and 
Extension boxes to input the identification numbers of 
the entities to include in the search filter. Normally only 

one or two of these entities are included in a search filter. This is because the 
search filter returns only records that include all of the defined entities. 
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Use the following steps to set the time range. 
 

1. Click the hour field in the Start Time box and input a number from 1 to 12. 
2. Click the minute field in the Start Time box and input a number from 00 to 

59. 
3. Click the seconds field in the Start Time box and input a number from 00 

to 59. 
4. Click the AM/PM field in the Start Time box and input A or AM or P for PM. 
5. Repeat steps 1 to 4 in the End Time box, making the End Time later than 

the Start Time. 
6. Select the events to include in the search filter. 
7. Click OK. 

 
Use the following steps to identify specific entities. 
 

1. Click the input box of the desired entity. 
2. Input a value. Use numeric characters only. 
3. Repeat steps 1 and 2 for any additional entities to include in the search 

filter. 
 
Enabling the Pattern Search disables the Additional Filters section of the dialog 
box. These filters cannot be used simultaneously. 
 

Filtering Call Records by Call Type 

A Call Type Filter provides call handling related search results based on user-defined 
search parameters. The search parameters are defined in the Call Type Filter dialog 
box. 
 
Use the following steps to open the call type filter dialog box. 
 

1. Click the PBX data tab in the Main Window to display the PBX file window. 
2. Click  or select Filter By Call Type from the Tools menu. 
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Using the Call Type Filter dialog box, define the call handling search parameters to 
include in the search filter. The Call Type Filter dialog box is comprised of four sections: 
Call States, Include Records Between, Call Types, and DataBase Members. Use the 
Call States section to include a call state in the search filter and to define a time range 
for the state. Use the Include Records Between section to establish a time of day time 
range for the events. Use the Call Types section to select the types of calls to include in 
the search filter. Use the DataBase Members section to search for call records handled 
by specific entities within the system. After defining all of the required search 
parameters in the four sections of the dialog box, click OK to proceed with the search 
operation. 
 

Selecting the Call State 

The Call States section of the Call Type Filter dialog box 
narrows the search by Calls Answered, Abandoned, 
Interflowed, or Overflowed. For each Call Type Filter 
operation, only one call state can be used. When 
selecting a call state to include in a Call Type Filter, 
define a time range for the call state. For instance, 
selecting the Calls Answered state and defining a time 
range of 00:01:30 to 00:05:00 results in a search filter 
that includes the calls that were answered after waiting a 
minimum of one minute and thirty seconds, but not more 
than five minutes. 

 
 
Use the following steps to select a call state and define a time frame. 
 

1. Select the radio button of the desired call state. 
2. Click the hour field in the first time box and input a number from 1 to 23. 
3. Click the minute field in the first time box and input a number from 00 to 

59. 
4. Click the seconds field in the first time box and input a number from 00 to 

59. 
5. Repeat steps 2 to 4 in the second time box, to set the upper end of the 

time range. 
6. Define any additional parameters to include in the search filter in the 

Include Records Between, Call Types, and DataBase Members sections 
of the dialog box. 

7. Click OK. 
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Selecting the Time Period 

Use the Start Time and End Time boxes in the Include Records Between section 
of the Call Type Filter dialog box to define the time range of the events to include 
in the filter. For instance, setting a start time of 9:00:00 AM and an end time of 
5:00:00 PM results in a search filter that includes records between 9 AM and 5 
PM. 
 

 
 
Use the following steps to set the time range. 
 

1. Click the hour field in the Start Time box and input a number from 1 to 12. 
2. Click the minute field in the Start Time box and input a number from 00 to 

59. 
3. Click the seconds field in the Start Time box and input a number from 00 

to 59. 
4. Click the AM/PM field in the Start Time box and input A or AM or P for PM. 
5. Repeat steps 1 to 4 in the End Time box, making the End Time later than 

the Start Time. 
6. Define any additional parameters to include in the search filter in the Call 

States, Call Types, and DataBase Members sections of the dialog box. 
7. Click OK. 

 

Selecting the Call Type 

Use the Call Types section of the Call Type Filter dialog box to select the call 
types to include in the search filter. There are three call types: ACD, Non ACD, 
and OutBound. To obtain search results select at least one call state. 
 

 
 
Use the following steps to select the call types to include in a search filter. 
 

1. Enable the check boxes of the call types to include in the search filter. 
2. Disable the check boxes of the call types to exclude from the search filter. 
3. Define any additional parameters to include in the search filter in the Call 

States, Include Records Between, and DataBase Members sections of the 
dialog box. 

4. Click OK. 
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Selecting Database Members 

The Database Members section of the Call Type Filter dialog box narrows the 
search by searching for events based on specific entities handling the calls. 
These entities are trunks, extensions, or ACD queues. Normally only one or two 
of these entities are included in a search filter. This is because the search filter 
returns only records that include all of the defined entities. 
 

 
 
Use the following steps to identify specific entities for a call type search filter. 
 

1. Click  for the desired type of entity. 
2. Select the entity from the drop-down list. 
3. Repeat steps 1 and 2 for any additional entities to include in the search 

filter. 
4. Define any additional parameters to include in the search filter in the Call 

States, Include Records Between, and Call Types sections of the dialog 
box. 

5. Click OK. 
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TASKE Chat 

TASKE Chat is a feature that is accessible through the ACD Monitor and Agent Desktop 
applications. Chat provides agents and supervisors with the ability to communicate 
using PCs over the local area network. Agent chat sessions are conducted on a one-to-
one basis. Supervisor chat sessions are also conducted on a one-to-one basis, but 
supervisors also have the ability to broadcast messages to everyone logged into 
TASKE Chat at the local site. 
 
When an agent or supervisor is logged into Chat an icon is present in the Windows 
System Tray. The icon displayed depends on the state of the Chat application. The 
table below illustrates the icons that may represent the Chat application in the Windows 
system tray and explanations for their presence. 
 
Symbol Description 

 This icon represents the Chat application in the Windows system tray when 
the agent or supervisor is logged into Chat and there are no individuals 
requesting chats or unread messages. 

 
This icon represents the Chat application in the Windows system tray when 
the agent or supervisor is logged into Chat and there is one or more 
individuals requesting a chat or there are unread messages for the agent 
or supervisor. 

 
Use the Chat icon in the Windows System Tray to open the Chat window and access 
the Chat functions. To open the window using the icon in the System Tray, right-click on 
the icon and select Chat from the menu.  
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Logging Into and Out of Chat from the ACD Monitor 

Supervisors are automatically logged into Chat when the ACD Monitor application is 
launched, but the TASKE Chat application window is not opened. Supervisors can log-
off the Chat application and log back in without exiting and restarting the ACD Monitor. 
 

Logging Out of Chat 

There are three methods for logging out of the Chat application. 
 
Method Description 

 
1. Select Logoff from the Chat menu at the top of the TASKE Chat 

application window. The application window closes and the user 
is logged out. 

 2. Right-click the Chat icon in the Windows system tray. When a 
user is logged into the Chat application an icon is visible in the 
Windows system tray. Right-click this icon to produce a menu. 
Select Logoff from the menu to log out of the Chat application 
and close the TASKE Chat window. 

 

3. Select Logoff from the Chat menu of the ACD Monitor 
application. The TASKE Chat application window closes and the 
user is logged out. 

 

Logging into Chat 

To log into Chat from the ACD Monitor, select Logon from the Chat 
menu. The user is logged into the Chat application but the TASKE 
Chat window does not open. The presence of the Chat icon in the 
Windows system tray indicates that the user is logged on. 

 
 
 
 
 
 
 
 
 
 
 
 



TASKE Call Center Management Tools            

 
- 292 - 

Opening the Chat Window from the ACD Monitor 

To open the TASKE Chat window from the ACD Monitor, the user must already be 
logged into the Chat application. Once logged into the Chat application, the TASKE 
Chat window can be opened using one of two methods. 

 
Method Description 

 

1. Select Chat from the Chat menu of the ACD Monitor application. This 
menu option is not available if the user is not logged into the Chat 
application. 

 2. Right-click on the Chat icon in the Windows system tray. When a user is 
logged into the Chat application an icon is visible in the Windows 
system tray. Right-click on this icon to produce a menu. Select Chat 
from the menu to open the TASKE Chat window. 

 

Logging Into and Out of Chat from the Agent Desktop 

Agents are automatically logged into Chat when the Agent Desktop application is 
launched, but the TASKE Chat application window is not opened. Agents can log-off the 
Chat application and log back in without exiting and restarting the Agent Desktop. 
 

Logging Out of TASKE Chat 

There are three methods for logging out of the Chat application from the Agent 
Desktop. 
 
Method Description 

 
1. Select Logoff from the Chat menu at the top of the TASKE Chat 

application window. The TASKE Chat application window closes 
and the user is logged out. 

 2. Right-click on the Chat icon in the Windows system tray. When 
a user is logged into the Chat application an icon is visible in the 
Windows system tray. Right-click on this icon to produce a 
menu. Select Logoff from the menu to log out of the Chat 
application and close the TASKE Chat window. 

 

3. Select Logoff from the Chat sub-menu of the Agent Desktop 
application. The TASKE Chat application window closes and the 
user is logged out. 
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Logging into TASKE Chat 

To log into Chat from the Agent Desktop, select Logon from the Chat 
menu. The user is logged into the Chat application but the TASKE 
Chat window does not open. The presence of the Chat icon in the 
Windows system tray indicates that the user is logged on. 

  

Opening the Chat Window from Agent Desktop 

To open the Chat window from the Agent Desktop, the user must already be logged into 
the Chat application. Once logged into the Chat application, the TASKE Chat window 
can be opened using one of two methods. 
 
Method Description 

 

1. Select Chat from the Chat sub-menu of the Agent Desktop 
application. This menu option is not available if the user is not 
logged into the Chat application. 

 2. Right-click on the Chat icon in the Windows system tray. When a 
user is logged into the Chat application an icon is visible in the 
Windows system tray. Right-click on this icon to produce a menu. 
Select Chat from the menu to open the TASKE Chat window. 

 

Using the Chat Interface 

The Chat window is opened from within the ACD Monitor or Agent Desktop applications. 
A user must be logged into Chat before the Chat application window can be opened. 
The application window consists of a menu bar and three panels. 
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Menu Bar 

The menu bar in the Chat window contains two menus. These menus are Chat 
and Help. 
 
The Chat menu contains two options: Logoff and Close. Select Logoff to log-off 
the Chat Server and close the Chat application window. The user will no longer 
be available to send or receive chat requests. Select Close to close the Chat 
application window without logging out of the Chat Server. The user is still 
available to accept chat requests. 
 
The Help menu contains one option: Contents. Select Contents to open the 
online help for the TASKE Chat application. 
 

Contact Panel 

The Contact Panel in the Chat window spans the left side of the application 
window. This area is responsible for initiating chat requests, controlling multiple 
chat sessions, maintaining the list of frequently called contacts, and accessing 
the list of all available contacts. 
 

Chat Panel 

The Chat Panel in the Chat window is located in the upper, right quadrant of the 
application window. This area displays the text for both parties involved in a chat 
session. Each time a message is posted by one of the parties, it is instantly 
displayed in the Chat Panel with the name of the individual posting the message. 
If multiple chat sessions are occurring simultaneously, the user selects the 
contact name from the Contact List to display the messages posted for that 
conversation in the Chat Panel. The heading for the Chat Panel states "Chat 
session with Name of Individual" to indicate the identity of the other party. 
 

Outgoing Message Panel 

The Outgoing Message panel in the Chat window is located in the lower, right 
quadrant of the application window. This is the input area for typing and posting 
outgoing messages. The heading for the Outgoing Message Panel states 
"Outgoing Message to Name of Individual" to indicate the intended recipient of 
the message. 
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Maintaining the Contact List 

The Contact Panel in the TASKE Chat window consists of a Contact List and the tools 
required to maintain the list. The Contact List is required to initiate and accept chat 
requests, switch between concurrent chat sessions, and to end chat sessions. 
The Contact List contains the names and chat availability status of those added to the 
list by the user and those who have requested a chat from the user. The list is 
maintained using the Add... and Remove buttons. 
 

Adding Contacts to the Contact List 

Contacts are added to the Contact List in one of two ways. The first method is 
through a chat request. When an individual who is not on the Contact List 
requests a chat, the name of the individual is automatically added to the Contact 
List. The name of the individual must be selected to accept or reject the chat 
request. The second method for adding a contact to the Contact List is to 
manually add an individual's name from the Add to Contact List dialog box. 
 
Use the following steps to add a contact to the Contact List using the Add to 
Contact List dialog box. 
 

1. Click Add... on the Contact panel to open the Add to Contact List dialog 
box. 

2. Select a contact from the list by clicking on the name of the individual. A 
contact is selected when the name of the individual is highlighted in blue. 

3. Click Add Contact to add the contact name to the Contact List. If the name 
is already on the list it will not be added a second time. 

 
To quickly find a contact in the Add to Contact List dialog box, type the name of 
the contact in the 'Search for:' box to have the list scroll to that name. 
The Add to Contact List dialog box displays only those agents and supervisors 
currently logged into Chat through the ACD Monitor or the Agent Desktop. 
 

Removing Contacts from the Contact List 

The Contact List can contain an unlimited number of contacts, however, it is most 
efficiently used as a list of most frequently called contacts. When unwanted 
contacts are cluttering the Contact List, remove them using the Remove button. 
 
Use the following steps to remove unwanted contacts from the Contact List. 

 
1. Select the name of the contact to remove from the Contact List. 
2. Click Remove. The name of the contact is removed from the list.  
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Understanding Contact Status Symbols 

Icons beside the names of the individuals in the Contact List illustrate the status of the 
individuals. The table below provides the icons and explanations of their meanings. 
 

Symbol Description 

 The individual is logged into Chat and is available to participate in a chat 
session. 

 The individual is not logged into Chat and cannot participate in a chat 
session. 

 A call is pending with this individual, but the chat request has not been 
accepted or rejected. 

 
The individual is requesting a chat session. 

 A chat is in session with this individual. The name of the individual in the 
Contact List is displayed in bold whenever an unread message is posted. 

   

Requesting a Chat 

To request a chat with another individual, the name of the individual must be on the 
Contact List and the contact must be logged into Chat. The icon beside the individual's 
name in the Contact list indicates the availability of the individual to accept a chat: 
 
Icon Description 

 The individual is logged into Chat and is available to participate in a chat 
session. 

 The individual is not logged into Chat and cannot participate in a chat session. 

 

To Send a Chat Request to an Individual 

Use the following steps to request a chat session with another individual who is 
logged into Chat. 

 
1. Select the name of the individual to contact in the Contact List. The 

Request a Chat button appears below the Outgoing Message Panel. 
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2. Click Request a Chat. The Chat Panel displays the name of the requester 
and a "Call pending..." message. The icon beside the name of the 
individual being contacted indicates that a call is pending. 
 
Icon Description 

 A call is pending with this individual, but the chat request has not 
been accepted or rejected. 

 
3. If the individual accepts the chat request, the Chat Panel displays the 

name of the individual accepting the chat request and a "Chat call was 
accepted." message. The icon beside the name of the individual accepting 
the chat request indicates that a chat is in session. 
 
Icon Description 

 A chat is in session with this individual. The name of the individual 
in the Contact List is displayed in bold whenever an unread 
message is posted. 

 
If the individual rejects the chat request, the Chat Panel displays the name 
of the individual rejecting the chat request and a "Chat call was rejected." 
message. 
 

Accepting or Rejecting a Chat Request 

A chat request from another party is recognized in two ways. 
 

1. The Chat window comes to the forefront of all other applications and the Chat 
Request dialog box pops up indicating who is requesting the chat. 
 

 
 

2. The name of the individual requesting a chat is automatically selected in the 
Contact List and the icon indicates that a chat request is pending. 
 
Icon Description 

 
The individual is requesting a chat session. 
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To Accept a Chat Request 

Use the following step to accept a chat request. 
 

1. Click Accept in the Chat Request dialog box. The Chat Panel displays the 
name of the individual accepting the chat request and a "Chat call was 
accepted." message. The icon beside the name of the individual who 
requested the chat indicates that a chat is in session. 
 
Icon Description 

 A chat is in session with this individual. 

 

To Reject a Chat Request 

Use the following step to reject a chat request. 
 

1. Click Reject in the Chat Request dialog box. The Chat Panel displays the 
name of the individual rejecting the chat request and a "Chat call was 
rejected." message. The icon beside the name of the individual who 
requested the chat returns to the logged in and available state. 
 
Icon Description 

 The individual is logged into Chat and is available to participate 
in a chat session. 

 

Broadcasting a Message - Supervisors Only 

Supervisors can broadcast messages to all individuals logged into Chat. Agents can 
respond to a broadcast message, but they cannot send a broadcast message. This is a 
useful feature for reaching all agents quickly. 
 

To Broadcast a Message 

Use the following steps to send a broadcast message. Broadcast messages can 
only be sent by Supervisors using the ACD Monitor to access Chat. 
 

1. Select <Broadcast> from the Contact List. 
 
Icon Description 

 The contact ID for all individuals logged into Chat. 
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2. Type the message in the Outgoing Message Panel and press Enter to 
send the message. 

3. The Chat Panel displays the name of the individual sending the broadcast 
message and the message text. 

 
To type more than one line of text in the Outgoing Message Panel, use 
CTRL+Enter to move to the next line. When ready to send the message, simply 
press Enter. 
 

Receiving Broadcast Messages 

Supervisors can broadcast messages to all individuals logged into Chat; agents and 
other supervisors. For supervisors, broadcast messages are received in the ACD 
Monitor dialog box. For agents, broadcast messages are received in the Agent Desktop 
dialog box.  
 

 
 
Clicking OK in the dialog box acknowledges receipt of the message and the message is 
posted on the Chat Panel. To review these messages, select <Broadcast> from the 
Contact List. 

 

Conducting a Chat Session 

Although an individual can participate in several chat sessions simultaneously, each 
chat session is conducted on a one-to-one basis. Conversing with another individual in 
a chat session consists of sending and receiving messages that are posted on the Chat 
Panels of both parties. After a chat request is accepted, the parties involved are free to 
send and receive messages. 
 

To Send an Outgoing Message 

Use the following steps to send a message to the selected individual. 
 

1. Select the name of the other participant in the chat from the Contact List. 
2. Type the message in the Outgoing Message Panel. 
3. Press Enter to send the message. The sender's name and the message 

are posted on the Chat Panel for both the sender and receiver of the 
message. 
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To type more than one line of text in the Outgoing Message Panel, use 
CTRL+Enter to move to the next line. When ready to send the message, simply 
press Enter. 
 

Receiving Incoming Messages 

Incoming messages are immediately posted to the Chat Panel of the individual 
receiving the message. If the receiver does not have the sender's name selected 
in the Contact List, the sender's name is displayed in bold print in the Contact List 
to indicate that an unread message is waiting. Select the name of the sender in 
the Contact List to display the Chat Panel for the sender and read the message. 
 

Switching between Chat Sessions 

An individual can conduct an unlimited number of chat sessions simultaneously. 
The Contact List provides the means for switching between the conversations. 
 
To display the chat session for a particular individual, simply click that person's 
name in the Contact List. Once the individual is selected a user can read a 
message, post a message, or end the chat. 
 
After a chat is ended, the conversation is not erased unless the user logs out of 
Chat. To review a conversation that has ended, click on the name of the 
individual involved in the chat and read the messages in the Chat Panel. 
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Save Time Using Copy and Paste 

In many cases it may be necessary to repeat the same message to many people, 
without broadcasting the message to everyone, or to make a quick correction to a 
message that has already been sent to another individual. The Chat application 
provides a Copy feature for the Chat Panel and a Paste feature for the Outgoing 
Message Panel that allows users to copy information from the Chat Panel and paste it 
into the Outgoing Message Panel. Using these features a user can send the same 
message to several people without retyping the message or make a quick correction to 
a sent message and resend it with the correct information. 
 

Copying Text in the Chat Panel 

The image below illustrates the process of copying the text in the Chat Panel. In 
the image, Jen has sent some new pricing information to the staff. Unfortunately, 
she has provided the wrong unit ranges for the pricing. Instead of retyping this 
message, Jen can simply copy the text in the Chat Panel, paste it into the 
Outgoing Message Panel, make the correction, and resend the message without 
retyping all of the text. 
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There are two methods for selecting and copying the text in the Chat Panel. 
These are to select and copy all of the text in the Chat Panel or to select and 
copy only the desired text in the Chat Panel. 
 
Method Description 

Selecting All 
Text 

1. Click anywhere in the Chat Panel. 
2. Right-click to open the pop-up menu. 
3. Choose Select All from the menu. All text in the window is 

selected. Selected text is highlighted in blue. 
4. Right-click to open the pop-up menu. 
5. Select Copy from the menu to copy the text. 

Selecting 
Specific Text 

1. Click at the beginning of the desired text in the Chat Panel 
and do not release the mouse button.  

2. Drag the mouse to the end of the desired text and release 
the mouse button. The desired text should be highlighted in 
blue. 

3. Right-click to open the pop-up menu. 
4. Select Copy from the menu to copy the text. 

 
As an alternative to selecting Copy from the menu in the steps above, Cut can 
also be used. Selecting Cut removes the selected text from the Chat Panel, but 
still pastes the text into the Clipboard, making it available to paste into the 
Outgoing Message Panel. 
 
Do not select Clear All from the menu for a Cut/Copy and Paste function. The 
Clear All option simply clears the text from the Chat Panel without pasting it into 
the Clipboard. This does not make the text available for pasting into the Outgoing 
Message Panel. 
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Pasting Text into the Outgoing Message Panel 

The image below illustrates the process of pasting the text from the Chat Panel 
into the Outgoing Message Panel. This image continues with the previous 
example. Jen has already copied the desired text in the Chat Panel and she is 
now pasting the text into the Outgoing Message Panel. Once the information is in 
the Outgoing Message Panel, she will edit the message and resend it with the 
correct information. 
 

 
 
Use the following steps to paste text into the Chat Panel. 
 

1. Click in the Outgoing Message Panel. 
2. Right-click to open the pop-up menu. 
3. Select Paste from the menu. The text copied/cut from the Chat Panel is 

pasted into the Outgoing Message Panel. 
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Ending a Chat Session 

A chat session can be terminated by either party involved in the chat. 
 

To Terminate a Chat Session with an Individual 

Use the following steps to end a chat session with another individual. 
 

1. Select the name of the individual in the Contact List. Assuming a chat is in 
session with the individual, the End Chat button is present below the 
Outgoing Message Panel. 
 
Icon Description 

 A chat is in session with this individual. 

 
2. Click End Chat. The Chat Panel displays the name of the individual ending 

the chat and a "Chat call ended." message. The icon beside the name of 
the individual who was involved in the chat session returns to the logged 
in and available state. 
 
Icon Description 

 
The individual is logged into Chat and is available to participate 
in a chat session. 

 

When a Chat Session is Terminated by the Other Party 

When a chat session is terminated by the other party, the Chat Panel displays 
the name of the individual ending the chat and a "Chat call ended." message. 
The icon beside the name of the individual who was involved in the chat session 
returns to the logged in and available state. 
 
Icon Description 

 The individual is logged into Chat and is available to participate in a chat 
session. 
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TASKE WallSign 

WallSign Administrator and WallSign Server are two applications in the TASKE Call 
Center Management Tools suite of applications. These applications provide a 
communication link with one or more Spectrum© reader boards and act as the interface 
for the configuration and management of messages displayed on the reader boards.  
 
Using the WallSign applications, build sign plans that play messages based on the call 
center conditions, the time of day, user-defined special days, the day of the week, and 
the location of a reader board within the call center. Additionally, use the Quick 
Messages feature to create and save messages that override the sign plan messages 
when information needs to be conveyed quickly to agents. 
 
Reader board messages can include text, call center statistics, colors, effects, and 
graphics. Several graphics are provided with the WallSign Administrator and a graphics 
editor is also available for the creation of user-defined graphics. 
 
The two WallSign applications work together to produce messages and drive the reader 
boards. Using WallSign Administrator, reader board messages are configured and 
managed. Meanwhile, the WallSign Server is a background application that analyzes 
the sign plan and communicates the appropriate message to the Spectrum reader 
boards based on the conditions specified in the sign plan. 
 
The TASKE WallSign applications run on both Windows 98 and NT platforms. Available 
for use in single-site call centers or in enterprise situations where a call center has 
several sites in different locations, WallSign allows reader board messages to be 
distributed to reader boards at call center locations across the globe. 
 
Call centers using several reader boards establish a sign network. Up to five Spectrum 
reader boards can be networked from a PC equipped with the WallSign Server. In turn, 
each of these PCs has access to the reader boards on other PCs through the local call 
center network. The WallSign Server must be installed on each PC that is physically 
connected to one or more reader boards. The WallSign Administrator can be installed 
on any network connected PC for the configuration and management of sign plans. In 
an enterprise enabled call center, reader board messages can be distributed across the 
enterprise network and displayed on reader boards at other sites, but the messages 
must be configured and managed through the local network. 
 

The WallSign Server 

To play the sign plan messages and quick messages created in the WallSign 
Administrator, a communication link is required between the TASKE WallSign 
Server and the reader boards. An application that is invisible to the user, the 

WallSign Server stores the sign plan and interfaces with the TASKE Information Server 
to determine which message should be played based on the current date, time, and call 
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center conditions. The WallSign Server must be running on a PC that is physically 
connected to one or more reader boards for messages to be displayed on those reader 
boards. 
 

The WallSign Administrator 

The TASKE WallSign Administrator is the user interface for the construction and 
configuration of reader board messages. Containing real-time statistics, special 
effects, graphics, color, and formatting, reader board messages are played based 

on the current call center conditions, the date, the time, and the location of the reader 
board. To add this type of complexity to reader board messages, it is necessary to 
define the messages together with the conditions required for them to play. 
 
Using the WallSign Administrator configure and manage reader board messages and 
their parameters using sign plans. A sign plan creates associations between messages 
and call center conditions, dates, times, and reader boards. The components of a sign 
plan are created separately in the WallSign Administrator. 
 
A sign plan contains all of the components required for a message to be played. 
Messages are played on a reader board when all of the conditions for the message are 
true throughout the sign plan. Each sign plan component has a dedicated window 
provided in the display area and accessed from the Main Control Panel. 
 
The sign plan components are: 
 

ACD Variables Messages Decisions Special Days 

    
Day Plans Scripts Signs   

   
  

 

Overriding A Sign Plan with Quick Messages 

The Quick Messages window is the interface for creating, modifying, and 
controlling messages that can override or alternate with the preset 

messages of a sign plan. Quick messages are often used in times of emergency 
or service alerts. 
 
Quick messages are constructed using the same tools as the Messages window. 
As with the preset messages of a sign plan, quick messages can contain text, 
ACD variables, color, graphics, special effects, and character formatting. 
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Creating Custom Graphics 

Use the Graphics window to create custom graphic images to include in 
your reader board messages. The record edit area of the Graphics window 

contains a color palette and a simulation of a reader board. Each of the gray dots 
on the reader board represent an LED. Filling these LEDs with color produces 
the image. Include the graphics in sign plan messages and quick messages. 
 

WallSign Startup and Shutdown 

For WallSign configuration, only the WallSign Administrator must be running. For the 
communication of messages to reader boards the WallSign Server must be running on 
a PC that is directly connected to one or more reader boards. 
 

Starting the WallSign Administrator 

Use the following steps to start the WallSign Administrator application. 
 

 
1. Double-click the TASKE ToolBox icon on the desktop of 

the PC to open the TASKE ToolBox folder. 

 

2. Double-click the WallSign Administrator icon to start the 
WallSign Administrator and open the application window. 

 

Starting the WallSign Server 

When the WallSign Server is started an icon appears in the taskbar of the PC's 
desktop and the WallSign Server light on the Main Control Panel of the WallSign 
Administrator turns green to indicate the establishment of communication. 
 

 
1. Double-click the TASKE ToolBox icon on the desktop of 

the PC to open the TASKE ToolBox folder. 

 

2. Double-click the WallSign Server icon to start the 
WallSign Server. 
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Shutting Down the WallSign Administrator 

Use the following steps to shut down the WallSign Administrator application. 
 

1. Click File on the menu bar to open the File menu. 
2. Select Exit from the File menu. 

 

Shutting Down the WallSign Server 

Use the following steps the shut down the WallSign Server application. 
 

1. Right-click on the WallSign Server icon on the taskbar of the Windows 
desktop. 

2. Select Shutdown from the pop-up menu. 
3. Click the Yes button to confirm. 

 

Using the WallSign Server 

The WallSign Server is the communication link between the sign plans of the WallSign 
Administrator and the Spectrum reader boards. The WallSign Server runs in the 
background, transmitting the sign plan configuration to the reader boards. The WallSign 
Server must be running on a PC that is physically connected to one or more reader 
boards for messages to be displayed on those reader boards. 
 

To indicate that the WallSign Server is running, an icon appears in the Windows 
System Tray. Right-clicking on the icon produces a pop-up menu with three 
options. 

 

 
 

Shutdown... - select Shutdown... to close the TASKE WallSign Server application 
and terminate the connection with the Spectrum reader board. Selection of the 
Shutdown... option produces a dialog box asking the user to confirm the closure of 
the application. Click Yes to close the application. 
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Settings... - select Settings... to change the communication port the WallSign Server 
is using to communicate with the Spectrum reader board. Selection of the Settings... 
option produces the WallSign Server Settings dialog box. To change the 
communication port the WallSign Server is using, select the desired communication 
port from the Comport drop-down menu and click OK. 
 

 
 

About... - Select About... to view the lock, version, and copyright information for the 
TASKE WallSign Server application. Click OK to exit the dialog box. 
 

Using the WallSign Administrator 

The TASKE WallSign Administrator is the interface for configuring and managing reader 
board messages and their parameters using sign plans. A sign plan creates 
associations between messages and call center conditions, dates, times, and reader 
boards. The components of a sign plan are created separately in the WallSign 
Administrator. 
 
A sign plan contains all of the components required for a message to be played. 
Messages are played on a reader board when all of the conditions for the message are 
true throughout the sign plan. Each sign plan component has a dedicated window that is 
viewed in the display area and accessed from the Main Control Panel. 
 

Sign Plan Components 

There are seven sign plan components that work together to display messages 
and customer interaction center conditions on reader boards. The sign plan 
components act like steps in a ladder. Each component is linked to another, and 
to create the proper linking, the components of the sign plan must be created 
using a top-down approach. This means that the ACD variables must be defined 
first and the reader boards last. Messages are played on a reader board when all 
of the conditions for the message are true throughout the sign plan. ACD 
variables and special days are not required in a sign plan. All other components 
must be present. 

 
ACD Variables - use the ACD Variables window to define call center statistics 
for use in reader board messages. An ACD variable is a real-time or recent 
historical call center statistic that can be included in a reader board message. 
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Messages - use the Messages window to combine text, ACD variables, 
graphics, effects, color, and formatting to produce the text and effects seen on 
reader boards. 
 
Decisions - use the Decisions window to create decision trees. A decision tree is 
comprised of a default decision and optionally, one or more conditional decisions. 
A conditional decision is a statement that defines the state an ACD variable must 
be in before its associated message can be played on a reader board. A default 
decision is not associated with ACD variables and it is the decision used when 
the current call center conditions do not meet the requirements of the conditional 
decisions. 
 
Days - use the Days window to define special days within the year that require 
unique messages due to specific events. 
 
Day Plans - use the Day Plans window to partition a 24-hour period and apply a 
decision tree to each partition. This process breaks the call center day into 
segments and allows different messages to be applied to different times of the 
day. 
 
Scripts - use the Scripts window to apply day plans to the days of the week and 
special days. This process produces associations between the day, the time of 
day, and the call center conditions by creating a link between a script, a day plan, 
and a decision tree. 
 
Signs (reader boards) - use the Signs window to assign addresses and scripts 
to the reader boards in the call center. The address assigned to a reader board in 
the WallSign Administrator must equal the address setting in the reader board to 
establish a communication link between the reader board and the WallSign 
Server. The assignment of a script to a reader board creates a link between the 
reader board and the day plan, decision trees, and messages used in the script. 

 
Just as it is important to create a sign plan in the proper order, the elements of a 
sign plan must also be deleted in the proper order. Sign plan elements must be 
deleted in the reverse order of their creation. This is because sign plan 
components reference one another and all references to a component must be 
removed prior to deleting a sign plan component. 
 

Using the Menu Bar 

The menu bar contains five menus that provide keyboard or mouse access to the 
functions of the WallSign Administrator. The menus are File, Edit, View, Tools, and 
Help.  
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File Menu 

Use the File menu to exit the ACD Monitor application. The table below outlines 
the functionality of the File menu option.   
 
Option Shortcut Description 

Settings... N/A Use the Settings... option on the File menu of the 
WallSign Administrator application to open the 
Configuration dialog box where the communication 
paths to the WallSign Server and the TASKE WallSign 
Database are configured. 

Exit N/A Closes the WallSign Administrator application. This 
action does not close the WallSign Server application. 

 

Edit Menu 

Use the Edit menu to create new elements, update existing elements, and delete 
elements for the selected window. 
 
Option Shortcut Description 

New N/A Selecting the New option from the Edit menu creates a 
new sign plan element for the window selected in the 
Main Control Panel. This option on the Edit menu has 
the same effect as clicking the New button on the 
toolbar in the open window of the display area. 

Update N/A Selecting the Update option from the Edit menu saves 
the changes to the sign plan element in the window 
selected from the Main Control Panel. This option on 
the Edit menu has the same effect as clicking the 
Update button on the toolbar in the open window of the 
display area.  

Delete N/A Selecting the Delete option from the Edit menu deletes 
the selected sign plan element from the window 
selected in the Main Control Panel. This option on the 
Edit menu has the same effect as clicking the Delete 
button on the toolbar in the open window of the display 
area.  
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View Menu 

The View menu provides keyboard or mouse access to various sections of the 
ACD Monitor interface. The table below outlines the functionality of the View 
menu options. 
 
Option Shortcut Description 

Variables N/A Select this option to display the ACD Variables 
window. 

Graphics N/A Select this option to display the Graphics 
window. 

Messages N/A Select this option to display the Messages 
window. 

Quick Messages N/A Select this option to display the Quick 
Messages window. 

Decisions N/A Select this option to display the Decisions 
window. 

Day Plans N/A Select this option to display the Day Plans 
window. 

Scripts N/A Select this option to display the Scripts 
window. 

Days N/A Select this option to display the Days window. 

Signs N/A Select this option to display the Signs window. 

Config Mode N/A Select this option to switch to the Configuration 
mode. 

View Mode N/A Select this option to switch to the View Mode. 

Next Window F2 Move the window focus to the next section of 
the WallSign Administrator interface. Use the 
arrow keys to move throughout the elements of 
a window section and the Enter key to select. 

Previous Window Shift+F2 Move the window focus to the previous section 
of the WallSign Adminstrator interface. Use the 
arrow keys to move throughout the elements of 
a window section and the Enter key to select.  
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Tools Menu 

Use the Tools menu to perform configuration and testing procedures.  
 
Option Shortcut Description 

Reset Sign... N/A The Reset Sign... option on the Tools menu 
clears the RAM (random access memory) on a 
reader board. Selection of the Reset Sign... 
option opens the Reset Sign dialog box where 
the address of the reader board being reset is 
entered. Clicking OK resets the selected reader 
board. When a reader board is reset, the last 
message displayed is displayed again. The reset 
function is used to verify that the Sign Service is 
communicating with the selected reader board.  

Send Test 
Message... 

N/A Test messages are used to test the 
communication between the WallSign Server and 
the selected reader board(s). The Send Test 
Message... menu option opens the Send Test 
Message dialog box. 

Get Sign 
Version... 

N/A The Get Sign Version... menu option opens the 
Get Version Information For Sign dialog box. To 
obtain the part number and the release date of 
the reader board chip for a particular reader 
board, input the address of the reader board in 
the Sign Address field using the up and down 
arrow buttons. The reader board information is 
returned in the Sign Version Information dialog 
box. Click Close to close the dialog box. 

Set Sign Date / 
Time From PC... 

N/A The Set Sign Date/Time From PC menu option 
opens the Set Sign Date/Time From PC dialog 
box. Enter the address of the reader board that 
requires time and date synchronization in the 
Sign Address field using the up and down arrow 
buttons. Click OK to synchronize the time and 
date of the reader board with the time and date 
of the PC. 

Configure 
Tones... 

N/A The Configure Tones... menu option opens the 
Configure Sign Tone dialog box. Use this dialog 
box to customize the tones that the reader board 
emits. 
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Help Menu 

Use the Help menu to access the online help for WallSign. Additionally, use this 
menu to view version and copyright information for the application.  
 
Option Shortcut Description 

Contents F1 Select Contents to access the Online Help for the 
WallSign application.  

About Sign... N/A The About Sign... menu option opens the About 
TASKE Sign dialog box. This dialog box provides 
the software release number, the software version 
number, and the copyright information. Click OK to 
exit the dialog box 

 

Using the Main Control Panel 

The Main Control Panel spans the left side of the WallSign Administrator interface. This 
area of the interface has two functions: Mode selection and Window selection. 
 

Mode Selection 

Clicking the Config and View buttons toggle the TASKE 
WallSign Administrator program between the configuration 
mode and the view mode. The configuration mode enables 

users to create and edit sign plan components, graphics, and quick messages 
using the windows of the display area. The view mode changes these windows to 
read-only, real-time displays. In the view mode, the elements that are currently 
being used to display the message on the reader board are presented in the 
record area. 
 

Window Selection 

The Main Control Panel contains buttons to access the windows of the sign plan 
components, the quick messages window, and the graphics window. Selection of 
a button opens its corresponding window in the display area. The windows are: 
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The display area of the WallSign Administrator interface is the large area to the 
right of the Main Control Panel. The window selection buttons of the Main Control 
Panel determine the contents of the display area. Each window selection button 
opens a window that is displayed in the display area. These windows are the 
interface for creating and editing the elements of a sign plan, graphics, and quick 
messages in the configuration mode and the real-time display of these items in 
the view mode. 

  

Selecting a Mode in the WallSign Administrator 

The TASKE WallSign Administrator operates in one of two modes. These modes are 
configuration and view. To switch between the modes, use the Config and View buttons 
on the Main Control Panel. 
 
The primary difference between the configuration mode and the view mode is 
functionality, not the appearance of the program window. The display area of the 
TASKE WallSign Administrator is a pane that displays one of nine windows. Switch 
between the windows using the window selection buttons on the Main Control Panel. 
These windows provide the interface for creating, managing, and viewing sign plan 
elements, user-defined graphics, and quick messages. 
 
The only difference in appearance between the two modes occurs in the record area of 
the display area pane. In the configuration mode, the record area provides a detailed list 
of all defined elements for that window. In the view mode, the record area displays the 
element that the WallSign Server is currently transmitting to the reader board. 
 

Configuration Mode 

The configuration mode is the interface for the creation and 
management of sign plan elements, graphics, and quick 
messages. When in the configuration mode, each window 

accessed from the Main Control Panel displays its existing elements. Use the 
window in the configuration mode to create new elements and edit the existing 
elements. 
 
 
 
 
 
 
 
 
 
 



TASKE Call Center Management Tools            

 
- 316 - 

View Mode 

The view mode is a read-only, real-time display. When in the 
view mode, the windows accessed from the Main Control Panel 
display the element that is currently being used by the Wall Sign 

application to display the message on the reader board. This option is only 
available after configuration is complete and the WallSign Server is started. 
 
The View mode is disabled if the WallSign Server is not running. This is because 
there is no real-time data available for display when the WallSign Server is not 
running. 
 

Configuring Communication Paths 

Use the Settings... option on the File menu of the WallSign Administrator application to 
open the Configuration dialog box where the communication paths to the WallSign 
Server and the TASKE WallSign Database are configured. 
 

 
 
TASKE WallSign Server IP Address - use this field to view or edit the IP address of 
the TASKE WallSign Server. If the address of the WallSign Server has changed, it may 
be necessary to 'ping' the new WallSign Server to learn its IP address. To 'ping' the new 
WallSign Server, access a DOS prompt and type: ping WallSign Server PC network 
name. 
 
TASKE WallSign Server Port - the TASKE WallSign Server port is the port that 
receives information from the WallSign Server. This is a virtual number that is a 
connection ID. By default TASKE uses 100 for the connection ID. This means that any 
communication received by the PC with a connection ID of 100 is recognized as TASKE 
WallSign Server data. 
 
TASKE WallSign Database Path - the TASKE WallSign Database Path is the network 
path the PC uses to find the TASKE WallSign Database. Click the  button to access 
the established network connections and the Network Neighborhood and change the 
path if the path information is incorrect. 
 

 



TASKE Call Center Management Tools            

 
- 317 - 

Sending Test Messages to Reader Boards 

Test messages are used to test the communication between the WallSign Server and 
the selected reader board(s). The Send Test Message... menu option on the Tools 
menu opens the Send Test Message dialog box. 
 

 
 
Enter the text of the test message in the Message field and input the address of the 
reader board in the Sign Address field using the up and down arrow buttons. A Sign 
Address of 0 plays the test message on all reader boards. Click OK to display the test 
message on the selected reader board. 
 
The Send Test Message dialog box closes and the Sign dialog box opens indicating the 
test message is playing. To stop the test message, click OK. 
 

 
 

Configuring the Sign Tone 

Select Configure Tones... from the Tools menu to open the Configure Sign Tone dialog 
box. Use this dialog box to customize the sounds emitted from the reader boards. 
Enable or disable the playing of tones for a message in the Decisions window. 
 

 
 
Sign Address - input the address of the sign where the sounds will play. Setting a sign 
address of 0 changes the sounds for all reader boards. 
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Tone Options - select one of three options. The available options are: Continuous 
Tone, Three Beeps, and Programmable Tone. 
 

a. Continuous Tone - plays a single tone each time the message is played. 
b. Three Beeps - plays three tones each time the message is played. 
c. Programmable Tone - enables the Tone Frequency, Duration, and Repeat fields 

for the setup of a customizable tone.  
 
Tone Frequency - this field is only active when Programmable Tone is selected in the 
Tone Options field. Input a number to determine the pitch of the tone. The higher the 
number, the higher the pitch of the tone.   
 
Duration - this field is only active when Programmable Tone is selected in the Tone 
Options field. Input a number between 0.1 and 1.5 to determine the amount of time, in 
seconds, that the tone will play. 
 
Repeat - this field is only active when Programmable Tone is selected in the Tone 
Options field. Input a number in this field to determine the number of times the tone will 
play each time the message is played. 
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Using the ACD Variables Window 

The ACD Variables window is accessed by clicking the Variables button on the Main 
Control Panel. An ACD variable is a real-time or recent historical customer interaction 
center statistic that can be included in a reader board message.  
 
Each ACD variable included in a reader board message must be defined using the ACD 
Variables window. This window allows the definition of new ACD variables, the 
modification of ACD variables already defined, and the deletion of ACD variables that 
are no longer needed. 
 

Components of the ACD Variables Window 

The ACD Variables window is comprised of three sections: the record area, the 
toolbar, and the record edit area. 
 

Record Area 

The record area of the ACD Variables window lists the defined ACD variables. 
Select an ACD variable from the list for editing or deletion. When selected, an 
ACD variable is highlighted in blue and its details can be viewed and edited in the 
record edit area. 
 

 
 

Toolbar 

The toolbar in the ACD Variables window is used to create and name new ACD 
variables, edit existing ACD variables, and delete ACD variables that are no 
longer needed. 
 

 
 
Variable Name - each ACD variable must be assigned a user-defined name. 
Type a name in the Variable Name field on the toolbar of the ACD Variables 
window to identify the ACD variable throughout each section of the WallSign 
Administrator.  
 
New - click the New button on the toolbar of the ACD Variables window to define 
a new ACD variable. This action clears the fields of the record edit area. 
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Delete - the Delete button on the toolbar of the ACD Variables window deletes 
the ACD variable selected in the record area of the window. It is only possible to 
delete ACD variables that are not referenced elsewhere in the sign plan. If an 
ACD variable is referenced anywhere else in a sign plan, all references must be 
removed prior to deleting the ACD variable. 
 
Update - click the Update button to save changes to an ACD variable. 

 

Record Edit Area 

The record edit area of the ACD Variables window provides the parameters for 
the definition of the ACD variables for the reader board messages. This area is 
used to define new ACD variables and to edit the ACD variables already defined. 
 

 
 
ACD Variable - the ACD Variable field contains a drop-down list of the ACD 
statistics that can be included in a reader board message. 
 
ACD Group - the ACD Group field provides a drop-down list of all defined 
Queues and Queue Groups. Select a Queue or Queue Group to associate it with 
the ACD variable.  
 
Field Length - the field length of an ACD variable is the number of characters 
reserved for the ACD variable in the reader board message. Set the Field Length 
from 2 to 8 characters. It is important to specify a field length that is realistic. For 
example, if the value for the Calls Answered - Last 12 Hours ACD variable is 
expected to exceed 1000, then the field length should be set to 4. If the field 
length is not long enough to accommodate the entire value, the value will be 
truncated.  
 
Alignment - choose an alignment button to position the ACD variable to the left, 
center, or right of its field. 
 
Variable Color - select the Same As Message Text radio button in the record 
edit area of the ACD Variables window to have the ACD variable appear the 
same color as the message text on the reader board. Select the Dependant on 
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Threshold radio button in the record edit area of the ACD Variables window to 
define a color range for the display of the ACD variable on the reader board. The 
color of the ACD variable is dependant on the value of the ACD variable, based 
on user-defined thresholds. 
 

Setting the ACD Variable Color 

The color of the ACD variable text in a message can be set to be the same as 
the message text or to change depending on the threshold values.  
 
Same As Message Text – select the Same As Message Text radio button in the 
record edit area of the ACD Variables window to have the ACD variable appear 
the same color as the message text on the reader board. Nothing further is 
required for defining the ACD variable color when this radio button is selected. 
 
Dependant on Threshold – select the Dependant on Threshold radio button to 
define a color range for the display of the ACD variable on the reader board. The 
color of the ACD variable is dependant on the value of the ACD variable, based 
on user-defined thresholds. When this radio button is selected, the thresholds 
and their associated colors must be defined. 
 
To define the color thresholds, select a color for each threshold from the drop-
down lists in the three color boxes. To set the threshold values, input the values 
for the thresholds from 0 to x and from x to infinity, where x equals the value of 
the ACD variable you are defining. The values are input in the two boxes located 
to the right of the color boxes. 
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Defining ACD Variables 

The ACD Variables window provides an interface for defining the ACD variables 
that are used in reader board messages. Use the following steps to define an 
ACD Variable. 
 

1. Click Config to switch to the Configuration mode. 
2. Click the Variables button on the Main Control Panel to display the ACD 

Variables window. 
3. Click New on the toolbar. 
4. Type a variable name. 
5. Select an ACD variable. 
6. Select an ACD group. 
7. Define a field length. 
8. Set the alignment. 
9. Select a color option for the ACD variable. 
10. Click Update on the toolbar to save the new ACD variable. 

 

Deleting ACD Variables 

The Delete button on the toolbar of the ACD Variables window deletes the ACD 
variable selected in the record area of the window. It is only possible to delete 
ACD variables that are not referenced elsewhere in the sign plan. If an ACD 
variable is referenced anywhere else in a sign plan, all references must be 
removed prior to deleting the ACD variable. 
 
Use the following steps to delete an ACD variable. 
 

1. Select the ACD variable to delete in the record area of the ACD Variables 
window. 

2. Click the Delete button on the toolbar. 
3. Click Yes in the Sign dialog box to acknowledge the deletion. 
4. If the ACD variable is not referenced anywhere else in the sign plan, the 

ACD variable is deleted immediately. If the Sign dialog box opens with the 
statement: 
 

The selected element(s) cannot be deleted because they are being 
referenced by another part of the system. 
 

click OK and search the sign plan for references to the ACD variable and 
delete them before attempting to delete the ACD variable again. 
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Using the Messages and Quick Messages Windows 

The Messages Window is the interface for the construction of reader board 
messages. Message construction is the second step in the creation of a sign 

plan after the definition of the ACD variables. Reader board messages can contain text, 
ACD variables, color, graphics, special effects, and character formatting. 
 

Click the lightning bolt button to access the Quick Messages window. This window 
is the interface for creating, modifying, and controlling messages that can override 

or alternate with the preset messages of a sign plan. Quick messages are often used in 
times of emergency or service alerts. Quick messages are constructed using the same 
tools as the Messages window. As with the preset messages of a sign plan, quick 
messages can contain text, ACD variables, color, graphics, special effects, and 
character formatting. 
 
Messages and quick messages are created using text and using the tools of the record 
edit area. Simply click the buttons or make menu selections to add ACD variables, 
color, graphics, and effects to your message text. When one of these components is 
added to a message, the appropriate code for the component is added to the message 
string. 
 
When special effects, graphics, and formatting are incorporated into a reader board 
message, it is important to properly place these components around the message text 
and ACD variables to achieve the intended effect on the reader board. 
 

Components of the Messages and Quick Messages Windows 

Both the Messages and Quick Messages windows are comprised of three 
sections: the record area, the toolbar, and the record edit area. 
 

Record Area 

The record area of the Messages window lists the existing reader board 
messages. Select a message from the list for editing or deletion. When selected, 
a message is highlighted in blue and its details can be viewed and edited in the 
record edit area. 
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Toolbar 

The toolbar in the Messages and Quick Messages windows are used to create 
and name new reader board messages, edit existing messages, and delete 
messages no longer needed. In addition, the toolbar in the Quick Messages 
window provides the tools for starting and stopping the play of quick messages 
on the reader boards.  
 
Messages Toolbar 

 
 
Quick Messages Toolbar 

 
 
Message / Quick Message Name - each message/quick message must be 
assigned a user-defined name. This is done in the Message Name field on the 
toolbar of the Messages window or in the Quick Message Name field on the 
toolbar of the Quick Messages window. The names are used to identify the 
messages throughout the WallSign Administrator. For this reason, the names 
must be descriptive in nature. 
  
New - the New button on the toolbar allows for the construction of a new 
message. After clicking the New button, name the new message and construct 
the message in the record edit area. When finished, save the message by 
clicking the Update button. 
  
Delete - the Delete button on the toolbar deletes the message selected in the 
record area of the window. It is only possible to delete messages that are not 
referenced elsewhere in the sign plan. If a message is referenced anywhere else 
in a sign plan, all references must be removed prior to deleting the message. 
Quick messages are never referenced within the sign plan and can be deleted at 
any time. 
  
Update - click the Update button to save changes to a message. 
  
Start - this option is only available on the toolbar of the Quick Messages window. 
The Start button starts the display of the selected quick message on one or more 
reader boards. Clicking the Start button opens the Select Signs dialog box where 
the reader boards are selected for the quick message.  
  
Stop - this option is only available on the toolbar of the Quick Messages window. 
the Stop button on the toolbar of the Quick Messages window stops the display 
of the quick message on one or more reader boards. Clicking the Stop button 
opens the Select Signs dialog box where the reader boards are selected for the 
quick message.  
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Record Edit Area 

The record edit area of the Messages and Quick Messages windows provide the 
platform and the tools for the construction of reader board messages. This area 
is used to define new reader board messages and to edit the messages that 
have already been created. The white section of the record edit area is the 
message platform. This section is where the message is created by typing the 
message text directly into the message platform and inserting formatting codes 
using the tools below. 
 

 
 
Message Platform - the message platform is located in the record edit area. 
This is where the message text, ACD variables, effects, graphics, and character 
formatting are added or edited. 
  
Line Position - the line position buttons are used to select the vertical alignment 
of the message text on the reader board. The vertical alignment options are top, 
middle, bottom, and fill. 
  
Color - the Color buttons are used to specify the color of the message text. Click 
the solid color buttons and begin typing the message text in that color. Use the 
rainbow buttons, the color mix button, and the auto color button to insert code 
into the message that determines the color of the message text.  
  
Special Effects - the special effects buttons are used to define how a message 
moves across the reader board. If none of the options are specified, the 
automode option is automatically selected. Automode produces a random 
selection of the available special effects. Special effects must be placed before 
the message text or ACD variable they are intended to affect.  
  
Special Graphics - the special graphics buttons are used to insert the graphics 
provided with the WallSign Administrator into reader board messages. Clicking 
one of the Special Graphics buttons inserts the code for the graphic into the 
message. 
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Your Graphics - clicking the Your Graphics button produces a drop-down list 
that contains the names of the reader board illustrations created in the Graphics 
window. Selection of a graphic from the list inserts the graphic in the reader 
board message. 
  
Character Format - the Character Format button is used to insert call 
information in a message and specify character attributes such as character 
spacing, width, height and the speed at which characters are scrolled across the 
screen. Most of the character formatting options place both an on tag and an off 
tag in the message. It is important to place the text requiring the formatting 
between the two tags. 
  
ACD Variable - the ACD Variable button produces a drop-down list that contains 
the names of all defined ACD variables. Selection of an ACD variable from the 
list includes it in the reader board message. 
  
Display Quick Message - these options are only available on the Quick 
Messages window. This is the only difference between the Messages and Quick 
Messages windows. The Display Quick Message section in the record edit area 
of the Quick Messages window provides display options for the quick messages: 
 

a. Enable the Quick Message Only radio button to have the quick message 
replace the script and its associated messages. 

b. Enable the Alternate With Script radio button to have the reader board 
alternate between the quick message and the messages associated with 
the script. 

c. Enable the Stop Message At check box and enter a time in the field next 
to it to have the quick message stop playing at a specific time. 

d. Enable the Play Tone First Time check box to have the reader board emit 
a beep prior to displaying the quick message.  
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Building Messages and Quick Messages 

Use the Messages window to construct reader board messages. The positioning 
of the message components depends on how the message is to play on a reader 
board. Formatting and effects must be positioned in the message before the 
message text or the ACD variable it is supposed to affect. 
 
The following steps are suggestions for the order in which a reader board 
message can be constructed. As the message is constructed, its components are 
visible in the message platform. 
 

1. Click the Config button to switch to the Configuration mode. 
2. Click the Messages button on the Main Control Panel to display the 

Messages window, or click the lightning bolt icon on the Main Control 
Panel to display the Quick Messages window.  

3. Click New on the toolbar. 
4. Type a message name. 
5. Select the line position. 
6. Select a special effect. 
7. Select a color for the message text. 
8. Add character formatting, if desired. 
9. Type the message text in the message platform. If character formatting is 

present, ensure that the message text appears between the character 
formatting tags if both an on and an off tag are present. 

10. Select an ACD variable, if desired. Logically position the ACD variable in 
the message text where its value will make sense when played on a 
reader board. 

11. Select a special graphic or select a user defined graphic by clicking the 
Your Graphics button. Position the graphic as it should appear with the 
message text. 

12. If creating a quick message, select the desired display options for playing 
the quick message. 

13. Click Update on the toolbar to save the new message or quick message. 
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Selecting the Line Position 

The line position buttons are used to select the vertical alignment of the message 
text on the reader board. The vertical alignment options are top, middle, bottom, 
and fill. Selecting the top, middle, or bottom options means that the message text 
will only occupy the selected line on the reader board. Selecting the fill option 
means that the message text enters the reader board from the top, left corner 
and is able to occupy all three lines when the message is long enough to fill the 
reader board. 
 
Click a line position button to insert code into the message that determines the 
line position of the message text on the Spectrum reader board. 
 

Button Code In Message Description 

 {\Top} The text following the code appears on the 
top line of the reader board. 

 {\Middle} The text following the code appears on the 
middle line of the reader board. 

 {\Bottom} The text following the code appears on the 
bottom line of the reader board. 

 {\Fill} The text following the code fills all three 
lines of the reader board. 
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Adding Special Effects 

The special effects buttons are used to define how a message moves across the 
reader board. If none of the options are specified, the automode option is 
automatically selected. Automode produces a random selection of the available 
special effects. Special effects must be placed before the message text or ACD 
variable they are intended to affect. The available effects are: 
 

Button Code In Message Description 

 
{\Effect - Roll Up} Roll Up 

 
{\Effect - Roll Down} Roll Down 

 
{\Effect - Roll Left} Roll Left 

 
{\Effect - Roll Right} Roll Right 

 
{\Effect - Roll In} Roll In 

 
{\Effect - Roll Out} Roll Out 

 
{\Effect - Wipe Up} Wipe Up 

 
{\Effect - Wipe Down} Wipe Down 

 
{\Effect - Wipe Left} Wipe Left 

 
{\Effect - Wipe In} Wipe In 

 
{\Effect - Wipe Out} Wipe Out 

 
{\Effect - Auto Mode} Automode (randomly selects 

special effects) 

 
{\Effect - Scroll} Scroll 

 
{\Effect - Flash} Flash 

 
{\Effect - Hold} Hold 

 
{\Effect - Rotate Left} Rotate Left 

 
{\Effect - Compress Rotate} Compress Rotate 
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Button Code In Message Description 

 
{\Effect - Switch} Switch 

 
{\Effect - Interlock} Interlock 

 
{\Effect - Twinkle} Twinkle 

 
{\Effect - Sparkle} Sparkle 

 
{\Effect - Snow} Snow 

 
{\Effect - Spray} Spray 

 
{\Effect - Starburst} Starburst 

 
{\Effect - Slide} Slide 
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Adding Special Graphics 

The special graphics buttons are used to insert the graphics provided with the 
WallSign Administrator into reader board messages. Clicking one of the Special 
Graphics buttons inserts the code for the graphic into the message. The special 
graphics included with the WallSign Administrator are: 
 

Button Code In Message Description 

 
{\Special - Welcome} Scroll Welcome 

 
{\Special - Slot} Slot Machine 

 
{\Special - Thank You} Script Thank You 

 
{\Special - No Smoking} No Smoking 

 
{\Special - Don't Drink & 
Drive} 

Don't Drink and Drive 

 
{\Special - Animal Running} Running Animal 

 
{\Special - Fireworks} Fireworks 

 
{\Special - Turbo Car} Turbo Car 

 
{\Special - Cherry Bomb} Cherry Bomb 

 

Adding Character Formatting 

The Character Format button is used to insert call information in a message and 
specify character attributes such as character spacing, width, height and the 
speed at which characters are scrolled across the screen. The Character Format 
button produces a menu that contains three sub menus. These menus are Insert, 
Speed, and Effects. Most of the character formatting options place both an on tag 
and an off tag in the message. It is important to place the text requiring the 
formatting between the two tags. 
 
The Character Format button produces a pop-up menu with three sub-menus. 
The sub-menus contain character formatting options that, when selected, insert 
code into a message. The code affects the appearance of the text characters 
following the code. It is important to note that some reader boards do not have 
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the capability to adjust character width and height. A question mark displayed by 
the reader board indicates this hardware limitation. 
 

 
  
Insert Menu 

Menu Option Code In Message Description 

Call Time {\Format - Call Time} Inserts the call time in the message. 

Call Date {\Format - Call Date} Inserts the date in the message. 

Next Line {\Format - Next Line} Inserts a carriage return <CR>. 

No Hold {\Format - No Hold} Prevents pausing between format 
changes. 

  
Speed Menu 

Menu Option Code In Message Description 

Speed 1 - 
Slowest 

{\Format - Speed 1} The rate at which characters are 
displayed on the reader board. Speed 
1 is the slowest and Speed 5 is the 
fastest. 

Speed 2 {\Format - Speed 2} The rate at which characters are 
displayed on the reader board. Speed 
1 is the slowest and Speed 5 is the 
fastest. 

Speed 3 {\Format - Speed 3} The rate at which characters are 
displayed on the reader board. Speed 
1 is the slowest and Speed 5 is the 
fastest. 

Speed 4 {\Format - Speed 4} The rate at which characters are 
displayed on the reader board. Speed 
1 is the slowest and Speed 5 is the 
fastest. 

Speed 5 - 
Fastest 

{\Format - Speed 5} The rate at which characters are 
displayed on the reader board. Speed 
1 is the slowest and Speed 5 is the 
fastest. 
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Effects Menu 

Menu Option Code In Message Description 

Double High On {\Format - Double High 
On}{\Format - Double 
High Off} 

Doubles the height of the text 
between the tags. 

True Descender 
On 

{\Format - True 
Descender 
On}{\Format - True 
Descender Off} 

Causes the character with sections 
descending beyond the text 
baseline, such as lower case y and 
g, to be displayed below the 
baseline of the text. 

Character Flash 
On 

{\Format - Flash 
On}{\Format - Flash 
Off} 

Causes the characters between the 
tags to flash. 

Double Stroke On {\Format - Double 
Stroke On}{\Format - 
Double Stroke Off} 

Allows the characters two columns 
of pixels. 

Double Wide On {\Format - Double 
Wide On}{\Format - 
Double Wide Off} 

Stretches the character to double its 
regular width. 

Fixed Width On {\Format - Fixed Width 
On}{\Format - Fixed 
Width Off} 

All of the characters in the message 
are the same width. 

Fancy On {\Format - Fancy 
On}{\Format - Fancy 
Off} 

Adds serifs to the font. 

Wide Character 
On 

{\Format - Wide Char 
On}{\Format - Wide 
Char Off} 

Makes the characters between the 
tags wider. 

Full Height Fancy {\Format - Full Height 
Fancy} 

Widens, heightens, and adds serifs 
to the characters. 

Full Height 
Standard 

{\Format - Full Height 
Std} 

Heightens the characters without 
widening and adding serifs. 

Seven High 
Standard 
Character 

{\Format - 7 High Std 
Char} 

Characters are seven pixels in 
height. 

Five High 
Standard 
Character 

{\Format - 5 High Std 
Char} 

Characters are five pixels in height. 
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Effects Menu 

Menu Option Code In Message Description 

Proportional 
Character 
Spacing 

{\Format - Proportional 
Character Spacing} 

The spacing between characters 
varies according to the size of the 
characters. 

Fixed Character 
Spacing 

{\Format - Fixed 
Character Spacing} 

Character spacing is uniform, 
regardless of character size. 

 

Adding Color to a Message 

The Color buttons are used to specify the color of the message text. A different 
color can be used for each character of the message text. Unless otherwise 
specified in the ACD Variables window, the color selection also applies to the 
ACD variables. However, the characters of the ACD variable must all share the 
same color. Some Spectrum Sign types provide more color choices than others, 
as outlined in the literature from Spectrum Corporation. 
 
Click the solid color buttons and begin typing the message text in that color. Use 
the rainbow buttons, the color mix button, and the auto color button to insert code 
into the message that determines the color of the message text. 
 

Button Code In Message Description 

 None Select the red color button to type the 
message text in red. 

 None Select the green color button to type the 
message text in green. 

 None Select the dark yellow color button to type 
the message text in dark yellow. 

 None Select the dark red color button to type the 
message text in dark red. 

 None Select the dark green color button to type 
the message text in dark green. 

 None Select the black color button to type the 
message text in black. 

 None Select the orange color button to type the 
message text in orange. 

 None Select the yellow color button to type the 
message text in yellow. 
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Button Code In Message Description 

 {\Color - Rainbow 1} Inserts code into the message that makes 
the message text appear in multiple colors. 

 {\Color - Rainbow 2} Inserts code into the message that makes 
the message text appear in multiple colors. 

 {\Color - Color Mix} Uses all of the colors allowable by the 
reader board. Each character is a different 
color. When all of the colors have been 
used, the pattern is repeated. 

 None Randomly selects colors for the message 
text. 

 

Quick Message Display Options 

The Display Quick Message section in the record edit area of the Quick 
Messages window provides display options for the quick messages. 
 

 
 

Quick Message Only / Alternate With Script 

Enable the Quick Message Only radio button to have the quick message replace 
the script and its associated messages currently playing on the reader board. 
Enable the Alternate With Script radio button to have the reader board alternate 
between the quick message and the messages associated with the script that is 
currently in use. 
 

Stop Message At 

Enable the Stop Message At check box and enter a time in the field next to it to 
have the quick message stop playing at a specific time. The time must be 
entered in 24-hour format using the up and down arrows in the field. 
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Play Tone First Time 

Enable the Play Tone First Time check box to have the reader board emit a beep 
prior to displaying the quick message. The beep is only produced when the 
message is first played. 
 

Starting and Stopping Quick Messages 

The Start button starts the display of the selected quick message on one or more 
reader boards. Clicking the Start button opens the Select Signs dialog box. 
Select a single reader board from the list or enable the Send Command To All 
Signs check box to send the quick message to all reader boards in the sign 
network. Click OK to begin displaying the quick message. 
 
The Stop button on the toolbar of the Quick Messages window stops the display 
of the quick message on one or more reader boards. Clicking the Stop button 
opens the Select Signs dialog box. 
 
Select a single reader board from the list or enable the Send Command To All 
Signs check box to stop the quick message from playing on all reader boards in 
the sign network. Click OK to stop displaying the quick message. 
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Deleting Messages and Quick Messages 

The Delete buttons on the toolbars of both the Messages and Quick Messages 
windows are used to delete reader board messages.  
 

Deleting Messages 

Use the following steps to delete a message from the Messages window. A 
message cannot be deleted if it is referenced anywhere else in the sign plan. All 
references to the message must be deleted before the message can be deleted. 

1. Select the message to delete in the record area of the Messages window. 
2. Click the Delete button on the toolbar. 
3. Click Yes in the Sign dialog box to acknowledge the deletion. 
4. If the message is not referenced anywhere else in the sign plan, the 

message is deleted immediately. If the Sign dialog box opens with the 
statement: 
 

The selected element(s) cannot be deleted because they are being 
referenced by another part of the system. 
 

click OK and search the sign plan for references to the message and 
delete them before attempting to delete the message again. 

 

Deleting Quick Messages 

Use the following steps to delete a message from the Quick Messages window. 
 

1. Select the quick message you want to delete in the record area of the 
Quick Messages window. 

2. Click Delete on the toolbar. 
3. Click Yes in the Sign dialog box to acknowledge the deletion. 
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Using the Decisions Window 

The Decisions window provides an interface for the creation and modification of 
decision trees. A decision tree is comprised of one or more decisions. Two types of 
decisions are found in a decision tree: conditional and default. A conditional decision is 
a statement that defines the state an ACD variable must be in before its associated 
message can be played on a reader board. A default decision is the decision used when 
the current customer interaction center conditions do not meet the requirements of the 
conditional decisions. 
 
The decisions of a decision tree are prioritized in the order of their importance. The high 
priority decisions are at the top of the decision tree and the mandatory default message 
is always at the bottom of the decision tree. The WallSign Server searches through the 
decisions of a decision tree, looking for a decision that matches the current customer 
interaction center conditions. If none of the conditional decisions match the current 
conditions, the default decision is used and its associated message is played on the 
reader board. 
 

Decisions Window Components 

The Decisions window is comprised of three sections: the record area, the 
toolbar, and the record edit area. 
 

Record Area 

The record area of the Decisions window lists the defined decision trees. Select a 
decision tree from the list for editing or deletion. When selected, a decision tree is 
highlighted in blue and its details can be viewed and edited in the record edit 
area. 
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Toolbar 

The toolbar in the Decisions window is used to create and name new decision 
trees, edit existing decision trees, and delete decision trees no longer needed. 
 

 
 
Decision Name - each decision tree must be assigned a user-defined name. 
This is done in the Decision Name field on the toolbar of the Decisions window. 
The decision tree names are used to identify the decision trees throughout the 
WallSign Administrator. For this reason, the names must be descriptive in nature. 
 
New - the New button on the toolbar of the Decisions window allows for the 
creation of a new decision tree. After clicking the New button, name the new 
decision tree and add the required decisions. When finished, save the decision 
tree by clicking the Update button. 
 
Delete - the Delete button on the toolbar of the Decisions window deletes the 
decision tree selected in the record area of the window. It is only possible to 
delete decision trees that are not referenced elsewhere in the sign plan. If a 
decision tree is referenced anywhere else in a sign plan, all references must be 
removed prior to deleting the decision tree. 
 
Update - click the Update button to save changes to a decision tree. 

 

Record Edit Area 

The record edit area of the Decisions window provides the tools and the platform 
for defining the decisions of a decision tree. This area is used to define new 
decisions and to edit the decisions already defined for the decision tree. 
 

 
 
Decision Tree Platform - the decision tree platform is the table located in the 
record edit area of the Decisions window. This is where the decisions are 
defined, edited, and prioritized within the decision tree. 
  
Play Message - click the Play Message field to access a drop-down list that 
contains the names of all messages created in the Messages window. Select a 
message from the list to associate it with the decision. 
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IF ACD Variable - click the IF ACD Variable field to access a drop-down list that 
contains the names of all ACD variables defined in the ACD Variables window. 
Select an ACD variable from the list to associate it with the decision. 
  
Condition - click the Condition field and select a condition for the ACD variable. 
Select Above, Below, In, or Out from the list. These adjectives refer to the range 
of values in the Min and Max fields. The value of the ACD variable must fall 
within the range of the selected condition to play the message associated with 
the decision. If Above is selected, data cannot be input in the Max field because 
the range is any value above the minimum value specified. If Below is selected, 
data cannot be input in the Min field because the range is any value below the 
maximum value specified. Values are accepted by both the Min and Max field if 
either In or Out is selected. 
  
Min / Max - type values in the Min and Max fields to define a range for the value 
of the ACD variable. When the value of the ACD variable falls within the range 
specified by the Min, Max, and Condition fields, the message associated with the 
decision will play on the reader board. The availability of the Min and Max fields 
is dependant upon the condition specified in the Condition field. 
  
Sec - the Sec field is used to specify the minimum number of seconds a 
conditional decision must be true before its associated message will play.  
  
Play Tone - enable the Play Tone check box to have the reader board emit a 
beep prior to displaying the message associated with the decision. The beep is 
only produced when the message is first played. It will not be heard if the 
message is repeated on the reader board.  
  
Complete Decision - the Complete Decision field displays the decision in plain 
language after the update button on the toolbar is clicked.  
  

- click the add entry button in the record edit area of the window to add a 
new entry to the decision.  

  
- click the delete entry button in the record edit area to delete the selected 
entry from the record edit area.  

 
- the up and down arrow buttons in the record edit area of the Decisions 
window promote and demote the selected decision within the decision tree. 
The priority of a conditional decision cannot be lower than that of the 
default decision in a decision tree.  
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Defining Decision Trees 

Use the Decisions window to create decision trees that play messages based on 
the current customer interaction center conditions. To do this, apply a message 
to each decision along with an ACD variable and a set of conditions that the ACD 
variable must be experiencing for the message to play. 
 
Use the following steps to define a decision tree. 
 

1. Click the Config button on the Main Control Panel to switch to the 
Configuration mode. 

2. Click the Decisions button on the Main Control Panel to display the 
Decisions window. 

3. Click New on the toolbar. 
4. Type a Name for the decision tree. 
5. Click the Play Message field in the default decision and select a message. 
6. Click  to add a decision to the decision tree. 
7. Click the down-arrow in the Play Message field. Select a message from 

the drop-down list to associate the message with the new decision. 
8. Click the down-arrow in the If ACD Variable field. Select an ACD variable 

from the list. 
9. Click the down-arrow in the Condition field. Select the condition the ACD 

variable must be in to play the message. 
10. Input a value in the Min field to define the minimum value for the ACD 

variable condition. 
11. Input a value in the Max field (if applicable) to define the maximum value 

for the ACD variable condition. 
12. Input a value in the Sec field to indicate the number of seconds the ACD 

variable must be in the defined condition before the message will play. 
13. Enable the Tone check box to have the reader board emit a tone when the 

message associated with the decision is first played. 
14. Repeat steps 6 to 13 to add additional decisions to the decision tree. 
15. Click Update on the toolbar to save the new decision tree and add it to the 

list in the record area. 
 

Default and Conditional Decisions 

Conditional decisions are created by defining the ACD queue conditions that 
must be in effect for a message to play. This is done by associating a message 
with an ACD variable and then specifying the conditions the ACD variable must 
be experiencing in order for the message to play. Each message and ACD 
variable association is one decision within a decision tree. The order the 
decisions are listed within a decision tree identifies their priority within the 
decision tree. 
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For example, if decision 2 is satisfied, a message for decision 2 will continue to 
be played until either: 
 

a. decision 2 is no longer satisfied because the value of the performance 
variable has fallen/risen within acceptable service limits and the default 
decision is used, or 

b. decision 1 is satisfied. A message for the higher priority decision will 
interrupt a message for the second decision. 

 
Default decisions are used when the current call center conditions do not match 
any of the conditions specified in the conditional decisions. Unlike the conditional 
decisions, default decisions cannot be associated with ACD variables. Every 
decision tree must contain a default decision. In a decision tree, the default 
decision is always the lowest priority decision. 
 

Deleting A Decision Tree 

The Delete button on the toolbar of the Decisions window deletes the decision 
tree selected in the record area of the window. It is only possible to delete 
decision trees that are not referenced elsewhere in the sign plan. If an decision 
tree is referenced anywhere else in a sign plan, all references must be removed 
prior to deleting the decision tree. 
 
Use the following steps to delete a decision tree from the Decisions window. 
 

1. Select the decision tree to delete in the record area of the Decisions 
window. 

2. Click the Delete button on the toolbar. 
3. Click Yes in the Sign dialog box to acknowledge the deletion. 
4. If the message is not referenced anywhere else in the sign plan, the 

message is deleted immediately. If the Sign dialog box opens with the 
statement: 
 

The selected element(s) cannot be deleted because they are being 
referenced by another part of the system. 
 

click OK and search the sign plan for references to the decision tree and 
delete them before attempting to delete the decision tree again. 
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Using the Days Window 

The Days window is accessed by clicking the calendar button on the Main Control 
Panel. This window is used to identify special days that require unique messages. 

Special days are included in scripts. The scripts associate with messages through the 
assignment of a day plan. 
 
The WallSign Administrator is provided with a number of pre-defined special days. 
These days encompass the major holidays and events in a year. Add these pre-defined 
special days to a script for use in a sign plan, or use the Days window to define any 
additional days the customer interaction center requires. 
 

Days Window Components 

The Days window is comprised of three sections: the record area, the toolbar, 
and the record edit area. 
 

Record Area 

The record area of the Days window lists the defined special days that require 
specific messages. Select a special day from the list for editing or deletion. When 
selected, a special day is highlighted in blue and its details can be viewed and 
edited in the record edit area. 
 

 
 

Toolbar 

The toolbar in the Days window is used to create and name new special days, 
edit existing special days, and delete special days no longer needed. 
 

 
 
Day Name - each special day or group of days must be assigned a user-defined 
name. This is done in the Day Name field on the toolbar of the Days window. The 
names for the special days are used to identify the dates throughout the WallSign 
Administrator. For this reason, the names must be descriptive in nature. 
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New - the New button on the toolbar of the Days window allows for the definition 
of a new special day. After clicking the New button, name the new special day 
and define the dates for the period in the record edit area. When finished, save 
the new special day by clicking the Update button. 
 
Delete - the Delete button on the toolbar of the Days window deletes the special 
day or group of days selected in the record area of the window. It is only possible 
to delete special days that are not referenced elsewhere in the sign plan. If a 
special day is referenced anywhere else in a sign plan, all references must be 
removed prior to deleting the day or group of days. 
 
Update - click the Update button to save changes to a special day or a group of 
special days. 

 

Record Edit Area 

The record edit area of the Days window is the interface for the definition of a 
special day. This area is used to define new special days and to edit the special 
days already defined. 
 

 
 
Date is Specific - a special day is defined as a specific date when it applies to a 
particular calendar date. For instance, Christmas is a specific date because it 
falls on the 25th of December every year.  
 
Date is Reference - a special day is defined as a reference date when it applies 
to an event that falls on the same day of the week, in the same month, every 
year. A date like Father's Day is considered to be a reference date because it is 
defined by its occurrence on the third Sunday in June each year.  
 
Description - the Description field in the record edit area of the Days window is 
an optional field where a description for the special day is entered. This field 
allows you to elaborate on the name of the special day for easier identification.   
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Defining Special Days 

Use the Days window to define special days or groups of days throughout 
the year that require specific messages. Special dates can refer to specific 

calendar dates or to a reference period within a month, such as the third 
Thursday of February. 
 
Use the following steps to define a special day. 
 

1. Click the Config button on the Main Control Panel to switch to 
Configuration mode. 

2. Click the calendar button on the Main Control Panel to display the Days 
window. 

3. Click New on the toolbar. 
4. Type a Name for the day or group of days. 
5. Define the date as a specific date or a reference date. 
6. Click in the Description field and type a description for the day or group of 

days. 
7. Click Update on the toolbar to save the special day or group of days. 

 

Defining Specific Dates 

A special day is defined as a specific date when it applies to a particular calendar 
date. For instance, Christmas is a specific date because it falls on the 25th of 
December every year. 
 

 
 
Use the following steps to define a specific day or group of days. 
 

1. Enable the Specific radio button to define a specific calendar date or a 
group of dates. 

2. Click on the numeric day of the month and use the up and down arrows to 
select the day of the month. 

3. Click on the month and use the up and down arrows to select the month. 
4. Use the up and down arrows in the day(s) field to define the number of 

days the period encompasses, beginning with the selected date. 
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Defining Reference Dates 

A special day is defined as a reference date when it applies to an event that falls 
on the same day of the week, in the same month, every year. A date like Father's 
Day is considered to be a reference date because it is defined by its occurrence 
on the third Sunday in June each year. 
 

 
 
Use the following steps to define a reference day or group of days. 
 

1. Enable the Reference radio button to define a reference date or group of 
dates within a month. 

2. Click the reference field to select the reference day within the month. The 
selections in this list are First, Second, Third, Fourth, or Last. These 
adjectives refer to specific days of the week within a specific month. For 
instance, it may be referring to the first Friday in June. 

3. Click on the day of the week and use the up and down arrows to select a 
day. 

4. Click on the month and use the up and down arrows to select a month. 
5. Use the up and down arrows in the day(s) field to define the number of 

days the period will encompass, beginning with the selected date. 
 

Deleting Special Days 

The Delete button on the toolbar of the Days window deletes the special day 
selected in the record area of the window. It is only possible to delete special 
days that are not referenced elsewhere in the sign plan. If a special day is 
referenced anywhere else in a sign plan, all references must be removed prior to 
deleting the special day. 
 
Use the following steps to delete a special day. 
 

1. Select the special day to delete in the record area of the Days window. 
2. Click the Delete button on the toolbar. 
3. Click Yes in the Sign dialog box to acknowledge the deletion. 
4. If the special day is not referenced anywhere else in the sign plan, it is 

deleted immediately. If the Sign dialog box opens with the statement: 
 

The selected element(s) cannot be deleted because they are being 
referenced by another part of the system. 
 

click OK and search the sign plan for references to the special day and 
delete them before attempting to delete the special day again. 
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Using the Day Plans Window 

The Day Plans window is accessed by clicking the Day Plans button on the Main 
Control Panel. This window is used to partition a 24-hour period and apply a decision 
tree to each partition. This process breaks the customer interaction center day into 
segments and allows different messages to be applied to different times of the day.  
 
Once defined, the day plans are applied to specific days of the week or special days in 
the Scripts window. A default day plan is automatically created in the Day Plans 
window. The default day plan cannot be renamed, but time segments and decision trees 
can be applied.  
 

Day Plans Window Components 

The Day Plans window is comprised of three sections: the record area, the 
toolbar, and the record edit area. 
 

Record Area 

The record area of the Day Plans window lists the defined day plans. Select a 
day plan from the list for editing or deletion. When selected, a day plan is 
highlighted in blue and its details can be viewed and edited in the record edit 
area. 
 

 
 

Toolbar 

The toolbar in the Day Plans window allows you to create and name new day 
plans, edit existing day plans, and delete day plans no longer needed. 
 

 
 
Day Plan Name - each day plan must be assigned a user-defined name. This is 
done in the Day Plan Name field on the toolbar of the Day Plans window. The 
day plan names are used to identify the day plans throughout the WallSign 
Administrator. For this reason, the names must be descriptive in nature. 
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New - the New button on the toolbar of the Day Plans window allows for the 
definition of a new day plan. After clicking the New button, name the new day 
plan and define its parameters. When finished, save the new day plan by clicking 
the Update button. 
 
Delete - the Delete button on the toolbar of the Day Plans window deletes the 
day plan selected in the record area of the window. It is only possible to delete 
day plans that are not referenced elsewhere in the sign plan. If a day plan is 
referenced anywhere else in a sign plan, all references must be removed prior to 
deleting the day plan. 
 
Update - click the Update button to save changes to a day plan. 

 

Record Edit Area 

The record edit area of the Day Plans window is the interface for defining the 
time segments of a day plan. This area is used to define new time segments, 
delete time segments, and to edit the existing time segments of a day plan. 
 

 
 
Day Plans Platform - the day plans platform is located in the record edit area of 
the Day Plans window. This area provides a table where the time segments of 
the day plans are displayed with their associated decision trees. Click on the 
hour or minute field of a time segment in either the From or To columns of the 
table to edit the time. Click the down-arrow in the Decision Tree column to assign 
a decision tree to the time segment.  
 
From - the From column in the record edit area of the Day Plans window defines 
the starting time for a day plan time segment. The time in the From column for 
the first time segment of a day plan must be 00:00. Each day plan must 
encompass a 24-hour period, beginning with 00:00 and ending with 23:59. To set 
the starting hour of a time segment, click the hour field in the From column and 
type a value between 00 and 23. To set the starting minute of a time segment, 
click the minute field in the From column and type a value between 00 and 59.  
 
To - the To column in the record edit area of the Day Plans window defines the 
ending time for a day plan time segment. The time in the To column for the last 
time segment of a day plan must be 23:59. Each day plan must encompass a 24-
hour period, beginning with 00:00 and ending with 23:59.To set the ending hour 
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of a time segment, click the hour field in the To column and type a value between 
00 and 23. To set the ending minute of a time segment, click the minute field in 
the To column and type a value between 00 and 59. 
  
Decision Tree - applying decision trees to the time segments of a day plan 
creates an association between the time of day and the customer interaction 
center conditions. The WallSign Server searches the day plan configuration for a 
time segment that matches the current time. It then searches the decision tree 
associated with the time segment for ACD variables that match the current 
customer interaction center conditions.  
 

- click the add entry button in the record edit area of the window to add a 
new entry to the day plan.  

 
- click the delete entry button in the record edit area to delete the selected 
entry from the record edit area.  

 

Defining Day Plans 

Use the Day Plans window to apply decision trees to specific segments of a 24-
hour period. A day plan must begin with 00:00 and end with 23:59. The minimum 
size of a day plan segment is 1 minute while the maximum size is 24-hours. A 
default day plan is automatically created in the Day Plans window. 
 
Use the following steps to define a new day plan with three time segments.  
 

1. Click the Config button on the Main Control Panel to switch to 
Configuration mode.  

2. Click the Day Plans button on the Main Control Panel to display the Day 
Plans window. 

3. Click New on the toolbar. 
4. Type a Name for the day plan. 
5. Click the add entry button  twice to add a second and third time 

segment to the day plan. 
6. Set the start time for each time segment in the From column. 
7. Set the end time for each time segment in the To column. 
8. Select a decision tree for each time segment from the Decision Tree 

column. 
9. Click Update on the toolbar to save the new day plan and add it to the list 

in the record area. 
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Deleting a Day Plan 

The Delete button on the toolbar of the Day Plans window deletes the day plan 
selected in the record area of the window. It is only possible to delete a day plan 
that is not referenced elsewhere in the sign plan. If a day plan is referenced 
anywhere else in a sign plan, all references must be removed prior to deleting 
the day plan. 
 
Use the following steps to delete a day plan from the Day Plans window. 
 

1. Select the day plan you want to delete in the record area of the Day Plans 
window. 

2. Click the Delete button on the toolbar. 
3. Click Yes in the Sign dialog box to acknowledge the deletion. 
4. If the day plan is not referenced anywhere else in the sign plan, it is 

deleted immediately. If the Sign dialog box opens with the statement: 
 

The selected element(s) cannot be deleted because they are being 
referenced by another part of the system. 
 

click OK and search the sign plan for references to the day plan and delete 
them before attempting to delete the day plan again. 
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Using the Scripts Window 

The Scripts window is accessed by clicking the Scripts button on the Main Control 
Panel. This window is used to apply day plans to the days of the week and to special 
days. This process produces associations between the day of the week, the time of day, 
and the customer interaction center conditions by creating a link between a script, a day 
plan, and a decision tree. 
 
The first entry in every script is the default entry. The default day plan is automatically 
applied to the default script entry, but any existing day plan can be used with the default 
script. The default script entry is used when no other script entries are present, or when 
the existing script entries do not apply to the current conditions.  

Scripts Window Components 

The Scripts window is comprised of three sections: the record area, the toolbar, 
and the record edit area. 
 

Record Area 

The record area of the Scripts window lists the defined scripts. Select a script 
from the list for editing or deletion. When selected, a script is highlighted in blue 
and its details can be viewed and edited in the record edit area. 
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Toolbar 

The toolbar in the Scripts window is used to create and name new scripts, edit 
existing scripts, and delete scripts no longer needed. 
 

 
 
Script Name - each script must be assigned a user-defined name. This is done 
in the Script Name field on the toolbar of the Scripts window. The script names 
are used to identify the scripts throughout the WallSign Administrator. For this 
reason, the names must be descriptive in nature. 
 
New - the New button on the toolbar of the Scripts window allows for the creation 
of a script. After clicking the New button, name the new script and add the 
required days and day plans. When finished, save the script by clicking the 
Update button. 
 
Delete - the Delete button on the toolbar of the Scripts window deletes the script 
selected in the record area of the window. It is only possible to delete scripts that 
are not referenced elsewhere in the sign plan. If a script is referenced anywhere 
else in a sign plan, all references must be removed prior to deleting the script. 
 
Update - click the Update button to save changes to a script. 

 

Record Edit Area 

The record edit area of the Scripts window provides the interface for the 
application of day plans to the days of the week or to special days. Together, 
these days and their associated day plans create a script. The record edit area is 
used to add days to a script and to edit the days that have already been defined 
for an existing script. 
 

 
 
Script Platform - the script platform is located in the record edit area of the 
Scripts window. This area provides a table that displays the script entries. To edit 
or delete a script entry, other than the default entry, select the script entry from 
the table by clicking in one of its table fields. 
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Day - the Day column of the Scripts window assigns days of the week or special 
days to script entries. Click the down-arrow in each row of the Day column and 
select a weekday or special day from the drop-down list. Each day in the list can 
only appear in a script once. 
 
Day Plan - the Day Plan column of the Scripts window assigns day plans to the 
script entries. Click the down-arrow in each row of the Day Plan column and 
select a day plan from the drop-down list. 
 

- click the add entry button in the record edit area of the window to add a 
new entry to the script.  

 
- click the delete entry button in the record edit area to delete the selected 
entry from the record edit area.  

 

Defining a Script 

Use the Scripts window to create scripts that apply day plans to the days of the 
week or to special days. When a new script is created, a default entry is 
automatically added that uses the default day plan. Use each day of the week or 
special day only once in each script. 
 
Use the following steps to define a new script. 
 

1. Click the Config button to choose Configuration mode and click the Scripts 
button on the Main Control Panel. 

2. Click New on the toolbar. 
3. Type a Name for the new script. 
4. Click the add entry button  to add a new script entry. 
5. Click in the Day column for the entry and select a day of the week. 
6. Click in the Day Plan column for the entry and select a day plan. 
7. Repeat steps 4 to 6 to define additional script entries. 
8. Click the Update button on the toolbar to save the new script. 
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Deleting a Script 

The Delete button on the toolbar of the Scripts window deletes the script selected 
in the record area of the window. It is only possible to delete scripts not 
referenced elsewhere in a sign plan. If a sign references the script in the Signs 
window, the reference must be deleted from the Signs window prior to deleting 
the script. 
 
Use the following steps to delete a script from the Scripts window. 
 

1. Select the script to delete in the record area of the Scripts window. 
2. Click the Delete button on the toolbar. 
3. Click Yes in the Sign dialog box to acknowledge the deletion. 
4. If the script is not referenced anywhere else in the sign plan, the script is 

deleted immediately. If the Sign dialog box opens with the statement: 
 

The selected element(s) cannot be deleted because they are being 
referenced by another part of the system. 
 

click OK and search the sign plan for references to the script and delete 
them before attempting to delete the script again. 
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Using the Signs Window 

The Signs window is the final stop in the creation of a sign plan. Access the Signs 
window by clicking the Signs button on the Main Control Panel. This window is used to 
assign addresses and scripts to individual reader boards.The reader board address in 
the TASKE WallSign Administrator must equal the address setting in the reader board. 
Matching the two addresses is essential in establishing a communication link between 
the reader board and the software. 
 
The assignment of a script to a reader board creates a link between the reader board 
and the sign plan. When a script is assigned to a reader board it is linking the reader 
board to its associated day plan, decision trees, and messages. Using the sign plan 
components the WallSign Server is capable of determining which message to play 
based on the location of the reader board, the day of the week, the time of the day, and 
the customer interaction center conditions. 
 
When several reader boards are linked together, it creates a sign network. A sign 
network is a group of two to five reader boards that are controlled by a TASKE PC 
running the WallSign Server. The reader boards are connected in a daisy-chain fashion. 
The reader board that is directly connected to the TASKE PC is known as the master 
reader board. The rest of the reader boards in the network are known as slave reader 
boards. 

 

Signs Window Components 

The Signs window is comprised of three sections: the record area, the toolbar, 
and the record edit area. The functionality of each of these sections is very 
specific. 
 

Record Area 

The record area of the Signs window lists the defined reader boards. Select a 
reader board from the list for editing or deletion. When selected, a reader board 
is highlighted in blue and its details can be viewed and edited in the record edit 
area. 
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Toolbar 

The toolbar in the Signs window is used to define and name new reader boards, 
edit the setup of existing reader boards, and delete the setup of reader boards no 
longer needed. 
 

 
 

Sign Name - each reader board must be assigned a user-defined name. This is 
done in the Sign Name field on the toolbar of the Signs window. The reader 
board names are used to identify the signs throughout the WallSign 
Administrator. For this reason, the names must be descriptive in nature. 
 
New - the New button on the toolbar of the Signs window allows for the addition 
of a reader board. After clicking the New button, name the new reader board, set 
its address, and assign a script. When finished, save the reader board setup by 
clicking the Update button. 
 
Delete - the Delete button on the toolbar of the Signs window deletes the setup 
of the reader board selected in the record area of the window.  
 
Update - click the Update button to save changes to the sign address or script 
assignment. 

 

Record Edit Area 

The record edit area of the Signs window provides the interface for addressing 
reader boards and assigning scripts to each. Use this area to address and assign 
scripts to new reader boards and to edit the addresses and script assignments of 
existing reader boards. 
 

 
 
Sign Address - the Sign Address field in the record edit area of the Signs 
window defines the address of a reader board. Use the up and down arrows to 
set the address from 00 to 99. Ensure that the address setting in the reader 
board and the address setting in the WallSign Administrator match. For 
information on setting the address on the Spectrum reader board, refer to the 
Spectrum Corporation documentation. 
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Script - the Script field in the record edit area of the Signs window assigns a 
script to the reader board. Use the down-arrow to view a list of all defined scripts. 
Select a script from the list to assign it to the reader board. 
 

Defining A Sign (Spectrum Reader Board) 

Use the Signs window to associate a Spectrum reader board with a message or 
a group of messages. To add a reader board to your TASKE system it must be 
named, addressed, and assigned a script. The assignment of a script to a reader 
board completes a sign plan. The script associates messages and all of their 
conditions with a particular reader board. 
 
Use the following steps to add a reader board to the TASKE system. 
 

1. Click the Config button on the Main Control Panel to switch to the 
Configuration mode.  

2. Click the Signs button on the Main Control Panel to display the Signs 
window. 

3. Click New on the toolbar. 
4. Type a Name for the reader board. 
5. Select an Address for the reader board from 00 to 99. 
6. Click the Script field and select a script. 
7. Click the Update button on the toolbar to save the settings for the reader 

board. 
8. Follow the instructions from Spectrum Corporation and address the reader 

board to match the address of the reader board in the WallSign 
Administrator. 
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Deleting a Sign 

The Delete button on the toolbar of the Signs window deletes the sign selected in 
the record area of the window. It is only possible to delete signs that are not 
referenced elsewhere in a sign plan. If a sign is referenced anywhere in a sign 
plan, the reference must be deleted from the Signs window prior to deleting the 
sign. 
 
Use the following steps to delete a sign from the Signs window. 
 

1. Select the sign to delete in the record area of the Signs window. 
2. Click the Delete button on the toolbar. 
3. Click Yes in the Sign dialog box to acknowledge the deletion. 
4. If the sign is not referenced anywhere else in the sign plan, the sign is 

deleted immediately. If the Sign dialog box opens with the statement: 
 

The selected element(s) cannot be deleted because they are being 
referenced by another part of the system. 
 

click OK and search the sign plan for references to the sign and delete 
them before attempting to delete the sign again. 
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Using the Graphics Window 

Use the Graphics window to create custom graphic images. Include the images in 
reader board messages and quick messages, as a replacement to, or as an 

accompaniment to the images provided with the WallSign application. To view the 
Graphics window, click the color palette button on the Main Control Panel.  
 
The record edit area of the Graphics window contains a color palette and a simulation of 
a reader board. Each of the gray dots on the reader board represent an LED. Filling 
these LEDs with color produces the image. Include the graphics in the messages of the 
Messages window for the sign plan or in quick messages through the Quick Messages 
window. 
 

Graphics Window Components 

The Graphics window is comprised of three sections: the record area, the 
toolbar, and the record edit area. 
 

Record Area 

The record area of the Graphics window lists the existing user-defined graphics . 
Select a graphic from the list for editing or deletion. When selected, a graphic is 
highlighted in blue and it can be viewed and edited in the record edit area. 
 

 
 

Toolbar 

The toolbar in the Graphics window is used to create and name new reader 
board graphics, edit existing graphics, and delete graphics no longer needed. In 
addition, the toolbar provides the tools for defining the dimensions of the graphic 
on the reader board, clearing graphics from the drawing platform in the record 
edit area, and testing graphics on the reader boards. 
 

 
 
Graphic Name - each user-defined graphic must be assigned a name. This is 
done in the Graphic Name field on the toolbar of the Graphics window. The 
graphic names are used to identify the user-defined graphics throughout the 
WallSign Administrator. For this reason, the names must be descriptive in nature. 
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Dimensions - the Dimensions... button is used to specify the dimensions of a 
graphic on a reader board. The dimensions are measured by the number of 
LEDs high by the number of LEDs wide. The size of reader boards vary between 
models, therefore, it is important to know the number of LEDs on the reader 
board prior to setting the dimensions. 
 
Clear - use the Clear button to clear the drawing platform. 
 
Test - the Test... button displays the graphic on the selected reader board. 
Clicking the Test... button opens the Test Graphic to Sign dialog box. Use the up 
and down arrows of the Sign Address field to select the address of the reader 
board testing the graphic. Click OK to display the graphic on the reader board. 
 
New - the New button on the toolbar of the Graphics window allows for the 
creation of a new reader board graphic. Clicking the New button automatically 
clears the drawing platform in anticipation of the new graphic. Name the new 
graphic, set the dimensions, and begin drawing, using the colors of the color 
palette. When finished, save the graphic by clicking the Update button. 
 
Delete - the Delete button on the toolbar of the Graphics window deletes the 
graphic selected in the record area of the window. It is only possible to delete 
graphics that are not referenced elsewhere in the sign plan. If a graphic is 
referenced anywhere else in a sign plan, all references must be removed prior to 
deleting the graphic. 
 
Update - click the Update button to save changes to a custom graphic. 

 

Record Edit Area 

The record edit area of the Graphics window provides the platform and the tools 
for the creation of reader board graphics. This area is used to create new reader 
board graphics and to edit the existing graphics. The color palette provides the 
drawing tools for the creation of the graphics, while the drawing platform provides 
a drawing area that is a simulation of a reader board for realistic graphic creation. 
 

 
 
Color Palette - the color palette in the record edit area of the Graphics window 
provides the drawing colors for the creation of the user-defined reader board 
graphics. Click on a color in the color palette. The selected color is displayed in 
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the color selection box to the right of the color palette. After selecting a color, fill 
in the gray dots of the drawing area to create the graphic. Switch colors where 
applicable and use gray to erase any errors. 
 
Drawing Platform - the drawing platform in the record edit area of the Graphics 
window is the area where user-defined graphics are created. The drawing 
platform is a simulation of a reader board. Each gray dot in the drawing platform 
represents an LED that can be filled with color using the colors of the color 
palette.  

 

Creating Custom Graphics 

Use the Graphics window to create custom graphic images to include in the 
reader board messages. The record edit area of the Graphics window contains a 
color palette and a simulation of a reader board. Each of the gray dots on the 
reader board represent an LED. Filling these LEDs with color produces the 
image. 
 

Creating a New Graphic 

Use the following steps to create a new graphic. 
 

1. Click the Config button to enable the Configuration mode.  
2. Click the color palette button on the Main Control Panel to display the 

Graphics window. 
3. Click New on the toolbar. 
4. Type a Name for the graphic. 
5. Click the color you want to use first. 
6. Click a gray dot on the simulated reader board to fill the dot with the 

selected color. 
7. Continue filling the dots to create the image, changing colors where 

required. To erase a mistake, use the gray color to fill the dot with its 
original color. 

8. Click the Update button on the toolbar to save the new graphic. 
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Dimensions 

The Dimensions... button is used to specify the dimensions of a graphic on a 
reader board. The dimensions are measured by the number of LEDs high by the 
number of LEDs wide. The size of reader boards vary between models, 
therefore, it is important to know the number of LEDs on the reader board prior to 
setting the dimensions. The graphic will not function properly if the dimensions 
are larger than the number of LEDs that physically exist on the reader board. 
 

To set the dimensions of a graphic, click Dimensions... 
to open the Specify Sign Dimensions dialog box. Input 
values for the number of LEDs in height and width and 
click OK. 
 
 
 

Making the dimensions larger than the graphic does not distort the graphic. It 
simply determines how much real estate the graphic will require on the reader 
board. For instance, to display a graphic at the same time as the message text 
set the dimensions to accommodate the size of the graphic, but no larger. 
However, to display the graphic by itself on the reader board and have the 
message text precede or follow the graphic, make the graphic dimensions large 
enough to occupy the entire reader board. 
 
If the graphics created for the Reader Board are not displayed properly on the 
Spectrum Reader Board, try setting the dimensions to a slightly smaller size. 
 

Using the Color Palette and Drawing Platform 

The color palette and drawing platform in the record edit area of the Graphics 
window provide the tools for creating custom graphics.  
 

Using the Color Palette 

The color palette in the record edit area of the Graphics window provides the 
drawing colors for the creation of the user-defined reader board graphics. Click 
on a color in the color palette. The selected color is displayed in the color 
selection box to the right of the color palette. After selecting a color, fill in the gray 
dots of the drawing area to create the graphic. Switch colors where applicable 
and use gray to erase any errors. 
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Some models of the Spectrum reader boards do not support all of the colors 
provided in the color palette. Consult the Spectrum Corporation documentation 
for information on the colors supported. 
 

 
 

Using the Drawing Platform 

The drawing platform in the record edit area of the Graphics window is the area 
where user-defined graphics are created. The drawing platform is a simulation of 
a reader board. Each gray dot in the drawing platform represents an LED that 
can be filled with color using the colors of the color palette. 
 

 
 

Deleting Custom Graphics 

The Delete button on the toolbar of the Graphics window deletes the graphic 
selected in the record area of the window. It is only possible to delete graphics 
that are not referenced in a sign plan. If a graphic is referenced anywhere in a 
sign plan, all references must be removed prior to deleting the graphic. 
 
Use the following steps to delete a graphic from the Graphics window. 
 

1. Select the graphic to delete in the record area of the Graphics window. 
2. Click the Delete button on the toolbar. 
3. Click Yes in the Sign dialog box to acknowledge the deletion. 
4. If the graphic is not referenced anywhere else in the sign plan, it is deleted 

immediately. If the Sign dialog box opens with the statement: 
 

The selected element(s) cannot be deleted because they are being 
referenced by another part of the system. 
 

click OK and search the sign plan for references to the graphic and delete 
them before attempting to delete the graphic again. 
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TASKE Voice ToolBox 

TASKE Voice ToolBox is an application of the TASKE ToolBox that works in conjunction 
with Dialogic® voice cards to provide a call center with intelligent voice messaging 
capabilities.  
 
Using the Voice ToolBox application a call center is able to: 
 

• Route multiple messages to multiple answering points. Play messages that are of 
interest to callers and their position within the call center queues. For instance, 
play technical support messages in the technical support queue and play sales 
messages in the sales queue. 

• Incorporate variables into messages that change the message content based on 
the current call center conditions, the time of day, day of the week, or user 
defined special day. 

• Accept routing instructions from callers using DTMF (dual-tone-multi-frequency). 
This means callers can route themselves to the desired destination using their 
keypad and the options provided in the message. 

• Create messages using the sound files provided with the Voice ToolBox or 
create custom messages specific to the call center by creating .wav files and 
incorporating them into messages. 

 
The Voice ToolBox consists of two programs: TASKE Voice Administrator and TASKE 
Voice Server.  
 

  

Voice Administrator Icon Voice Server Icon 

 
The Voice Administrator is the Voice ToolBox user interface for configuring voice 
channels and defining voice plans. The Voice Server is the communication link between 
the Voice ToolBox application and the voice channels. Operating in the background, the 
Voice Server stores the voice plans, interfaces with the TASKE Information Server to 
determine the current call center conditions, and distributes the appropriate messages 
to the appropriate voice channels based on the conditions defined in the voice plan. 
  
It is not necessary to have both Voice ToolBox applications running concurrently. 
Because the Voice Server stores the voice plans, the Voice Administrator only needs to 
be started for configuration changes or to play quick messages. The Voice 
Administrator is required to play quick messages because the control of these 
messages is accessed via the Voice Administrator interface. 
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Controlling Media Using Voice Plans 

A voice plan contains all of the components required to communicate and play audio 
messages created with the Voice ToolBox through a Dialogic card. Use the windows of 
the Voice Administrator application to create voice plans. 
 
A voice plan plays recorded media through one or more voice channels. These 
channels are able to accept DTMF digits (dual-tone-multi-frequency digits, also known 
as touch-tone) from the caller and route the caller to the desired area of the call center. 
Creating voice plans that suit the needs of the call center require planning. Create voice 
plans using a top-down approach. This means the creation of a voice plan must begin 
with the creation of the messages and finish with the channel definition. This approach 
is necessary to develop the links between the voice plan elements.  
 
The components of a voice plan are as follows: 
 
Messages - voice messages are the messages played to callers. These messages may 
contain any of the pre-defined .wav files included with the Voice Toolbox application or 
users can create custom .wav files. 
 
Auto-attendants - an auto-attendant provides the structure for routing callers through 
the call center and determining which messages the callers will hear. Callers hear the 
choices available and dial the digits required to route themselves to the desired section 
of the call center.   
 
Day Plans - day plans break the call center day into segments and apply an auto-
attendant to each segment. This allows different messages to be applied to different 
times of the day.  
 
Scripts - scripts apply day plans to the days of the week and to special days. This 
allows different message combinations to be played to callers depending on the day of 
the week or user-defined special day.  
 
Channels - a voice channel is an output point for audio messages on a Dialogic voice 
card. When configuring a channel, an unique address number from 1 to 255 is required. 
Using the address number, the Voice ToolBox application maps messages to the 
correct voice channels. Assign scripts to voice channels to define the output point for 
the messages associated with the script.  
 
Special Days - special days are optional elements in a voice plans. Define special days 
or groups of days throughout the year that require specific messages or unique call 
center hours.  
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The chart, above, illustrates the linking between the voice plan elements. Messages 
must link to auto-attendants, auto-attendants must be embedded in day plans, day 
plans must be embedded in scripts, and finally, a channel cannot be defined without an 
embedded script. The calendar icon in the chart represents special days. These are 
days, such as holidays, that require unique messaging and may have operational hours 
that are not normal for the call center. Special days are optional elements in a voice 
plan, however, if they are to be included, they must be used in scripts when identifying 
the days of the week.  
 

Voice ToolBox Startup and Shutdown 

For Voice ToolBox configuration, only the Voice Administrator must be running. For the 
communication of messages from the Voice ToolBox to the telephone system, the Voice 
Server must be running on a PC with one or more Dialogic boards installed. 
 

Starting the Voice Administrator 

Use the following steps to start the Voice Administrator application. 
 

1. Double-click the TASKE ToolBox icon  on the desktop of the PC to 
open the TASKE ToolBox folder. 

2. Double-click the Voice Administrator icon  to start the Voice 
Administrator and open the application window. 

 

Starting the Voice Server 

When the Voice Server is started an icon appears in the taskbar of the PC's 
desktop and the Voice Server light on the Main Control Panel of the Voice 
Administrator turns green to indicate the establishment of communication. 
 

1. Double-click the TASKE ToolBox icon  on the desktop of the PC to 
open the TASKE ToolBox folder. 

2. Double-click the Voice Server icon  to start the Voice Server. 
 

Shutting Down the Voice Administrator 

Use the following steps to shut down the Voice Administrator application. 
 

1. Click File on the menu bar to open the File menu. 
2. Select Exit from the File menu. 
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Shutting Down the Voice Server 

Use the following steps to shut down the Voice Server application. 
 

1. Right-click on the Voice Server icon on the taskbar of the Windows 
desktop. 

2. Select Shutdown from the pop-up menu. 
3. Click the Yes button to confirm. 

 

Using the Voice Administrator Interface 

The Voice Administrator window is comprised of three sections: the menu bar, the Main 
Control Panel, and the display area. 
 

Menu Bar 

Spanning the top of the Voice Administrator window, the menu bar contains four 
menus. The four menus of the menu bar are File, Edit, View, and Help. 
 

File Menu 

System Parameters... - Use the System Parameters... 
option to open the System Parameters dialog box and 
configure system-wide parameters for the Voice 
ToolBox. 

 
Settings... - Use the Settings... option to open the Configuration dialog box to 
configure the communication paths to the Voice Server and to the TASKE Voice 
Database. 
 
Send Data to Voice Machine... - Use the Send Data to Voice Machine... option 
to update voice configuration or voice plan changes in the Voice Server. 
 
Exit - Select the Exit option to close the Voice Administrator application. This 
action does not shutdown the Voice Server application. 
 

Edit Menu 

Set Dynamic System Variable Values... - Select 
Set Dynamic System Variable Values... to open the 

Dynamic Phrase Test Values dialog box and enter test values for the ACD 
variables. These values are used in the playback of messages during system 
configuration. 
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View Menu 

The TASKE Voice Administrator operates in one of two modes. 
These modes are configuration and view. To switch between the 

modes, use the Config and View buttons on the Main Control Panel or use the 
View menu. 
 
Config Mode - The configuration mode is the interface for the creation and 
management of voice plan elements. When in the configuration mode, each 
window accessed from the Main Control Panel displays its existing elements. 
Use the window in the configuration mode to create new elements and edit the 
existing elements. 
 
View Mode - The view mode is a read-only, real-time display. When in the view 
mode, the windows accessed from the Main Control Panel display the element 
that is currently being used by the Voice ToolBox to play the message on the 
voice channel. This option is only available after configuration is complete and 
the communication with the Voice Server is established. 
 

Help Menu 

Contents - Select Contents from the Help menu to 
access the online help for the TASKE Voice 
Administrator and the TASKE Voice Server. 

 
About TASKE Voice Administrator... - This menu option opens the About 
TASKE Voice Administrator dialog box. This dialog box provides the software 
release number, the software version number, the copyright information, and the 
TASKE Lock Number. Click OK to exit the dialog box. 
 

Main Control Panel 

The Main Control Panel spans the left side of the Voice Administrator interface. 
This area of the interface has two functions: Mode selection and Window 
selection. 
 
 - when the light at the bottom of the Main Control Panel is green it 
indicates an established communication link with the Voice Server. If the light is 
red communication with the Voice Server is not available. 

 
Mode Selection - clicking the Config and View buttons toggle the 
TASKE Voice Administrator program between the configuration 

mode and the view mode. The configuration mode enables users to create and 
edit voice plan components using the windows of the display area. The view 
mode changes these windows to read-only, real-time displays. In the view mode, 
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the elements that are currently being used to broadcast messages through the 
voice channels are presented in the record area. 
 
Window Selection - the Main Control Panel contains buttons to access the 
windows of the voice plan components. Selection of a button opens its 
corresponding window in the display area. The windows are: 
 

Messages Auto-attendants Day Plans 

   

 Scripts Channels Days 

   
  

Display Area 

The display area of the Voice Administrator interface is the large area to the right 
of the Main Control Panel. The window selection buttons of the Main Control 
Panel determine the contents of the display area. Each window selection button 
opens a window that is displayed in the display area. These windows are the 
interface for creating and editing the elements of a voice plan in the configuration 
mode and the real-time display of these items in the view mode. 
 

Selecting a Mode 

The TASKE Voice Administrator operates in one of two modes. These modes are 
configuration and view. To switch between the modes, use the Config and View buttons 
on the Main Control Panel or use the View menu. 
 
The primary difference between the configuration mode and the view mode is 
functionality, not the appearance of the program window. The display area of the 
TASKE Voice Administrator is a pane that displays one of six windows. Switch between 
the windows using the window selection buttons on the Main Control Panel. These 
windows provide the interface for creating, managing, and viewing voice plan elements. 
 
The only difference in appearance between the two modes occurs in the record area of 
the display area pane. In the configuration mode, the record area provides a detailed list 
of all defined elements for that window. In the view mode, the record area displays the 
element that the Voice Server is currently transmitting to the voice channel. 
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Configuration Mode 

The configuration mode is the interface for the creation and 
management of voice plan elements. When in the configuration 

mode, each window accessed from the Main Control Panel displays its existing 
elements. Use the window in the configuration mode to create new elements and 
edit the existing elements. 
 

View Mode 

The view mode is a read-only, real-time display. When in the view 
mode, the windows accessed from the Main Control Panel display 

the element that is currently being used by the Voice ToolBox to play the 
message on the voice channel. This option is only available after configuration is 
complete and the communication with the Voice Server is established. 
 
The View mode is disabled if the Voice Server is not running. This is because 
there is no real-time data available for display when the Voice Server is not 
running. 
 
The Auto-attendant and Days windows do not operate in View Mode. 
 

Setting System Parameters 

Use the System Parameters... option on the File menu of the Voice Administrator 
application to open the System Parameters dialog box. This dialog box provides user 
access to system-wide parameters for configuration. 
 

 
 
Maximum Play Length (seconds) - This value, defined in seconds, indicates the 
maximum length of a message. The default value is 300 seconds or 5 minutes. 
 
Maximum Record Length (seconds) - This value, defined in seconds, indicates the 
maximum amount of time available for a user to record a message through the handset. 
The default value is 300 seconds or 5 minutes. 
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Interdigit Timeout (seconds) - This value, defined in seconds, is the maximum amount 
of time that is acceptable between the digits dialed by the caller. When the value for the 
Interdigit Timeout expires, the Voice ToolBox assumes the caller is finished entering 
digits and continues with the next action. The default value is 300 seconds or 5 minutes. 
 
Supervisor Password... - Select Supervisor Password... to change the password for 
accessing the Supervisor channel. Selection of this option opens the Change Password 
dialog box where the user must input the existing password and the new password 
twice. For security reasons, the * character appears for all characters input by the user 
in the fields of this dialog box. 
 

 
 
The default Voice ToolBox Supervisor password is 8885. Change this number as soon 
as possible to prevent changes by unauthorized users. 
 

Configuring Communication Paths 

Use the Settings... option on the File menu of the Voice Administrator application to 
open the Configuration dialog box where the communication paths to the Voice Server 
and the TASKE Voice Database are configured. 
 

 
 
TASKE Voice Server IP Address - Use this field to view or edit the IP address of the 
TASKE Voice Server. If the address of the Voice Server has changed, it may be 
necessary to 'ping' the new Voice Server to learn its IP address. To 'ping' the new Voice 
Server, access a DOS prompt and type: ping Voice Server PC network name. 
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TASKE Voice Server Port - The TASKE Voice Server port is the port that receives 
information from the Voice Server. This is a virtual number that is a connection ID. By 
default TASKE uses 700 for the connection ID. This means that any communication 
received by the PC with a connection ID of 700 is recognized as TASKE Voice Server 
data. 
 
TASKE Voice Database Path - The TASKE Voice Database Path is the network path 
the PC uses to find the TASKE Voice Database. Click the  button to access the 
established network connections and the Network Neighborhood and change the path if 
the path information is incorrect. 
 

Updating System Data in the Voice Server 

Use the Send Data to Voice Machine... option on the File menu of the Voice 
Administrator application to send changes made in the Voice Administrator application 
to the Voice Server. This option is only available when the Voice Server is running and 
communicating with the Voice Administrator. To confirm communication with the Voice 
Server, look for the green light on the Main Control Panel - . If a red light 
is present, communication is not available with the Voice Server and the connections 
should be verified. 
 

Updating System Data Using the Send Data to Voice Machine Option 

Use the following steps to update the system data using the Send Data to Voice 
Machine option. 
 

1. Select Send Data To Voice Machine... from the File menu. 
 

 
 

2. Click Yes in the TASKE Voice Administrator dialog box to confirm the 
update. 
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Defining Test Variables 

Dynamic phrase test values are used in the playback of messages during the 
configuration of the Voice ToolBox. For instance, when real-time information is not 
available, but a user is configuring a message that includes the Dynamic System 
Phrase for the number of calls waiting, the message can still be tested. When the 
message is tested, the user hears the value input in the Calls Waiting field of the 
Dynamic Phrase Test Values dialog box instead of a real-time value. 
 
Select Set Dynamic System Variable Values... from the Edit menu to open the Dynamic 
Phrase Test Values dialog box. Input the values in the fields of the dialog box as 
required and click OK to accept the values and close the dialog box. 
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Using the Messages Window 

The Messages Window is the interface for the construction of voice messages. Voice 
messages can contain any of the pre-defined .wav files included with the Voice Toolbox 
application or users can create custom .wav files. 
 
The .wav files are drawn from the \\taske\VoiceData directory on the PC where the 
Voice Server is installed. There are two folders in this directory that contain sound files: 
System and User. 
 
The System folder contains .wav files that are used for the creation of dynamic system 
phrases and the sound files for the prompts supervisors hear during remote 
programming of the Voice ToolBox. Many of the files in the System folder are useful for 
the creation of voice messages, however, due to the required file naming structure for 
system sounds, the files are difficult to identify. For easier file identification, the files are 
grouped by theme on the System Sounds tab of the Messages window. 
 
The User folder contains the .wav files that are most commonly used to create a 
message. Place custom .wav files in the User directory to make them available to the 
Voice ToolBox. The sounds from the User folder are available for message creation on 
the User Sounds tab of the Messages window. 
 

Messages Window Components 

The Messages window is comprised of three sections: the record area, the 
toolbar, and the record edit area. 
 

Record Area 

The record area of the Messages window lists the messages. Select a message 
from the list for editing or deletion. When selected, a message is highlighted in 
blue and its details can be viewed and edited in the record edit area. 
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Toolbar 

The toolbar in the Messages window is used to create and name new messages, 
edit existing messages, and delete messages no longer needed. 
 

 
 

Record Edit Area 

The record edit area of the Messages window provides the platform and the 
sound files for the construction of voice messages. This area is used to define 
new voice messages and to edit existing messages. The window in the left side 
of the record edit area is the message platform. This section is where messages 
are created by inserting sound files and arranging them logically. The window in 
the right side of the record edit area houses three tabs that contain the sound 
files available for message creation. 
 

 
 

Using the Tools of the Messages Window 

The following descriptions provide instruction on how to use the tools of the 
Messages window that are required for the creation of messages.  
 
Message Platform - The message platform is the window located on the right 
side of the record edit area. The message platform contains a grid that lists 
sound files in the first column and the play duration of the file in the second 
column. These files combine to create a voice message. The files are played in 
the order they are listed from top to bottom. Use the up and down arrows to the 
right of the message platform to reorder the files. 
 

 
Inserting Sound Files in a Message - Select a sound file from the User 
Sounds, System Sounds, or Dynamic System Phrase tab and click the 
insert button to add the file to the message platform.  
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Re-arranging Sound Files in a Message - Select a sound file in the 
message platform and use the up and down buttons located to the left of 
the message platform to change the order of the file in relation to the 
other files in the list. The sound files in the message platform are played 
in order, beginning at the top and ending with the last sound file in the list.
  

 
Playing Messages and Sound Files - Click the play button under the 
message platform to play the voice message (all sound files in the list). It 
is not necessary to have a sound file selected to play the message.   
To play a sound file from one of the tabs, select a sound file from the User 
Sounds tab or System Sounds tab and click the play button below the 
tabs to play the sound file. Files cannot be played from the Dynamic 
System Phrase tab. These files will play when included in a message on 
the message platform. 
 

 
Deleting Messages from the Message Platform - Select a message in 
the message platform and click the Delete Entry button to remove the 
message from the message platform. 
 

 
Stopping Messages and Sound Files - Click the stop button to stop a 
message from playing. This button stops messages from the message 
platform and sound files from the User Sounds and System Sounds tabs. 
 

User Sounds Tab - The User Sounds tab in the record edit area of the 
Messages, Quick Messages, and Decisions windows contain all of the .wav files 
located in the \\taske\VoiceData\User directory. The directory contains .wav files 
supplied with the TASKE Voice ToolBox and all user defined files must be 
placed in this directory for them to be accessible from within the Voice 
Administrator application. 
 
System Sounds Tab - The System Sounds tab in the record edit area of the 
Messages, Quick Messages, and Decisions windows contain all of the .wav files 
located in the \\taske\VoiceData\System directory. This directory houses all of 
the files used to create the dynamic system phrases and the sound files for the 
prompts supervisors hear during remote programming of the Voice ToolBox. 
System files must be named in the following manner: Sysxxx, where x is a 
number between 1 and 9. The system files are grouped by theme on the System 
Sounds tab for easy identification. 
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Dynamic System Phrase Tab - The Dynamic System Phrase tab in the record 
edit area of the Messages and Quick Messages windows contain the dynamic 
system phrases provided with the Voice ToolBox. A dynamic system phrase 
uses the system sounds to create a message that includes real-time information 
such as ACD statistics, the date, or the time.  
 
Several dynamic system phrases are provided on the Dynamic System Phrase 
tab of the Messages window. Include dynamic system phrases in a voice 
message that include ACD statistics, the date, or the time. 
 

Building a Message 

Use the Messages window to construct voice messages using the sound files 
provided with the Voice ToolBox, dynamic system phrases, and user defined 
.wav files. The positioning of the sound files in the message platform determines 
the order the sound files are played. 
 

Steps for Creating a Voice Message 

Use the following steps to create a new voice message. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Messages button on the Main Control Panel to view 
the Messages window. 

 3. Click New on the toolbar. 

  4. Type a message name in the Message Name field. 

 5. Select a sound file or dynamic system phrase from the User 
Sounds, System Sounds, or Dynamic System Phrase tabs. To 
listen to the sound before adding it to the message platform 
click the play button below the sound tabs. 

 6. Click the insert button to add the selected sound file to the 
message platform. 

  7. Repeat steps 5 and 6 to add additional sound files to the 
message platform. 

 8. Use the up and down arrow buttons to reorder the sound files 
as required. 

 9. Click the play button below the message platform to test the 
message. 

 10. Click Update on the toolbar to save the new message when 
satisfied with the message contents and order. 
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Deleting a Message 

The Delete button on the toolbar is used to delete voice messages. A message 
cannot be deleted if it is referenced anywhere else in the voice plan. All 
references to the message must be deleted before the message can be deleted. 
 

Steps for Deleting a Voice Message 

Use the following steps to delete a voice message. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Messages button on the Main Control Panel to view 
the Messages window. 

  3. Select the message to delete in the record area of the 
Messages window. 

 4. Click the Delete button on the toolbar. 

  5. Click Yes in the TASKE Voice Administrator dialog box to 
acknowledge the deletion. 

  6. If the message is not referenced anywhere else in the voice 
plan, it is deleted immediately. If the TASKE Voice 
Administrator dialog box opens with the statement: 

Message Name - Referenced by Voice Plan Element: 
Element Name 

click OK and search the voice plan for references to the 
message and delete them before attempting to delete the 
message again. 
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Using the Auto-attendants Window 

The Auto-attendants window provides an interface for the creation and modification of 
auto-attendants. An auto-attendant is able to route calls and determine which messages 
to play based on the digits dialed by a caller.  
 
By configuring a voice channel as an auto-attendant and assigning an auto-attendant 
script to the channel, it is able to accept DTMF digits (dual-tone-multi-frequency digits, 
also known as touch-tone) from the caller and route the caller to the desired area of the 
call center based on the conditions outlined in the auto-attendant and the other voice 
plan components. 
 

Auto-attendants Window Components 

The Auto-attendants window is comprised of three sections: the record area, the 
toolbar, and the record edit area. 
 

Record Area 

The record area of the Auto-attendants window lists the defined auto-attendants. 
Select an auto-attendant from the list for editing or deletion. When selected, an 
auto-attendant is highlighted in blue and its details can be viewed and edited in 
the record edit area. 
 

 
 

Toolbar 

The toolbar in the Auto-attendants window is used to create and name new auto-
attendants, save new auto-attendants and edits to existing auto-attendants, and 
delete auto-attendants no longer needed. 
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Record Edit Area 

The record edit area of the Auto-attendants window provides the tools and the 
platform for defining auto-attendants. This area is used to define new auto-
attendants and to edit the auto-attendants already defined. 
 

 
 

Using the Node List and Properties Window 

The auto-attendant node list is the platform for designing auto-attendants. Use 
the auto-attendant node tools, located to the right of the auto-attendant node list, 
to add nodes to the auto-attendant and the corresponding node properties 
windows to define the parameters for each node. 
 

 
 

The delete tool located to the right of the node list deletes the selected 
node in the node list and all nodes that branch directly from that node. 

Select a node in the auto-attendant node list and click the delete node button to 
remove the node and all subordinate nodes. Clicking the delete node button 
opens the TASKE Voice Administrator dialog box which states: 
 

Deleting the selected node will also remove any child nodes. Do you wish to 
continue? 

 
Click Yes to delete the selected node and all subordinate nodes, or No to 
abandon the procedure. 
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The node properties window is located below the node list. The content of the 
auto-attendant node properties window varies according to the type of node 
selected in the auto-attendant node list. There is a properties window for each of 
the node types. Use the node properties windows to define the settings for each 
node. Refer to the Auto-attendants Node Descriptions section for information on 
the node types and how to define the properties for each type of node. 
 

 
 
Play Node Properties  

 
 
Get Digit Node Properties  

 
 
Digit Node Properties  

 
 
Dial Node Properties  

 
 
Supervisor Node Properties  
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Using Play Nodes 

Use the Play node button to insert a play node in the auto-attendant node list. A 
play node is inserted in an auto-attendant to provide a message when a caller 
reaches that point of the auto-attendant node list. The contents of a play node 
can be a message created in the messages window or another auto-attendant.  
 
Insert play nodes beneath ring nodes, other play nodes, digit nodes, dial nodes, 
and supervisor nodes. Inserting a play node in the node list opens the play node 
properties in the properties window of the record edit area. The settings for the 
play node are defined in the properties window. These settings define the 
message for the play node and the conditions required for it to play. 
 

Defining Play Node Properties 

Enable the Named radio button to select a 
message or auto-attendant from the tabs in the 
right side of the record edit area. To input a 
message or auto-attendant in a play node, 

select the desired file and click the play node button in the Play properties 
window. 
 
Select the Digits radio button to have the auto-attendant select a sound file 
(.wav) to play that is based on the digits dialed in the above dial node. This 
option is primarily used to access the system sound files. The system sound files 
are located in the \\taske\VoiceData\System directory. System files must be 
named in the following manner: Sysxxx, where x is a number between 1 and 9.  
 
To acc/ess one of these files using the digits dialed by the caller, the file must be 
named by adding a prefix, postfix, and suppressing digits as required. For 
instance, to have the play node use the SYS999.wav file, when the digit dialed by 
the caller was 9, input SYS9 in the Pre field, input 9 in the Post field, and nothing 
in the Suppress field. This creates the filename SYS999.wav by combining the 
prefix of SYS9 with the 9 dialed by the caller and the postfix of 9. 
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Selecting Play Node Content 

The content for the play nodes is located in the Messages tab and the Auto-
attendants tab. 
 
Messages Tab - the Messages tab in the Auto-attendants window displays all of 
the messages created in the Messages window. Use the messages by inserting 
them into the play nodes of an auto-attendant. 
 
Use the following steps to insert a message from the Messages tab into a play 
node. 
 

 1. Select the play node in the auto-attendant node list.  
  2. Select the Named radio button in the Play properties window. 
  3. Select the desired message from the Messages tab in the Auto-

attendant window. 

 4. Click the play node button in the Play properties window to insert the 
Message into the play node. The name of the Message appears in the 
field beside the Named radio button. 

 
Auto-attendants Tab - the Auto Attendants tab in the Auto-attendants window 
displays all of the auto-attendants defined in the Auto-attendants window except 
for the one that is currently selected. Insert an auto-attendant in a play node of 
the selected auto-attendant to use it and its associated messages when a caller 
reaches it in the auto-attendant node list. The currently selected auto-attendant is 
not displayed in the Auto Attendant tab to prevent users from attempting to nest 
the auto-attendant onto itself. 
 
Use the following steps to insert an auto-attendant in a play node. 
 

 1. Select the play node in the auto-attendant node list.  
  2. Select the Named radio button in the Play properties window. 
  3. Select the desired auto-attendant from the Auto-attendants tab in the 

Auto-attendant window. 

 4. Click the play node button in the Play properties window to insert the 
auto-attendant into the play node. The name of the auto-attendant 
appears in the field beside the Named radio button.. 
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Using Get Digit Nodes 

A Get Digits node prepares the auto-attendant to receive dialed digits from 
the caller. Every time a Get Digits node is inserted into an auto-attendant 

node list, a default Digit node is also inserted. Insert additional Digit nodes below 
the Get Digits node as required.  
 
The default Digit node prompts the auto-attendant to move to the next action in 
the auto-attendant node list. For instance, under the Get Digits node there may 
be two Digit nodes: the default Digit node and a Digit node that expects the caller 
to dial a 1. If the caller dials anything but a 1 at this point in the auto-attendant 
tree, it uses the default Digit node. 
 
When a Get Digits node is selected in the auto-attendant node list, the node 
properties window displays the property settings for the node. 
 

Defining Get Digit Node Properties 

The only property setting for the Get Digit node 
determines the state of the input digit buffer. 
Enable the Clear Digit Buffer? check box to 
clear the input digit buffer before the message 

is played or disable the check box to have the numbers remain in the buffer for 
later use. 
 

Using Digit Nodes 

A Digit node identifies the dial string a caller enters to route the call to a 
specific person or department. Every time a Get Digits node is inserted into 

the auto-attendant node list a default Digit node is also inserted. Insert additional 
Digit nodes below the Get Digits node as required. 
 
The default Digit node prompts the auto-attendant to move to the next action in 
the auto-attendant node list. For instance, under the Get Digits node there may 
be two Digit nodes: the default Digit node and a Digit node that expects the caller 
to dial a 1. If the caller dials anything but a 1 at this point in the auto-attendant 
tree, it uses the default Digit node. 
 
When a Digit node is selected in the auto-attendant node list, the node properties 
window displays the property settings for the node. 
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Defining Digit Node Properties 

The only property setting for the Digit node is 
the identification of the dial string. Input a 
specific dial string or combine digits with 
wildcards when there are several dialing 

possibilities for the caller. For instance, input 8NNN to tell the Voice ToolBox that 
the call can be routed after the fourth digit is entered, when the first digit dialed is 
an 8. If, on the other hand, only an 8 was identified for the dial string, the call 
would be routed the moment the caller dialed the 8. 
 

Using Dial Nodes 

A Dial node provides the Voice ToolBox with the dial string that it must use 
to route the call based on the digits dialed by the caller. When a Dial node 

is selected in the auto-attendant node list, the node properties window displays 
the property settings for the node. The node properties window for the Dial node 
requires the dial string for routing the call. There are two types of dial strings for a 
Dial node: Static and Dynamic. Select only one type of dial string for each Dial 
node. 
 

Defining Dial Node Properties 

To create a Static dial string, enable the Static 
radio button and input a dial string in the field to 
the right. The dial string may include special 
characters such as & and , to perform functions 

in the PBX. For instance, the & in a dial string tells the channel to go "off hook" 
so the number can be dialed, whereas, the , creates a 5 second delay. Therefore 
the dial string &,,5900 takes the channel "off hook" waits 10 seconds and then 
dials the numbers 5900. 
 
To create a Dynamic dial string, enable the Dynamic radio button and input 
characters in the Pre, Post, and Suppress fields as required. A Dynamic dial 
string uses the digits dialed by the caller and adds characters identified in the Pre 
field to the start of the string, adds characters identified in the Post field to the 
end to the dial string, and suppresses any digits dialed that are identified in the 
Suppress field. For instance if the caller dialed 5900 and the user wants the call 
to be routed to extension 5923, the user creating a Dynamic dial node can input 
&,, in the Pre field to take the channel "off hook" and wait 10 seconds, input the 
numbers 23 in the post field, and input the number 00 in the suppress field to 
have the Voice ToolBox route the call to extension 5923. The formula for this 
type of dial string is: Prefix + (Digits Dialed - Digits to Suppress) + Postfix. 
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Using Supervisor Nodes 

Insert a Supervisor node into an auto-attendant to route supervisors to the 
supervisor channel. Supervisors can perform remote programming from the 

supervisor channel.  
 

Defining Supervisor Node Properties 

There are no properties associated with this type of auto-attendant node. See 
Remote Programming Using the Supervisor Channel in the TASKE Voice 
ToolBox section of the online help for further information on programming the 
Voice ToolBox using the supervisor channel. 
 

Defining Auto-attendants 

An auto-attendant is able to route calls and determine which messages to play 
based on the digits dialed by a caller. The node combinations in an auto-
attendant are completely dependant on the user. The following is only one 
example of the combinations available. 
 

Steps to Define an Auto-attendant 

Use the following steps to create a new auto-attendant. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the AA (Auto-attendant) button on the Main Control Panel 
to view the Auto-attendants window. 

 3. Click New on the toolbar. 

  4. Type a name for the auto-attendant in the Auto-attendant field. 

 5. Click the Play node button to insert a Play node in the auto-
attendant node list. This prompts the auto-attendant to play the 
message associated with the Play node when the voice 
channel rings. An example of a message a Play node may 
deliver is: Welcome, press 1 for Technical Support or 2200 for 
Sales. 

  6. Set the Play node properties in the Play properties window. 
See Using Play Nodes for information on setting the properties 
for a Play node. 
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 7. Click the Get Digits node button to insert a Get Digits node and 
the default Digit node below the Play node in the auto-
attendant node list. 

  8. Set the Get Digits node properties in the Get Digit properties 
window. See Using Get Digit Nodes for information on setting 
the properties for a Get Digits node. 

 9. Click the Digit node button to add a Digit node above the 
default Digit node. 

  10. Input 1 in the String field of the Digit properties window (see 
the example message in step 5). See Using Digit Nodes for 
information on setting the Digit node properties. 

 11. Click the Dial node button to insert a Dial node below the Digit 
node in the auto-attendant node list. 

  12. Set the Dial node properties in the Dial properties window. 
Ensure that the Dial string accesses Technical Support (see 
the message in step 5). See Using Dial Nodes for information 
on setting the Dial node properties. 

 13. Select the Get Digits node and repeat step 9 to add another 
Digit node. 

  14. Input 2NNN in the String field of the Digit properties window 
(see the message in step 5). The NNN tells the Voice ToolBox 
not to route the call until an additional 3 digits are dialed after 
the 2. 

 15. Repeat step 11 to add a Dial node below the Digit node. 
  16. Set the Dial node properties in the Dial properties window. 

Ensure that the Dial string accesses Sales (see the message in 
step 4). 

 17. Click Update on the toolbar to save the new auto-attendant.  
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Deleting Auto-attendants 

The Delete button on the toolbar of the Auto-attendants window deletes the auto-
attendant selected in the record area of the window. It is only possible to delete 
an auto-attendant that is not referenced elsewhere in the voice plan. If an auto-
attendant is referenced anywhere else in a voice plan, all references must be 
removed prior to deleting the auto-attendant. 
 

Steps to Delete an Auto-attendant 

Use the following steps to delete an auto-attendant. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the AA (Auto-attendant) button on the Main Control 
Panel to view the Auto-attendants window. 

  3. Select the auto-attendant to delete in the record area of the 
Auto-attendants window. 

 4. Click the Delete button on the toolbar. 

  5. Click Yes in the TASKE Voice Administrator dialog box to 
acknowledge the deletion. 

  6. If the auto-attendant is not referenced anywhere else in the 
voice plan, it is deleted immediately. If the TASKE Voice 
Administrator dialog box opens with the statement: 

Auto-attendant Name - Referenced by Voice Plan Element: 
Element Name 

click OK and search the voice plan for references to the auto-
attendant and delete them before attempting to delete the 
auto-attendant again. 
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Using the Day Plans Window 

The Day Plans window is accessed by clicking the Day Plans button on the Main 
Control Panel. This window is used to partition a 24-hour period and apply an auto-
attendant to each partition.  
 
This process breaks the call center day into segments and allows different messages to 
be applied to different times of the day. Once defined, the day plans are applied to 
specific days of the week or special days in the Scripts window. 
 

Day Plans Window Components 

The Day Plans window is comprised of three sections: the record area, the 
toolbar, and the record edit area. 
 

Record Area 

The record area of the Day Plans window lists each of the defined day plans with 
its day plan type. Select a day plan from the list for editing or deletion. When 
selected, a day plan is highlighted in blue and its details can be viewed and 
edited in the record edit area. 
 

 
 

Toolbar 

The toolbar in the Day Plans window allows users to create and name new day 
plans, edit existing day plans, and delete day plans no longer needed. 
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Record Edit Area 

The record edit area of the Day Plans window is the interface for defining the 
time segments of a day plan. This area is used to define new time segments, 
delete time segments, and to edit the existing time segments of a day plan. 
 

 
 

Using the Tools of the Day Plans Window 

The following descriptions provide instruction on how to use the tools of the Day 
Plans window that are required for the creation of day plans.  
 
Day Plans Platform - The day plans platform is located in the record edit area of 
the Day Plans window. This area provides a table where the time segments of 
the day plans are displayed with their associated decisions. Click on the hour or 
minute field of a time segment in either the From or To columns of the table to 
edit the time. Click the down-arrow in the Decision column to assign an auto-
attendant to the time segment. 
 
Setting the Start Time for a Time Segment - The From column in the record 
edit area of the Day Plans window defines the starting time for a day plan time 
segment. The time in the From column for the first time segment of a day plan 
must be 00:00. Each day plan must encompass a 24-hour period, beginning with 
00:00 and ending with 23:59. 
 
To set the starting hour of a time segment, click the hour field in the From 
column and type a value between 00 and 23. To set the starting minute of a time 
segment, click the minute field in the From column and type a value between 00 
and 59. 
 
Setting the End Time for a Time Segment - The To column in the record edit 
area of the Day Plans window defines the ending time for a day plan time 
segment. The time in the To column for the last time segment of a day plan must 
be 23:59. Each day plan must encompass a 24-hour period, beginning with 
00:00 and ending with 23:59. 
 
To set the ending hour of a time segment, click the hour field in the To column 
and type a value between 00 and 23. To set the ending minute of a time 
segment, click the minute field in the To column and type a value between 00 
and 59. 
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Applying Auto-attendants to Time Segments - Applying auto-attendants to 
the time segments of a day plan creates an association between the time of day, 
messages, and call center conditions that may be embedded in the messages. 
The Voice Server searches the day plan configuration for a time segment that 
matches the current time. It then searches the auto-attendant associated with 
the time segment for the appropriate message to play.  
 

 
Adding Segments to a Day Plan - Click the Add Entry button to add a 
new time segment to the day plan in the day plans platform. 
 

 
Deleting Day Plan Segments from the Day Plans Platform - Select a 
time segment in the day plans platform and click the Delete Entry button to 
remove the time segment from the day plans platform. 

 

Defining Day Plans 

Use the Day Plans window to apply auto-attendants to specific segments of a 24-
hour period. A day plan must begin with 00:00 and end with 23:59. The minimum 
size of a day plan segment is 1 minute while the maximum size is 24-hours. A 
default day plan is automatically created in the Day Plans window. 
 

Steps for Creating a Day Plan 

Use the following steps to create a new day plan. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Day Plans button on the Main Control Panel to view 
the Day Plans window. 

 3. Click New on the toolbar. 

  4. Type a day plan name in the Day Plan Name field. 

 5. Click the Add Entry button twice to add a second and third time 
segment to the day plan. 

  6. Set the start time for each time segment in the From column. 
  7. Set the end time for each time segment in the To column. 
  8. Select an auto-attendant for each time segment from the Auto-

attendant column. 

 9. Click Update on the toolbar to save the new day plan when 
satisfied with the day plan contents. 
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Deleting a Day Plan 

The Delete button on the toolbar of the Day Plans window deletes the day plan 
selected in the record area of the window. It is only possible to delete a day plan 
that is not referenced elsewhere in the voice plan. If a day plan is referenced 
anywhere else in a voice plan, all references must be removed prior to deleting 
the day plan. 
 

Steps for Deleting a Day Plan 

Use the following steps to delete a day plan. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Day Plans button on the Main Control Panel to view 
the Day Plans window. 

  3. Select the day plan to delete in the record area of the Day 
Plans window. 

 4. Click the Delete button on the toolbar. 

  5. Click Yes in the TASKE Voice Administrator dialog box to 
acknowledge the deletion. 

  6. If the day plan is not referenced anywhere else in the voice 
plan, it is deleted immediately. If the TASKE Voice 
Administrator dialog box opens with the statement: 
Day Plan Name - Referenced by Voice Plan Element: Element 

Name 
click OK and search the voice plan for references to the day 
plan and delete them before attempting to delete the day plan 
again. 
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Using the Days Window 

The Days window is accessed by clicking the calendar icon on the main control 
panel. Use this window to identify special days that require unique messages.  

 
Special days are included in a voice plan using the Scripts window. A special day is 
included in a script and associated with messages through the assignment of a day 
plan. 
 

Days Window Components 

The Days window is comprised of three sections: the record area, the toolbar, 
and the record edit area. 
 

Record Area 

The record area of the Days window lists the defined special days that require 
specific messages. Select a special day from the list for editing or deletion. When 
selected, a special day is highlighted in blue and its details are viewable and 
editable in the record edit area. 
 

 
 

Toolbar 

The toolbar in the Days window is used to create and name new special days, 
edit existing special days, and delete special days no longer needed. 
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Record Edit Area 

The record edit area of the Days window is the interface for defining and editing 
the special days. Define Specific dates or Reference Dates and type a 
description of the date for easy identification in the record area. 
 

 
 

Defining Specific Dates 

Use the Days window to define special days or groups of days throughout the 
year that require specific messages. A special day is defined as a specific date 
when it applies to a particular calendar date. For instance, Christmas is a specific 
date because it falls on the 25th of December every year. 
 

 
 

Steps for Creating a Specific Date 

Use the following steps to create a new specific date for a special day. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Days button (calendar icon) on the Main Control 
Panel to view the Days window. 

 3. Click New on the toolbar. 

  4. Type a name in the Day Name field for the new day or group 
of days. 

  5. Enable the Specific radio button to define a specific calendar 
date or a group of dates. 

  6. Click on the numeric day of the month and use the up and 
down arrows to select the day of the month. 

  7. Click on the month and use the up and down arrows to select 
the month. 
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  8. Use the up and down arrows in the day(s) field to define the 
number of days the period encompasses, beginning with the 
selected date. 

  9. Click in the Description field and type a description for the day 
or group of days. 

 10. Click Update on the toolbar to save the new day, or group of 
days. 

 

Defining Reference Dates 

Use the Days window to define special days or groups of days throughout the 
year that require specific messages. A special day is defined as a reference date 
when it applies to an event that falls on the same day of the week, in the same 
month, every year. A date like Father's Day is considered to be a reference date 
because it is defined by its occurrence on the third Sunday in June each year. 
 

 
 

Steps for Creating a Reference Date 

Use the following steps to create a new specific date for a special day. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Days button (calendar icon) on the Main Control 
Panel to view the Days window. 

 3. Click New on the toolbar. 

  4. Type a name in the Day Name field for the new day or group of 
days. 

  5. Enable the Reference radio button to define a reference date 
or a group of dates. 

  6. Click the down arrow in the first field to the right of the 
Reference radio button to select the reference day within the 
month. The selections in this list are First, Second, Third, 
Fourth, or Last. These adjectives refer to specific days of the 
week within a specific month. For instance, it may be referring 
to the first Friday in June. 

  7. Click on the day of the week and use the up and down arrows 
to select a day. 
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  8. Click on the month and use the up and down arrows to select a 
month. 

  9. Use the up and down arrows in the day(s) field to define the 
number of days the period will encompass, beginning with the 
selected date. 

  10. Click in the Description field and type a description for the day 
or group of days. 

 11. Click Update on the toolbar to save the new day, or group of 
days. 

 

Deleting Special Days 

The Delete button on the toolbar of the Days window deletes the special day 
selected in the record area of the window. It is only possible to delete special 
days that are not referenced elsewhere in the voice plan. If a special day is 
referenced anywhere else in a voice plan, all references must be removed prior 
to deleting the special day. 
 

Steps for Deleting a Special Day 

Use the following steps to delete a voice message. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Days button (calendar icon) on the Main Control 
Panel to view the Days window. 

  3. Select the special day to delete in the record area of the Days 
window. 

 4. Click the Delete button on the toolbar. 

  5. Click Yes in the TASKE Voice Administrator dialog box to 
acknowledge the deletion. 

  6. If the special day is not referenced anywhere else in the voice 
plan, it is deleted immediately. If the TASKE Voice 
Administrator dialog box opens with the statement: 

Day Name - Referenced by Voice Plan Element: Element 
Name 

click OK and search the voice plan for references to the special 
day and delete them before attempting to delete the special 
day again. 
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Using the Scripts Window 

The Scripts window is accessed by clicking the Scripts button on the Main Control 
Panel. This window is used to apply day plans to the days of the week and to special 
days.  
 
This process produces associations between the day of the week, the time of day, 
messages, and call center conditions by creating links between a script, a day plan, and 
a decision. 
 

Scripts Window Components 

The Scripts window is comprised of three sections: the record area, the toolbar, 
and the record edit area. 
 

Record Area 

The record area of the Scripts window lists the defined scripts. Select a script 
from the list for editing or deletion. When selected, a script is highlighted in blue 
and its details can be viewed and edited in the record edit area. 
 

 
 

Toolbar 

The toolbar in the Scripts window is used to create and name new scripts, edit 
existing scripts, and delete scripts no longer needed. 
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Record Edit Area 

The record edit area of the Scripts window provides the interface for the 
application of day plans to the days of the week or to special days. Together, 
these days and their associated day plans create a script. The record edit area is 
used to add days to a script and to edit the days that have already been defined 
for an existing script. 
 

 
 

Using the Tools of the Scripts Window 

The following descriptions provide instruction on how to use the tools of the 
Scripts window that are required for the creation of scripts.  
 
Script Platform - The script platform is located in the record edit area of the 
Scripts window. This area provides a table that displays the script entries. To edit 
or delete a script entry, other than the default entry, select the script entry from 
the table by clicking in one of its table fields. 
 
Selecting a Day for a Script Entry - The Day column of the Scripts window 
assigns days of the week or special days to script entries. Click the down-arrow 
in each row of the Day column and select a weekday or special day from the 
drop-down list. Each day in the list can only appear in a script once. 
The first entry in every script is the default entry. The default day plan is 
automatically applied to the default script entry. This script entry is used when no 
other script entries are present, or when the existing script entries do not apply to 
the current conditions. 
 
Selecting a Day Plan for a Script Entry - The Day Plan column of the Scripts 
window assigns day plans to the script entries. Click the down-arrow in each row 
of the Day Plan column and select a day plan from the drop-down list. 
 

 
Adding Segments to a Day Plan - Click the Add Entry button to add a new 
time segment to the day plan in the day plans platform. 
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Deleting Day Plan Segments from the Day Plans Platform - Select a time 
segment in the day plans platform and click the Delete Entry button to remove 
the time segment from the day plans platform. 
 

 

Defining a Script 

Use the Scripts window to create scripts that apply day plans to the days of the 
week or to special days. When a new script is created, a default entry is 
automatically added that uses the default day plan for the script type. Use each 
day of the week or special day only once in each script. 
 

Steps for Creating a Script 

Use the following steps to create a new script. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Scripts button on the Main Control Panel to view the 
Scripts window. 

 3. Click New on the toolbar. 

  4. Type a script name in the Script Name field. 

 5. Click the Add Entry button to add a new script entry. 
  6. Click in the Day column for the entry and select a day of the 

week. 
  7. Click in the Day Plan column for the entry and select a day 

plan. 
  8. Repeat steps 5 to 7 to define additional script entries. 

 9. Click Update on the toolbar to save the new script when 
satisfied with the script contents. 
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Deleting a Script 

The Delete button on the toolbar of the Scripts window deletes the script selected 
in the record area of the window. It is only possible to delete scripts not 
referenced elsewhere in a voice plan. If a channel references the script in the 
Channels window, the reference must be deleted from the Channels window 
prior to deleting the script. 
 

Steps for Deleting a Script 

Use the following steps to delete a script. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Scripts button on the Main Control Panel to view the 
Scripts window. 

  3. Select the script to delete in the record area of the Scripts 
window. 

 4. Click the Delete button on the toolbar. 

  5. Click Yes in the TASKE Voice Administrator dialog box to 
acknowledge the deletion. 

  6. If the script is not referenced anywhere else in the voice plan, it 
is deleted immediately. If the TASKE Voice Administrator 
dialog box opens with the statement: 

Script Name - Referenced by Voice Plan Element: Element 
Name 

click OK and search the voice plan for references to the script 
and delete them before attempting to delete the script again. 
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Using the Channels Window 

The Channels window is accessed by clicking the Channels button on the Main Control 
Panel. This window is used to configure the voice channels and complete voice plans 
through the application of scripts to the channels.  
 
A voice channel is an output point for audio messages on a Dialogic voice card. 
Depending on the number of Dialogic cards installed, a PC can support 16 to 64 voice 
channels. When configuring a channel in the Voice Administrator, an unique address 
number from 1 to 255 is required. Using the address number, the Voice ToolBox 
application maps messages to the correct voice channels. 
 

Channels Window Components 

The Channels window is comprised of three sections: the record area, the 
toolbar, and the record edit area. 
 

Record Area 

The record area of the Channels window lists the defined channels with their 
channel numbers, types, and associated scripts. Select a channel from the list for 
editing or deletion. When selected, a channel is highlighted in blue and its details 
can be viewed and edited in the record edit area. 
 

 
 

Toolbar 

The toolbar in the Channels window is used to create and name new channels, 
save new channels and edits to existing channels, and delete channels no longer 
needed. 
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Record Edit Area 

The record edit area of the Channels window provides the interface for 
configuring voice channels. The record edit area is used to assign scripts to voice 
channels and to define voice channel parameters.  
 

 
 

Defining a Voice Channel 

Use the Channels window to configure the voice channels and complete voice 
plans through the application of scripts to the channels. 
 

Steps for Creating a Voice Message 

Use the following steps to create a new voice message. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Channels button on the Main Control Panel to view 
the Channels window. 

 3. Click New on the toolbar. 

  4. Select a channel type from the Channel Parameters dialog 
box. Once the channel type is selected, it cannot be changed. 

  5. Assign a channel number in the Channel field of the Channel 
Parameters dialog box.  

  6. Click OK to accept the channel parameters and close the 
dialog box.  

  7. Type a channel name in the Channel Name field. 
  8. Select a message from the Pre-Message field of the record edit 

area if desired. 
  9. Select a script from the Script field of the record edit area. 
  10. Select a message from the Post-Message field of the record 

edit area if desired. 
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  11. Select a Queue from the Queue drop-down list in the record 
edit area. 

  12. Input an extension number in the Extension field of the record 
edit area if desired. 

 13. Click Update on the toolbar to save the new channel. 

 

Setting Channel Parameters 

Open the Channel Parameters dialog box by clicking the New button on the 
toolbar of the Channels window. This dialog box allows users to define the 
channel type and channel number. 
 

 
 

Selecting a Channel Type 

Select the radio button of the desired channel type in the Channel Parameters 
dialog box. There are two channel types: 
 

• AA (Auto-attendant) channels wait for the channel to ring, answer the 
call, and depending on the configuration, proceed to play a message, get 
DTMF digits from the caller, or dial a string of digits. 
 

• Supervisor channels wait for the channel to ring, answer the call, and 
prompt the caller for a password. The password accesses a series of 
menus that remotely configure and control the Voice ToolBox. 

 

Defining a Channel Number 

Select a channel number in the Channel field of the Channel Parameters dialog 
box. Use the spin control to select the channel number or type the number into 
the box. The channel number can be any number between 1 and 255. Ensure 
that the channel number does not conflict with any other channels. 
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Properties of a Voice Channel 

The record edit area of the Channels window provides an interface for defining or 
editing the properties of a voice channel. Refer to the descriptions below for 
information on the properties of a voice channel. 
 

 
 

Channel Type Configure each voice channel to one of the following two 
types: 
 
AA (Auto-attendant) channels wait for the channel to ring, 
answer the call, and depending on the configuration, proceed 
to play a message, get DTMF digits from the caller, or dial a 
string of digits. 
 
Supervisor channels wait for the channel to ring, answer the 
call, and prompt the caller for a password. The password 
accesses a series of menus that remotely configure and 
control the Voice ToolBox. 
 

Pre-Message 
  

The Pre-Message field in the record edit area of the Channels 
window allows users to select a message for the voice channel 
to play before the messages associated with the script are 
played. This field uses the messages created in the Messages 
window. Leave the field blank if a pre-message is not required.  
 

Script Use the Script field to apply a script to the channel. A script 
applies day plans to the days of the week and to special days. 
This process produces associations between the day of the 
week, the time of day, and the call center conditions by 
creating a link between a script, a day plan, and a decision or 
auto-attendant. This final step links those associations to a 
voice channel.  
 
Apply AA scripts to AA (auto-attendant) channels only. 
Supervisor channels do not accept script associations. 
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Post-Message The Post-Message field allows users to select a message for 
the voice channel to play after the messages associated with 
the script have played. This field uses the messages created in 
the Messages window. Leave the field blank if a post-message 
is not required.  
 

Queue Use the Queue field in the record edit area of the Channels 
window to apply the voice channel and associated script to a 
Queue. A Queue is a dialable number that accesses a group of 
answering positions (agents or extension groups). When a 
caller enters the Queue the voice channel plays the messages 
associated with its script. 
 

Extension Input an extension number in the Extension field in the record 
edit area of the Channels window to identify the extension 
number dialed when a caller enters the queue for the voice 
channel. This field is used solely to provide information to the 
user.  

 

Deleting a Voice Channel 

The Delete button on the toolbar of the Channels window deletes the channel 
selected in the record area of the window. 
 

Steps for Deleting a Voice Channel 

Use the following steps to delete a voice message. 
 

 
1. Click the Config button to choose Configuration mode.  

 2. Click the Channels button on the Main Control Panel to view 
the Channels window. 

  3. Select the channel to delete in the record area of the Channels 
window. 

 4. Click the Delete button on the toolbar. 

  5. Click Yes in the TASKE Voice Administrator dialog box to 
acknowledge the deletion. 
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Remote Programming 

A Supervisor channel allows an administrator to remotely configure the Voice ToolBox, 
including changing and recording voice messages, from a touch tone telephone.  
 
A Supervisor channel is enabled in one of two ways: 
 

• creating a Supervisor channel in the Channels window of the Voice Administrator 
 

• add a Supervisor node in the auto-attendant node list of an auto-attendant 
channel. 

 
To remotely administer voice messaging, an administrator must know the extension of a 
dedicated Supervisor channel or the path that leads to a Supervisor node in an auto-
attendant node list. The Supervisor channel provides the administrator with a group of 
menus that lead the administrator through the programming process. Following is an 
illustration of the introductory menu. 
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Accessing System Messaging 

Menu # 1 provides options an option that leads to menus for reviewing and 
recording voice messages. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



TASKE Call Center Management Tools            

 
- 408 - 

Reviewing the System Message 

The Review the System Message menu provides the functionality for reviewing 
and recording the messages currently programmed for a channel. 
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Recording Messages 

The Record Message menu allows a user to record a message and to access 
Menu # 2 for reviewing, re-recording, and saving the recorded message. 
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Reviewing, Re-recording, and Saving Messages 

Menu # 2 allows a user to review, re-record, and save a recorded message. 
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Identifying System Sounds 

The System Sounds Tab is located in the record edit area of each of these windows in 
the Voice Administrator application. To aid in the identification of the contents of the 
sound files on this tab, refer to the table below. The table contains 176 references, one 
for each of the sound files in the System Sounds Tab. Each sound in the table is named 
as it is named on the System Sounds tab, in the format SYSXXX where X is a numeric 
value from 0 to 9. 
 

Sound Name Statement 

Sys000 Testing: one, two, three 

Sys001 Zero 

Sys002 One 

Sys003 Two 

Sys004 Three 

Sys005 Four 

Sys006 Five 

Sys007 Six 

Sys008 Seven 

Sys009 Eight 

Sys010 Nine 

Sys011 Ten 

Sys012 Eleven 

Sys013 Twelve 

Sys014 Thirteen 

Sys015 Fourteen 

Sys016 Fifteen 

Sys017 Sixteen 

Sys018 Seventeen 

Sys019 Eighteen 

Sys020 Nineteen 

Sys021 Twenty 

Sys022 Thirty 
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Sound Name Statement 

Sys023 Forty 

Sys024 Fifty 

Sys025 Sixty 

Sys026 Seventy 

Sys027 Eighty 

Sys028 Ninety 

Sys029 Hundred 

Sys030 Thousand 

Sys031 January 

Sys032 February 

Sys033 March 

Sys034 April 

Sys035 May 

Sys036 June 

Sys037 July 

Sys038 August 

Sys039 September 

Sys040 October 

Sys041 November 

Sys042 December 

Sys043 Tomorrow 

Sys044 Yesterday 

Sys045 Today 

Sys046 A.M. 

Sys047 P.M. 

Sys048 Star 

Sys049 Pound 

Sys050 Goodbye 
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Sound Name Statement 

Sys051 Minus 

Sys052 And 

Sys053 More than nine 

Sys054 Cents 

Sys055 Dollars 

Sys056 Seconds 

Sys057 Minutes 

Sys058 Hours 

Sys059 Pause 

Sys060 Flash 

Sys061 Call 

Sys062 Good morning 

Sys063 Good afternoon 

Sys064 Good evening 

Sys065 Point 

Sys066 That was not a valid entry 

Sys067 Million 

Sys068 A 

Sys069 B 

Sys070 C 

Sys071 D 

Sys072 E 

Sys073 F 

Sys074 G 

Sys075 H 

Sys076 I 

Sys077 J 

Sys078 K 
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Sound Name Statement 

Sys079 L 

Sys080 M 

Sys081 N 

Sys082 O 

Sys083 P 

Sys084 Q 

Sys085 R 

Sys086 S 

Sys087 T 

Sys088 U 

Sys089 V 

Sys090 W 

Sys091 X 

Sys092 Y 

Sys093 Z (zed) 

Sys094 Z (zee) 

Sys095 First 

Sys096 Second 

Sys097 Third 

Sys098 Fourth 

Sys099 Fifth 

Sys100 Sixth 

Sys101 Seventh 

Sys102 Eighth 

Sys103 Ninth 

Sys104 Tenth 

Sys105 Eleventh 

Sys106 Twelfth 
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Sound Name Statement 

Sys107 Thirteenth 

Sys108 Fourteenth 

Sys109 Fifteenth 

Sys110 Sixteenth 

Sys111 Seventeenth 

Sys112 Eighteenth 

Sys113 Nineteenth 

Sys114 Twentieth 

Sys115 Thirtieth 

Sys116 Fortieth 

Sys117 Fiftieth 

Sys118 Sixtieth 

Sys119 Seventieth 

Sys120 Eightieth 

Sys121 Ninetieth 

Sys122 Hundredth 

Sys123 Thousandth 

Sys124 Millionth 

Sys125 Space 

Sys126 Hundred 

Sys127 Thousand 

Sys128 Million 

Sys129 Twenty-one 

Sys130 Thirty-one 

Sys131 Forty-one 

Sys132 Fifty-one 

Sys133 Sixty-one 

Sys134 Seventy-one 
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Sound Name Statement 

Sys135 Eighty-one 

Sys136 Ninety-one 

Sys137 One 

Sys138 One 

Sys139 Welcome to the TASKE Voice ToolKit. 

Sys140 Please enter your supervisor password. 

Sys141 Please enter the emergency authorization password. 

Sys142 That is an invalid password. 

Sys143 To review a system message, press 1. To exit, press the star key. 

Sys144 To review a system message, press 1. To review the emergency 
status, press 5. To review emergency messaging, press 9. To exit, 
press the star key. 

Sys145 To confirm setting emergency mode on all channels, press 9. 

Sys146 To review the emergency message, press 1. To record a new 
emergency message, press 3. To review the emergency status, 
press 5. To disable emergency mode on all channels, press 7. To 
enable emergency mode on all channels, press 9. To return to main 
menu, press star. 

Sys147 Begin recording your message after the tone. Press any key to end 
the recording. 

Sys148 TASKE VoiceKit system error. 

Sys148b TASKE VoiceKit system error. The message phrase for this channel 
cannot currently be accessed. 

Sys149 does not exist 

Sys150 Please enter the two-digit message number in the range of 00 to 99. 

Sys151 Please enter the three-digit message number in the range of 000 to 
999. 

Sys152 Please enter the four-digit message number in the range of 0000 to 
9999. 

Sys153 The message number 

Sys154 is invalid 
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Sound Name Statement 

Sys155 There are not enough system resources to continue with your 
request. 

Sys156 This message cannot be accessed, please select another message 
number. 

Sys157 The TASKE Voice ToolKit is calling you. 

Sys158 Please use the TASKE configuration tool to select the voice files to 
play or record. 

Sys159 Please use the TASKE configuration tool to select the voice files to 
play. 

Sys160 To record this message, press 3. To return to the main menu press 
star. 

Sys161 Message number 

Sys162 exists 

Sys162b exist 

Sys163 To play this message, press 1. To re-record this message, press 3. 
To save this message, press 5. To return to the main menu, press 
star. 

Sys164 To return to the main menu without saving the recorded message, 
press star. To return to the current menu press any key. 

Sys165 To confirm saving this message, press 5. 

Sys166 Saved. 

Sys167 The TASKE Voice ToolKit is currently busy, please call again later. 

Sys168 Please try again. 

Sys169 To re-enter the password, press 1. To return to the main menu , 
press star. 

Sys170 The TASKE Voice ToolKit is now in 

Sys171 Normal mode 

Sys172 Emergency mode 

Sys173 The message phrase for this channel cannot currently be accessed. 

Sys174 Please contact the TASKE Voice ToolKit system Administrator. 
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Glossary of Terms 

Term Definition 

Abandoned Call A caller terminates the call before an agent can answer. 

ABSBH Average Busy Season Busy Hour 

Account Code A number assigned to departments, projects, devices, telecom 
services, and employees for cost tracking purposes. 

ACD  Automatic Call Distribution 

ACD Call Inbound or outbound calls that are handled by an ACD queue. 

ACD Call Center  Refers to any host PBX that handles many telephone calls of a 
similar nature. 

ACD Queue The line of calls to be answered. 

ACD Record  

 

Event records that are immediately generated when an agent 
enters a new call state (such as idle or answer ACD call) and 
when an agent activates a feature (such as log in, log out or make 
busy). These records are periodically generated to report on a 
cumulative group event for an ACD queue (such as the number of 
calls waiting, the number of available agents or longest call waiting 
time). Agent events are reported on whenever an agent responds 
to a call, regardless of whether or not an external trunk is involved 
in the call. 

ACD Search Allows a supervisor to view specific real time event records. 
Search is based on... 

Agent  An employee who answers calls directed to the call center. 

Agent Group A collection of agents who answer calls of a similar nature. 

Agent Identifier A number that represents the agent within the PBX system. This 
number is used by the agent to log in and log out of the PBX 
system.  
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Term Definition 

Agent Report   

 

Shows parameters used to monitor agent activity and 
performance. These reports indicate the amount of time an agent 
spends on ACD calls, on inbound non-ACD calls, on outgoing 
calls, the amount if time an Agent spends in Do Not Disturb and 
Make Busy, and the duration of time an Agent is logged in. 

Agent Scheduling  The process of scheduling agents to work shifts. 

Agent State May be one of the following: idle, on inbound ACD call, on 
outbound or internal call, hold, work time, make busy, DND, 
logged out, or indeterminate.  

ANI Automatic Number Identification 

ASA Average Speed of Answer 

Baud Rate Refers to the speed of transmission of a data communication link. 

Blocking Blocking is a term that is used to indicate a call which is 
unsuccessful because it cannot find an available trunk. 

Busy Hour The period of the day when the traffic is at its highest. The traffic is 
measured over 15, 30, or 60 minute periods throughout the day, 
over a ten day period. Each day's busy hour traffic is averaged to 
determine the average busy hour. The traffic for all periods over 
each of the 10 days is drawn up as a matrix and the busy hour is 
identified. 

Busy Season A seasonal variation that produces a large volume of calling traffic. 
An example of the busy season may be Christmas. 

Call Costing An application that allows for the apportionment of telecom costs 
among departments, projects, and departments. 

Call Duration: Agent The aggregate of the talk time and the work time. 

Call Duration: Trunk The aggregate of the queue time and the talk time 
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Term Definition 

Call Load Expresses, as a percentage, the proportion of waiting calls to the 
number of agents that are currently engaged in ACD calls.  

Call Load = 100*(#Calls Waiting / #Agents on ACD Calls) 

Call Load Messages A category of messages for the TASKE Sign Application.  Call 
load messages are used to alert agents and supervisors to a 
growing backlog of waiting calls.  

Call Load Threshold A user defined parameter to determine when the TASKE Sign 
Application will provide the reader board with a call load message 
that alerts the staff to a potential backlog of calls. 

CCS Centime Call Seconds or 100 seconds of server time.  

CO Central Office: the local telephone company’s telephone switching 
system that allows local access on and off of the PSTN.  

Comport A communication port used to connect external devices to a PC.  

Consistent Busy 
Hour 

Derived by identifying the hour of the day that has the highest 
traffic when averaged over a ten-day period. 

Cost-based Call 
Center 

 

In this type of call center a cost is incurred for each call to the 
organization. The call handling incurs costs but does not result in 
additional revenue. The costs to the organization include the cost 
of handling the call and the cost of providing the support service. 
The level of service in a cost-based call center involves a low 
probability blocking but an almost certain delay of considerable 
length. The length of the delay is generally a balance between 
long distance and manpower costs, and the long-term impact of 
potential lost business. 

CTI Computer-to-Telephony Interface 

CTS Clear To Send 

Customer The caller that has decided to phone your call center for the 
services you provide.  
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Term Definition 

CW Calls Waiting 

Daily Report Presents data for a single day. 

Data Bit Refers to the number of bits used to transmit information in the 
words carried over comport links.  

DCD Data Carrier Detect 

Decision Tree A TASKE Sign function that is comprised of a set of condition 
statements that are applied to ACD performance variables. When 
the condition is true, the associated message is displayed on the 
reader board. 

Default Messages A category of messages for the TASKE Sign Application. Default 
messages typically display background information. These 
messages may contain variables and be used to display queue 
status information. 

DND Do Not Disturb 

DNIS Directory Number Information Service 

DSR Data Set Ready 

DTMF Dual Tone 
Multi 

Frequency refers to industry standard tone frequencies produced 
by selecting keys on a touch tone telephone. The Voice ToolBox 
programs recognize the tone frequencies associated with the 
digits selected on touch-tone telephones. 

End Hour To File An option available on a networked TASKE system that indicates 
the ending hour of a LANs operating period. This option instructs 
the system to begin storing files to the shadow drive at the hour 
specified. Once the time specified for the Start Hour To File is 
reached, the system begins to store files to the LAN once again.  

Erlang One hour of server time.  
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Term Definition 

Erlang B An equation used for trunk and blocking calculations. The 
equation assumes that there is no queuing and that callers who 
get blocked do not retry the call.  

Erlang C An equation used for agent and delay calculations where ACD 
queuing is employed. The equation assumes that all callers who 
reach the queue wait until being answered. 

ExePath Defines the location of the TASKE ACD ToolBox executable files. 
Unless changed by the user during installation, the ExePath is 
c:\ttbx. 

Extension Physical telephone devices. These devices may include 
telephones, voice mail ports, or an auto attendant. 

Extension Group A collection of similar extensions that are grouped together for 
reporting purposes.  

Extension Report Shows the amount of time extensions are engaged in ACD calls, 
inbound nonACD calls, and outbound calls. These reports also 
display the number of abandoned calls, the number of transferred 
calls, and cumulative statistics on extensions across work shifts.  

Fixed Messages A category of messages for the TASKE Sign Application. Fixed 
messages are played continuously when no variables are 
available. They are generally used in situations which override the 
operational considerations of the ACD queue, or where the ACD 
queue is not in operation.  

Floating Busy Hour Derived by identifying the hour that has the highest traffic for each 
day and averaging these figures. The Floating and Consistent 
Busy Hours may be the same. However, the floating Busy Hour 
traffic is usually higher than the consistent Busy Hour traffic. 

Forecasting An historical analysis of past traffic levels used to project future 
traffic patterns. 

GOS Grade of Service or the probability of being blocked. 
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Term Definition 

Historical Reports Reports based on the ACD and SMDR records. These reports 
provide information on call center activity over extended periods of 
time and are used to identify trends in call volume.     

Idle Agent Agent is logged in, but not on a call, in work time, make busy, or 
DND. 

Interflow Limits the potential call answering delay by routing the call to 
another answering point after a predetermined period of time. 
Another answering point may be an operator or voice messaging 
system. This action may also be referred to as Recall.  

Interflow Time The amount of time a call may be in one or more queues before 
being interflowed to another answering point.  

Internal Call A call initiated from within the call center that is directed to another 
call center member. 

IVR Integrated Voice Recognition and response 

LAN Local Area Network 

LANA Number Local Area Network Adapter Number 

LCW Longest Call Waiting 

Level of Service The length of time that a caller waits for an agent to respond after 
obtaining a free trunk. 

Log In The procedure involved for an agent or supervisor to enter the 
ACD system by inputting their identifier number. 

Log Out The procedure involved for an agent or supervisor to exit the ACD 
system by inputting their identifier number. 
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Term Definition 

Maintenance Error 
Log 

A log entry is added to the Maintenance Error Log when a running 
TASKE program encounters and error or and alert condition. The 
system records the error, the time it occurred, and provides a 
short description. 

Make Busy An agent state where the agent is still logged into the call center 
but is unavailable to take calls. 

Manager Team A team of supervisors, each of whom manage a team of agents. 

Monthly Report Presents data for one calendar month. 

Multi-line 
Appearances 

An extension with multiple telephone lines and multiple telephone 
numbers that are used for call handling. 

NCB Network Control Block 

Nickname A short name used to identify an agent. 

Non-ACD Call Inbound or outbound calls that are not handled by an ACD queue. 

Offered Traffic The number of calls attempted. 

Outbound Call A call initiated from within the call center that is bound for the 
PSTN. 

Overflow   

 

Limits the potential call answering delay by: 

taking a call from one queue and placing it in another queue 

adding the call to a second queue in addition to keeping its place 
in the first queue 

Overflow Time The amount of time a call may be in one queue before being 
overflowed to a second queue. 
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Term Definition 

Parity The parity bit is added to the transmission of a word in 
asynchronous communication to detect any transmission errors. 
The extra bit may be ignored (no parity), may designate an even 
number of “1” bits (even parity), or may designate an odd number 
of “1” bits (odd parity). 

Path A route to one or more answering points within a call center. 

PBX Private Branch Exchange 

Peaky Traffic Periods in the day that experience high call volume. An example 
might be a training course where everyone rushes out at coffee 
break to make a telephone call, but in between coffee breaks 
there are almost no calls. 

Peg Count The number of calls. 

Pilot A dialable access number to an extension or agent group. 

Pilot Group A collection of pilots. 

Pilot/Pilot Group 
Report 

Also known as a Queue Activity Report, this report shows the 
service level experienced by Callers; indicate the percentage of 
calls which are answered or abandoned before the target 
threshold time.  

Poisson An equation used for trunk and blocking calculations. The 
equation assumes that there is no queuing and that all callers who 
fail to connect retry the call. 

Prime Line  The first line on a multi-line extension. 

Priority Answering Allows calls meeting a certain criteria to be routed to the front of 
an ACD queue. For instance, calls arriving over an 800 line may 
be given priority to local calls in order to reduce costs. 

PSTN Public Switched Telephone Network: the network that enables you 
to directly dial anywhere in the world. 
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Term Definition 

Quality of Service Describes the response of the agent. Agent courtesy, information 
accuracy, and how current the information is are all considered. 

RAD Recorded Announcement Device: taped or digital recordings 
played to callers in the ACD queue. 

RAD Recorded Announcement Device 

Rate Table Rate tables are defined for all outgoing trunk groups. Each rate 
table specifies the costs associated with using a specific carrier for 
a given telecom service. 

Reader Board A wall mounted LED sign that displays messages from the TASKE 
Sign application. 

Real Time 
Information  

 

Current call center information on call activity, agent activity, and 
service levels. This information is available through the ACD 
Monitor application and is updated once per second. 

Revenue-based Call 
Center 

In this type of call center each call has value in terms of the net 
revenue per call. The objective in this type of call center is to 
provide a very high level of service with few blocked calls and 
minimal delays. Otherwise, the caller may go to the competition 
and the organization loses revenue. Thus, the call center must 
balance average call answering costs against average per call 
revenues. 

RT Real Time 

Scheduling The process of estimating the number of resources required to 
meet the forecast call load. 

Secondary Line Any line, except for the first line, on a multi-line extension. 

Serv% The proportion of calls, answered and abandoned, before the 
threshold TSF time. 
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Term Definition 

Server Number The number assigned to a TASKE network server where multiple 
TASKE network servers exist on the same physical network. This 
number cannot conflict with any other server on the network. 

ServerPath Defines the location of the TASKE database files. These files may 
reside on the TASKE Standalone PC, the TASKE Server, or on a 
network connected file server.  

Service Criteria The combination of the GOS, level of service, and quality of 
service required to achieve caller satisfaction. 

Shadow Drive In a networked system, the shadow drive stores incoming data 
records on the hard drive of the TASKE server, in addition to 
storing them on the LAN Server. 

ShadowPath Defines the location of the shadow drive in a networked system.  

Shift The amount of time an agent is scheduled to be working in the call 
center on a given day. 

Sign Message A message sent from the TASKE Sign application to a reader 
board for broadcast. Up to 50 messages can be defined at one 
time. 

Sign Network A network of reader boards driven by the same PC. 

Sign Plan Using a unique address for each reader board, a sign plan 
determines which reader board will display which message.  

SMDR Station Message Detail Recording 
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Term Definition 

SMDR Records Event records that are generated by the host PBX when a call or a 
call segment completes. A call can have multiple SMDR records 
that are generated when a call is transferred or conferenced, or 
when account codes are entered while the call is active. The 
information that is generated includes: the start time of the call, the 
duration of the call, who started the call and who the answering 
party was. These records are typically generated when an external 
Trunk is involved in a call, and not when a call originates 
internally. 

SMDR Search Allows a supervisor to view specific SMDR records. Search is 
based on... 

Smooth Traffic The number of calls arrive in an even flow throughout the day. 

SNMP Simple Network Management Protocol 

SP Service Percentage 

Special Day Allows for the definition of holidays and days when staffing 
discrepancies may exist.  

Start Hour To File An option available on a networked TASKE system that indicates 
the starting hour of a LANs operating period. This option instructs 
the system to store files to the shadow drive until the hour 
specified. Once the specified hour is reached, the system begins 
to store files to the LAN.  

Stop Bit Denotes the end of an asynchronous word transmitted on a 
comport link.  

Supervisor The manager of the call center who ensures that performance 
targets and caller expectations are met. Call center management 
requires the estimation of the current call center needs and the 
forecasting of future requirements. This is accomplished through 
the analysis of real time and historical reports.  

TAPI Telephony Application Program Interface 
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Term Definition 

TASKE 
Administrator 

Responsible for the development of the TASKE database, its 
configuration and maintenance, and the configuration and 
maintenance of its associated files. 

TASKE Network 
Client 

A TASKE PC that receives data from one or more TASKE Server 
PCs.  

TASKE Network 
Server 

A TASKE PC that collects records from one or more host PBX 
devices and provides information to one or more TASKE Client 
PCs. 

TASKE Network 
System 

A network of TASKE PCs, one of which acts as a server that 
interfaces with the host PBX, and the remainder of which act as 
clients, receiving data from the server. 

TASKE Sign 
Application 

Provides messages for display on a reader board. The application 
runs on TASKE standalone, network server, and network client 
PCs, with each PC driving its own network of reader boards.  

TASKE Standalone 
System 

A TASKE PC that interfaces with the host PBX to provide call 
center data to agents and supervisors.  

Time of Day 
Schedule 

A TASKE Sign function that is used to select a decision tree based 
on the current date and time of day.  

Traffic The aggregate effect of the number of calls and their duration. 

Trunk Physical lines that connect the telephone switch to the outside 
world.  

Trunk Group A collections of trunks.  

Trunk Group Report Indicates the highest number of Trunks in use during an interval.  

Trunk Report Shows the number of calls the trunks carry; the percentage of time 
the trunks are engaged in calls or are idle; the highest number of 
trunks used in each interval; and the number of short calls the 
trunks receive.  
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Term Definition 

TSAPI Telephony Services Application Programmers Interface 

TSF Telephone Service Factor. This is the percentage of calls that are 
answered or abandoned within a defined threshold time, 
compared to the total number of calls received.  

TSF%   The proportion of calls answered and abandoned before the 
threshold TSF time. 

Unavailable Agent An agent who is logged into the call center but is either in a make 
busy or work time state. 

VTB Voice Toolbox 

WAN Wide Area Network 

Watchdog This function restarts the PC in the event of a crash. 

Weekly Report Presents data for seven consecutive days. 

Work Time A time period designated to agents after completing an ACD call. 
The work time allows agents to complete paperwork associated 
with a call. During this time, the agent is unavailable to accept 
calls.  

Year By Month 
Report 

Presents data for a user specified number of months, beginning 
with a month selected by the user. 

Year to Date Report Presents data for a specified number of consecutive weeks from a 
specific start date. 

 

 

 
 
 
 



TASKE Call Center Management Tools            

 
- 431 - 

Index 

A 

Abandon ................................................................59, 85, 111, 121, 155, 208, 223 
Average Time ........................................................................................ 111, 121 
Level ............................................................................................................. 223 

Abandon Rate ................................................................................................. 223 
Abandon Spectrums ........................................................................................... 59 
Abandoned Calls ............................................................................................ 131 
ABSBH............................................................................................................. 221 
Account Codes ................................................................................. 85, 187, 203 

referencing............................................................................................. 187, 203 
ACD Hold......................................................................................................... 105 
ACD Monitor8, 12, 90, 99, 101, 102, 105, 107, 108, 115, 119, 129, 131, 133, 134, 291, 

292, 293, 295, 298 
Network Client ............................................................................................... 90 
restarting ...................................................................................................... 291 

ACD Queue .............................................................................................. 222, 227 
ACD Queue ID.......................................................................................... 115, 119 
ACD Replay ..................................................................................................... 105 
ACD Variables................................................................. 249, 250, 254, 322, 323 

Adding .................................................................................................. 249, 250 
Defining ........................................................................................................ 322 
Deleting ................................................................................................ 249, 322 
Editing .................................................................................................. 249, 250 

ACD Variables window ............................................................. 310, 321, 322, 334 
Administrator ...................................................................... 29, 30, 34, 74, 76, 83 

Configuration Mode....................................................................................... 34 
Starting ........................................................................................................... 29 

Agent Desktop .........8, 9, 244, 245, 247, 249, 252, 253, 254, 256, 292, 293, 295 
Agent Desktop Grid Setting dialog ............................................................... 254 
Agent Desktop window ...................244, 245, 247, 249, 250, 252, 253, 254, 256 

Adjust ........................................................................................................... 245 
Displaying .................................................................................................... 245 
Docking ........................................................................................................ 253 
Position ........................................................................................................ 245 

Agent Group IDs........................................................................................... 47, 50 
Agent Group Report Templates........................................................................ 174 
Agent Group Reports ..................................................................... 141, 149, 174 
Agent Groups ..........................................................47, 50, 85, 138, 149, 174, 227 

Defining ..................................................................................................... 47, 50 
delete......................................................................................................... 47, 50 
duplicate .................................................................................................... 47, 50 
modify........................................................................................................ 47, 50 
naming....................................................................................................... 47, 50 



TASKE Call Center Management Tools            

 
- 432 - 

Agent List ................................................................................................. 115, 118 
Accessing ...................................................................................................... 115 

Agent Map ..................................................90, 105, 108, 111, 115, 118, 119, 134 
Accessing ...................................................................................................... 108 
Filtering.......................................................................................................... 119 

Agent Report Templates................................................................................... 172 
Creating......................................................................................................... 172 

Agent Reports ................................................................................. 141, 149, 172 
Agent State Characters .................................................................................. 134 
Agent States..................................................................... 108, 111, 115, 119, 134 
Agent States Report ......................................................................... 108, 115, 134 

Accessing ...................................................................................................... 108 
Agent States Table ......................................................................................... 105 
Agents Available....................................................................................... 101, 111 
Agents Idle........................................................................................................ 111 
Agents Logged Out........................................................................................... 111 
Agents On ........................................................................................................ 111 
Agents Required............................................................................................... 227 
Agents Unavailable........................................................................................... 111 
Alarm Parameters............................................................................................. 101 
Alarm Settings .................................................................................................. 101 
Alarm Situations ............................................................................................. 105 
Alarm Sound Frequency .................................................................................. 90 
Alarms ............................................................................................. 30, 34, 82, 83 
All Agents ......................................................................................................... 227 
Alternate With Script................................................................................. 323, 335 

Enable ................................................................................................... 323, 335 
Always on Top ................................................................................................ 245 
Answer Service Factor ..................................................................................... 111 
Answer Spectrums ............................................................................................. 59 
Answered By Group ......................................................................................... 121 
Archive Files ........................................................................................... 72, 76, 79 
Archiving............................................................................................................. 72 

Files Automatically........................................................................................... 72 
Files Manually.................................................................................................. 72 
PBX ................................................................................................................. 72 
PBX Data Files ................................................................................................ 72 

ASA .................................................................................................................. 222 
Ascii .................................................................................................... 36, 149, 161 
ASF .................................................................................................................. 101 
Auto Delete TASKE Files ................................................................................... 76 

Enable ............................................................................................................. 76 
Auto Export148, 149, 165, 167, 169, 172, 174, 177, 179, 182, 184, 187, 190, 192, 195, 

197, 200, 203, 205, 211, 214 
Enable165, 167, 169, 172, 174, 177, 179, 182, 184, 187, 190, 192, 195, 197, 200, 

203, 205, 214 



TASKE Call Center Management Tools            

 
- 433 - 

Auto Print148, 149, 165, 167, 169, 172, 174, 177, 179, 182, 184, 187, 190, 192, 195, 
197, 200, 203, 205, 211, 214 
Enable165, 167, 169, 172, 174, 177, 179, 182, 184, 187, 190, 192, 195, 197, 200, 

203, 205, 214 
Automatic Archive............................................................................................... 72 
Automatic File Synchronization .......................................................................... 79 
Automation Costs........................................................................................... 242 
Availale .............................................................................................................. 24 
Average Delay .................................................................................................. 227 
Average Interflow Time..................................................................................... 111 
Average Queue Depth...................................................................................... 227 
Average Speed of Answer................................................................................ 222 
Average Talk Time ................................................................................... 111, 121 
Average Time ........................................................................................... 111, 121 

Abandon ................................................................................................ 111, 121 
Answer................................................................................................... 111, 121 
Interflow......................................................................................................... 121 

B 

Background/Foreground Colors ........................................................... 249, 250 
Bad Logins........................................................................................................ 101 
Bar Charts ....................................................................................................... 240 
Beeps............................................................................................................... 317 
Blockage........................................................................................... 227, 232, 236 
Broadcast Message........................................................................................ 298 
Busy Hour......................................................................................... 190, 205, 221 
Busy Hour/Busy Season ................................................................................ 221 
Busy Season ................................................................................................... 221 
Busy Season—or Average Busy Season Busy Hour .................................. 221 

C 

Calculate Required Staffing........................................................................... 219 
Calculating........................................................................................ 227, 232, 236 

GOS .............................................................................................. 227, 232, 236 
Calculation Wizard ................................................................................. 235, 240 
Call Arrival Rate................................................................................................ 236 
Call Center Cost Dynamics............................................................................ 242 
Call Center Costs............................................................................................ 242 

Reducing ...................................................................................................... 242 
Call Center Revenue....................................................................................... 242 

Increasing..................................................................................................... 242 
Call Counts............................................................................................... 111, 121 
Call Duration..................................................................................................... 222 
Calls Abandoned ...................................................................................... 101, 111 
Calls Answered................................................................................................. 111 
Calls Interflowed............................................................................................... 111 
Calls Waiting............................................................................. 101, 111, 121, 131 



TASKE Call Center Management Tools            

 
- 434 - 

CCS .................................................................................................................. 221 
Cell Information .............................................................................................. 252 

Filtering ........................................................................................................ 252 
Selecting....................................................................................................... 252 

Cell Properties.......................................................................................... 115, 119 
Central Office .................................................................................................... 85 
Change Font............................................................................................ 160, 161 
Character Flash On .......................................................................................... 331 
Character Format ..................................................................................... 323, 331 

Adding ........................................................................................................... 331 
Chat ................................8, 90, 134, 291, 292, 293, 295, 296, 297, 298, 299, 304 
Chat Connections............................................................................................... 8 

Viewing ............................................................................................................. 8 
Chat Interface.................................................................................................. 293 

Using ............................................................................................................ 293 
Chat Members..................................................................................................... 8 
Chat Panel ........................................................293, 296, 297, 298, 299, 301, 304 

heading......................................................................................................... 293 
posted........................................................................................................... 299 

Chat Request .......................................................................................... 296, 297 
Accept........................................................................................................... 297 
Rejecting ...................................................................................................... 297 
Send.............................................................................................................. 296 

Chat Server ..................................................................................................... 293 
Chat Session........................................................................................... 299, 304 

Conducting................................................................................................... 299 
Ending .......................................................................................................... 304 

Clear Log ........................................................................................................... 30 
Clients ............................................................................................................... 25 
CO .................................................................................................................... 222 
Collector ................................................................................................ 13, 82, 83 
Collector Alarms ............................................................................................... 82 

Setting ............................................................................................................ 82 
Color Palette............................................................................................. 359, 362 
Comma Separated Variable ............................................................... 36, 149, 161 
Communication Paths.................................................................................... 316 
Conditional Decisions .................................................................................... 341 
Config Mode ..................................................................................................... 310 
Configuration Mode...................................................................... 30, 34, 69, 315 

Administrator ................................................................................................. 34 
Configure Tones............................................................................................... 310 
Contact Panel.......................................................................................... 293, 295 
Contact Status Symbols ................................................................................ 296 
Continuous Tone ............................................................................................ 317 
Cost Dynamics................................................................................................ 242 
Cost Justification Guide ........................................................................ 219, 242 



TASKE Call Center Management Tools            

 
- 435 - 

open .............................................................................................................. 242 
Use ................................................................................................................ 219 

Critical Alarm .................................................................................................... 101 
Current States Report............................................................................... 108, 134 
Custom Graphics............................................................................................ 363 

Deleting ........................................................................................................ 363 
Cut/Copy.......................................................................................................... 301 

D 

Daily Files........................................................................................................... 69 
Daily Reports .................................................................................................. 141 
Daily Summary ................................................................................................... 69 
Daily Summary Files............................................................................... 71, 74, 76 
Data Alarms....................................................................................................... 13 
Database ............................................................................................... 30, 34, 36 
Database Mode ..................................................30, 34, 38, 45, 47, 50, 55, 59, 63 
Date Files ........................................................................................................... 69 
Date Selection Calendar165, 167, 169, 172, 174, 177, 179, 182, 184, 187, 190, 192, 

195, 197, 200, 203, 205, 208, 214 
Day Plan........................................................................................... 310, 350, 351 

Deleting ........................................................................................................ 350 
Days window .................................................................................... 310, 343, 346 
DBase II.............................................................................................. 36, 149, 161 
DBase III............................................................................................. 36, 149, 161 
DBase IV ............................................................................................ 36, 149, 161 
Deactivating Sites............................................................................................. 24 
Delayed Answer.............................................................................................. 242 
Deleting ACD Variables.................................................................................. 249 
Descender On .................................................................................................. 331 
Dialed Number Identification Service............................................................ 63, 85 
Disabling Notification Reports ...................................................................... 217 
Disconnecting Clients ...................................................................................... 25 
Disk Space Alarms ........................................................................................... 83 
Disk Statistics ......................................................................................... 72, 74, 76 
DND.................................................................................................. 105, 115, 134 
DNIS..................................................................................... 63, 85, 149, 177, 192 
DNIS Entries....................................................................................................... 63 

Adding ............................................................................................................. 63 
Deleting ........................................................................................................... 63 
Duplicating....................................................................................................... 63 
Modifying ......................................................................................................... 63 

DNIS Number ..................................................................................................... 63 
Do Not Disturb .......................................................................................... 115, 134 
Docking ........................................................................................................... 253 
Drawing Platform............................................................................................ 362 



TASKE Call Center Management Tools            

 
- 436 - 

E 

Effects .............................................................................................................. 331 
Enterprise.......................................................................................................... 18 
Enterprise ACD Monitor ........................................................................... 90, 133 
Enterprise Licensing ........................................................................................ 18 
Enterprise report............................................................................................... 214 

Creating......................................................................................................... 214 
Enterprise Site Connection.................................................................. 19, 20, 24 

Activating ....................................................................................................... 24 
Adding ............................................................................................................ 20 
Deactivating ................................................................................................... 24 
Modifying........................................................................................................ 20 
Removing ....................................................................................................... 20 
Viewing ........................................................................................................... 19 

Enterprise Supervisor ...................................................... 9, 18, 19, 20, 133, 214 
Erlang B........................................................................................... 219, 223, 232 
Erlang C........................................................................................... 219, 223, 227 
Expected Wait Time ......................................................................................... 101 
Export36, 139, 148, 149, 161, 165, 167, 169, 172, 174, 177, 179, 182, 184, 187, 190, 

192, 195, 197, 200, 203, 205, 214 
Report Template............................................................................................ 161 
TASKE Database ............................................................................................ 36 

Extension Group Entries..................................................................................... 45 
Adding ............................................................................................................. 45 
Deleting ........................................................................................................... 45 
Duplicating....................................................................................................... 45 
Modifying ......................................................................................................... 45 

Extension Reports.......................................................................... 141, 149, 167 
F 

File Statistics ...................................................................................................... 69 
Filtering............................................................................................. 115, 119, 252 

Agent Maps ................................................................................................... 119 
Cell Information ........................................................................................... 252 

Font.................................................................................................. 161, 250, 256 
Forecast Report Templates .............................................................................. 208 
Forecasting Parameters ........................................................................... 155, 208 
Free Disk Space ................................................................................................. 69 

G 

GOS ..........................................................................219, 222, 223, 227, 232, 236 
Grade Of Service ............................................................................ 223, 232, 239 
Graph Styles ................................................................................................... 240 
Graphics ........................................................................................................... 323 
Graphics window .............................................................. 310, 323, 359, 362, 363 
Grid .................................................................................................................. 254 



TASKE Call Center Management Tools            

 
- 437 - 

H 

Hide/Restore ................................................................................................... 245 
Hold .................................................................................................. 115, 134, 331 
HTML Table........................................................................................ 36, 149, 161 
Hunt Groups...................................................................................................... 85 

I 
Idle............................................................................................ 108, 111, 115, 134 
Idle Forward .................................................................................... 105, 115, 134 
If ACD Variable................................................................................................ 341 
Incoming Messages ....................................................................................... 299 
Increasing Call Center Revenue.................................................................... 242 
Individual Extensions........................................................................................ 167 
Individual Trunks .............................................................................................. 165 
Individual Trunks/Extensions............................................................................ 214 
Information Server.........................9, 12, 13, 14, 18, 19, 20, 24, 25, 90, 133, 249 

Closing ........................................................................................................... 14 
Interflow Spectrums............................................................................................ 59 
Interflowed...........................59, 111, 121, 141, 149, 155, 184, 190, 200, 205, 208 
IP ...................................................................................................... 8, 11, 20, 316 
IP Port ................................................................................................................ 20 

L 

LED .......................................................................................................... 359, 362 
License .................................................................................................... 9, 18, 19 
Line Charts...................................................................................................... 240 
Line Position..................................................................................................... 323 
Load Labor Costs ........................................................................................... 242 
Local site ..................................................................................................... 19, 24 
Lock Number....................................................................................................... 9 
Locking.............................................................................................................. 25 
Log file......................................................................................................... 66, 82 
Logged Out ..................................................................... 105, 108, 111, 115, 134 
Logoff ........................................................................................................ 90, 293 
Logon ...................................................................................................... 291, 292 
Logs ......................................................................30, 34, 66, 72, 76, 79, 291, 292 
Longest Call Waiting......................................................................... 101, 111, 121 
Longest Waiting Time....................................................................................... 111 
Lotus 123 1A ...................................................................................... 36, 149, 161 

M 

Make Busy....................................................................................... 105, 115, 134 
Make Busy/DND .............................................................................................. 105 
Manual Archive................................................................................................... 72 
Manual File Synchronization............................................................................... 79 
Manually Delete Files ................................................................................... 74, 83 



TASKE Call Center Management Tools            

 
- 438 - 

Manually Exporting ........................................................................................... 161 
Manually Printing............................................................................................ 163 
Manually Synchronizing Shadow Files ............................................................... 79 
Map .................................................................................................................. 119 
Map Layout...................................................................................................... 118 
Maximum Calls Waiting .................................................................................... 111 
Messages window .................................................................... 310, 323, 327, 359 
Microsoft Excel 2.1 ............................................................................. 36, 149, 161 
Microsoft Excel 3.0 ............................................................................. 36, 149, 161 
Microsoft Excel 4.0 ............................................................................. 36, 149, 161 
Mode Selection ............................................................................................... 134 
Monthly Reports ............................................................................................. 141 
Monthly Summary............................................................................................... 69 
Monthly Summary Files .......................................................................... 71, 74, 76 

N 

Network Client .................................................................................................. 90 
Nick Name...................................................................... 38, 45, 47, 50, 55, 63, 85 
Non-ACD.......................................................................... 105, 108, 111, 115, 134 
Non-ACD Hold................................................................................................. 105 
Non-Adherence............................................................................................... 105 
Non-Verified Account Codes ........................................................................... 85 
Normal States........................................................................................... 115, 119 
Notification Report ................................................................................. 217, 218 

O 

Off-Phone Period ............................................................................................ 105 
Opening Agent Desktop Settings...................................................................... 247 
Options ............................................................................................................. 331 
OR .................................................................................................................... 235 
Outbound Hold ............................................................................................... 105 
Outbound Trunk ..................................................................................... 105, 134 
Outgoing Message ................................................................................. 293, 299 

P 

Password.......................................................................................................... 211 
Paste ................................................................................................................ 301 
PBX Data Files ........................................................................... 69, 71, 72, 74, 76 
Peak Abandoned...................................................................................... 190, 205 
Peak Answered ........................................................................................ 190, 205 
Peak Interflowed....................................................................................... 190, 205 
Peak Offered ............................................................................................ 190, 205 
Pie Charts........................................................................................................ 240 
Poisson ................................................................................... 219, 223, 235, 236 
PrimeTime Schedules ...................................................................................... 12 
Print ......................................................................................................... 163, 211 
Print Image ......................................................................................... 36, 149, 161 



TASKE Call Center Management Tools            

 
- 439 - 

Print Preview........................................................................................... 160, 163 
Properties window148, 149, 155, 161, 165, 167, 169, 172, 174, 177, 179, 182, 184, 

187, 190, 192, 195, 197, 200, 203, 205, 208, 211, 214 
Public Network.................................................................................................. 85 
Publication Viewer138, 148, 160, 161, 163, 164, 165, 167, 169, 172, 174, 177, 179, 

182, 184, 187, 190, 192, 195, 197, 200, 203, 205, 208, 214, 217 
Q 

QIDA ...............................................................90, 95, 99, 102, 104, 115, 121, 134 
Quattro ............................................................................................... 36, 149, 161 
Quattro Pro......................................................................................... 36, 149, 161 
Quattro Pro 5.0 ................................................................................... 36, 149, 161 
Queue Abandon Spectrum ............................................................ 141, 149, 182 
Queue Activity ................................................................................ 141, 149, 187 
Queue Answer Spectrum ............................................................... 141, 149, 179 
Queue Delay/Call Abandons.......................................................................... 222 
Queue Group Abandon Spectrum................................................. 141, 149, 197 
Queue Group Activity..................................................................... 141, 149, 203 
Queue Group Answer Spectrum ................................................... 141, 149, 195 
Queue Group Entries.......................................................................................... 55 

Adding ............................................................................................................. 55 
Deleting ........................................................................................................... 55 
Duplicating....................................................................................................... 55 
Modifying ......................................................................................................... 55 

Queue Group Interflow Spectrum ................................................. 141, 149, 200 
Queue Group Peaks ....................................................................... 141, 149, 205 
Queue Group Reports ............................................................ 141, 149, 192, 200 
Queue Information Display Area ........................................................... 102, 134 
Queue Interflow Spectrum ............................................................. 141, 149, 184 
Queue Manager............................................................. 90, 95, 99, 101, 105, 133 
Queue Members................................................................................................. 55 
Queue Monitor List......................95, 99, 102, 104, 105, 115, 121, 127, 133, 134 
Queue on Queue Time ..................................................................................... 222 
Queue Panel Icons ........................................................................................... 111 
Queue Panels90, 99, 102, 104, 105, 107, 108, 111, 115, 119, 121, 127, 129, 131, 134 
Queue Peaks ................................................................................... 141, 149, 190 
Queue Reports................................................................................ 141, 149, 177 
Queue Selector ........................................................................... 90, 99, 101, 133 
Queue Time...................................................................................................... 222 
Quick Messages............................................................................... 310, 323, 327 

R 

RAD.................................................................................................................. 227 
Reader Board .......................................................................................... 317, 362 
Reader board messages .................................................................................. 323 
Real-time Adherence .......................................................................... 12, 90, 101 
Real-time Adherence Schedule File Location ................................................ 12 



TASKE Call Center Management Tools            

 
- 440 - 

Real-time Agent Adherence Alarms.............................................................. 105 
Real-time mode................................................................................................. 95 
Real-time Panel Icons ...................................................................................... 111 
Recorded Announcement Device ..................................................................... 227 
Reducing Call Center Costs .......................................................................... 242 
Reference Dates ............................................................................................. 346 
Remote Site......................................................................................... 19, 24, 133 
Removing Agents ........................................................................................... 118 
Removing Enterprise Site Connections ......................................................... 20 
Replay..... 90, 95, 99, 102, 104, 105, 107, 111, 115, 127, 129, 130, 131, 133, 134 
Replay Controls ................................................................................ 95, 129, 134 
Replay date ............................................................................. 102, 127, 129, 130 
Replay Mode ................................................................................... 102, 107, 127 
Report Font ..................................................................................................... 161 
Report Generator.............................................................................................. 211 
Report Options141, 149, 165, 167, 169, 172, 174, 177, 179, 182, 184, 190, 192, 195, 

197, 200, 203, 205 
Report Templates139, 148, 149, 155, 160, 161, 164, 165, 167, 169, 172, 174, 177, 

179, 182, 184, 187, 190, 192, 195, 197, 200, 203, 205, 208, 211, 214 
Reports application............................................................. 72, 138, 139, 160, 214 
Re-queues........................................................................................................ 101 
Reset Sign........................................................................................................ 310 
Restore ............................................................................................................ 245 
Review Panel................................................................... 102, 104, 108, 111, 121 
Review Panel Icons .......................................................................................... 111 
Review Panel Time Periods ........................................................................... 134 

S 

Same As Message Text .................................................................................. 321 
Saved Settings........................................................................................ 107, 247 
Saving.................................................................................................. 66, 79, 247 

Existing Settings File ..................................................................................... 247 
Log File........................................................................................................... 66 
New Settings File........................................................................................... 247 
Shadow............................................................................................................ 79 

Schedule Auto Archive ........................................................................... 72, 76, 79 
Schedule File Location .................................................................................... 12 
Schedule Report Generator139, 149, 165, 167, 169, 172, 174, 177, 179, 182, 184, 

187, 190, 192, 195, 197, 200, 203, 205, 211, 214 
Scheduled State.............................................................................................. 105 
Scheduling.......................................................................... 76, 211, 227, 232, 236 
Script ........................................................................................................ 355, 357 
Search ............................................................................................................. 295 
Secondary IDs..................................................................................................... 9 
Send Command To All Signs......................................................................... 336 
Send Test Message.................................................................................. 310, 317 
Service Criteria ............................................................................................... 223 



TASKE Call Center Management Tools            

 
- 441 - 

Service Factors......................................................................................... 111, 121 
Service Percentages ...................................................................................... 223 
Set Password ......................................................................................... 72, 76, 79 
Set Password dialog....................................................................... 72, 76, 79, 211 
Set RTAA Schedule File Location ................................................................... 12 
Set Schedule File Location dialog .................................................................. 12 
Set Sign Date ................................................................................................... 310 
Set Sign Date/Time From PC dialog................................................................. 310 
Set Sign Date/Time From PC menu ................................................................. 310 
Settings File...................................................................................................... 247 
Shadow Files .............................................................................. 71, 74, 76, 79, 85 
Show Agent List ............................................................................... 90, 115, 118 
Show Nick Names............................................................................................. 90 
Show State Color Legend................................................................. 101, 115, 119 
Sign.......................................................................................................... 357, 358 
Sign Address ............................................................................ 310, 317, 355, 359 
Sign Plan .......................................................................................................... 355 
Sign Tone ........................................................................................................ 317 
Simple Line Chart ........................................................................................... 240 
Site Actions menu ............................................................................................ 19 
SiteData ............................................................................................................. 20 
Sites ........................................................................................... 18, 19, 20, 24, 25 
SMDR ................................................................................................................. 82 
Special Days ................................................................................................... 346 

Deleting ........................................................................................................ 346 
Special Effects.......................................................................................... 323, 329 
Special Graphics ...................................................................................... 323, 331 
Specific Dates ................................................................................................. 345 

Defining ........................................................................................................ 345 
SS............................................................................................................. 111, 131 
State Color Legend................................................................................... 115, 119 
Stop Message At ...................................................................................... 323, 335 
Summary Files.............................................................................................. 74, 76 
Supervisor................................................................................... 9, 214, 227, 298 
Sync To Server list ............................................................................................. 79 
Synchronization .............................................................................. 72, 76, 79, 310 
Synchronize Shadow Files ..................................................................... 72, 76, 79 
System Event Log ............................................................................................ 66 

T 

Tab Separated Variable...................................................................... 36, 149, 161 
TASKE License ................................................................................................... 9 
TaskeLck.lis ........................................................................................................ 9 
Telephone Service Factor ................................................ 85, 111, 155, 208, 223 
Test Messages ................................................................................................ 317 
Time To Abandon............................................................................................... 59 
Time To Answer ................................................................................................. 59 



TASKE Call Center Management Tools            

 
- 442 - 

Time To Interflow................................................................................................ 59 
Tone ................................................................................................................. 341 
Tone Frequency.............................................................................................. 317 
Traffic Analyzer............................................................................... 219, 239, 242 
Traffic Capacity............................................................................................... 239 
Traffic Reports ................................................................................................ 239 
Transmission Costs ....................................................................................... 242 
Trigger ............................................................................................................. 129 
Trigger Stops.................................................................................... 111, 129, 131 
Trunk Entries ...................................................................................................... 38 

Adding ............................................................................................................. 38 
Deleting ........................................................................................................... 38 
Duplicating....................................................................................................... 38 
Modifying ......................................................................................................... 38 

Trunk Reports ................................................................................. 141, 149, 165 
Trunks button...................................................................................................... 38 
Trunks Required ....................................................................................... 232, 236 
TSF..............................................................................85, 101, 155, 208, 223, 227 
TSF Time ........................................................................................... 85, 155, 208 

U 

Unavailable............................................................................... 108, 111, 115, 134 
Undocked ........................................................................................................ 253 

V 

Variable ........................................................................................................... 254 
Variable Display.............................................................................................. 254 
Verified Account Codes ................................................................................... 85 
Verified Call Activity Account Codes.............................................................. 85 
View Mode................................................................................................ 310, 315 

W 

WallSign Administrator307, 308, 310, 314, 315, 323, 331, 343, 351, 355, 357, 359 
WallSign Server ...............................................307, 308, 310, 315, 316, 317, 355 
WAN ................................................................................................................... 20 
Warning Alarm.................................................................................................. 101 
Weekly Files ....................................................................................................... 69 
Weekly Reports............................................................................................... 141 
Weekly Summary Files........................................................................... 71, 74, 76 
Word Processing Text ........................................................................ 36, 149, 161 
Work Time ............................................................................... 105, 115, 134, 222 

X 

XX..................................................................................................................... 227 
Y 

Yearly Summary ................................................................................................. 69 



TASKE Call Center Management Tools            

 
- 443 - 

Year-to-date Summary Files................................................................... 71, 74, 76 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



TASKE Call Center Management Tools            

 
- 444 - 

 

 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This document is provided to you for informational purposes only. The information is believed by TASKE Technology to be accurate 
as of the date of its publication, and is subject to change without notice. TASKE Technology assumes no responsibility for any errors 
or omissions in this document and shall have no obligation to you as a result of having made this document available to you or 
based upon the information it contains. 
 
TASKE is a registered trademark of TASKE Technology Inc. All other products are the trademark of their respective holders. 
 
© Copyright 2001. TASKE Technology. All rights reserved. Printed in Canada. 


	Application User Manual
	Table of Contents
	TASKE Call Center Management Tools
	Using this Guide

	TASKE Information Server
	Starting the Information Server
	Viewing Client Connections
	Status
	Disconnect
	Details
	Messages

	Viewing the SMDR Connection
	SMDR Events
	Communications

	Viewing Chat Connections
	Chat Members

	Viewing License Information
	Viewing General Information
	TASKE Server Information

	Integrating PrimeTime with TASKE
	Setting the Real-time Adherence Schedule File Location
	Showing Data Alarms
	Closing Versus Exiting the Information Server
	Closing the Information Server
	Exiting the Information Server


	TASKE Enterprise
	Checking for Enterprise Licensing
	Viewing Enterprise Site Connections
	Status
	Details
	Last Message

	Adding, Modifying, and Removing Enterprise Site Connections
	Adding an Enterprise Site Connection
	Modifying an Enterprise Site Connection
	Removing an Enterprise Site Connection

	Activating and Deactivating Sites
	Activating an Enterprise Site Connection
	Deactivating an Enterprise Site Connection

	Locking Sites and Disconnecting Clients
	Locking an Enterprise Site
	Disconnecting All Clients from an Enterprise Site


	TASKE Network Client
	Using the Network Client Interface
	Status
	Last Message


	TASKE Administrator
	Starting the Administrator
	Opening the Administrator Using the Start Button
	Opening the Administrator from the TASKE Program Folder

	Using the Menu Bar
	File Menu
	View Menu
	Help Menu

	Using the Main Control Panel
	Mode Selection
	Table Selection in Database Mode
	Tool Selection in Configuration Mode

	Selecting a Mode
	Using the Database Mode
	Using the Database Mode Interface
	Exporting the TASKE Database
	Defining Trunks
	Defining Trunk Groups
	Defining Extensions
	Defining Extension Groups
	Defining Agents
	Defining Agent Groups
	Defining Queues
	Queue Groups
	Defining Qualifier Codes
	Defining Spectrums
	Defining Options
	Defining DNIS Numbers

	Using the Configuration Mode
	Using the Configuration Mode Interface
	Using the Event Log
	Using the Maintenance Tool
	Setting Alarms

	Administrator Glossary

	TASKE ACD Monitor
	Real-time Mode
	Replay Mode
	ACD Monitor Interface
	Starting the TASKE ACD / Enterprise ACD Monitor
	Network Client

	Using the Menu Bar
	File Menu
	View Menu
	Properties Menu
	Replay Menu - Replay Mode Only
	Chat Menu
	Help Menu

	Using the Main Control Panel
	Mode Selection
	Date and Time
	Queue Manager
	Queue Monitor List
	Replay Date Selection
	Replay Control

	Using the Queue Manager
	Queue Selector
	Properties for Selected Queue(s)
	Closing the Queue Manager
	Enabling and Disabling the Monitoring of Queues and Queue Groups
	Setting Alarm Parameters for Queues and Queue Groups

	Selecting a Mode: Real-time or Replay
	The Queue Information Display Area
	Displaying Queue and Queue Group Information
	Alarm Situations

	Overview of the Queue Panels
	Real-time Panel
	Review Panel

	Recognizing Alarm Situations
	Understanding Real-time Agent Adherence Alarms

	Saved Settings
	Using the Real-time Mode
	Accessing Real-time Information
	Legend of Queue Panel Icons
	Monitoring with the Agent States Report
	Monitoring with Agent Maps
	Filtering the Agent States Report and Agent Maps
	Accessing Recent Historical Information

	Using the Replay Mode
	Selecting the Replay Date
	Using the Replay Controls
	Setting the Replay Speed
	Setting Trigger Stops in Replay

	Using the Enterprise ACD Monitor
	Monitoring Remote Sites

	ACD Monitor Glossary

	TASKE Reports
	Starting TASKE Reports
	Opening Reports Using the Start Button
	Opening Reports from the TASKE Program Folder

	Using the Menu Bar
	File Menu
	Help Menu

	Using the Main Control Panel
	Daily Reports
	Weekly Reports
	Monthly Reports
	Year By Week Reports
	Year By Month Reports
	Forecast Reports

	Using the Report Templates Panel
	Using the Properties Window
	Defining Export Properties for Reports
	Using the Forecast Properties Window

	Using the Publication Viewer
	Changing the Report Font
	Manually Exporting a Report
	Manually Printing a Report

	Generating Reports
	Generating Reports from Existing Templates
	Creating Trunk Report Templates
	Creating Extension Report Templates
	Creating Extension Group Report Templates
	Creating Agent Report Templates
	Creating Agent Group Report Templates
	Creating Queue Report Templates
	Creating Queue Answer Spectrum Report Templates
	Creating Queue Abandon Spectrum Report Templates
	Creating Queue Interflow Spectrum Report Templates
	Creating Queue Activity Report Templates
	Creating Queue Peaks Report Templates
	Creating Queue Group Report Templates
	Creating Queue Group Answer Spectrum Report Templates
	Creating Queue Group Abandon Spectrum Report Templates
	Creating Queue Group Interflow Spectrum Report Templates
	Creating Queue Group Activity Report Templates
	Creating Queue Group Peaks Report Templates
	Creating Forecast Report Templates

	Printing and Exporting Reports Automatically
	Scheduling Reports to Print and Export Automatically

	Using Enterprise Reports
	Creating Enterprise Reports

	Using Notification Reports
	Generating Notification Reports
	Notification Report Events


	Traffic Analyzer
	Overview of the Traffic Analyzer Interface
	Menu Bar
	Tool Bar
	Main Window
	Status Bar

	Understanding Traffic Concepts
	Busy Hour/Busy Season
	Blocking
	Queue Delay/Call Abandons
	Call Duration
	Service Criteria

	Creating a Traffic Analysis
	Service Percentage - Level of Abandons
	Telephone Service Factor - Speed of Answer
	Creating an Erlang C Traffic Analysis
	Erlang C Traffic Calculations
	Creating an Erlang B Traffic Analysis
	Erlang B Traffic Calculations
	Creating a Poisson Traffic Analysis
	Poisson Traffic Calculations

	Understanding Traffic Reports
	Recalculating a Traffic Analysis
	Switching Between Line, Bar, and Pie Charts
	Calculating Staffing Requirements
	Traffic Model Information Panel
	Data Table Panel
	Graph Panel

	Using the Cost Justification Guide
	Call Center Cost Dynamics


	TASKE Agent Desktop
	Starting Agent Desktop
	Opening the Agent Desktop Using the Start Button
	Opening the Agent Desktop from the TASKE Program Folder

	Using the Agent Desktop Interface
	Adjusting the Window Size and Position
	Agent Desktop Display Window: Hide/Restore Versus Always on Top

	Creating, Saving, and Opening Agent Desktop Settings
	Creating a New Settings File
	Saving a New Settings File
	Saving an Existing Settings File
	Opening a Settings File

	Adding, Editing, and Deleting ACD Variables
	Adding ACD Variables to the Agent Desktop Window
	Editing ACD Variables
	Deleting ACD Variables
	Defining Thresholds for ACD Variables

	Filtering Cell Information
	Selecting Cell Information for Display

	Docking the Agent Desktop Window to the PC Desktop
	Docking the Agent Desktop Window
	Undocking the Agent Desktop Window

	Changing the Variable Display
	Changing the Display Order of Variables
	Displaying Variables Horizontally
	Displaying Variables Vertically
	Displaying the Agent Desktop as a Grid

	Changing the Font
	Exiting from the Agent Desktop Application

	TASKE Search
	Using the Search Interface
	Main Window
	Information Window
	Information Tabs
	Menu Bar and Toolbars

	Opening PBX files
	Printing Search Information
	Print Preview from the Main Window
	Printing the Main Window Contents
	Printing the Information Window Contents

	Copying Information to the Clipboard
	Saving Search Information
	Using the Search Commands
	Using the File Menu
	Using the Edit Menu
	Using the View Menu
	Using the Tools Menu
	Using the Window Menu
	Using the Help Menu

	Understanding Call Event Records
	Identifying ACD Events
	Identifying COL Events
	Identifying ICM Events
	Sorting Records by Call ID
	Explaining Call Records

	Filtering Call Records by Event
	Selecting Events
	Searching for a Pattern
	Using Additional Filters

	Filtering Call Records by Call Type
	Selecting the Call State
	Selecting the Time Period
	Selecting the Call Type
	Selecting Database Members


	TASKE Chat
	Logging Into and Out of Chat from the ACD Monitor
	Logging Out of Chat
	Logging into Chat

	Opening the Chat Window from the ACD Monitor
	Logging Into and Out of Chat from the Agent Desktop
	Logging Out of TASKE Chat
	Logging into TASKE Chat

	Opening the Chat Window from Agent Desktop
	Using the Chat Interface
	Menu Bar
	Contact Panel
	Chat Panel
	Outgoing Message Panel

	Maintaining the Contact List
	Adding Contacts to the Contact List
	Removing Contacts from the Contact List

	Understanding Contact Status Symbols
	Requesting a Chat
	To Send a Chat Request to an Individual

	Accepting or Rejecting a Chat Request
	To Accept a Chat Request
	To Reject a Chat Request

	Broadcasting a Message - Supervisors Only
	To Broadcast a Message

	Receiving Broadcast Messages
	Conducting a Chat Session
	To Send an Outgoing Message
	Receiving Incoming Messages
	Switching between Chat Sessions

	Save Time Using Copy and Paste
	Copying Text in the Chat Panel
	Pasting Text into the Outgoing Message Panel

	Ending a Chat Session
	To Terminate a Chat Session with an Individual
	When a Chat Session is Terminated by the Other Party


	TASKE WallSign
	The WallSign Server
	The WallSign Administrator
	Overriding A Sign Plan with Quick Messages
	Creating Custom Graphics

	WallSign Startup and Shutdown
	Starting the WallSign Administrator
	Starting the WallSign Server
	Shutting Down the WallSign Administrator
	Shutting Down the WallSign Server

	Using the WallSign Server
	Using the WallSign Administrator
	Sign Plan Components

	Using the Menu Bar
	File Menu
	Edit Menu
	View Menu
	Tools Menu
	Help Menu

	Using the Main Control Panel
	Mode Selection
	Window Selection

	Selecting a Mode in the WallSign Administrator
	Configuration Mode
	View Mode

	Configuring Communication Paths
	Sending Test Messages to Reader Boards
	Configuring the Sign Tone
	Using the ACD Variables Window
	Components of the ACD Variables Window
	Defining ACD Variables
	Deleting ACD Variables

	Using the Messages and Quick Messages Windows
	Components of the Messages and Quick Messages Windows
	Building Messages and Quick Messages
	Selecting the Line Position
	Adding Special Effects
	Adding Special Graphics
	Adding Character Formatting
	Adding Color to a Message
	Quick Message Display Options
	Starting and Stopping Quick Messages
	Deleting Messages and Quick Messages

	Using the Decisions Window
	Decisions Window Components
	Defining Decision Trees
	Default and Conditional Decisions
	Deleting A Decision Tree

	Using the Days Window
	Days Window Components
	Defining Special Days
	Defining Specific Dates
	Defining Reference Dates
	Deleting Special Days

	Using the Day Plans Window
	Day Plans Window Components
	Defining Day Plans
	Deleting a Day Plan

	Using the Scripts Window
	Scripts Window Components
	Defining a Script
	Deleting a Script

	Using the Signs Window
	Signs Window Components
	Defining A Sign (Spectrum Reader Board)
	Deleting a Sign

	Using the Graphics Window
	Graphics Window Components
	Creating Custom Graphics
	Dimensions
	Using the Color Palette and Drawing Platform
	Deleting Custom Graphics


	TASKE Voice ToolBox
	Controlling Media Using Voice Plans
	Voice ToolBox Startup and Shutdown
	Starting the Voice Administrator
	Starting the Voice Server
	Shutting Down the Voice Administrator
	Shutting Down the Voice Server

	Using the Voice Administrator Interface
	Menu Bar
	Main Control Panel
	Display Area

	Selecting a Mode
	Configuration Mode
	View Mode

	Setting System Parameters
	Configuring Communication Paths
	Updating System Data in the Voice Server
	Updating System Data Using the Send Data to Voice Machine Option

	Defining Test Variables
	Using the Messages Window
	Messages Window Components
	Using the Tools of the Messages Window
	Building a Message
	Deleting a Message

	Using the Auto-attendants Window
	Auto-attendants Window Components
	Using the Node List and Properties Window
	Using Play Nodes
	Using Get Digit Nodes
	Using Digit Nodes
	Using Dial Nodes
	Using Supervisor Nodes
	Defining Auto-attendants
	Deleting Auto-attendants

	Using the Day Plans Window
	Day Plans Window Components
	Using the Tools of the Day Plans Window
	Defining Day Plans
	Deleting a Day Plan

	Using the Days Window
	Days Window Components
	Defining Specific Dates
	Defining Reference Dates
	Deleting Special Days

	Using the Scripts Window
	Scripts Window Components
	Using the Tools of the Scripts Window
	Defining a Script
	Deleting a Script

	Using the Channels Window
	Channels Window Components
	Defining a Voice Channel
	Setting Channel Parameters
	Properties of a Voice Channel
	Deleting a Voice Channel

	Remote Programming
	Accessing System Messaging
	Reviewing the System Message
	Recording Messages
	Reviewing, Re-recording, and Saving Messages

	Identifying System Sounds

	Glossary of Terms
	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X
	Y



